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Hesap Makinesini Kullanmadan Önce

Öncelikle Bunu Okuyun

Bu Kılavuz Hakkında
•　Bu kılavuzun içeriği önceden haber verilmeden değiştirilebilir.
•　Bu kılavuzun içeriği, üretim sürecinin her aşamasında kontrol edilmiştir. Şüpheli, hatalı veya benzeri bir 

durum fark ederseniz bizimle iletişime geçmekten çekinmeyin.
•　Bu kılavuzun hiçbir bölümü, üreticinin yazılı izni olmadan hiçbir şekilde çoğaltılamaz.
•　Bu kılavuzda gösterilen ekranlar ve görseller (örneğin tuş işaretleri) yalnızca açıklayıcı amaçlıdır 

ve temsil ettikleri gerçek öğelerden biraz farklı olabilir.
•　QR Kodu, Japonya ve diğer ülkelerde DENSO WAVE INCORPORATED’ın tescilli markasıdır.
•　Python, Python Yazılım Vakfı'nın tescilli bir markasıdır. Bu kılavuzda, ticari marka (™) ve tescilli ticari marka 

(®) sembollerine yer verilmemiştir.
•　Bu kılavuzda kullanılan şirket ve ürün isimleri, ilgili sahiplerinin tescilli markaları veya ticari markaları olabilir.
•　CASIO Computer Co., Ltd. hiçbir durumda, bu ürünün ve beraberinde gelen öğelerin satın alınması veya 

kullanımıyla bağlantılı ya da bunlardan kaynaklanan özel, dolaylı, rastlantısal veya sonuç olarak ortaya çıkan 
zararlardan dolayı herhangi bir kişiye karşı sorumlu tutulamaz. Ayrıca, CASIO Computer Co., Ltd., bu ürünün 
ve beraberinde gelen öğelerin kullanımıyla bağlantılı olarak üçüncü taraflarca ileri sürülebilecek hiçbir türdeki 
talepten de sorumlu değildir.

•　Üretici ve tedarikçileri, hiçbir durumda size veya başka herhangi bir kişiye, arıza, onarım veya pil değişimi 
nedeniyle oluşabilecek veri ve/veya formül kaybından kaynaklanan zararlar, masraflar, kar kaybı, tasarruf 
kaybı ya da diğer herhangi bir zarardan dolayı sorumlu tutulamaz. Bu tür veri kayıplarına karşı korunmak 
sizin sorumluluğunuzdadır; bu nedenle verilerin fiziksel kayıtlarını oluşturmanız tavsiye edilir.

fx-CG100 Kullanıcıları için Dikkat
•　Aksi belirtilmedikçe, bu kılavuzda anlatılan işlemler, Ülke ayarı için "International" (Uluslararası) 

seçildiğinde geçerlidir (sayfa 200). Ülke ayarı için "United States" (Amerika Birleşik Devletleri) veya 
"International" dışında bir ayar seçildiğinde, ekran içeriği ve ekran öğelerinin düzeni bu kılavuzda 
gösterilenden farklılık gösterebilir 

fx-1AU GRFİK Kullanıcıları için Dikkat
•　Aksi özellikle belirtilmedikçe, bu kılavuzda fx-CG100 ile yapılan işlemler açıklanmaktadır (Ülke 

ayarı (sayfa 200): International (Uluslararası)). fx-1AU GRAPH modelinde ise ekran içerikleri ve 
ekran öğelerinin düzeni farklılık gösterebilir. 
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 Düğme İşlemleri
Hesap makinenizin bazı tuşlarına birden fazla işlev atanmıştır. Bu kılavuz, her işleve erişmek için gerekli tuş 
işlemlerini belirtmek üzere aşağıdaki gösterimleri kullanır.

(1)

(2) (3)

fx-CG100

(1)

(2) (3)

fx-1AU GRAPH

(1) (2) (3)

C (

(1) “       ” ye girmek için ®  ye basın.  .
Bu, tuş üstünde yazan işlevi kullanma işlemidir.

(2) G ® tuşuna bastıktan sonra, parantez içinde gösterilen “G” harfini girmek için yukarıdaki tuşa basın.
Bu işlem, tuşun üstünde ve solunda yeşil (fx-CG100) / mavi (fx-1AU GRAPH) renkte yazılı olan işlevlere 
erişmek için kullanılır.
 (3) P ® tuşuna bastıktan sonra, parantez içinde gösterilen “C” harfini girmek için yukarıdaki tuşa basın.
Bu işlem, tuşun üstünde ve sağında turuncu (fx-CG100) / kırmızı (fx-1AU GRAPH) renkte yazılı olan işlevlere 
erişmek için kullanılır.

 Tuşu ve   Tuşu
Ⓑ tuşu ve      tuşu aynı işlemi gerçekleştirir. Bu kılavuzda,    bir ayarı seçmek veya uygulamak için kullanılırken,  
     bir hesaplamayı yürütmek için kullanılır. Ancak,  veya      tuşlarından birinin gösterildiği işlemler için hangi tuşa
bastığınızın bir farkı yoktur.

 

İmleci veya vurgulamayı taşımak için bu tuşları kullanın. Bu kılavuz boyunca bu tuşlar “imleç tuşları” olarak
anılacaktır. 

” 

Tüm Uygulamalar İçin Genel Önlemler
•　Hesaplamalar biraz zaman alabilir.

Dahili bir hesaplama devam ederken ekranın sağ üst köşesinde dönen bir       simgesi görüntülenir. 
Hesaplamanın tamamlanmasını beklemeden işlemi durdurmak için ac tuşuna basın.  
 
Zaman Alan Hesaplama Örnekleri
-　Integral Hesaplamları (f(x) ve x aralığına bağlı olarak) 
-　Çok sayıda eleman içeren matrisler veya vektörlerle yapılan hesaplamalar.
-　Üç veya daha fazla değişkenli eşzamanlı denklemler, daha yüksek dereceli doğrusal denklemler ya da 

üçüncü dereceden (kübik) veya daha yüksek dereceden denklemleri çözme.
-　Büyük miktarda veriyle regresyon grafikleri çizme (özellikle sinüzoidal regresyon ve lojistik regresyon 

durumlarında).
•　Hesaplama sonuçları hataya açık olabilir.

•Hesap makinenizin hesaplama doğruluğu ve hata bilgileri hakkında ayrıntılı bilgi için “Hesaplama Aralıkları, 
Basamak Sayısı ve Hassasiyet” (sayfa 254) bölümüne bakınız. 

•　Bir hata mesajı görüntülenirse, içerikleri kontrol edin.
Her bir hata mesajının anlamı için “Hata Mesajları Tablosu”na bakınız. (sayfa 247) 

•　Çoğu fonksiyon, katalog menüsü aracılığıyla erişilerek ulaşılır.
Fonksiyonların açıklamaları ve sözdizimleri için “Katalog Menüsü Detayları”na (sayfa 221) bakınız. d/u/l/r
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 Hesap Makinesi Başlangıç Ekranı
•  Ana ekrandayken “S” tuşuna basmak sizi alttaki bilgileri içeren “Başlangıç Ekranı” na 
ulaştıracaktır.
•　Casio'nun dünya geneli eğitim servisi sitesinin başlangıç ekranına ulaştıran kod. 

(https://wes.casio.com/calc/cg/)
Başlangıç ekranı sizin Kullanım kılavuzuna erişiminizi sağlar ve diğer bağlantılı bilgiler size Hesap Makinenizi 
kullanmaya başlamakta yardım eder.

•　Hesap Makinesi ID numarası (8 Karakterlik dize)

QR Kodun ekran parlaklığını ayarlamak için
Başlangıç ekranı görüntülenirken, ekran parlaklığını ayarlamak için   ve  tuşlarını kullanın. Bu ayarla yapılan 
ayarlar, Sistem uygulamasının Görüntü Ayarları (sayfa 200) ile paylaşılır.

Ana ekrana dönmek için 
 tuşuna basın.
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Basit Uygulama Operasyonları

Uygulamayı Kullanmaya Başlama

2.　Başlatmak istediğiniz uygulamanın simgesine vurgu çubuğunu taşımak için imleç      tuşlarını kullanın ve 
ardından  tuşuna basın. Alternatif olarak, bir sayı veya harf tuşuna basarak da bir uygulama seçebilirsiniz.

　•Seçmek istediğiniz simgenin sağ üst köşesinde 1 gösteriliyorsa,    tuşuna basın.
•Eğer A harfi gösteriliyorsa,      tuşuna basın.
 

 Uygulana Ekranı Yapılandırması

Durum Çubuğu

Uygulama Ekranı

Sekme

Durum Çubuğu
Ekranın üst kısmında yer alan durum çubuğu; pil durumunu, anlık ayarları, çeşitli statüleri ve yardım mesajlarını 
gösterir.

Uygulama Ekranı
Bu, uygulamanın görüntüleme alanıdır. Pencere bir grafik görüntülerken, sekmeleri gizleyerek görüntüleme 
alanını genişletebilirsiniz (bkz. 'Sekmelerin Kullanımı' (sayfa 8)).

Sekme
Hesap makinenizdeki bazı uygulamaların birden fazla sekmesi vardır. Her sekme için bir rol veya fonksiyon 
atanmıştır. Aktif olarak kullanılan sekme beyaz, kullanılmayan sekme ise siyah bir şekilde görünüm sağlar. 
Bazı uygulamalar ise sekmeye sahip değillerdir.

Sekmelerin Kullanımı
Bazı uygulamalarda, sekmeler işlevlere veya özelliklere göre düzenlenmiştir.
•　 Sekmeli uygulamalar iki farklı tipe ayrılır ve uygulamanın tipi, sekmelerin organizasyonuna bağlıdır.

Tek Yönlü Tip: Bu tür bir uygulamada bir başlangıç sekmesi ve bir bitiş sekmesi bulunur. Uygulama işlemleri, 
başlangıç (en soldaki) sekmeden bitiş (en sağdaki) sekmeye kadar sırasıyla ilerler. 
Her     tuşuna basıldığında bir sonraki sağdaki sekmeye geçilir.

 

Dağıtım Uygulaması
 
< tuşuna basıldığında, başlangıç (en soldaki) sekmeye ulaşılana kadar işlemler ters sırada (sola doğru) ilerler.  

1.　Ana ekrana ulaşmak için  tuşuna basın .
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Dairesel tip: Bu tür uygulamalarda işlemler sekmeler arasında döngüsel olarak ilerler. Herhangi bir  

Grafik & Tablo uygulaması Python Uygulaması
 
Bir sonraki sekmeye geçmek için     tuşuna basın 
 Sekmelerin her iki ucundaki      ve       işaretleri, okların gösterdiği yönde sekme olduğunu belirtir.

 

•　    tuşuna basarak ekran üzerindeki grafiği gizleyebilirsiniz. Bu ekran alanını genişletir.

Bazı durumlarda sekmeler otomatik olarak gizlenebilir. Eğer gizlenen sekmeleri       görebiliyorsanız bu durum 
çubuğunda görünecektir. Bu durumda bu tuşa basınız      . 

 Alfa Karakter Uygulaması ve Sayısal Girdiler

Doğal Girdi ve Doğrusal Girdi
Hesap makineniz, ifadeleri girmek için doğal girdi veya doğrusal girdi olmak üzere iki farklı yöntem sunar. 
Doğal girdi, ifadeleri ders kitabı formatında girmenize olanak tanır. Doğrusal girdi ile ise ifadeleri doğrusal formatta 
girebilirsiniz. Kesirler, karekökler (√), bazı fonksiyonlar, vektörler ve matrisler girilirken doğal girdi ve doğrusal girdi 
arasında farklılıklar bulunur. Aşağıdaki tablo, doğal ve doğrusal girdi örneklerini göstermektedir.

 

Açıklama
Girdi Metodu

Kesir,  
Fonksiyon-İntegral 
Açıklamaları Matris

Natural input

Linear input

Daha önce girilen sayısal değeri (yalnızca doğrudan giriş) bir fonksiyonun argümanı olarak kullanmak için

Örnek: girin1 + 7
6

 ve bu değeri ile               değiştirin.1 + 7
6

1

Yukarıdaki örnekte girilen     sayısı,           (INS)tuşuna basıldığı      nda, bir sonraki tuş işlemiyle girilen fonksiyonunun 
(   ) argümanı haline gelir. 
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sekme görüntülenirken       tuşuna basıldığında, bir sonraki (sağdaki) sekmeye geçilir.



Tekleme modu ile üzerine yazma modu arasında geçiş yapmak (sadece doğrusal girdiler)
Üzerine yazma modunda, imlecin bulunduğu konumdaki karakter, girdiğiniz karakter ile değiştirilir. Her G ® (INS) 
tuşuna basıldığında ekleme modu ile üzerine yazma modu arasında geçiş yapılır. İmleç şekli, ekleme modunda “1” 
ve üzerine yazma modunda “     ” şeklindedir.

Alfabetik Girdiler
Tekli alfa karakter gireceksen, P tuşuna bas (durum çubuğunda olan      göstergesine), ardından turuncu ile 
işaretlendirirmiş tuşa(fx-CG100) ya da kırmızı ile işaretlendirirmiş tuşa (fx-1AU GRAPH). Alfa karakterler ek 
olarak boşluk (     ) ve tırnak işareti de girebilirsiniz. 

*　Diğer sembolleri kullanmak için  % > [TAMAMI] > SEMBOL.

Alfa Kilidi
Alfa karakterlerinin sürekli girişine izin vermek için tuşları alfa kilidine alabilirsiniz, böylece her karakter için P 
tuşuna basmanıza gerek kalmaz. 

 

                      tuşuna basmaktıktan sonra alfa tuşları kilitler ve bu durum çubuğunda      ile gösterilir. Alfa 
kilidini açmak için                                  tuşuna basın.   

Not
•　Python uygulamasının düzenleyicisini kullanırken, tuşlar otomatik olarak küçük harfe alfa kilitlenir ve 

bu durum çubuğunda      ile gösterilir.

Kopyalama, Kesme ve Yapıştırma İfadeleri
Daha önce girilmiş ifadeler veya metin dizilerini seçebilir ve bunları panoya kopyalayabilir ya da kesebilirsiniz. 
Daha sonra pano içeriğini aynı uygulamaya veya başka bir uygulamaya yapıştırabilirsiniz.

Ekran Bilgisini Kesme ya da Kopyalama

1.　Kopyalamak veya kesmek istediğiniz veri aralığının başına giriş imlecini ( ) taşıyın.

2.　g  ($)     tuşlarına basın.
•　Bu,     4. adımda     düğmesine basana kadar durum çubuğunda görüntülenir.

3.　Kopyalamak veya kesmek istediğiniz veri aralığının sonuna imleci taşıyın.

4.　  tuşuna bastıktan sonra beliren menüden kopyalama ya da kesme seçeneğini seçin.
•　İsterseniz ilk olarak bitiş noktasını belirleyebilirsiniz

Bilgiyi yapıştırmak

1.　Girdi imlecini ( ) yapıştırmak istediğiniz yere hareket ettirin. 

2.　gg(%)       ’e basın.

Sık Kullanılan Ayarlar Menüsü

S  Ayarlar Menüsü (Uygulama ayarlarını değiştirme)
Ayarlar menüsü, şu anda kullandığınız uygulamaya ait ayar öğelerini görüntüler. Bu menü, birden fazla 
uygulamada ortak olan öğeleri ve belirli bir uygulamaya özgü öğeleri içerir.

Uygulama ayarlarının değişimi

1.　Ⓐ tuşuna bastıktan sonra, uygulamayı seçip, sonra da Ⓑ tuşuna basın.

2.　Ayarlar menüsünü görüntülemek için S  tuşuna basın ve daha sonra ayarları değiştirebilirsiniz.  
•　Bir menü öğesinin sağında  bir anahtar (Kapalı:       , Açık:      ) varsa, Kapalı ve Açık arasında geçiş yapmak 

için (B) düğmesine basın. 
•　Ayarlar ve seçenekler hakkında daha detaylı bilgi almak için “Ayarlar menüsü detayları” (page 214).

.
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 Değişken Menüsü (Bir Hesaplama ya da İfadeye Değişken Girmek)
Bir değişkeni bir hesaplama veya ifadeye girmek için Değişken menüsünü kullanın.

Değişken isimleri:             Menüden seçiniz:             Detaylar:
Alpha değeri  > [Alpha] Alfa değişkenini kullanmak(Sayfa 18)

Fonksiyon değişkeni  > [Function] Fonksiyon Değişkenlerini Kullanma (Sayfa 18)
Bir fonksiyon girmek için (sayfa 76)

Vektör değişkeni  > [Vector] Hesaplamaya Vektör Girme( sayfa 22)
Vektör Değişkenlerini Saklama (sayfa 21)

Matris değişkeni  > [Matrix] Bir Hesaplamaya Matris Girme  (sayfa 25)
Matris Değişkenlerini Saklama (sayfa 24)

Liste değişkeni  > [List] Hesaplamaya Liste Girme  (sayfa 27)
Liste Değişkenlerini Saklama (sayfa 27)

Not
•　Her değişkenin menü öğesi, değişkende şu anda depolanan içeriğin satır biçimini de gösterir. 

      Katalog Menü (Fonksiyon ve Komut Girişi)
Katalog menüsü, tüm işlevlerin, komutların, uygulama değişkenlerinin* ve sembollerin kapsamlı bir listesidir.
* Belirli giriş veya çıkış değerlerini otomatik olarak saklayan değişkenler.
,
　

Katalog menüsünde yer alan öğelerle ilgili ayrıntılar için "Katalog Menüsü Ayrıntıları" na (sayfa 221) bakın..

Not
•　Python uygulamasını veya Base-N uygulamasını kullanırken     tuşuna basıldığında, kullanmakta 

olduğunuz uygulamanın Katalog menüsü görüntülenir. Ayrıntılar için her bir uygulamanın açıklandığı 
bölümlere bakın.

 Araçlar menüsü (İşlem Seçeneklerini Görüntüleme)

Araçlar menüsünü görüntülemek için      tuşuna basın. Araçlar menüsünde görünen öğeler, şu anda kullanmakta 
olduğunuz uygulamaya veya sekmeye bağlıdır. 

 

Bir menü öğesi vurgulandığında sağ tarafında      harfi görüntüleniyorsa,     tuşuna bastığınızda açılan araçlar 
menüsü, vurgulanan satır için etkinleştirilmiş işlem seçeneklerini içerecektir 

 

 Format  

.
*　

Menü ve Diyalog İşlemleri (Seçenek Numaralarını Kullanma)
Bir uygulamada belirli tuşlara (    ,    vb.) basmak veya bazı işlemleri yürütmek bir menü veya iletişim 
kutusunun görünmesine neden olur.

Menü Örneği Diyalog Örneği
Menü veya iletişim kutusundaki bir öğeyi seçmenin iki yolu vardır.
•　Method 1 : Vurgulamayı kullanmak istediğiniz öğeye taşımak için     ve     düğmelerini kullanın ve ardından 

b düğmesine basın. 
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            tuşuna bastığınızda çıkan Format menüsü, hesaplama sonucunun görüntü formatını ve hücre detaylarını 
değiştirmenizi sağlar. Format menüsünde yer alan öğeler hakkında detaylı bilgi için, "Hesaplama Sonuçlarının 
Görüntü Formatını Değiştirme (Format Menüsü)" bölümüne (sayfa 17) bakın.

    > için "               Ondalık" seçildiğinde  [FORMAT Tuşu] (sayfa 220) (ilk varsayılan).



•　Metot 2 : Seçmek istediğiniz öğenin solundaki sayı veya harfe karşılık gelen sayı veya harf tuşuna* basın.

Bir öğenin solundaki sayı veya harf, onun "Seçenek Numarası" dır.
*　A'dan L'ye kadar bir harf girmek için,      'dan       ' ye kadar (    'ye basmadan) tuşlarına basın.

M'den Z'ye bir harf girmek için P + M ila P + Z tuşlarına basın. Bu durumda önce P 'ye bastığınızdan emin olun.  

Not
•　Menü veya iletişim kutusu o anda görüntülenmese bile, karşılık gelen numara veya harf tuşuna basarak 

bir menü veya iletişim kutusu işlemini seçmek için Seçenek numaralarını kullanabilirsiniz. Bunun nasıl 
çalıştığını anlamak için aşağıdaki örnek işlemi gerçekleştirmeyi deneyin.

•　Seçenek Numaraları, S > [Show Option Numbers] (sayfa 220)  açık olduğunda ve açık 
olmadığında görüntülenir. Kapatıldığında görüntülenir. Varsayılan ayar Açık'tır. Sayı ve harf tuşlarına 
basarak yürüttüğünüz menü ve iletişim kutusu işlemlerinin, S > [Show Option Numbers] kapalı 
olsa bile etkin kaldığını unutmayın.
 

Seçenek Numaralarını Kullanarak Menü İşlemleri Örneği
Bu örnekteki işlemler, Calculate uygulaması çalışırken ve Ayarlar menüsü görüntülenirken gerçekleştirilir. 
Seçenek Numaraları kullanılarak aşağıdaki işlemler gerçekleştirilecektir.
•　[Complex Mode] ayarı için [a+bi] seçimi
•　[Show Option Numbers] özelliğini kapatıp tekrar açma
 

1.　h  > Calculate

2.　       tuşuna basın. .
•　Bu işlem ayarlar menüsünü görüntüler. 
•　 ‘ nin Karmaşık Modun solunda gösterildiğinde

3.　      tuşuna basın. .
•　Bu işlem direky menünün sonuna ilerleminizi sağlar.
•　 ‘ in Seçenek Numaralarını Göster butonunun solunda 

gösterildiğine dikkat edin. 

4.　(Kompleks Mod)'u seçmek için 2  'ye basın. 
•　Bu, mevcut Kompleks Mod ayarlarının bir listesini görüntüler.

5.　[a+bi]'yi seçmek için 2  'ye basın.
•　Bu, Kompleks Mod ayarını a+bi olarak değiştirir ve Ayarlar 

menüsüne geri döner.

6.　8  'e basarak [Show Option Numbers] ayarını seçin.
•　Bu, [Seçenek Numaralarını Göster] ayarını kapatır (        ) ve 

menü öğelerinin solundaki Seçenek Numaralarının 
kaybolmasına neden olur.
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7.　Tekrar     tuşuna basın (veya (    )). 
•　Bu, Seçenek Numaralarının yeniden görünmesine neden olan [Seçenek Numaralarını Göster] ayarını 

(      ) açar.
Seçenek Numarası İşlemlerinin Devre Dışı Bırakıldığı Durumlar
Seçenek Numarası işlemleri devre dışı bırakılırken, doğrudan sayısal giriş gerektiren bir ayar öğesi vurgulanır, 
çünkü bir sayı veya harf tuşuna basıldığında bir giriş iletişim kutusu görüntülenir. Seçenek Numaraları devre 
dışı bırakıldıklarında soluklaşır.

Ekran Yakalama İşlevini Kullanma
Ekranda görüntülenenleri yakalamak için                  tuşuna basın. Yakalama başarılı olduğunda ekranın 
ortasında "Capt01" (burada "01", 01 ile 20 arasında bir sayıdır) görünecektir. 

Yakalanan görüntü dosyası, Depolama Belleği içindeki 'Capt' klasörüne kaydedilir.

Ekran Yakalama Formatı
Yakalanan görüntüler g4p (varsayılan) veya .bmp görüntüler olarak kaydedilebilir. Ayrıntılar için, "Görüntü 
Yakalama Formatını Belirleme (Yakalama Formatı)"  (sayfa 201) bölümüne bakın..

Ekran Fotoğraflarını Görüntüleme
Yakalanan görüntüleri, Bellek uygulamasının Depolama Belleği sekmesini görüntüleyerek "Capt" klasöründe 
görüntüleyebilirsiniz. Ayrıntılar için, "Depolama Belleği Sekmesini Kullanma" (sayfa 196) bölümüne bakın..

Ekran Fotoğraflarını Kullanma
g4p formatında kaydedilen bir görüntü, grafik penceresi arka planı olarak kullanılabilir ("Arka Plan (Grafik)" 
(sayfa 219)). Bmp formatında kaydedilen görüntüler bir PC'ye aktarılarak kullanılabilir ("Hesap Makinesini 
Bilgisayara Bağlama" (sayfa 210)).

.

Yakalamanın Gerçekleştirilemediği Durumlar

Aşağıdaki koşullardan herhangi biri mevcutken                  tuşuna  basmak            ekranın ortasında 
görünmesine neden olur ve bu da yakalamanın gerçekleştirilemeyeceğini gösterir.
•　Kullanılabilir Depolama Belleği yetersiz olduğunda.
•　Kullanılabilir tüm bmp dosya adları (Capt01.bmp ile Capt20.bmp arasında) kullanımdayken bir bmp       

görüntüsünü kaydetmeye çalıştığınızda.
•　Mevcut tüm g4p dosya adları (Capt01.g4p - Capt20.g4p) kullanımdayken bir g4p görüntüsünü 

kaydetmeye çalıştığınızda.
•　Yetersiz pil gücü olduğunda.
•　Sınav Modundayken.

 Arıza olduğunu düşünmeden önce
Sorun devam ederse,      'den başlayarak aşağıdaki adımları gerçekleştirmeyi deneyin.① .
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①　 Hesap makinesinin ayarlarını sıfırlama
(1)  > System
(2) Sıfırlamayı seçiniz > [Settings].
(3) Diyalog belirdiğinde (OK) seçeneğini seçiniz.
Eğer bu işe yaramadıysa adım ② ‘yi uygulayınız. 

②　 Yeniden başlat tuşuna basarak hesap makinesini yeniden başlatınız.

Önemli!
•　Hesap makinesini yeniden başlatmak için YENİDEN BAŞLAT düğmesine bastığınızda, hesap 

makinesinin belleğinde zaten kayıtlı olan veriler normalde korunur. Ancak, düzenlenmekte olan veriler 
veya girilmekte olan ancak RESTART düğmesine basıldığı sırada henüz sonlandırılmamış veriler 
korunmaz.

Yeniden Başlat butonu

RESTART düğmesine bastıktan sonra, ekranda sırayla görünen aşağıdaki ayarların tümünü yapılandırın: Dil, 
Ülke (yalnızca fx-CG100), Görüntü Ayarları, Güç Özellikleri, Pil Ayarları.
Her ayar hakkında bilgi için "Sistem Uygulaması" na (sayfa 199) bakın. 
Eğer problemi çözmediyse adım ③’ ü deneyin.

③　 Hesap makinesi geçmişini silme
Aşağıdaki işlemi gerçekleştirmeden önce, hesap makinesinde depolanan tüm önemli verileri kopyaladığınızdan 
emin olun. Adım (2) hesap makinenizin Ana Belleğindeki tüm verileri siler. Adım (3), tüm hesap makinesi 
ayarlarını ilk varsayılanlarına döndürür ve Ana Bellek ve Depolama Belleğindeki tüm verileri siler.
(1)  > System
(2) Sıfırlama işlemini başlat > [Main Memory].
(3) İşlem düzelmezse, [Delete] > [Initialize ALL] komutunu yürütün.
Sıfırlama işlemi hakkında bilgi için, "Hesap Makinesini Sıfırlama (Reset)" (sayfa 199) bölümüne bakın. 

Düşük Pil Uyarısı
Aşağıdaki Düşük Pil Uyarısı belirirse, hesap makinenizi hemen kapatın ve pillerini değiştirin.

Önemli!
•　Düşük pil uyarısı göründükten sonra hesap makinenizi pilleri değiştirmeden kullanmaya 

devam ederseniz, bellek içeriğini korumak için otomatik olarak kapanır ve tekrar açamazsınız.
•　Düşük pil uyarısı göründükten sonra pilleri değiştirmeden üniteden ayrılmak, bellek içeriğinin 

silinmesine neden olabilir.
•
　
Düşük pil uyarısı göründükten sonra, pilleri değiştirene kadar verileri bir bilgisayara aktaramazsınız.
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Uygulamaların Kullanımları

Hesaplama Uygulamaları
Hesaplama, çeşitli fonksiyon türlerini kullanarak fonksiyonları girmeye ve çalıştırmaya olanak tanıyan bir 
uygulamadır. Gerçek sayılar, karmaşık sayılar, vektörler, matrisler ve listeler kullanımını destekler.

Basit Hesap Makinesi İşlemleri

Hesaplamaya Başlamadan Önce
1.　  > Calculate

•　İmleç, Hesaplama sekmesindeki giriş kutusunun en solunda görün 

2.　Yapmak istediğiniz formülü girin ve       tuşuna basın 
•　İşlem sonucu, bir sonraki satırda sağa yaslanmış olarak görünecektir.

Örnek Hesaplama

Aritmetik 
Hesaplama 7 8 − 4 5 36

Eksi İşareti -8 7 − (-6) -50

Kesirler 2
3 11

2
13
6

İşlemi silmek için 
        tuşuna basın. 

Hesaplama sekmesindeki tüm içerikleri silmek için 
İmleç, hiçbir şey girilmemiş bir satırdaki giriş kutusunun en solunda bulunurken,       tuşuna basın.

Önceki işlemleri kullanma (Ans)
En son hesaplamaların sonucu, Ans adlı bir değişkende saklanır.          (Ans) tuşuna basarak Ans değişkenini 
yeni bir hesaplamaya girebilirsiniz.

Örnek: 

Yeni bir hesaplamanın basında                       işlem tuşlarına basmak, otomatik olarak Ans değişkenini ve 
ardından ilgili işlemi girer.

Örnek: 

g veya     tuşuna bastığınızda ya da hemen öncesinde bir argüman alan bir fonksiyon (örneğin n! veya nPr 
gibi) girdiğinizde, Ans otomatik olarak girilir.  
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Hesaplama Geçmişini Kullanma
Hesaplama sekmesi, en son yapılan hesaplamalardan oluşan en fazla 30 adet hesaplama satırı ve sonucunu 
saklar.
Hesaplama geçmişindeki bir hesaplama satırını düzenlemek ve yeniden çalıştırmak için
Düzenlemek istediğiniz hesaplama satırını vurgulamak için Ⓒ/Ⓒ tuşlarını kullanın.    /    tuşuna basarak imleci 
hesaplama satırına getirin ve formülü düzenleyin. Düzenlemeyi tamamladıktan sonra, sonraki tüm hesaplama 
satırlarını yeniden hesaplamak ve sonuç satırını güncellemek için     basın. 

 

Bir hesaplama geçmişinin sonuç satırını kopyalayarak yeni bir formüle eklemek için
Kopyalamak istediğiniz hesaplama geçmişi sonuç satırını (sayısal değer içeren sonuç satırı) vurgulayın ve         
ardından      tuşuna basın. Bu işlem satırı panoya kopyalar (bkz. “İfadeleri Kopyalama, Kesme ve Yapıştırma” 
(sayfa10)  

Bu işlem, aşağıda açıklanan durumlarda gerçekleştirilemez:
•　Sonuç satırı bir vektör, matris veya liste biçimindeyse (Bu durumda, Ⓑ tuşuna basıldığında Ans penceresi 

görüntülenir.*) 
•
　
Sonuç satırı, bir formüle girilemeyecek türdeyse (Örneğin, bir hesaplamada kullanılan sonucun...)

“I Simp” (sayfa 223)“F = 4,  14 ,” vb.)

*　Ans penceresi hakkında bilgi için, "Vct Ans" (sayfa 23), "Mat Ans" (sayfa 26) ve "List Ans" (sayfa 28) 
bölümlerine bakın.

Bir hesaplama geçmişi setini silmek için
Silmek istediğiniz hesaplama geçmişi setinin hesaplama satırını veya sonuç satırını vurgulayın ve ardından
     > [Delete Line] seçeneğini belirleyin. 

Hesaplama geçmişini temizlemek için
     > [Delete All] seçeneğini seçin. 

Not
•　S  > [  π  Result] ayarını değiştirmek de hesaplama geçmişini temizler.

Hesaplama Sonuçlarını Standart (Kesir, π,     Biçimi) ve Ondalık arasında geçiş  

Bir hesaplama sonucu görüntülenirken F   tuşuna her basıldığında, sonuç aşağıdaki iki biçim arasında geçiş yapar:
-　Kesir,    veya    içeren biçimπ  
-　Ondalık biçim

Operasyon Açıklamaları:

2 /j 2E

F

F

Not
•　Hesaplama sonuçlarının görüntüleme formatlarını sadece       tuşuna basarak değiştirme, A   > [FORMAT 

Key] (sayfa 220) ayarında               (başlangıç varsayılanı) seçildiğinde desteklenir.
Eğer     > [FORMAT Tuşu] ayarında Format Menüsü seçilmişse,           tuşuna basın..
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Hesaplama Sonuçlarını Görüntüleme Biçimini Değiştirme (Format Menü)
            tuşlarına bastığınızda Format menüsü görüntülenir. Bu menüyü, hesaplama sonuçlarının görüntüleme 
biçimini değiştirmek için kullan.

         tuşlarına bas ve ardından   Bunu  yap:
bunu seç:

 

π   (Standart)  Ondalık Görüntülenen hesaplama sonucunu standart biçim*2 ile ondalık biçim 
arasında değiştirir. Standart biçime dönüştürme,     > [π Sonucu] > [Açık] 
seçildiğinde etkinleştirilir. *3

 

Görüntülenen hesaplama sonucunu, bileşik kesir ile tam sayılı kesir 
biçimi arasında değiştirir. Eğer görüntülenen hesaplama sonucu ondalık 
biçimindeyse ve dönüşüm mümkünse, bu seçenek sonucu kesir biçimine 
dönüştürür.

Altmışlık Kesir Görüntülenen hesaplama sonucunu derece/dakika/saniye (altmışlık 
kesir) biçimine dönüştürür.

Mühendislik gösterimini ters
Mühendislik gösterimine 
çevirme

Görüntülenen hesaplama sonucunu mühendislik gösterimi biçimine 
dönüştürür (a × 10ⁿ biçimi; burada n, 3’ün katı olan bir tam sayıdır). 
ENG Notation] seçeneği her seçildiğinde, mantisadaki ondalık noktanın 
konumu üç basamak sağa kaydırılır (üst sayı 3 azaltılır). [Reverse ENG 
Notation] seçeneği her seçildiğinde ise, ondalık nokta üç basamak sola 
kaydırılır (üst sayı 3 artırılır).

*1　     > [FORMAT Tuşu] (sayfa 220) için               "Decimal" (Ondalık) seçildiğinde (başlangıç varsayılanı).
*2　Kesir,π içeren biçim veya     içeren biçim   
*3　Dönüşümlerin görüntü aralıkları sınırlıdır. Hesap makinesinin hesaplama sonuçlarının kesir biçimi ve biçim 

görüntü aralıkları hakkında bilgi için, “Kesir Biçimli Hesaplama Sonuçları” (sayfa 17) ve “Biçim Hesaplama Aralığı” 
(sayfa 18) bölümlerine bakınız. 

İşlem Açıklaması:

2/j 2E

sF  > [ π   (Standard)  Decimal]

sF  > [ π   (Standard)  Decimal]

Not
•　Format menüsünü kullanarak yapılan görüntüleme biçimi değişiklikleri, hücre ayrıntılarına da uygulanır. 
•　Bir formül girdikten sonra,    yerine              tuşuna basmak, hesaplama sonuçlarını ondalık 

biçimde gösterir.

Kesir biçimli hesaplama sonuçları
Bir hesaplama sonucunun kesir biçiminde mi yoksa ondalık biçimde mi görüntüleneceği, sonucun doğrusal biçimde
ifade edilmesi için gereken basamak sayısına bağlıdır. Gerekli basamak sayısı aşağıda gösterildiği şekilde sayılır. 

Geçerli Ondalık: 1
2 = 1 2

Üç basamak. Pay ve payda için iki basamak, ayrıcı için bir basamak.
Geçersiz Ondalık: 3

2  = 11
2 = 1 1 2

Beş yer. Tamsayı, pay ve payda için üç yer ve ayırıcılar için iki yer. Hesaplama sonucunun doğrusal formu 10 veya 
daha az basamaktan oluşuyorsa, aşağıdaki Örnek 1'de gösterildiği gibi kesir biçiminde görüntülenir. 11 veya daha 
fazla basamağı varsa, aşağıdaki Örnek 2'de gösterildiği gibi ondalık biçimde görüntülenir.

Örnek 1: 1 1
123456 = 123457

123456 (Doğal form)       1 1 123456 = 123457 123456 (Düzlemsel form)
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se (B )1r 1d 123456E

Örnek 2: 1 1
1234567  1.00000081 (Doğal form)  1 1 1234567 = 1.00000081 (Düzlemsel form)

(B )1r 1d 1234567E

Form Hesaplama Aralığı
Form hesaplama sonucunun izin verilen görüntüleme aralıkları   aşağıda gösterilmiştir.

a b, d a b, a b
c

d e
f

1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f  < 100

Örnek: 10 2 15 3 3  45 3 10 2 ...   Formunda görünür.
99 999 297 111  3129.089165 ... Ondalık değer şeklinde görünür.

Alfa Değişkenlerini Kullanma
Alfa değişkenleri, sayısal değerlerin geçici olarak depolanması için kullanılır. A'dan Z'ye, r'ye ve θ'ye kadar 
adlandırılan 28 değişken vardır.

Bir alfa değişkeninin içeriğini görüntülemek için
Seç V > [Alfa].

Bir alfa değişkenine değer atamak için
Söz dizimi: Değer → Alfa Değişkeni
Alfa değişkenleri, tuş veya menü işlemleri kullanılarak girilebilir.
Örnek: Alfa değişkeni A'ya 5 atamak için

Anahtar işlemi: sX (→)PX (A)E

Menü işlemi: 5sX (→)V  > [Alpha] > [A]E

Birden fazla ardışık alfa değişkenine aynı değeri toplu olarak atamak için
Örnek: A'dan F'ye kadar olan alfa değişkenlerine 10 değerini toplu olarak atamak için

10 (→) (A)
C  > [All] > [Symbol] > [~]PN (F)E

Bir formülde alfa değişkeni kullanmak

Örnek: A = 5 ve B =  B A
B−Aiken          işlemi 

(B) (A)
Pe (B)-PX (A)E

Not
•　Bir alfa değişkenine bir değer atandığında, Ans'lar da bu değerle güncellenir. 
•　X  'e basılarak girilen x, alfa değişkeni X ile aynıdır.

x

•　Bir değer, değerin kaydedildiği anda geçerli olan S > [Açı] ve S  > [Karmaşık Mod] ayarlarına uygun 
olarak bir değişkene kaydedilir. 

Fonksiyon Değişkenlerini Kullanma
"Grafik&Tablo Uygulaması"nın (sayfa 75)  İşlev sekmesinde kaydedilen işlevler , Calculate uygulamasıyla 
birlikte kullanılabilir.
Örnek: y1  (y1 =  3x) işlev değişkenine atanan işlevi geri çağırmak için, x değişkenine 10 değerini atayın ve 

y1 değerini belirleyin. 
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3.　Atanacak değeri girin ve ardından       tuşuna basın. 

( 10)E

Not
•　Yalnızca ‘y1’ girilip      tuşuna basıldığında, x değişkenine atanmış olan mevcut değer atanır.

Bilimsel Fonksiyon Hesaplamaları
Tüm yerleşik işlevlere,      tuşuna basarak görüntüleyebileceğiniz Katalog menüsünden girilebilir. Ayrıntılar 
için "Katalog Menü Detayları"na (sayfa 221) bakınız. Aşağıdaki tabloda, tuşlar kullanılarak doğrudan 
girilebilen örnek fonksiyon hesaplamaları gösterilmektedir.

Hesaplama Örnekleri (  > [Angle] > [Radian]*1)

Trigonometrik
Fonksiyonlar*1

cos π3 = 1
2 ces7 (π)d 3r)E

Ters
Trigonometrik
Fonksiyonlar*1

sin-1 0.5 = 1
6π sv (sin-1)0. 5)E

Kuvvetler (52)3 = 15625 ( 5i)g

10’un Kuvvetleri 4 × 107

3 × 108 = 2
15

4k 7d 3k 8E

k 7e 3k

4k 7re 3k 8E

Köklü Sayılar
2 × 3 = 3 2 j 2r/

325 = 2

Logaritma
log 1000 = 3 (log)1000)E

log2 16 = 4 (R )2r 16E

Doğal
Logaritmalar e4.5 = 90.0171313 4. 5E

1.　V  > [Function]

2.　Ⓑ tuşuna bas ve [y1] i aydınlat. 
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Doğal Logaritma ln (90) = 4.49980967 sN (ln)90)E

Pi (π) π= 3.141592654 (π)sE (J )

*1　1 Trigonometrik veya ters trigonometrik fonksiyonları kullanırken, açı birimini (       > [Angle]) belirttiğinizden 
emin olun.

*2　    > [       Key] > [        (Güç)] seçildiğinde k   tuşuna basarak girilen elde ettiğiniz gibidir,                  . Bu nedenle, 
4 × 107 ÷ 3 × 108'in yürütülmesi, hesaplamanın soldan sağa sırayla yapılmasına neden olur ve bu da 
hesaplamadakinden farklı bir hesaplama sonucu üretir.
Yukarıdaki örnek (kesirler kullanılarak). Aynı hesaplama sonucunu elde etmek için, her terimin parantez içine 
alınması gerekir: (4 × 107) ÷ (3 × 108).

*3　    > [Key] > [                 (Sci Notasyonu)] seçildiğinde. Şu anda, k   tuşuna basın  ve  4       ÷ 3       ‘i 
yürütmek için girilen fonksiyon, yukarıdaki hesaplama örneğindeki ile aynı hesaplama sonucunu üretecektir. 

*4　S  > [ Key] > [(Sci Notasyonu)] seçildiğinde (varsayılan ayar). Şu anda, k    tuşuna basmak ve    4 7  ÷ 38' i 
yürütmek için girilen fonksiyonu kullanmak, yukarıdaki hesaplama örneğindekiyle aynı hesaplama sonucunu 
verecektir. 

 

*5　    yerine g (=)        tuşuna basıldığında hesaplama sonucu ondalık biçimde görüntülenir.

Asal Çarpanlara Ayırma
2 veya daha büyük ve 10'dan az basamaklı tamsayılar üzerinde asal çarpanlara ayırma yapmak için Calculate 
uygulamasını kullanabilirsiniz.

Örnek: 61226001 sayısında asal çarpanlara ayırma işlemi yapmak için

61226001 
T  > [Prime Factorization]

•　Asal Çarpanlara Ayırma iletişim kutusu yalnızca görüntülenir. Değerleri düzenlenemez veya kopyalanamaz.
•　Asal Çarpanlara Ayırma iletişim kutusunu kapatmak için      veya       tuşuna basın.

Not
•　Bir sayıyı asal çarpanlarına ayırmak için, hesaplama geçmişinde (sayfa 16) sonuç satırını 

vurgulayabilir ve      > [Prime Factorization] seçeneğini seçebilirsiniz.

Kompleks Sayı Hesaplamaları
Aşağıda açıklanan işlemleri gerçekleştirmek için Calculate uygulamasını kullanabilirsiniz.
•　Hesaplamalara karmaşık sayı girişi

Dikdörtgen formu girmek için 1 + i:i 1+s9 (i)

Kutupsal formata geçmek için  2    π: ∠ j 2rs8 (∠)s7 (π)
•　Hayali sonuç ekranı

S > [Karmaşık Mod] ayarına bağlı olarak aşağıda gösterildiği gibi hayali bir çözüm görüntülenir. 
[Real] ... Gerçek sayı: -1 = “Gerçek olmayan HATA” (Gerçek olmayan sayı hatası)*1

[a+bi] ... Dörtgen form: -1 = i
[r∠θ] ... Kutuplu form: -1 = 1∠1

2π*2

•　Mutlak değer, kompleks argümanı, eşlenik kompleks sayı, gerçel ve sanal parça hesaplaması, kutupsal ve 
dikdörtgen biçim dönüşümü
Bu hesaplamalar için "Katalog Menü Detayları" nın (sayfa 221)  "Karmaşık Numara" (sayfa 229 ) bölümüne  bakınız. 
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*1　Argüman gerçek bir sayı ve çözüm sanal bir sayı olduğunda. Bağımsız değişken karmaşık bir sayıysa (   i 
gibi), hesaplama sonucu       > [Complex Mode] [a+bi] olarak ayarlandığında olduğu gibi olur. 

*2　S  > [Angle] > [Radian] olduğunda. θ görüntüleme aralığı, S    > [Angle] ayarına bağlı olarak aşağıdaki gibidir.  
Derece: -180 < θ ≤ 180 Radyan: -π < θ ≤ π Gradyan: -200 < θ ≤ 200

Vektör Hesaplamaları
Hesap makineniz, vektör hesaplamaları için Vct A'dan Vct Z'ye kadar ve Vct Ans olmak üzere vektör 
değişkenleriyle donatılmıştır.
Vektör Değişkenlerini Depolama
Hesaplamalarda vektör değişkenlerini kullanırken, hesaplama için gerekli vektörleri gerektiği gibi Vct A'dan Vct 
Z'ye vektör değişkenlerinde saklayabilirsiniz. Örneğin, [1 2] + [3 4] ve [1 2] - [3 4] 'ü hesaplamak istiyorsanız,
Vct A'da [1 2] ve Vct B'de [3 4]. Ardından, Vct A+Vct B ve Vct A-Vct B işlemlerini gerçekleştirebilirsiniz.   
Vektörün boyutu 999 satır ile 1 sütun veya 1 satır ile 999 sütun içinde belirtilebilir. 
Örnek: 1 satırlı × 2 sütunlu vektör  [4 8]  'i Vct A'da saklamak için 

2.　[Vct A] öğesini vurgulayın ve T   > [Dimension] öğesini seçin.

5.　Vektör listesine dönmek için       ya da       tuşuna basınız.

Bir vektör değişkenini başka bir vektör değişkenine atamak için
Örnek: Vct A'yı Vct D'ye atamak için, Hesaplama sekmesinde "Vct A → Vct D" ifadesini girin. 

V  > [Vector] > [Vct A]
sX (→)V  > [Vector] > [Vct D]

Not
•　Vektör değişkenleri, matris değişkenlerine atanabilir. Örneğin, "Vct A → Mat A", Vct A'yı Mat A'ya 

atar. 

Bir vektör değişkeninin belirli bir öğesine bir değer atamak (üzerine yazmak) için
Sözdizimi:  vektör adı → atanan değer [satır numarası, sütun numarası]
Örnek: Vct A = [1,2,3] olduğunda Vct A'nın 1. satır, 2. sütunundaki elemana 20 atamak için

Vct A'nın mevcut içeriğini kontrol etmek için: V   > [vektör] 

Bir vektör değişkeninin belirli bir öğesinin değerini hatırlamak için
Sözdizimi: vektör adı [satır numarası, sütun numarası]
Örnek: Vct A = [1, 2, 3] iken, 1. satır, 2. sütundaki elemanı çağırmak için

V  > [Vector] > [Vct A]s4 ([)1` 2s5 (])E

1.　Hesaplama sekmesi açıkken x      tuşuna basın. 
•　Bu, Vektör sekmesindeki Vektör listesini görüntüler.

3.　Görüntülenen iletişim kutusunda, bir satır ve iki sütun belirtmek 
için aşağıdaki işlemi gerçekleştirin: 1      2        
•　Bu, Vct A giriş penceresini görüntüler.

4.　Vektörün elemanlarını girmek için aşağıdaki işlemi gerçekleştirin:
4 8 .
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Bir Vektörün Hesaplamaya Girilmesi 
Bir vektörü kullanmak için, onu bir hesaplamaya girmek için aşağıda açıklanan yöntemlerden herhangi birini 
kullanabilirsiniz.
Metot 1: Vektör değişkeninin adını kullanma 

Vct A”yı girmek
C  > [Vector] > [Vector] PX (A)

Not
•　"Vct X" vektör değişkeni için büyük harf X (              ) veya küçük harf x (     ) girebilirsiniz. 

Hem "Vct X" hem de "Vct x" aynı vektör değişkenini ifade eder.

Metot 2: Kalıp kullanma
En fazla 6 satır ve 1 sütuna veya 6 sütun ve 1 satıra kadar olan vektörler, bir şablon kullanılarak girilebilir.

Example: 2-satırlı × 1-sütunlu vektörü girmek için 
2
4

.

1.　Hesaplama sekmesi etkinken T   > [m×n] öğesini seçin. 

3.　Değerleri girmek için şablonu kullanın.

2 4

Metot 3: Düzlemsel Girdi Formunu Kullanma
Bu değeri girmek için: Bu formu kullanın:

m-satır × 1-sütun vektörü 

a11

a21

…
am1

a11 a21 … am1

1-satır × n-sütun vektörü a11 a12 … a1n a11, a12,  … a1n

m ve n değişkenlerinin alabileceği en büyük değer 999’dur.
Örnek: 1 satır × 3 sütunluk vektör olan (1 2 3)’ü girmek için.

s4 ([)s4 ([)1` 2` 3s5 (])s5 (])

Hesaplamada Vektörleri Kullanma
Hesap makineniz vektör hesaplama türlerini destekler.
•　İki vektörün toplanması, çıkarılması ve çarpılması ve bir vektörün skaler çarpımı.

Bu tür hesaplamalar vektörler ve operatörler girilerek gerçekleştirilir. Bu hesaplamaların nasıl yapılacağına 
ilişkin örnekler aşağıda verilmiştir.

•　Nokta çarpım, çapraz çarpım, bir vektörün normu (büyüklüğü), iki vektör arasındaki açı, birim vektör. Bu 
hesaplamalar için "Katalog Menü Detayları" nın (sayfa 221) "Vektör" (sayfa 227)  bölümüne bakınız..

Not
•　Vektör hesaplamaları için görüntülenen sonuçların hesaplama hassasiyeti, en az anlamlı basamakta 

±1'dir.

Vektör Hesaplama Örnekleri
Buradaki örnekler, aşağıdaki vektör toplamasına dayalı çeşitli giriş yöntemlerini göstermektedir:  1 2 + 3 4 = 4 6 .

Vektör Değişkenlerini Kullanma
 Vct A'ya        ve Vct B'ye        girin ve ardından aşağıdaki işlemleri gerçekleştirin.1 2 3 4

2.　Görüntülenen iletişim kutusunda, iki satır ve bir sütun belirtmek için 
aşağıdaki işlemi gerçekleştirin : 
•　Bu, 2 satırlı × 1 sütunlu bir şablon görüntüler.
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V  > [Vector] > [Vct A]+
V  > [Vector] > [Vct B]E

Şablon Kullanma
 > [m×n]1E 2EO 1r 2r+

T  > [m×n]ddO 3r 4E

Düzlemsel girdi 
formunu kullanma s4 ([)s4 ([)1` 2s5 (])s5 (])+

s4 ([)s4 ([)3` 4s5 (])s5 (])E

Vct Ans
Vct Ans, en son vektör hesaplama sonucunu saklayan bir değişkendir. Bir hesaplama sonucu vektör biçiminde 
olduğunda, bu sonuç Vct Ans içeriğinin üzerine yazılır. "Mat Ans" (sayfa 26) değişkeninin içeriğinin de her vektör 
hesaplamasının sonucunun üzerine yazıldığına dikkat edin. 
256 bayttan küçük hesaplama sonuçları Hesaplama sekmesinde görüntülenir, ancak 256 bayta eşit veya daha 
büyük hesaplama sonuçları Ans penceresinde görüntülenir. Ans penceresi görüntülenirken,     düğmesine 
basıldığında Hesaplama sekmesine geri dönülür ve sonuç satırı "Mat/Vct Sonucu" olarak görüntülenir.

 

Not
•　Bir vektör değişkenini başka bir vektör değişkenine atamak Vct Ans içeriğini etkilemez. 
•　Bir vektör hesaplama sonucu Vct Ans'a sığmayacak kadar büyükse, bir hata oluşur.

Matris Sekmesini Kullanma
Vektör sekmesi ile Vct A'dan Vct Z'ye ve Vct Ans vektör değişkenlerini düzenleyebilirsiniz.

Vektör Risk İşlemleri
Bunu Yapın: Bu Menü Öğesini Seçin:
Vurgulanan vektör değişkeninin boyutunu belirtin.

 > [Dimension]

Vurgulanan vektör değişkeninin içeriğini silin.  > [Delete]

Tüm vektör değişkenlerinin içeriğini temizleyin.  > [Delete all]

Vektör Giriş Penceresi İşlemleri
Bunu Yapın: Bu Menü Öğesini Seçin:
Vurgulanan satırı silin.  > [Row] > [Delete]

Vurgulanan satırdan önce satır ekleyin.  > [Row] > [Insert]

Vurgulanan satırdan sonraa bir satır daha ekleyin.  > [Row] > [Add]

Vurgulanan sütunu silin.  > [Column] > [Delete]

Vurgulanan sütundan önce bir sütun ekleyin.  > [Column] > [Insert]

Vurgulanan sütundan sonra bir sütun ekleyin.  > [Column] > [Add]

Vurgulanan hücrenin içeriğini düzenleyin.  > [Edit]

Matris Hesaplamaları
Hesap makineniz, matris hesaplamaları için matris değişkenleri (Mat A'dan Mat Z'ye, Mat Ans) ile sağlanır.
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Matris Değişkenlerini Depolama
Hesaplamalarda matris değişkenlerini kullanırken, gerekli matrisleri Mat A'dan Mat Z'ye kadar olan matris 
değişkenlerinde saklayabilirsiniz. Örneğin, işlemlerini hesaplamak isterseniz,

 

1 3
2 4

2 6
4 8

 and 
1 3
2 4

−
2 6
4 8

1 3
2 4

 matrisini Mat A'ya ve
 

2 6
4 8

matrisini Mat B'ye saklayın. Daha sonra, Mat A + Mat B ve Mat A - Mat B 

işlemlerini çalıştırabilirsiniz. Matrisin hem satır hem de sütun sayısı 999'a kadar belirtilebilir.

Örnek: 2 satırlı × 2 sütunlu 
1 3
2 4

 matrisini Mat A'ya saklamak için

2.　[Mat A]'yı vurgulayın ve ardından      > [Dimension] (Boyut)'ı seçin.  

5.　Matris listesine dönmek için       veya       düğmesine basın.

Bir matris değişkenini başka bir matris değişkenine atamak için
Örnek: Mat A'yı Mat D'ye atamak için, Hesaplama sekmesine "Mat A → Mat D" 

girin. V  > [Matrix] > [Mat A]
sX (→)V  > [Matrix] > [Mat D]E

Not
•　1 satır ve n sütun veya m  satır ve 1 sütun içeren bir matris değişkeni bir vektör değişkenine atanabilir. 

Örneğin, "Mat A → Vct A", Mat A'yı Vct A'ya atar.

Bir matris değişkeninin belirli bir elemanına bir değer atamak (üzerine yazmak) için
Sözdizimi: matris adı → atanan değer [satır numarası, sütun numarası]

Mat A =          iken, Mat A'nın 2. satır, 2. sütundaki öğesine 40 sayısını atamak için. 
1 2
3 4

sX (→)V  > [Matrix] > [Mat A]
s4 ([)2` 2s5 (])E

Mat A'nın mevcut içeriğini kontrol etmek için:       > [Matrix] 
(Matris) 

 

Bir matris değişkeninin belirli bir elemanının değerini geri çağırmak için
Sözdizimi: matris adı [satır numarası, sütun numarası]

Örnek: 

V  > [Matrix] > [Mat A]s4 ([)2` 2s5 (])E

1.　Hesaplama sekmesi aktifken,      tuşuna basın.  
•　Bu, Matris sekmesinde Matris listesini görüntüler.

3.　Görüntülenen iletişim kutusunda, iki satır ve iki sütun belirtmek
için aşağıdaki işlemi gerçekleştirin: 2 2 .
•　Bu, Mat A giriş penceresini görüntüler.

4.　Matrisin öğelerini girmek için aşağıdaki işlemi gerçekleştirin:
1 3 2 4 .
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Mat A =          iken, 2. satır, 2. sütundaki öğeyi geri çağırmak için. 
1 2
3 4



Bir Hesaplamaya Matris Girme
Bir matrisi kullanmak için, onu bir hesaplamaya girmek için aşağıda açıklanan yöntemlerden herhangi birini 
kullanabilirsiniz.
Metot 1: Matris değişkeninin adını kullanma 
Örnek: “Mat A” girdisi

 > [Matrix] > [Matrix] PX (A)

Not
•　Mat X" matris değişkeni için büyük harf X (            ) veya küçük harf x (    )  girebilirsiniz. Hem "Mat X" 

hem de "Mat x" aynı matris değişkenini ifade eder.

Metot 2: Şablon Kullanma
Bir şablon kullanılarak en fazla 6 sütun ve 6 satır içeren bir matris girilebilir.

Örnek: 2 satırlı × 2 sütunlu matrisi girmek için 
2 6
4 8

.

1.　Hesaplama sekmesi etkinken,       > [m×n] öğesini seçin. 

3.　Değerleri girmek için şablonu kullanın.

2r 6r 4r 8

Metot 3: Doğrusal girdi formunu kullanma
Bunu girmek için: Bu formu kullanın:

m-satır × n-sütunlu matriks

a11 a21 … am1

a21 a22 … am2

… … … …
am1 am2 … amn

a11,a21, … ,am1 a12,a22, … ,am2  … am1,am2, … ,amn

Hem m hem  de n'nin maksimum değeri 999'dur.

Örnek: 2 satırlı × 2 sütunlu          matrisini girmek için
2 6
4 8

s4 ([)s4 ([)2` 6s5 (])
s4 ([)4` 8s5 (])s5 (])

Hesaplamalarda Matris Kullanma
Hesap makineniz matris hesaplama türlerini destekler.
•　İki matrisin toplanması, çıkarılması ve çarpılması ve tek bir matrisin skaler çarpması, karesi, kuvvetleri, 

mutlak değeri ve karmaşık sayı hesaplamaları.
Bu tür hesaplamalar matrisler ve operatörler girilerek gerçekleştirilir. Bu hesaplamaların nasıl yapılacağına 
ilişkin örnekler aşağıda verilmiştir.

•　Matris tersi, determinant, matris transpozisyonu, özdeşlik matrisi, bir matrisin satır elon formu, bir matrisin 
indirgenmiş sıra elveli formu.
Bu hesaplamalar için "Katalog Menü Detayları" nın (sayfa 221) "Matris" (sayfa 227)  bölümüne  bakınız. .

Not
•　Matris hesaplamaları için görüntülenen sonuçların hesaplama hassasiyeti, en az anlamlı basamakta 

±1'dir.

2.　Görüntülenen iletişim kutusunda, iki satır ve iki sütun belirtmek için 
aşağıdaki işlemi gerçekleştirin: 2       2 
•　Bu, 2 satırlı × 2 sütunlu bir şablon görüntüler.
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Matris Hesaplama Örnekleri
Buradaki örnekler, aşağıdaki matris eklemesine dayalı olarak çeşitli giriş yöntemlerini göstermektedir:
1 3
2 4

+
2 6
4 8

=
3 9
6 12

.

Matris Değerlerinin Kullanımı 

Mat A'ya
1 3
2 4

 matrisini ve Mat B'ye 
2 6
4 8

 matrisini girin ve ardından aşağıdaki işlemleri gerçekleştirin.

V  > [Matrix] > [Mat A]+
V  > [Matrix] > [Mat B]E

Şablon kullanma

T  > [m×n]2E 2EO 1r 3r 2r 4r+
T  > [m×n]ddO 2r 6r 4r 8E

Doğrusal Girdi Formunu Kullanma

s4 ([)s4 ([)1` 3s5 (])s4 ([)2` 4s5 (])s5 (])+
s4 ([)s4 ([)2` 6s5 (])s4 ([)4` 8s5 (])s5 (])E

Mat Ans
Mat Ans, en son matris hesaplama sonucunu saklayan bir değişkendir. Bir hesaplama sonucu matris biçiminde 
olduğunda, Mat Ans içeriği bu sonucun üzerine yazılır. Bir matris hesaplama sonucu 1 satırlı × n sütunlu veya 
m-satırlı × 1 sütunlu matris olduğunda, "Vct Ans"  (sayfa 23) değişkeninin içeriğinin üzerine de bu matris 
hesaplamasının sonucu yazılır.

256 bayttan küçük hesaplama sonuçları Hesaplama sekmesinde görüntülenir, ancak 256 bayta eşit veya daha 
büyük hesaplama sonuçları Ans penceresinde görüntülenir. Ans penceresi görüntülenirken,      düğmesine 
basıldığında Hesaplama sekmesine geri dönülür ve sonuç satırı "Mat Sonucu" olarak görüntülenir.

 

Not
•　Bir matris değişkenini başka bir matris değişkenine atamak Mat Ans içeriğini etkilemez.
•　Bir matris hesaplama sonucu Mat Ans'a sığmayacak kadar büyükse, bir hata oluşur.

Matris Sekmesini Kullanma
Matris sekmesi ile Mat A'dan Mat Z'ye ve Mat Ans'a kadar olan matris değişkenlerini düzenleyebilirsiniz.

Matriks Liste Operasyonları
Bu işlemi yapmak için: Bu Menü Ögesini Seçin:
Vurgulanan matris değişkeninin boyutunu belirtin.  > [Dimension]

Vurgulanan matris değişkenine CSV formatında 
bir dosya yükleyin. *

 > [CSV] > [Load]

Vurgulanan matris değişkeninin içeriğini CSV 
biçimindeki bir dosyaya kaydedin. * 

 > [CSV] > [Save As]

Vurgulanan matris değişkeninin içeriğini silin.  > [Delete]
Tüm matris değişkenlerinin içeriğini temizleyin.  > [Delete all]

*　Tüm matris değişkenlerinin içeriğini temizleyin.

Matris Giriş Penceresi İşlemleri
Bu işlemi Yapmak için: Bu Menü Ögesini Seçin:
İki satır seçin ve öğelerini değiştirin.  > [Row Operation] > [Swap] *
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Belirtilen satırın her öğesini, o satırın skaler katıyla 
değiştirin.

 > [Row Operation] > [*Row]*

Belirtilen bir satırın her bir öğesinin skaler katlarını 
başka bir satırın her bir öğesine ekleyin.

 > [Row Operation] > [*Row+] *

Belirtilen satırın her öğesini, belirtilen başka bir 
satırın her bir öğesine ekleyin.

 > [Row Operation] 

!"#$%!

> [Row+] *

Belirtilmiş satırı silin.  > [Row] > [Delete]
Belirtilmiş satırdan önceye satır ekleyin.  > [Row] > [Insert]
Belirtilmiş satırdan sonraya satır ekleyin.  > [Row] > [Add]
Belirtilmiş sütunu silin.  > [Column] > [Delete]
Belirtilmiş sütundan önceye sütun ekleyin.  > [Column] > [Insert]
Belirtilmiş sütundan sonraya sütun ekleyin.  > [Column] > [Add]
Belirtilmiş hücrenin içeriğini düzenleyin.  > [Edit]

*　Bu menü öğesi seçildiğinde, satırları ve/veya değerleri belirtmek için bir iletişim kutusu görüntülenir.

Liste Hesaplamaları
Hesap makineniz, liste hesaplamaları için liste değişkenleri (Liste 1- Liste 26, Liste Ans) ile sağlanır.

Liste Değişkenlerini Depolama
Liste değişkenlerini saklamak için aşağıdaki yöntemlerden herhangi birini kullanabilirsiniz.
•　Metot 1: Bir liste değişkeni oluşturmak için İstatistik uygulamasının Liste Düzenleyici sekmesini kullanma. 
•　Metot 2: Bir liste değişkenine liste atamak için hesaplama uygulamasını kullanma 

Örnek 1: {1,2,3} → Liste 1
Örnek  2: List 1 → Liste 2 (Liste 1'in içeriğini Liste 2'ye atar.)

•　Metot 3: Graph&Table uygulamasını veya Recursion uygulamasının Table sekmesini kullanarak, bir sayı 
tablosunun tek bir sütununu liste değişkenine atamak.

Bir liste değişkeninin belirli bir öğesine değer atamak (üzerine yazmak) için
Sözdizimi: Atanan değer → liste adı [eleman numarası]
Örnek: Aşağıdaki listenin 2. elemanına 20 değerini atamak için: Liste 1 = {1,2,3,4,5}

20 sX (→) V  > [List] > [List 1]
s4 ([) 2 s5 (]) E

List 1'in mevcut içeriğini kontrol etmek için: V  > [List] 

Aşağıdaki listenin 2. elemanına 20 değerini atamak için: Liste 1 = {1,2,3,4,5}
Sözdizimi: liste adı [element numarası]
Örnek: List 1 = {1,2,3} iken, 2 öğesini geri çağırmak için.

V  > [List] > [List 1]s4 ([) 2 s5 (]) E

Hesaplamaya Liste Girme
Bir listeyi kullanmak için, aşağıda açıklanan yöntemlerden herhangi birini kullanarak bir hesaplamaya 
girebilirsiniz
Metot 1: Liste değişkeninin adını kullanma
“List 1”i girmek için:

 > [List] > [List 1], or C  > [Statistics] > [List] 1

Metot 2: Bir liste değişkeninin alt adını girme
Alt adı* "QTY" olan bir liste değişkeni girmek için: 
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 > [İstatistik] > [Liste] ”QTY”
*　Alt adlar hakkında daha fazla bilgi için, "Liste Düzenleyici Sekmesini Kullanma"  (sayfa 31) bölümüne bakın.

Metot 3: Düzlemsel girdi formunu kullanma ({1,2,3,…})
Seç %    > [İstatistik]> [{}] ardından virgülle ayrılmış bir öğe listesi gelir. {1,2,3} 
girmek için:

C  > [İstatistik]  > [{ }] 1 `  2 `  3

Hesaplamalarda Listeleri Kullanma
Hesap makineniz aşağıda açıklanan liste hesaplamalarını destekler.
•　Listeler ve değerler arasında veya listeler arasında aritmetik işlemler ve bağımsız değişken olarak listelerle 

işlev hesaplamaları
{1,2,3}+{4,5,6}, {1,2,3}×2, {1,2,3}2, {1,2,3}, etc.

Örnek 1: {1,2,3}+{4,5,6}
Düzlemsel girdi formunu kullanma

 > [İstatistik]  > [{ }] 1 `  2 `  3r+
 > [İstatistik] > [{ }] 4 `  5 `  6E

Liste değişkenlerini kullanma  (Liste 1 = {1,2,3}, List 2 = {4,5,6})
 > [Liste] > [Liste 1]
 > [Liste] > [Liste 2]

Örnek 2: Yukarıdaki işlemin sonuçlarını karesini almak için

iE

•　Liste Manipülasyon Fonksiyonlarını Kullanarak Hesaplamalar
Hesap makineniz size listeler oluşturmanız, öğeleri değiştirmeniz ve bir listedeki öğelerin toplamlarını ve 
ortalamalarını hesaplamanız için araçlar sağlar. Ayrıntılar için, "Katalog Menü Ayrıntıları" nın (sayfa 221) 
"İstatistikler" (sayfa 230)  bölümüne  bakın .

Liste Ans
Liste Ans, en son liste hesaplama sonucunu saklayan bir değişkendir. Bir hesaplama sonucu liste biçiminde 
olduğunda, Liste Ans değişkeni içeriğinin üzerine bu sonuç yazılır.
256 bayttan küçük hesaplama sonuçları, Hesaplama sekmesindeki sonuç satırında görüntülenirken, 256 
bayta eşit veya daha büyük sonuçlar Ans penceresinde görüntülenir. Ans penceresi görüntülenirken,    
düğmesine basıldığında, sonuç satırı "Sonucu Listele" olarak görüntülenecek şekilde Hesaplama sekmesine 
geri döner.

Birim Dönüşümleri
Bir değeri bir birimden diğerine dönüştürebilirsiniz. Ayrıntılar için "Birim Dönüşümleri" ne (sayfa 239) bakın. 
Örnek: 25.4 cm inç e çevirmek için

25 4  > [Unit Conversions] > [Length] > [[cm]]
C  > [Unit Conversions] > [  ]

C  > [Unit Conversions] > [Length] > [[in]]
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İstatistik Uygulaması
İstatistik uygulaması, giriş verilerine dayalı istatistiksel hesaplamalar yapmak, özet istatistikleri ve regresyon 
modeli bilgilerini görüntülemek ve grafikler çizmek için ihtiyacınız olan araçları sağlar. Ayrıca size hipotez testi 
ve güven aralığı yetenekleri sağlar

İstatistik Uygulamasında Ne Yapmak İstediğinizi Seçme

2.　Basınız >
•　Eğer bu, Tür Seç menüsünün görünmesine neden oluyorsa, bu işlemin 4. adımına gidin. Aksi takdirde, 

3. adıma gidin.

4.　Yapmak istediğinizi işlemi seçmek için menüyü kullanın.

Bunu Yapmak İçin: Bu Menü Ögesini Vurgula:
Özet İstatistikleri veya Regresyon Modeli Bilgilerini 
Görüntüleme (sayfa 32)*1 

[Calculate Summary Statistics]

İstatistik Grafiği Çizme (sayfa 35)*2 [Draw Statistics Graph]

Hipotez Testi Yapma (sayfa 42) [Hypothesis Test]
Bir Güven Aralığı Bulun (sayfa 49) [Confidence Interval]
*1　Regresyon modeli bilgileri, regresyon denklemleri katsayılarını, belirleme katsayısını vb. içerir. 

     
*2　2 Değişkenli verilere dayalı dağılım grafikleri ve regresyon grafikleri, 1 Değişkenli verilere dayalı 

histogramlar ve kutu ve bıyık diyagramları vb.

5.　 tuşuna basınız.
•　Bu, Kurulum sekmesinde seçtiğiniz öğe için bir ayarlar menüsü görüntüler.

Veri Girişi
İstatistik uygulaması'nın Liste Düzenleyicisi, istatistiksel verileri girmek ve düzenlemek için uygulamaya özel 
bir düzenleyicidir. Liste Düzenleyicisi'ni kullanarak aynı anda 26 adede kadar (List 1'den List 26'ya) liste değişkeni 
oluşturabilirsiniz.

İşlenecek istatistiksel verilere bağlı olarak, bir ila üç liste değişkeni oluşturun.*1

1.　h  > Statistics
•　Bu, İstatistik uygulamasının Liste Düzenleyici sekmesine aktif olarak 

giriş yapar.

3.　Ayarlar sekmesinin ilk satırını vurgulayın ve ardından        tuşuna basın. 
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İstatistiksel Bilgiler: Gerekli Değerler Listesi:
1-Değişken (frekans yok) XList'e atamak için bir liste değişkeni*2
1-Değişken (frekanslarla) XList ve Freq'e atamak için iki liste değişkeni*2
2-Değişken (frekans yok) XList ve YList'e atamak için iki liste değişkeni*2
2-Değişken (frekanslarla) XList, YList ve Freq'e atamak için üç liste değişkeni*2

*1　Değişkenli veya 2 Değişkenli istatistiksel hesaplama için istatistiksel veri oluşturma yöntemi, hipotez 
testleri yapmak  (sayfa 42)  veya güven aralıklarını bulmak ( sayfa 49) yönteminden farklıdır.

*2　Bu hesaplayıcı, 1-Değişkenli istatistiksel hesaplamalar için kullanılan liste verilerini XList olarak görüntüler, 
liste verileri için kullanılır. 2-XList ve YList olarak değişken istatistiksel hesaplamalar ve frekanslar için 
kullanılan verileri Freq veya Frekans olarak listeleyin.

Frekanslar
İstatistiksel verileri girmek için iki yol vardır: frekanslarla ve frekanslar olmadan (tüm veri frekansları için 1 
kullanılır). Kullanmak istediğiniz yöntemi, Liste Düzenleyicisi'nde >     tuşuna bastığınızda çıkan Kurulum 
sekmesinde, aşağıdaki örnekte gösterildiği gibi belirtebilirsiniz.

    Veriler için List1'i kullanır.
Tüm veri değerlerinin sıklığı: 1

     Veriler için List1'i kullanır.
Frekanslar için List2'yi kullanır.

Önemli!
•　Bir frekans listesinde yer alan değerler 0 veya yalnızca pozitif değerler olmalıdır. Tek bir negatif değer 

bile hataya neden olur (Etki Alanı Dışında).
•　Minimum ve maksimum değerlerin hesaplanması için 0 frekanslı istatistiksel veriler kullanılmaz.

Liste Düzenleyiciye Veri Girme
Liste Düzenleyici'ye veri girmek için aşağıdaki iki yöntemden birini kullanabilirsiniz.

Bireysel Hücre Girişi
Bu yöntemle, bir hücreye bir değer girersiniz ve ardından      tuşuna basarsınız. 
Ayrıca bir hücreye bir hesaplama da girebilirsiniz. Bunu yaparsanız, hesaplamanın sonucu olan sayısal değer, 
     düğmesine bastıktan hemen sonra girilir. 

{1,3, ...} formunu kullanarak toplu giriş 
Örnek: Girmek için {1,2,3,4,5}

1` 2` 3` 4` 5E

Diğer Liste Değişkenlerini Atama
Liste 1 verilerini doğrudan Liste 2'ye atayabilir veya Liste  28'ye bir liste hesaplama  (sayfa 28)  sonucu 
atayabilirsiniz. 
Örnek: Liste 1+2'yi (Liste 1'in her öğesine 2 ekler) Liste 2'ye atamak için
1.　Liste adını vurgulamak için imleç tuşlarını kullanın Liste 2.

2.　"Liste 1+2" girin.

1.　Kullanmak istediğiniz listenin adını vurgulamak için imleç tuşlarını kullanın. 

2.　C > [Statistics] > [{}]'ı seçin, değeri girin ve ardından     tuşuna 
basın. 
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V  > [Liste] > [Liste 1] 2

Not
•　Liste değişkenlerini değiştirmek için Calculate uygulamasını da kullanabilirsiniz. Bkz. "Liste 

Değişkenlerini Saklama" (sayfa 27). .

Liste Düzenleyici Sekmesini Kullanma

Hücre içeriğini düzenlemek için
Bunu Yapmak İçin:To do this: Bu işlemi gerçekleştirin:
Hücrenin değerini değiştirme      Hücreyi vurgulayın ve yeni bir değer girin.
Hücrenin içeriğini düzenleme Hücreyi vurgulayın ve ardından       > [Edit] öğesini seçin. 
Hücrenin içeriğini silme Hücreyi vurgulayın ve ardından      > [Delete]> [One Value] öğesini seçin.

•Bu, silinen hücrenin altındaki tüm satırların bir satır yukarı kaydırılmasına               
olur. 

neden　
Belirli bir listedeki tüm 
hücrelerin içeriğini silme

Listede hücre içeriğini silmek istediğiniz herhangi bir hücreyi vurgulayın 
ve ardından       > [Delete]> [One List] öğesini seçin.

Liste Düzenleyici sekmesindeki 
tüm listeleri silme

Seç      > [Delete]> [All List].

Yeni hücre ekleme Seç       > [Insert]. .
•　Bu, 0 değerini içeren yeni bir hücre ekler. Eklenen hücrenin altındaki 

tüm hücreler bir satır aşağı kaydırılır.

Listeye alt ad vermek için
Alt ad vermek istediğiniz listenin "SUB" satırını vurgulayın ve ardından istediğiniz adı girin. Sekiz karaktere kadar 
girebilirsiniz, ancak yalnızca ekranın genişliğine sığabilecek karakterler gösterilir. S   > (Sub Name) ayarı 
kapatıldığında "SUB" satırı görüntülenmez. 

Bir değerin görüntü rengini değiştirmek için
Bunu yapmak için: Bu işlemi gerçekleştirin:
Bir hücrenin görüntü rengini 
değiştirme

1.　Değerinin görüntü rengini değiştirmek istediğiniz hücreyi vurgulayın 
ve ardından     > [Color] öğesini seçin.

2.　İstediğiniz rengi seçtikten sonra       tuşuna basınız. 
Bir listedeki tüm değerlerin 
görüntü rengini değiştirme*

1.　Listeden istediğiniz rengi seçerek vurgulayın ardından şu işlemleri uygulayınız 
       > [Color].

2.　İstediğiniz rengi seçtikten sonra        tuşuna basınız. 
*　Listenin alt adının rengi bu işlemden etkilenmez. Ayrıca, bu işlemi gerçekleştirdikten sonra boş hücrelere 

girdiğiniz tüm değerler siyah olarak görüntülenir (varsayılan ayar).

3.　 Tuşuna basınız.

31



Liste Öğelerini Sıralama
Liste Düzenleyici sekmesindeki bir listenin öğelerini, değerlerinin artan veya azalan düzeninde sıralamak için 
aşağıdaki yordamı kullanın. Temel liste olarak kullanmak üzere bir liste belirtebilir ve ardından en fazla altı listenin 
öğelerini aynı anda buna göre sıralayabilirsiniz.

1.　Seç        > [Sort/Jump]> [Sort Ascending] ya da [Sort Descending].
•　Bu, sıralanacak liste sayısını belirtmek için bir iletişim kutusu görüntüler.

2.　Sıralanacak liste sayısını belirtin ve ardından       tuşuna basın.
•　Bu, sıralama için temel listeyi belirtmek için bir iletişim kutusu görüntüler.

3.　Temel liste olarak kullanılacak listenin numarasını girin ve ardından       düğmesine basın.
•　2.adımda bir liste belirttiyseniz,       düğmesine basıldığında, buraya numarasını girdiğiniz listedeki veriler 

sıralanır. 
•
　
2.adımda iki veya daha fazla liste belirttiyseniz, (B) düğmesine basıldığında aynı anda sıralanacak ikinci 
listeyi belirtmek için bir iletişim kutusu görüntülenir.

4.　İletişim kutuları göründükçe, sıralanacak diğer listelerin numaralarını sırayla girin.
•　Aynı listenin birden çok kez belirtilmesi hataya neden olur. Sıralamayı yürütmeye çalışırsanız ve tüm 

listeler aynı sayıda öğeye (satır) sahip değilse de bir hata oluşur.

Liste Dosyaları
Hesaplayıcınız, her biri toplam 26 liste değişkeni (Liste 1- Liste 26) içeren altı liste dosyası (Dosya 1 - Dosya 6) 
sağlar, bu da bellekte en fazla 156 liste değişkeni saklayabileceğiniz anlamına gelir. Ancak, hesap makinesi aynı 
anda en fazla 26 liste değişkenini (şu anda açık olan liste dosyasındakiler) işleyebilir. Liste dosyaları arasında geçiş 
yapmak için S    > [List File] öğesini seçin. 

CSV Dosyalarını İçe ve Dışa Aktarma
Şu anda açık olan liste dosyasını bir CSV dosyasına aktarabilirsiniz. Ayrıca, bir CSV dosyasının içeriğini bir liste 
dosyasına da içe aktarabilirsiniz. Ayrıntılar için "CSV Dosyalarını Kullanma"  (sayfa 244) bölümüne bakın..

Özet İstatistikleri veya Regresyon Modeli Bilgilerini Görüntüleme
1 Değişkenli veya 2 Değişkenli istatistiksel verilerden çeşitli özet istatistikleri bulmak ve görüntülemek için 
aşağıdaki prosedürü kullanabilirsiniz. Bu prosedür, regresyon modelleri 2 Değişkenli istatistiksel verilere 
uygulandığında regresyon denklemi katsayılarını ve belirleme katsayılarını (bu kılavuzda "regresyon modeli 
bilgileri" olarak anılacaktır) görüntülemek için de kullanılabilir.

 

Operasyon Akışı
1.　Hesaplama da kullanmak için istatiksel bilgileri hesap makinesine girin.

•　Verileri girmek için Liste Düzenleyiciyi kullanın ve ardından ihtiyacınız olan liste değişkenlerini 
oluşturun. Ayrıntılar için "Veri Girme "  (sayfa 29) bölümüne bakın. .

2.　[Calculate Summary Statistics]'i seçmek için "İstatistik Uygulamasıyla Ne Yapmak İstediğinizi Seçme"  
(sayfa 29)  altındaki prosedürü kullanın.

 

3.　Sekmede 2. satırı vurgulayın ve ardından (B) düğmesine basın.

4.　Görüntülenen menüde, gerçekleştirmek istediğiniz istatistiksel hesaplama türünü seçin.

Bunu yapmak için: Bu menü ögesini seçin:
1-Değişken istatistiksel verilere (X) dayalı özet istatistikleri 
görüntüle 1-Variable

2-Değişkenli istatistiksel verilere (X, Y) dayalı özet 
istatistikleri görüntüleyin 2-Variable

•　Bu, ayarlar sekmesinde İstatistikleri Hesapla menüsünün 
görünmesine neden olur. 
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2 Değişkenli istatistiksel verilere (X, Y) dayalı regresyon 
modeli bilgilerini görüntüleyin.
(İstenen regresyon modelini menüden seçin.)

Linear Regression(ax+b)
Linear Regression(a+bx)
Med-Med Regression
Quadratic Regression
Cubic Regression
Quartic Regression
Logarithm Regression
Exp Regression(a･e^bx)
Exp Regression(a･b^x)
Power Regression
Sinusoidal Regression
Logistic Regression

5.　Gerekirse, istatistiksel veri olarak kullanmak için bir liste belirtin.
1-Değişkenli İstatistiksel Veriler İçin:
(1)　 [1Var X Liste] ögesini vurguladıktan sonra        tuşuna basınız.
(2)　  Veri olarak kullanılacak liste değişkeninin numarasını belirtmek için görüntülenen iletişim kutusunu 

kullanın ve ardından x tuşuna basınız.
(3)　 [1Var Freq] ögesini vurguladıktan sonra B    tuşuna basın.  

2-Değişkenli istatistiksel veriler için:
(1)　 [2Var X Liste] ögesini vurguladıktan sonra C    tuşuna basınız.
(2)　 Açılan iletişim kutusunu kullanarak XListe için veri olarak kullanılacak liste değişkeninin numarasını 

belirtin ve ardından        tuşuna basın.
(3)　 [2Var Y Liste] ögesini vurgulayın ardından B    tuşuna basınız. 

(4)　 Y Liste için veri olarak kullanılacak değişkenin numarasını belirtmek için görüntülenen iletişim 
kutusunu kullanın ve ardından B     düğmesine basın. 

(5)　

6.　 C   > basın veya vurgulayın                ve ardından (B) düğmesine basın.

•　Ekranda görünen değerlerin anlamları için "Özet İstatistikler"  (sayfa 33)  ve "Regresyon Modeli Bilgileri"  
(sayfa 34) bölümlerine  bakın.

İstatik Özetleri

1-Değerler

x ortalama (mean)
Σx toplam (sum)

Σx2 karelerin toplamı (sum of squares)

σx nüfus standart sapması (population standard deviation)

sx örneklem standart sapma (sample standard deviation)

n veri sayısı (number of data)
minX minimum değer (minimum value)
Q1 birinci çeyrek değer* (first quartile*)
Med medyan (median)

•　Bu, Sonuçlar sekmesindeki 4. adımda seçtiğiniz özet istatistikleri 
veya regresyon modeli bilgilerini görüntüler. Pencerenin sağ kenarı 
boyunca bir kaydırma çubuğu görünürse, (C) ve (C) düğmelerini 
kullanarak ekranı kaydırın.
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[2Var Freq] ögesini  vurguladıktan sonra C    tuşuna basınız.



Q3 üçüncü çeyrek değer* (third quartile*)
maxX maksimum değer (maximum value)
Mod mod (mode)
Mod:n moddaki veri öğelerinin sayısı
Mod:F moddaki veri sıklığı

*　Q1 ve Q3 hesaplama yöntemi, S  > [Q1Q3 Type] ayarına uygundur. Ayrıntılar için, "Q1Q3 Türü (İstatistikler)"  
(sayfa 216) bölümüne bakın.

2-Variable

x XListesinin verilerinin ortalaması
Σx XListesinin verilerinin toplamı

Σx2 XListesi verilerinin karelerinin toplamı

σx XListesi verilerinin nüfus standart sapması

sx XListesi verilerinin örneklem standart sapması 

n veri sayısı
y YListesi verilerinin ortalaması
Σy YListesi verilerinin toplamı

Σy2 YListesinin karelerinin toplamı

σy YListesi verilerinin nüfus standart sapması

sy YListesi verilerinin örneklem standart sapması

Σxy XListesi ve YListesi verilerinin ürünlerinin toplamı
minX XListesi verilerinin minimum değeri
maxX XListesi verilerinin maksimum değeri 
minY YListesi verilerinin minimum değeri
maxY YListesi verilerinin maksimum değeri

Not
•　

•　

Regresyon Model Bilgisi

Sonuçlar sekmesinde regresyon modeli bilgileri görüntülendiğinde, regresyon modeli adı ilk satırda 
görüntülenir ve regresyon formülü alt satırda yer alır. Regresyon modeline göre görüntülenen bilgiler 
aşağıdaki tabloda gösterilmiştir.
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Yukarıdaki 1-Değişkenin her bir özet istatistiğinin değeri,       > [Variable Data]> [Statistics]> [X] 
(sayfa 240)  ve       > [Variable Data]> [Statistics]> [Graph] (sayfa 240)  içinde yer alan değişkenlerde 
saklanır (Mod:n ve Mod:F hariç).
Yukarıdaki 2-Değişkenli her bir özet istatistiğin değeri,      > [Variable Data]> [Statistics]> [X] (sayfa 240)  
ve      > [Variable Data]> [Statistics]> [Y] (sayfa 240) içinde yer alan değişkenlerde saklanır.



Regresyon Modelleri Görüntülenen Bilgi*
Düzlemsel Regresyon(ax+b) a, b, r, r2, MSe
Düzlemsel Regresyon(a+bx) a, b, r, r2, MSe
Med-Med Regresyon a, b
İkinci Dereceden Regresyon a, b, c, r2, MSe
Kübik regresyon a, b, c, d, r2, MSe
Dördüncü Dereceden Regresyon a, b, c, d, e, r2, MSe
Logaritmik Regresyon a, b, r, r2, MSe
Üssel Regresyon(a･e^bx) a, b, r, r2, MSe
Üssel Regresyon(a･b^x) a, b, r, r2, MSe
Kuvvet Regresyon a, b, r, r2, MSe
Sinüzoidal Regresyon a, b, c, d, MSe
Lojistik Regresyon a, b, c, MSe

*　a, b, c, d, e: Regresyon formül katsayıları, r: Korelasyon katsayısı, r : Belirleme katsayısı, MSe: Ortalama 
kare hata

Not
•　Yukarıdaki "Görüntülenen Bilgiler" öğelerinin her bir değeri,      cinsinden bir değişkende saklanır         

> [Variable Data] [Statistics]> [Graph] (sayfa 240).
 

.
•　

Regresyon modeli bilgilerini görüntülerken yapabilecekleriniz
Sonuçlar sekmesinde regresyon modeli bilgileri görüntülenirken aşağıda gösterilen işlemleri 
gerçekleştirebilirsiniz. 

Bunu yapmak için: Bu işlemi gerçekleştirin:
Hesaplama sonucu regresyon denklemini bir 
fonksiyon değişkenine kaydedin.

1.　    > [Save Function] seçeneklerini seçiniz.
2.　Görüntülenen menüden hedef işlev numarasını 

seçin ve ardından (B) düğmesine basın.

*1

Gerçek verilerin (         ) kalıntılarını (           ) ve 
regresyon tarafından hesaplanan değerleri (         ) 
bulun modelleyin ve bunları bir liste değişkenine 
kaydedin.

yn－y′nxn, yn
xn, y′n

1.　T  > [Save Residuals in List] seçeneğini seçiniz.
2.　Bir listenin numarasını girmek için görünen 

iletişim kutusunu kullanın ve ardından (B) düğme-
sine basın.

*2

*1　Şu anda hiçbir şeyin depolanmadığı bir işlev numarası seçin. Üzerine yazma kaydetme kullanılamaz.
*2　Boş bir listenin numarasını girin. Üzerine yazma kaydetme kullanılamaz.

İstatistik Grafiği Çizme
Dağılım grafikleri ve çeşitli regresyon grafikleri çizmek için 2 Değişkenli istatistiksel verileri kullanabilirsiniz. 
1-Değişken istatistiksel veriler, histogramlar ve kutu ve bıyık diyagramları dahil olmak üzere yedi tür grafik 
çizmek için kullanılabilir. Bir grafik çizdikten sonra, özet istatistikleri ve regresyon modeli bilgilerini 
görüntüleyebilirsiniz.
Varsayılan ayarları kullanarak dağılım grafikleri ve regresyon grafikleri çizme
Bu örnekte, 2 Değişkenli istatistiksel verilerden bir dağılım grafiği çiziyoruz ve ardından bunun üzerine bir 
regresyon grafiği çiziyoruz. 

1.　Alttaki varilleri girmek için Editör Listesini kullanın.

List 1 List 2

11 1.5
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2

x1, y1; x2, y2; x3, y3

Bir Med-Med Regresyon hesaplaması yapıldığında, üç özet noktası koordinat kümesinin her biri 
(                             )        > [Variable Data]> [Statistics]> [Point Coordinates] ( sayfa 241)  cinsinden 
değişkenlerde saklanır.



21 2.2

32 3.4

43 5.1

59 8.7

•　Detaylar için şuraya gidin “Veri girişi” (sayfa 29). 

2.　[İstatistik Grafiği Çiz]'i seçmek için "İstatistik Uygulamasıyla Ne Yapmak İstediğinizi Seçme" (sayfa 29)  
altındaki prosedürü kullanın.

Not
•　Yukarıdaki 2. adımdaki Kurulum sekmesindeki Graph1'den Graph3'e kadar olan ayrıntılar için 

"Çoklu Grafik Kurulumları  Kullanarak Grafik Çizme " (sayfa 42) bölümüne bakın. 
•　Yukarıdaki 4. adımdaki Grafik sekmesi işlemleri ve 6. adımdaki Regresyon Grafiği sekme işlemleri 

hakkında ayrıntılar için "Grafik Penceresi İşlemleri" ne (sayfa 41) bakın..
•　Yukarıdaki 5. adımdaki Sonuçlar sekmesinde görüntülenen değerlerin anlamı için "Regresyon Modeli 

Bilgileri"ne (sayfa 34) bakın.

1-Değişkenli İstatistik Grafiği Çizme (Histogram, Kutu ve Bıyık Diyagramı vb.)
Liste Düzenleyici’ ye girdiğiniz 1-Değişkenli istatistiksel verilere dayanarak aşağıdaki işlemleri 
gerçekleştirebilirsiniz.
(1) Bir kutu grafiği, histogram, kesik çizgi grafiği, pasta grafiği, çubuk grafik, normal olasılık grafiği veya normal 
yoğunluk eğrisi çizin. .
(2) Grafiği çizdikten sonra özet istatistikleri görüntüleyin (Pasta Grafiği hariç).

•　Bu, İstatistik Grafiği Çiz menüsünün Kurulum sekmesinde 
görünmesine neden olur. Varsayılan Graph1 ayarı Scatter 
(dağılım grafikleri) şeklindedir ve Graph2 ve Graph3 
ayarlarının her ikisi de None (Grafik yapma) şeklindedir.

 

3.　(Grafik 1)’ i vurguladıktan sonra        tuşuna basınız.
•　Bu, Kurulum sekmesi ekranının Graph1 ayar menüsüne 

değişmesine neden olur.
•　Varsayılan olarak, X List'e List1, YList'e List2 ve Frekans'a 

1 atanır.

4.　     Tuşuna basınız.
•　Bu, x ekseninde List1 verileri ve y ekseninde List2 verileri 

ile bir dağılım grafiği çizer.

5.　      Tuşuna basınız. Menü belirdiğinde, [İkinci Dereceden 
Regresyon] seçeneğini seçiniz.
•　Bu, verilere ikinci dereceden (kuadratik) regresyon modeli 

uygular ve hesaplama sonuçlarını gösterir.

6.　         Tuşuna basınız. 
•　Bu, dağılım grafiği üzerine yerleştirilmiş ikinci dereceden bir 

regresyon grafiği çizer.
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Operasyon Akışı
1.　Verilerinizi girmek için Liste Düzenleyiciyi kullanın.

•　Ayrıntılar için "Veri Girme"  (sayfa 29) bölümüne bakın. 

2.　[İstatistik Grafiği Çiz]'i seçmek için "İstatistik Uygulamasıyla Ne Yapmak İstediğinizi Seçme"  (sayfa 29)  
altındaki prosedürü kullanın.

3.　Çizmek istediğiniz grafik tipini seçiniz..
(1)　 Grafik 1 i vurguladıktan sonra c tuşuna basınız. 

(2)　 Tekrardan       tuşuna basınız. 
•　Bu grafik türünü seçmek için menüyü görüntüler.

(3)　 Menüden seçmek istediğiniz grafik türünü seçip onu vurgulayınız ve ardından C tuşuna basınız. 

4.　İstatistiksel veri olarak kullanılacak bir liste belirtin.
Kutu grafiği, histogram, kesik çizgi grafiği, normal olasılık grafiği veya normal yoğunluk eğrisi için:

(1)　 [ XList ] öğesini vurgulayın ve ardından       düğmesine basın.
(2)　 Veri olarak kullanılacak liste değişkeninin numarasını belirtmek için görüntülenen iletişim kutusunu 

kullanın ve ardından        tuşuna basın.

(3)　      [ Frekans ] öğesini vurgulayın ve ardından        düğmesine basın. (Normal Olasılık Grafiği Hariç) 
Pasta grafiği için:

(1)　 [Veri] öğesini vurgulayın ve ardından        düğmesine basın.
(2)　 Veri olarak kullanılacak liste değişkeninin numarasını belirtmek için görüntülenen iletişim kutusunu 

kullanın ve ardından        tuşuna basın.
•　Pasta Grafiği çizerken, en fazla 20 liste değişkeni (bir listedeki satır sayısı) kullanabilirsiniz.

Bar Grafiği için:
Çubuk grafik çizmek için veri olarak en fazla üç liste değişkeni belirtebilirsiniz.

(1)　 Data 1i vurguladıktan sonra       tuşuna basınız. 
(2)　 Veri olarak kullanılacak liste değişkeninin numarasını belirtmek için görüntülenen iletişim kutusunu 

kullanın ve ardından       tuşuna basın.

(3)　 [Veri2] ve [Veri3] için yukarıdaki (1) ve (2) adımlarını tekrarlayın..
•　Birden çok liste değişkeni kullanırken, hepsindeki öğe sayısının aynı olduğundan emin olun. Liste 

değişkenlerinin tümü aynı sayıda öğeye sahip değilse, bir hata (Dimension ERROR) oluşur.

•　İki liste değişkeni kullanırken, bunları [Veri1] ve [Veri2]'ye atayın. Liste değişkenlerinin [Veri1] ve 
[Veri3] öğelerine atanması ve [Veri2] için Yok ifadesinin belirtilmesi hataya neden olur 
(Condition ERROR).

5.　Grafik rengini ve diğer ayarları gerektiği gibi belirtin.
•　Ayrıntılar için, "Her 1 Değişkenli İstatistik Grafik Türü için Öğeleri Ayarlama"  (sayfa 38) bölümüne bakın.

6.　Grafiği çizmek için       basın veya vurgulayın                ve ardından        düğmesine basın.
•　Grafik, grafik sekmesinde belirecektir. 

•　Bu, Ayarlar sekmesinde İstatistik Grafiği Çiz menüsünün görünmesini 
sağlar

•　Bu, Kurulum sekmesi ekranının Graph1 ayar menüsüne 
değişmesine neden olur.
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•　Adım 3-(2)'de seçtiğiniz grafik bir Histogram veya Kesik Çizgi Grafiği ise, Başlangıç (grafik çizimi başlangıç 
noktasının x koordinatı) ve Genişlik (grafik çizim genişliği)  seçeneğini belirleyebileceğiniz bir iletişim kutusu 
görüntülenir.Değerlerin her birini girin, öğesini vurgulayın                 ve ardından (B) düğmesine basın. 

•　Grafik sekmesinde gerçekleştirebileceğiniz işlemler hakkında bilgi için, "Grafik Penceresi İşlemleri" (sayfa 41) 
bölümüne bakın. 

7.　İstatistiklerin özetini görmek için        tuşuna basın. (Bu işlem pasta grafiği için kullanılamaz.)
•　Bu istatistik özetlerinin sonuç sekmesinde gözükmesini sağlar. Ekranlar arası geçiş yapmak için c    ve      

tuşlarını kullanabilirsiniz.
•　Gözüken istatistik özetlerinin anlamları için, "Özet İstatistikler" (sayfa 33)e gidebilirsiniz.

Her 1-Değişkenli İstatistik Grafik Türü için Öğeleri Ayarlama

Kutu Grafiği
Outliers: Kutu Grafiğindeki aykırı değer noktalarını gösterir veya gizler. 

[On]: Göster
[Off ]: Gizle

minX

Q1
Med

Q3

maxX

Aykırı değer

Box: Q1'den Q3'e kadar olan kutu alanının kenarlığının ve Med çizgisinin rengini belirtir.
Whisker: Kutunun uçlarından minX ve maxX'e kadar uzanan çizgilerin rengini belirtir.
OutlierColor:                Aykırı değer noktalarının rengini belirtir.
Box Inside: Q1'den Q3'e kadar olan kutu alanının dolgu rengini belirtir.

- Area Color : Dolgu rengini belirtir.
[Otomatik] seçeneğini belirlemek, kutunun Q1'den Med'e kadar olan iç 
kısmını mavi, Med'den Q3'e kadar olan iç kısmını ise sarı ile doldurur.

- Paint Style:  
[Normal]: Normal yoğunlukta dolgu
[Lighter]: Daha açık yoğunlukta dolgu

Not
•　

Histogram
Area: Histogramın dolgu rengini belirtir..

- Area Color : Dolgu rengini belirtir.
[Otomatik] seçeneğini belirlemek, her bir veri öğesini aşağıdaki sırayla altı renk 
arasında döngüsel olarak geçiş yaparak otomatik olarak renklendirir: mavi, kırmızı, 
yeşil, macenta, camgöbeği, sarı.

- Paint Style : Kutu Grafiği (Box Plot) ile aynıdır.
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Dolgu renginin yoğunluğunu belirtir.

      > [Q1Q3 Type] ayarının değiştirilmesi, Kutu Grafiği aynı verilere dayalı olarak çizilse bile Q1 ve 
Q3’ün konumunu değiştirebilir. 



Border: Histogram kenarlık rengini belirler. [Clear] seçilirse kenarlık çizilmez.

Kırık Doğru Grafiği:
Color: Grafik çizim rengini belirler.

Pasta Grafiği
Display: Veri görüntüleme formunu belirtir. 

[%]: Yüzdelik
[Data]: Değerler

Pie Area: Pasta grafiğin dolgu rengini belirler.
- Alan Rengi: Histogram ile aynı.
- Boyama Stili: Kutu grafiği ile aynı

Pie Border:                   Pasta grafiğin kenarlık rengini belirler. [Clear] seçilirse kenarlık çizilmez. 

Bar Grafiği
Stick Style: Çubukların yönünü belirtir.

[Lenght]: Dikey
 [Horizantal]: Yatay

D1 Area, D2 Area, D3 Area:
Veri1, Veri2 ve Veri3 için her çubuğun dolgu rengini belirler

- Alan Rengi: Histogram ile aynı.
- Boyama Stili: Kutu grafiği ile aynı.

D1 Border, D2 Border, D3 Border:
Veri1, Veri2 ve Veri3 için her çubuğun kenarlık rengini belirtir. [Temizle] seçilirse 
kenarlıklar çizilmez.

Normal Olasılık Grafiği
Mark Type: Çizim için kullanılacak işareti belirtir.
Color: Grafik çizim rengini belirler.

Normal Yoğunluk Eğrisi
Color: Grafik çizim rengini belirler.

2-Değişkenli İstatistik Grafiği Çizme (Dağılım Grafiği veya Regresyon Grafiği)
List Editor'a girdiğiniz 2-Değişkenli istatistiksel verilere dayanarak aşağıdaki işlemleri gerçekleştirebilirsiniz.
(1) Dağılım Grafiği, xy Çizgi Grafiği veya regresyon grafiği çizin.
(2) Bir grafik çizdikten sonra, özet istatistikleri veya regresyon modeli bilgilerini görüntüleyin.
(3) Yukarıda (1)'de açıklanan bir grafiğin üzerine bir regresyon grafiği çizin*
*　(1)'deki yaygın uygulama, bir Dağılım Grafiği çizmek ve ardından bunun üzerine bir regresyon grafiği 

çizmektir. Ayrıca bir xy Çizgi Grafiği veya başka bir regresyon grafiği üzerine bir regresyon grafiği çizebilirsiniz.

İşlem Akışı
1.　Verilerinizi girmek için Liste Düzenleyici'yi kullanın.

•　Ayrıntılar için "Veri Girme"  (sayfa 29) bölümüne bakın.

2.　[Calculate Summary Statictics]'i seçmek için "İstatistik Uygulamasıyla Ne Yapmak İstediğinizi Seçme" (sayfa 29)  
altındaki prosedürü kullanın.
•　Bu, İstatistik Grafiği Çiz menüsünün Kurulum sekmesinde görünmesine neden olur. 

3.　Çizmek istediğiniz grafik türünü seçin.
(1)　 Grafik 1’i vurgulayın ardından 3     tuşuna basın

•　Bu, Kurulum sekmesi ekranının Graph1 ayar menüsüne değişmesine neden olur.
(2)　 Tekrar       tuşuna basınız.

•　Bu, grafik türünü seçmek için bir menü görüntüler.
•　Menü, hem 1-Değişkenli hem de 2-Değişkenli grafikleri içerir. Dağılım Grafiği, xy Çizgi Grafiği veya 

regresyon grafiği seçin.

(3)　 Menüden çizmek istediğiniz grafik türünü vurgulayın ve ardından (B) düğmesine basın.
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4.　İstatistiksel veri olarak kullanılacak bir liste belirtin.
(1)　 [XList]'i vurgulayın ve ardından O   tuşuna basın.
(2)　 Açılan iletişim kutusunu kullanarak XList için veri olarak kullanılacak liste değişkeninin numarasını belirtin 

ve ardından O   tuşuna basın.

(3)　 [YList]'i vurgulayın ve ardından O   tuşuna basın.
(4)　 Açılan iletişim kutusunu kullanarak YList için veri olarak kullanılacak liste değişkeninin numarasını 

belirtin ve ardından O   tuşuna basın.

(5)　 [Frekans]’ı vurgulayın ve ardından O   tuşuna basın. (Bu işlem, Sinüsoidal Regresyon Grafiği veya Lojistik 
Regresyon Grafiği ile çalışmaz.)

5.　Gerektiği gibi grafik rengini ve diğer ayarları belirtin.
•　İşaret Tipi: Grafik türü olarak Dağılım Grafiği veya xy Çizgi Grafiği seçtiyseniz, çizim için kullanılacak 

işareti belirtin.
•　Renk: Grafik çizim rengini belirtir..

6.　
•　Grafik, Grafik sekmesinde görüntülenir. 
•　Grafik sekmesinde gerçekleştirebileceğiniz işlemler hakkında bilgi için, "Grafik Penceresi İşlemleri" 

(sayfa 41) bölümüne bakın..

7.　Özet istatistiklerini veya regresyon modeli bilgilerini görüntüleyin.
(1)　 >'ya basın.
(2)　 Aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bu bilgiyi görüntülemek için: Bu menü öğesini seçin:
Özet istatistikleri 2-Variable

Regresyon modeli bilgisi
(İstediğiniz regresyon modelini seçebilirsiniz.)

Linear Linear Regression(ax+b)
Linear Regression(a+bx)
Med-Med Regression
Quadratic Regression
Cubic Regression
Quartic Regression
Logarithm Regression
Exp Regression(a･e^bx)
Exp Regression(a･b^x)
Power Regression
Sinusoidal Regression
Logistic Regression

(3)　        tuşuna basın.
•　Bu, yukarıdaki 2. adımda seçtiğiniz menü öğesinin detaylarını Sonuçlar sekmesinde görüntüler.
•　Görüntülenen değerlerin anlamları için "Özet İstatistikleri" (sayfa 33) ve "Regresyon Modeli Bilgisi" 

(sayfa 34) bölümlerine bakın.

8.　

9.　Gerektiğinde regresyon grafikleri ekleyin.
Regresyon Grafiği sekmesinde birden fazla regresyon grafiği ekleyebilirsiniz. Bunu yapmak için aşağıdaki 
adımları uygulayın.

•　7. adımda regresyon modellerinden birini seçmek, 6. adımda çizilen 
grafiğin üzerine bir regresyon grafiği çizer. 2-Değişkenli'yi seçmek ise 
sadece 6. adımda çizilen grafiği görüntüler.

(1)　 T     > [Draw Regression Graph]'ı seçin.
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Grafiği çizmek için       basın. Veya vurgulayın                ve ardından       tuşuna basın.

Regresyon Grafiği sekmesine gitmek ve bir regresyon grafiği çizmek 
için       basın.



İzleme (Trace) işlevi, bir grafikte, belirli bir konumdaki koordinat değerlerini okumak için kullanabileceğiniz bir 
çapraz işaretçi (      ) görüntüler. İzlemeyi etkinleştirmek için        > [Trace]'i seçin. İzleme işlevi etkinken 
gerçekleştirilebilecek işlemler aşağıdaki tabloda açıklanmıştır.

•　Regresyon Grafiği sekmesinde mevcut olan işlemler için, "Grafik Penceresi İşlemleri" (sayfa 41) 
bölümüne bakın. 

Grafik Penceresi İşlemleri
Bu bölüm, İstatistik uygulaması'nın grafik penceresinde (Grafik sekmesi veya Regresyon Grafiği sekmesi) 
mevcut olan işlemleri açıklar.

Sadece Pasta Grafiği İşlemleri
Aşağıdaki işlemler, bir Pasta Grafiği görüntülenirken kullanılabilir.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Görüntülenen değerleri veri değerleri ile yüzdeler 
arasında değiştirme

        > [%/Data]'yı seçin.

Görüntülenen Pasta Grafiği yüzdelik değerlerini bir 
liste değişkenine kaydetme

1.　
2.　Açılan iletişim kutusunu kullanarak bir depolama 

hedefi liste numarası girin ve ardından O   tuşuna 
basınız.

Sekmeleri göstermek veya gizlemek için
"Sekmeleri Gösterme ve Gizleme" (sayfa 79) bölümüne bakın. 

Grafik penceresini yukarı, aşağı, sola veya sağa taşımak için
İmleç tuşlarını kullanın.

Grafik penceresini yakınlaştırmak veya uzaklaştırmak için
Yakınlaştırmak için        ‘ya, uzaklaştırmak için -      'ye basın. 

İzleme (Trace) Kullanımı

Bunu yapmak için: Bu işlemi gerçekleştirin:
İşaretçiyi grafik boyunca hareket ettirme       veya       ‘ye basın.
Birden fazla grafik olduğunda, işaretçiyi aralarında 
hareket ettirme

      veya       'ya basın.

İzlemeden çıkış        'ye basın.

Yakınlaştırma (Zoom) Kullanımı
      > [Zoom] menü öğeleri, grafik penceresinin görüntüleme aralığını değiştirmek için kullanılabilir. Detaylar 
için, "Grafik Penceresi Yakınlaştırma Ayarını Değiştirme (Zoom)" (sayfa 81) bölümüne bakın. İstatistik 
uygulaması'nın yakınlaştırma işlevi [Zoom Auto]'yu desteklemez.

 

Grafik penceresinin görüntüleme aralığını belirtmek için (Görünüm Penceresi) 
"İstatistik Grafiği Görünüm Penceresi Ayarları" (sayfa 52) bölümüne bakın..

Çizim (Sketch) Kullanımı
Çizim'i, grafik alanında noktalar, çizgiler ve metin çizmek için kullanabilirsiniz. Detaylar için, "Çizim Kullanımı 
(Sketch)" (sayfa 85) bölümüne bakın. Aşağıdaki menü öğeleri, İstatistik uygulaması'nda mevcuttur:
[Ekranı Temizle], [Nokta Çiz], [Çizgi], [Daire], [Dikey Çizgi], [Yatay Çizgi], [Kalem], [Metin]

Grafik ve Tablo uygulamasında girilen bir fonksiyonu grafik haline getirme (Fonksiyon Çiz)
2-Değişkenli bir grafik görüntülenirken, fonksiyonların grafiklerini üst üste çizmek için aşağıdaki işlemi 
kullanabilirsiniz.

(2)　 

•　Bu, seçtiğiniz regresyon modelinin grafiğini ekler. 
•　Daha fazla regresyon grafiği eklemek için yukarıdaki (1) ve 

(2) adımlarını tekrarlayabilirsiniz.
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Açılan menüden, istediğiniz regresyon modelini seçin ve ardından 
      tuşuna basınız.

      > [Save % in List]'i seçin.



1.　T   > [Draw Function]'ı seçin. 

2.　Açılan menüde, grafik haline getirmek istediğiniz fonksiyonu vurgulayın ve ardından O    tuşuna basınız. 

Regresyon Grafiğinde x Değerlerine Karşılık Gelen y Değerlerini Bulma (Grafik Çözme) 
Bir regresyon grafiği görüntülenirken, grafikteki herhangi bir x değeri için y değerini bulmak amacıyla aşağıdaki 
işlemi kullanabilirsiniz.

1.　T   > [Graph Solve] > [y-Cal]'ı seçin.

2.　Açılan iletişim kutusunu kullanarak x değerini girin ve ardından O   tuşuna basınız. 
•　Regresyon grafiğindeki x ve y koordinat değerleri, pencerenin altında görüntülenir. 
•　Hem x hem de y koordinat değerleri pencerenin aralığı içindeyse, grafikte koordinatlarda bir işaretçi 

belirir. 
•　İletişim kutusunu yeniden görüntülemek ve başka bir x değeri girmek için O   tuşuna basınız. 

3.　Bu işlemden çıkmak için b'ye basınız. 

Arka Plan Görüntüsünü Ayarlama (Soldurma Aç/Kapa)
Bu işlemi, arka plan görüntüsünün opaklığını (şeffaflığını) ayarlamak için kullanabilirsiniz. "Grafik Penceresi 
Arka Plan Görüntüsünü Ayarlama (Fade I/O)" (sayfa 81) bölümüne bakın. 

Çoklu Grafik Ayarları Kullanarak Grafikler Çizme
İstatistik Grafiği Çiz menüsündeki Grafik1, Grafik2 ve Grafik3, grafik ayarlarını yapılandırmak için bağımsız 
alanlardır. Varsayılan olarak, Grafik2 ve Grafik3 için Hiçbiri (Grafik çizme) belirtilmiştir ve grafik çizmek için 
yalnızca Grafik1 ayarları kullanılır.

 

İsterseniz, aynı anda birden fazla grafik çizmek için iki veya üç grafik ayarı kullanabilirsiniz.

Çoklu grafik ayarları kullanarak grafik çizerken aşağıdaki noktalara dikkat ediniz.
•　  

•　Bir alanda 1-Değişkenli grafik ve başka bir alanda 2-Değişkenli grafik için yapılan grafik ayarları, eşzamanlı
grafikler çizmek için kullanılamaz.

•　Pasta Grafiği veya Çubuk Grafik çizerken, yalnızca çizdiğiniz grafiğin ayarı bir alana atanmalıdır. Diğer 
alanlar için Hiçbiri belirtilmelidir. Pasta Grafiği veya Çubuk Grafik durumunda, aynı anda yalnızca bir grafik 
ayarı kullanarak çizim yapabilirsiniz.

Hipotez Testi Gerçekleştirme
İstatistiksel hipotezler çeşitli şekillerde test edilir ve sonuçlar sayısal ve grafiksel olarak sunulur.
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Grafik sekmesinden Sonuçlar sekmesine gitmek için         basmak, bir grafik ayarı seçmek için bir menü 
görüntüler. Menüden bir grafik ayarı seçiniz ve       tuşuna basınız.



İşlem Akışı
1.　Verileri girmek ve gerekli liste değişkenlerini oluşturmak için Liste Düzenleyicisi'ni kullanın. 

•　Giriş işlemi hakkında detaylar için, "Veri Girme" (sayfa 29) bölümüne bakın. .
•　Test türüne göre sadece gerektiği kadar liste değişkeni oluşturun. "Test Türleri ve Liste Değişkenleri" 

(sayfa 44) bölümüne bakın. Doğrusal Regresyon t-Testi,     Uyum İyiliği Testi veya ANOVA 
gerçekleştirmek isterseniz bir liste değişkeni oluşturmanız gerekir.

χ2

2.　[Hypothesis Test]'i seçmek için "İstatistik Uygulaması ile Ne Yapmak İstediğinizi Seçme" (sayfa 29) 
bölümündeki prosedürü kullanın.

3.　Bir test türü seçin.
(1)　 Hipotez Testi menüsünün ikinci satırını vurgulayın ve ardından        tuşuna basınız.
(2)　 Açılan menüden bir test türü seçin.

Bunu seçmek için: Bu menü öğesini seçin: Result:
1-Örneklem    TestiZ [Z Test] > [1-Sample Z Test]

4. Adıma Git
2-Örneklem Z Testi [Z Test] > [2-Sample Z Test]
1-Oran Z Testi [Z Test] > [1-Proportion Z test]

5. Adıma Git
2-Oran 
 

Z Testi [Z Test] > [2-Proportion Z test]
1-Örneklem t Testi [t Test] > [1-Sample t Test]

4. Adıma Git
2-Örneklem t Testi [t Test] > [2-Sample t Test]
Doğrusal Regresyon t Testi [t Test] > [Linear Regression t Test]          5. Adıma Git

χ2 Uyum İyiliği Testi                  [χ2 Test] > [ χ2 Goodness-of-Fit Test]
6. Adıma Git

χ2 İki Yönlü Testi [χ2 Test] > [ χ2 Two-Way Test]
2-Örneklem F Testi [2-Sample F Test] 4. Adıma Git
ANOVA [ANOVA] 6. Adıma Git

4.　Örnek veri belirleme yöntemini seçin.
(1)　 [Veri]'yi vurgulayın ve ardından        tuşuna basınız. 
(2)　 Aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Örnek verileri belirtmek için bir liste değişkeni 
kullanma                                                                  

Örnek ortalamayı, standart sapmayı   ve veri 
noktası sayısını girme

*1  Açılan menüde, [Variable]'ı vurgulayın ve 
ardından        tuşuna basınız. 

*1　Z testi için giriş gerekmez.

5.　Alternatif hipotez için parametreleri girin.
•　Örneklem türüne özel parametreler hakkında bilgi için, "Test Türleri ve Parametreler" (sayfa 45) bölümüne bakın.
•　Örneğin, 3. adımda [Z Test] > [1-Sample Z Test]'ni seçtiyseniz, aşağıdaki adımları gerçekleştirin.
(1)　 [μ]'yü vurgulayın ve ardından        tuşuna basınız. 
(2)　 Açılan menüde, testin yönünü (≠, < veya >) vurgulayın ve ardından       tuşuna basınız.
(3)　 [μ0]'ı vurgulayın, varsayımsal popülasyon ortalamasının sayısal değerini girin ve ardından       tuşuna basınız. 

6.　Diğer parametreleri girin.
•　Örneklem türüne özel parametreler hakkında bilgi için, "Test Türleri ve Parametreler" (sayfa 45) bölümüne 

bakın. 

•　Bu, Kurulum sekmesinde Hipotez Testi menüsünü görüntüler. 
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 Açılan menüde, [List]'i vurgulayın ve ardından 
         tuşuna basınız.



7.　Gerektiği gibi grafik rengini belirtin.*2

(1)　 [Color]'ı vurgulayın ve ardından       tuşuna basınız.
(2)　 Açılan menüde, istediğiniz rengi vurgulayın ve ardından       tuşuna basınız.

8.　       basınız. Veya vurgulayın                ve ardından       tuşuna basınız. 
•　Bu, Sonuçlar sekmesinde, test hesaplama sonuçlarını ve girilen değerleri (veya belirtilen verilerden 

hesaplanan özet istatistiklerini) görüntüler.
•　 Görüntülenen hesaplama sonuçlarının açıklamaları ve Sonuçlar sekmesinde mevcut olan işlemler için, 

"Test Sonuçları Sekmesini Kullanma" (sayfa 46) bölümüne bakın.

9.　Grafiği görüntülemek için        tuşuna basınız. .
*2

•　Grafik sekmesinde gerçekleştirilebilecek işlemler için, "Test Grafiği Sekmesini Kullanma" (sayfa 48) 
bölümüne bakın.
*2
　

Bu işlem aşağıdaki durumlarda gerekli değildir:
-
　
Test türü Doğrusal Regresyon   Testi olduğunda. t

-
　
Test türü ANOVA olduğunda ve [How Many] > [1] belirtildiğinde.

Test Türleri ve Liste Değişkenleri
Gerçekleştirmek istediğiniz test türüne bağlı olarak, Liste Düzenleyicisi'ne aşağıdaki gibi veri girin ve liste 
değişkenlerini oluşturun.

Doğrusal Regresyon t Testi
Gerekli liste değişken(ler)i: Kurulum sekmesi görünümü:
XList (x verileri), YList (y verileri) ve Freq (frekans verileri) olarak 
kullanılmak üzere üç liste değişkeni.*

*　Frekans verileri kullanmıyorsanız, Freq liste değişkenine ihtiyacınız yoktur.

χ2 Goodness-of-Fit Test
Gerekli liste değişken(ler)i: Kurulum sekmesi görünümü:
Gözlenen (gözlenen sayımlar)* ve Beklenen (beklenen frekanslar) için 
kullanılan iki liste değişkeni.

*　Tüm liste öğeleri pozitif tam sayı olmalıdır.

ANOVA
Hem Tek Yönlü ANOVA hem de Çift Yönlü ANOVA'yı gerçekleştirebilirsiniz. Kurulum sekmesinde, Tek 
Yönlü ANOVA için [Kaç Tane] > [1]'i veya Çift Yönlü ANOVA için [2]'yi seçin. 

ANOVA Türleri: Gerekli liste değişken(ler)i: Kurulum sekmesi görünümü:
Tek Yönlü ANOVA Faktör A (Faktör A koşulu) ve Bağımlı (ör-

nek veri) için kullanılan iki liste değişkeni

Çift Yönlü ANOVA Faktör A (Faktör A koşulu), Faktör B (Fak-
tör B koşulu) ve Bağımlı (örnek veri) için 
kullanılan üç liste değişkeni

ANOVA'da kullanılan liste değişkenleri, aşağıda açıklandığı gibi oluşturulur.
•　Tek Yönlü ANOVA: Örneğin, Faktör A için iki koşul (Koşul 1, Koşul 2) varsa, her bir liste aşağıda gösterildiği 

gibi oluşturulur.

Faktör A Bağımlı   
1 113

 Koşul 1 örnek verisi
1 116
2 133

 Koşul 2 örnek verisi
2 131

•　Çift Yönlü ANOVA: Örneğin, Faktör A ve Faktör B için iki farklı koşul (Koşul 1, Koşul 2) varsa, her bir liste
aşağıda gösterildiği gibi oluşturulur.
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Faktör A Faktör B Bağımlı   
1 1 113 Faktör A Koşul 1 × Faktör B 

Koşul 1 örnek verisi1 1 116
2 1 133 Faktör A Koşul 2 × Faktör B 

Koşul 1 örnek verisi2 1 131
1 2 139 Faktör A Koşul 1 × Faktör B 

Koşul 2 örnek verisi1 2 132
2 2 126 Faktör A Koşul 2 × Faktör B 

Koşul 2 örnek verisi2 2 122

1-Örneklem veya 2-Örneklem Z Testi, 1-Örneklem veya 2-Örneklem t Testi, 2-Örneklem F Testi 
Eğer "İşlem Akışı" (sayfa 43) altındaki 4. adımda [Data] > [List]'i seçerseniz, aşağıdaki liste değişkenlerini 
oluşturmanız gerekir. 
Örnek veri: Gerekli liste değişken(ler)i: Kurulum sekmesi görünümü:
Tek örneklem veri (frekanssız) List'e atanacak liste değişkeni

Tek örneklem veri (frekanslı) List ve Freq'e atanacak iki liste değişkeni

İki örneklem veri (frekanssız) List(1) ve List(2)'ye atanacak iki liste 
değişkeni

İki örneklem veri (frekanslı) List(1), List(2), Freq(1), Freq(2)'ye 
atanacak dört liste değişkeni

Test Türleri ve Parametreler

Alternatif Hipotez Parametreleri
Test Türü: Parametre:

1-Örneklem Z Testi, 
1-Örneklem t Testi

μ: test koşulları  (“≠ μ0 ” çift kuyruklu test belirtir, “<μ0” alt tek kuyruklu test 
belirtir, “>μ0” üst tek kuyruklu test belirtir.)
μ0: varsayılan popülasyon ortalaması

2-Örneklem Z Testi, 
2-Örneklem t Testi 

μ1: test koşulları ("≠ μ2" çift kuyruklu test belirtir, "<μ2" örneklem 1'in 
örneklem 2'den daha küçük olduğu tek kuyruklu test belirtir, ">μ2" örnek-
lem 1'in örneklem 2'den daha büyük olduğu tek kuyruklu test belirtir.)

1-Oran Z Testi 
Prop: test koşulları ("≠p0" çift kuyruklu test belirtir, "<p0" alt tek kuyruklu 
test belirtir, ">p0" üst tek kuyruklu test belirtir.) 
p0: beklenen örneklem oranı (0 < p0 < 1)

2-Oran Z Testi 
p1: test koşulları ("≠p2" çift kuyruklu test belirtir, "<p2" örneklem 1'in
örneklem 2'den daha küçük olduğu tek kuyruklu test belirtir, ">p2"
örneklem 1'in örneklem 2'den daha büyük olduğu tek kuyruklu test belirtir.)

Doğrusal Regresyon t Testi β&ρ: test koşulları ("≠0" çift kuyruklu test belirtir, "< 0" alt tek kuyruklu
test belirtir, "> 0" üst tek kuyruklu test belirtir.)

2-Örneklem F Testi 
σ1:  test koşulları ("≠σ2" çift kuyruklu test belirtir, "<σ2" örneklem 1'in
örneklem 2'den daha küçük olduğu tek kuyruklu test belirtir, ">σ2"
örneklem 1'in örneklem 2'den daha büyük olduğu tek kuyruklu test belirtir.)

Diğer Parametreler
Aşağıdaki tabloda yıldız (*) işaretiyle belirtilen parametreler, "İşlem Akışı" (sayfa 43) bölümündeki prosedürün 
4. adımında [Veri] > [Değişken]'i seçtiğinizde girilmesi gereken parametrelerdir.[ .

Test Türü: Parametre:

1-Örneklem Z Testi 
σ: popülasyon standart sapması (σ > 0)
x−: örneklemin ortalaması*
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n: örneklem boyutu (pozitif tam sayı)*

2-Örneklem Z Testi 

σ1: 1. örneklemin popülasyon standart sapması (σ1 > 0)
σ2: 2. örneklemin popülasyon standart sapması (σ2 > 0)
x−1: 1. örneklemin ortalaması*

n1: 1. örneklemin boyutu (pozitif tam sayı)*

x−2: 2. örneklemin ortalaması *

n2: 2. örneklemin boyutu (pozitif tam sayı)*

1-Oran Z   Testi
x :örneklem değeri (x ≥ 0 tam sayı)
n: örneklem boyutu (pozitif tam sayı)

2-Oran Z Testi 

x1 :1. örneklemin veri değeri (x1 ≥ 0 tam sayı)
n1: 1. örneklemin boyutu (pozitif tam sayı)
x2: 2. örneklemin veri değeri (x2 ≥ 0 tam sayı)
n2: 2. örneklemin boyutu (pozitif tam sayı)

1-Örneklem t Testi 
x−: örneklemin ortalaması*

sx: örneklem standart sapması (sx > 0)*

n: örneklem boyutu (pozitif tam sayı)*

2-Örneklem t Testi 

x−1: örneklemin ortalaması*

sx1: 1. örneklemin standart sapması (sx1 > 0)*

n1: 1. örneklemin boyutu (pozitif tam sayı)*

x−2: 2. örneklemin ortalaması *

sx2: 2. örneklemin standart sapması (sx2 > 0)*

n2: 2. örneklemin boyutu (pozitif tam sayı)*

Havuzlanmış (Pooled): havuzlama Açık (etkin) veya Kapalı (etkin değil)

χ2 Uyum İyiliği Testi

Gözlenen: Gözlenen sayımları içeren bir liste değişkenini (List 1'den 
List 26'ya) belirtin (tüm liste öğeleri pozitif tam sayı olmalıdır).
Beklenen: Beklenen frekansların depolama konumu olarak bir liste 
değişkenini (List 1'den List 26'ya) belirtin.
df : serbestlik derecesi (pozitif tam sayı)
CNTRB: Hesaplama sonuçları olarak elde edilen her bir gözlenen sayımın 
katkısının depolama konumu olarak bir liste değişkenini (List 1'den List 
26'ya) belirtin.

χ2İki Yönlü Testi

Gözlenen: Gözlenen sayımları içeren bir matris değişkenini (Mat A'dan 
Mat Z'ye) belirtir. Aşağıdaki koşulları karşılayan bir matris belirttiğinizden 
emin olun. Bu koşulları karşılamayan bir matris belirtirseniz bir hata 
oluşur.
•　Matris en az 2 satır ve 2 sütuna sahip olmalıdır.
•　Matrisin tüm öğeleri pozitif tam sayı olmalıdır.
Beklenen: Beklenen frekansları içeren bir matris değişkenini (Mat A'dan 
Mat Z'ye) belirtir. 

2-Örneklem F Testi 

sx1: 1. örneklemin standart sapması (sx1 > 0)*

n1: 1. örneklemin boyutu (pozitif tam sayı)*

sx2: 2. örneklemin standart sapması ( sx2 > 0)*

n2: 2. örneklemin boyutu (pozitif tam sayı)*

ANOVA
Kaç Tane:

1: Tek Yönlü ANOVA
2: Çift Yönlü ANOVA

Test Sonuçları Sekmesini Kullanma

Sonuçlar Sekmesindeki Bilgiler
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ANOVA Dışında Bir Test Gerçekleştirildiğinde
Test hesaplama sonuçları ve örneklem verilerinin özet istatistikleri, Sonuçlar sekmesinde görüntülenir. 
Ekranda görünen öğelerin anlamları aşağıda verilmiştir.
Test Hesaplama Sonuçları
p: p-değeri
z: z puanı (  Test)
t: t değeri (t Test)

χ2: χ2 değeri (χ2 Test)
F: F değeri (F Test)
p: tahmini örneklem oranı (1-

Oran/2-Oran  Testi)
p1: 1. örneklemin tahmini oranı (2-

Oran  Testi)
p2: 2. örneklemin tahmini oranı (2-

Oran  Testi)
df : serbestlik derecesi (2-Örneklem t Testi,

Doğrusal Regresyon t Testi, χ2 Testi)
a: sabit terim (Doğrusal Regresyon t

Testi)
b: katsayı (Doğrusal Regresyon t Testi)

Örneklem Verilerinin Özet İstatistikleri
x−: örneklemin ortalaması
x−1: 1. örneklemin ortalaması

x−2: 2. örneklemin ortalaması

sx: örneklem standart sapması

sx1: 1. örneklemin standart sapması

sx2: 2. örneklemin standart sapması

sp: havuzlanmış örneklem standart sapması

n: örneklem boyutu
n1: 1. örneklemin boyutu

n2: 2. örneklemin boyutu

se: standart hata

r: korelasyon katsayısı

r2: belirleme katsayısı

ANOVA Gerçekleştirildiğinde
Hesaplama sonuçları, ders kitaplarında kullanılan tablo formuyla aynı şekilde görüntülenir.

Tek Yönlü ANOVA
*1

2. Satır: ERR değerleri

Çift Yönlü ANOVA
*1

2. Satır: B değerleri
3. Satır: AB değerleri*2

4. Satır: ERR değerleri
*1　Burada gösterilen tablolar, hesap makinesi tarafından iki ekrana yayılarak gösterilecektir, bu nedenle 

tablonun tüm içeriğini görmek için sola ve sağa kaydırmanız gerekebilir.
*2　Her bir hücrede yalnızca bir gözlem olduğunda 3. satır görünmez.

1. Sütun: df ... serbestlik derecesi
2. Sütun: ss ... kareler toplamı
3. Sütun: ms ... ortalama kareler
4. Sütun: F ... F değeri 
5. Sütun: P ... p değeri
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1. Satır: A değerleri

1. Satır: A değerleri



Not
•　

Hesaplama sonuçları görüntülenirken yapabilecekleriniz
Aşağıdaki işlemi kullanarak, Sonuçlar sekmesinde  şu anda görüntülenen tüm sayısal değerleri bir liste 
değişkenine kaydedebilirsiniz.

*1

1.　     > [Save Result in List]'i seçin. 

2.　Açılan iletişim kutusunu kullanarak, bir kaydetme hedefi olarak kullanmak istediğiniz listenin numarasını 
girin ve ardından       tuşuna basınız. 

*2*3
 

*1　Şu anda görüntülenen hesaplama sonuçlarını ve girilen değerleri içerir. Ancak, alternatif hipotez 
parametreleri (sayfa 45) kaydedilmez. 

*2　Boş bir listenin numarasını girin. Üzerine yazarak kaydetme mevcut değildir.
*3　ANOVA ile, her biri beş hesaplama sonucu sütunu, girdiğiniz liste numarasından başlayarak beş liste 

değişkenine kaydedilir. 1'den 22'ye kadar olan aralıkta bir liste numarası belirleyebilirsiniz.

Not
•　Doğrusal Regresyon t Testi'nin hesaplama sonuçları görüntülenirken aşağıdaki işlemleri 

gerçekleştirebilirsiniz.
-　Hesaplama sonucu regresyon denklemini bir fonksiyon değişkenine kaydetme.
-　Gerçek veriler ile regresyon modeli tarafından hesaplanan değerler arasındaki artıkları bulma ve 

bunları liste değişkenlerine kaydetme.
"Regresyon modeli bilgilerini görüntülerken yapabilecekleriniz" (sayfa 35) bölümüne bakın.

Test Grafiği Sekmesini Kullanma

When you perform a test other than Two-Way ANOVA
Çift Yönlü ANOVA dışındaki bir testi gerçekleştirdikten sonra aşağıdaki işlemleri yapabilirsiniz: 1-Örneklem Z 
Testi, 2-Örneklem Z Testi, 1-Oran Z Testi, 2-Oran Z Testi, 1-Örneklem t Testi, 2-Örneklem t Testi, χ2
Uyum İyiliği Testi, χ2 İki Yönlü Testi, 2-Örneklem F Testi. 

Bunu yapmak için: Bu menü öğesini seçin:
p değerini görüntüleme  > [Calculate P Value]
Z Testi: z değerini görüntüleme ve grafikteki karşılık gelen 

noktada bir çapraz işaretçi görüntüleme  > [Calculate Z Value]*1*2

1-Örneklem/2-Örneklem t Testi: t değerini(lerini) görüntüleme ve 
grafikteki karşılık gelen noktada bir çapraz işaretçi görüntüleme  > [Calculate T Value]*1*2

χ2Testi: χ2 değerini(lerini) görüntüleme ve grafikteki karşılık gelen 
noktada bir çapraz işaretçi görüntüleme  > [Calculate CHI Value]*1*2

2-Örneklem F Testi: F değerini görüntüleme ve grafikteki 
karşılık gelen noktada bir çapraz işaretçi görüntüleme  > [Calculate F Value]*1*2

*1　İki kuyruklu bir test için, l    veya r    ’ye her basıldığında çapraz işaretçi iki değer arasında hareket eder. 
*2　Görüntüleme aralığı dışındaki ilgili bir nokta görüntülenmez.

Not
•　Yukarıdaki işlemlerle görüntülenen hesaplama sonuçları, aşağıda açıklanan alfa değişkenlerinde 

saklanır.

Z Testi z ve p değerleri sırasıyla Z ve P değişkenlerinde saklanır.
t Testi t ve  p  değerleri sırasıyla T ve P değişkenlerinde saklanır.
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Sonuçlar sekmesinde görüntülenen değerler,       > [Variable Data] > [Statistics] > [Result] > [Test] 
(sayfa 241) ve       > [Variable Data] > [Statistics] > [Input] (sayfa 241) içindeki değişkenlerde saklanır. 
Ancak, a ve b değişkenleri       > [Variable Data] > [Statistics] > [Graph] (sayfa 240)  içinde bulunur.



Çift Yönlü ANOVA ile Etkileşim Grafiği çizebilirsiniz. Grafiklerin sayısı Faktör B'ye, x ekseni verilerinin sayısı ise 
Faktör A'ya bağlıdır. y ekseni, her kategorinin ortalama değeridir.      > [Trace]'i seçmek, grafikte bir çapraz 
işaretçi (İzleme) görüntüler.       veya       tuşlarına basmak, işaretçiyi grafikte ilgili yöne hareket ettirir. Birden fazla 
grafik olduğunda, grafikler arasında gezinmek için      ve      tuşlarını kullanabilirsiniz. 

χ2 Testi χ2 ve p  değerleri sırasıyla C ve P değişkenlerinde saklanır.
F Testi F ve p  değerleri sırasıyla F ve P değişkenlerinde saklanır.

Aşağıdaki ekranlar, μ≠μ0 (çift kuyruklu test) ile tek örneklem t-testi yapıp ardından bir grafik çizdiğinizde ne 
olacağına dair bir örnek göstermektedir. Sağdaki ekran, T   > [Calculate T Value]'yu seçtiğinizde ortaya çıkan 
bir örnektir.

Çift Yönlü ANOVA Gerçekleştirildiğinde

 

İzleme işlevini kullanmak, Faktör A'nın son koşul numarasını otomatik olarak A değişkenine ve son kategorinin 
ortalama değerini ise M değişkenine depolar.

Bir Güven Aralığı Bulma
Verilen örneklem verilerinden ve güven düzeyinden güven aralığının üst ve alt sınırlarını bulmak için aşağıdaki 
prosedürü kullanabilirsiniz.

İşlem Akışı
1.　Verileri girmek ve gerekli liste değişkenlerini oluşturmak için Liste Düzenleyicisi'ni kullanın.

•　Giriş işlemi hakkında detaylar için, "Veri Girme" (sayfa 29) bölümüne bakın.
•　Oluşturulması gereken liste değişkenleri için "Güven Aralığı Türleri ve Liste Değişkenleri" (sayfa 51) 

bölümüne bakın.
2.　[Confidence Interval]'ı seçmek için "İstatistik Uygulaması ile Ne Yapmak İstediğinizi Seçme" (sayfa 29) 

bölümündeki prosedürü kullanın. 

3.　Güven aralığı türünü seçin.
(1)　 Güven Aralığı menüsünün 2. satırını vurgulayın ve ardından       tuşuna basınız.
(2)　 Açılan menüden bir güven aralığı türü seçin.

Bunu seçmek için: Bu menü öğesini seçin: Sonuç:
1-Örneklem Z Aralığı [Z Confidence Interval] > [1-Sample Z Interval]

4. Adıma Git
2-Örneklem Z Aralığı [Z Confidence Interval] > [2-Sample Z Interval]

•　Bu, Kurulum sekmesinde Güven Aralığı menüsünü görüntüler.
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1-Oran Z Aralığı [Z Confidence Interval] > [1-Proportion Z Interval]
5. Adıma Git

2-Oran Z Aralığı [Z Confidence Interval] > [2-Proportion Z Interval]
1-Örneklem t Aralığı [t Confidence Interval] > [1-Sample t Interval]

4. Adıma Git
2-Örneklem t Aralığı [t Confidence Interval] > [2-Sample t Interval]

4.　Örnek Veri Belirleme Yöntemini Seçin.
(1)　 [Data]'yı vurgulayın ve ardından       tuşuna basınız.
(2)　 Aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Örnek verileri belirtmek için bir liste değişkeni 
kullanma

Örneklem ortalamasını, standart sapmasını ve 
veri noktası sayısını girme

5.　Parametreler İçin Değerleri Girin
(1)　 [C-Level]'ı vurgulayın ve ardından güven düzeyini girmek için sayı tuşlarını kullanın.

•　0 ile 1 arasında bir değer girin. Yaygın olarak kullanılan güven düzeyleri 0.95 (%95) ve 0.99 (%99)'dur.
(2)　        tuşuna basınız.
(3)　 Diğer parametreleri girin.

•　Oluşturulması gereken liste değişkenleri için "Güven Aralığı Türleri ve Parametreler" (sayfa 51) bölümüne bakın.

6.　> tuşuna basınız. Veya Vurgulayın                 ve Ardından        Tuşuna Basınız
•　Bu, Sonuçlar sekmesinde güven aralığı hesaplama sonuçlarını ve örneklem verilerinin özet istatistiklerini 

görüntüler.
Güven Aralığı Hesaplama Sonuçları
Lower: güven aralığı alt sınırı
Upper: güven aralığı üst sınırı
df : serbestlik derecesi
p: tahmini örneklem oranı
p1: 1. örneklemin tahmini oranı

p2: 2. örneklemin tahmini oranı

Örneklem Verilerinin Özet İstatistikleri
x−: örneklemin ortalaması
x−1: 1. örneklemin ortalaması

x−2: 2. örneklemin ortalaması

sx: örneklem standart sapması

sx1: 1. örneklemin standart sapması

sx2: 2. örneklemin standart sapması

sp: havuzlanmış örneklem standart sapması

n: örneklem boyutu
n1: örneklemin boyutu

n2: örneklemin boyutu

Not
•　Aşağıdaki işlemi kullanarak, Sonuçlar sekmesinde şu anda görüntülenen değerleri bir listeye 

kaydedebilirsiniz.
(1)　        > [Save Result in List]'i seçin.
(2)　 Açılan iletişim kutusunu kullanarak bir liste numarası* girin ve ardından        tuşuna basınız.
*　Boş bir listenin numarasını girin. Üzerine yazarak kaydetme mevcut değildir.

•　Sonuçlar sekmesinde görüntülenen değerler, aşağıda gösterilen menü öğelerindeki değişkenlerde 
saklanır.
Güven aralığı hesaplama sonuçları:       > [Variable Data] > [Statistics] > [Result] > [Confidence Interval] 
(sayfa 241)
Örneklem verilerinin özet istatistikleri:      > [Variable Data] > [Statistics] > [Input] (sayfa 241)
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Açılan menüde, [List]'i vurgulayın ve ardından 
       tuşuna basınız.

Açılan menüde, [Variable]'ı vurgulayın ve 
ardından        tuşuna basınız.



Güven Aralığı Türleri ve Liste Değişkenleri
Örneklem verilerinin bir listesini kullanarak güven aralıkları bulmak için, güven aralığı türüne göre aşağıdaki 
liste değişkenlerini oluşturun.

Örnek veri: Gerekli liste değişken(ler)i: Kurulum sekmesi görünümü:
Tek örneklem veri (frekanssız) List'e atanacak liste değişkeni

Tek örneklem veri (frekanslı) List ve Freq'e atanacak iki liste değişkeni 

İki örneklem veri (frekanssız) List(1) ve List(2)'ye atanacak iki liste 
değişkeni

İki örneklem veri (frekanslı) List(1), List(2), Freq(1), Freq(2)'ye 
atanacak dört liste değişkeni

Güven Aralığı Türleri ve Parametreler
Aşağıdaki tabloda yıldız (*) işaretiyle belirtilen parametreler, "İşlem Akışı" (sayfa 49) bölümündeki prosedürün 
4. adımında [Veri] > [Değişken]'i seçtiğinizde girilmesi gereken parametrelerdir.

Güven aralığı türü:                    Parametre:
1-Örneklem Z Aralığı σ: popülasyon standart sapması (σ > 0)

x− :örneklemin ortalaması*

n: örneklem boyutu (pozitif tam sayı)*

2-Örneklem Z Aralığı σ1: 1. örneklemin popülasyon standart sapması ( σ1 > 0)
σ2: 2. örneklemin popülasyon standart sapması (σ2 > 0)
x−1: 1. örneklemin ortalaması*

n1: 1. örneklemin boyutu (pozitif tam sayı)*

x−2: 2. örneklemin ortalaması*

n2: 2. örneklemin boyutu (pozitif tam sayı)*

1-Oran Z Aralığı x: örneklem değeri (x ≥ 0 integer)
n: örneklem boyutu (pozitif tam sayı)

2-Oran Z Aralığı x1: 1. örneklemin veri değeri (x1 ≥ 0 integer)
n1: 1. örneklemin boyutu (pozitif tam sayı)
x2: 2. örneklemin veri değeri (x2 ≥ 0 integer)
n2: 2. örneklemin boyutu (pozitif tam sayı)

1-Örneklem t Aralığı x−: örneklemin ortalaması*

sx: örneklem standart sapması ( sx > 0)*

n: örneklem boyutu (pozitif tam sayı)*

2-Örneklem t Aralığı x−1: 1. örneklemin ortalaması*

sx1: 1. örneklemin standart sapması ( sx1 > 0)*

n1: 1. örneklemin boyutu (pozitif tam sayı)*

x−2: 2. örneklemin ortalaması*

sx2: 2. örneklemin standart sapması (sx2 > 0)*

n2: 2. örneklemin boyutu (pozitif tam sayı)*

Havuzlanmış: Havuzlama Açık (etkin) veya Kapalı (etkin değil)
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İstatistik Grafiği Görüntü Penceresi Ayarları

Eğer       > [View Window] > [Manuel]'e geçerseniz, grafik penceresinde       > [View Window]'u 
seçtiğinizde açılan menü ile yapılandırılan Görüntü Penceresi ayarlarındaki değişiklikler, grafik penceresinin 
görüntüleme aralığına uygulanır. 
Görüntü Penceresi ayarları hakkında detaylar için, "Grafik Penceresinin Görüntüleme Aralığını Belirleme 
(Görüntü Penceresi)" (sayfa 80) bölümüne bakın.

Not
•　Aşağıdaki grafik türleri için,       > [View Window]'un [Manuel] olarak ayarlanıp ayarlanmadığına 

bakılmaksızın Görüntü Penceresi parametrelerinin otomatik olarak ayarlandığını unutmayın.
Pasta, 1-Örneklem Z  Testi, 2-Örneklem Z Testi, 1-Oran Z  Testi, 2-Oran Z  Testi, 1-Örneklem t Testi, 
2-Örneklem t Testi, χ2 Uyum İyiliği Testi, χ2 İki Yönlü Testi, 2-Örneklem F Testi (yalnızca x ekseni 
göz ardı edilir).
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İstatistik grafiği Görüntü Penceresi'nin ayarları, çizilen grafiğe göre otomatik olarak yapılandırılır. Bunun nedeni, 
hesap makinesinin varsayılan olarak       > [View Window] (sayfa 216) > [Otomatik]'i seçmesidir.



Dağılım Uygulaması
Dağılım uygulaması, binom dağılımı, normal dağılım, Poisson dağılımı ve çeşitli diğer olasılık dağılımı türlerini 
yönetebilir. 

Not
•　Dağılım hesaplaması,       > [Distribution]'daki işlevler kullanılarak Hesaplama uygulaması ile de 

gerçekleştirilebilir. Mevcut işlevler hakkında bilgi için, "Dağılım: Dağılım Hesaplamaları" (sayfa 233) 
bölümüne bakın.

İşlem Akışı
Adım 1: Bir dağılım seçin (Seçme sekmesi).

2.　Hesaplama için kullanmak istediğiniz dağılımı vurgulayın ve ardından >    (veya         ) tuşuna basınız.
•　Aşağıdaki dağılımlar arasından seçim yapabilirsiniz.

Kesikli dağılım
-　Binom dağılımı
-　Poisson dağılımı
-　Geometrik dağılım
-　Hipergeometrik dağılım

Sürekli Dağılım
-　Normal dağılım
-　Student-t dağılımı
-　χ2  dağılımı
-　F  dağılımı

Adım 2: Parametreleri girin (Kurulum sekmesi).

[ ]: Belirtilen x veri değeri veya daha düşük değerler için kümülatif olasılığı hesaplar.
[ ]: Veri değerlerinin alt (Lower) ve üst (Upper) sınırları için kümülatif olasılığı 

hesaplar.
[ ]: Belirtilen x veri değeri veya daha yüksek değerler için kümülatif olasılığı hesaplar. 
[ ]: Verilen x veri değeri için olasılığı hesaplar (yalnızca kesikli dağılım).

4.　Hesaplama için tek bir veri değeri mi yoksa birden fazla veri değeri mi kullanacağınızı belirtin.
(1)　  [Data]'yı vurgulayın ve ardından       tuşuna basınız.
(2)　 Hesaplama için tek bir veri değeri kullanmak üzere [Değişken]'i veya birden fazla veri değeri için 

[List]'i seçin.
5.　Diğer parametreleri girin.

Tüm dağılımlar için ortak parametreler
[Tail] (adım 3) ve [Veri] (adım 4) için ne belirttiğinize göre aşağıdaki parametreleri girin.

1.　  > Distribution
•　Bu, dağılım seçme menüsünü görüntüler.

3.　Olasılık hesaplaması için bir kuyruk ayarı seçin.

(1)　 [Tail]'i vurgulayın ve ardından       tuşuna basınız.
(2)　 Açılan menüden aşağıda açıklanan seçeneklerden birini seçin.
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Kuyruk
Veri

, ,

Değişken x: Veri değeri Lower: Veri değeri alt sınırı
Upper: Veri değeri üst sınırı

Liste List*1: Veri değerleri olarak 
kullanılacak liste

L.List*1: Veri değerlerinin alt sınırı olarak 
kullanılacak liste

U.List*1: Veri değerlerinin üst sınırı olarak 
kullanılacak liste

*1　Veri değerleri olarak kullanılacak bir liste değişkenini belirtme işlemi için, "Veri değerleri olarak 
kullanılacak bir liste değişkenini belirtme" (sayfa 55) bölümüne bakın..

Dağılım Türüne Özgü Parametreler
Binom dağılımı

Numtrial: Deneme sayısı
p: Başarı olasılığı (0 ≤ p ≤ 1)

Normal dağılım
DisplayZ: Z-Puanlarını Görüntüleme*2

μ: Popülasyon ortalaması
σ: Popülasyon standart sapması (σ > 0)

Poisson dağılımı
λ: Ortalama (λ > 0)

Geometrik dağılım
p: Başarı olasılığı (0 < p ≤ 1)

Hipergeometrik dağılım
n: Popülasyondan deneme sayısı (0 ≤ n tam sayı)
M: Popülasyondaki başarı sayısı (0 ≤ M tam sayı)
N: Popülasyon boyutu (n ≤ N, M ≤ N tam sayı)

Student-t dağılımı
df: Serbestlik derecesi (df > 0)

χ2 dağılımı
df: Serbestlik derecesi (Pozitif tam sayı)

F dağılımı
n:df: Payın serbestlik derecesi (Pozitif tam sayı)
d:df: Paydanın serbestlik derecesi (Pozitif tam sayı)

*2　Z-puanlarını (standartlaştırılmış değerler) göstermek için [Açık]'ı, gizlemek için [Kapalı]'yı seçin. [Açık]'ı 
seçerseniz, hesaplama μ = 0 ve σ = 1 olarak gerçekleştirilir.

Not
•　Grafiğin rengini, [Color]'ı vurgulayarak ve ardından         tuşuna basınız (yalnızca 4. adımda [Data] > 

[Variable]'ı seçtiyseniz) belirleyebilirsiniz.
•　        > [Input Descriptions]'ı seçmek, parametrelerin açıklamalarını görüntüler.

Adım 3: Hesaplama Sonuçlarını Görüntüleme (Sonuçlar sekmesi).

6.　Kurulum sekmesinde, >'ya basınız, veya vurgulayın                ve ardından        tuşuna basınız. 
•　Hesaplama sonuçları Sonuçlar sekmesinde görüntülenir.

Tek Veri Değeri Hesaplaması
([Data] > [Variable] seçildiğinde.)

Çoklu Veri Değeri Hesaplaması
([Data] > [List] seçildiğinde.)
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Veri değerleri olarak kullanılacak bir liste değişkenini belirtme
Kurulum sekmesinde [Data] > [List] seçildiğinde, veri değerleri olarak kullanılacak liste değişkenini belirtmek 
için aşağıdaki işlemi kullanın. Halihazırda kaydedilmiş bir liste değişkeni kullanıyorsanız, aşağıdaki 2. ila 5. 
adımlardaki işlemlere gerek yoktur. 

1.　Kurulum sekmesinde, [List], [L.List] veya [U.List]'i vurgulayın ve ardından       tuşuna basınız. 

2.　Açılan menüde, [List Editor]'ü vurgulayın ve ardından        tuşuna basınız.
•　Bu, Liste Düzenleyicisi'ni görüntüler.

3.　Listelerden herhangi birine (Liste 1'den Liste 26'ya) veri değerleri girin.
•　Giriş işlemi hakkında bilgi için, "Liste Düzenleyicisi'nde Veri Girme" (sayfa 30) bölümüne bakın..

4.　Veri girişini tamamladıktan sonra,       basınız. 

5.　       tuşuna basınız.

6.　Açılan menüde, [Select List]'i vurgulayın ve ardından        tuşuna basınız.

7.　Açılan iletişim kutusunu kullanarak bir liste numarası girin ve ardından        tuşuna basınız..

Sonuçlar Sekmesini Kullanma
Veri değerlerini değiştirme ve olasılık değerlerini yeniden hesaplama (Yalnızca [Data] > [Variable] 
seçildiğinde.) 
x, Lower veya Upper değerini vurgulayın ve ardından sayı tuşlarını kullanın veya değeri değiştirmek için        > 
[Edit/View Value]'yu seçin. 

P (X ≤ x  ) = p
P ( Düşük  ≤ X ≤ Yüksek ) = p
P (X ≥ x  ) = p
P (X = x  ) = p*

*　Yalnızca kesikli dağılım

Olasılık değerini değiştirme ve ters veri değerlerini hesaplama (Yalnızca [Data] > [Variable] 
seçildiğinde.)
p değerini vurgulayın ve ardından sayı tuşlarını kullanın veya değeri değiştirmek için      > [Edit/View 
Value]'yu seçin. 

P (X ≤ x) = Lp
P (Düşük ≤ X ≤ Yüksek) = p *

P (X ≥ x) = p
*　Yalnızca normal dağılım

Not
•　Kesikli dağılım için [Kuyruk] >   ile ters işlem gerçekleştirilemez.

Kuyruk ayarını değiştirme
     > [Tail]'i seçtiğinizde açılan menüden istediğiniz seçeneği belirleyin. Mevcut seçenekler hakkında bilgi 
için, "İşlem Akışı" (sayfa 53) bölümündeki 3. adıma bakın. .

Diğer İşlemler
Bunu yapmak için: Bu menü öğesini seçin:
Grafik penceresinin görüntüleme aralığı için ayarlanan değeri 
kontrol etme (Veri: Yalnızca Değişken seçildiğinde.) T  > [View Window] *1

Arka plan görüntüsünü ayarlama (Veri: Yalnızca Değişken 
seçildiğinde.) T  > [Fade I/O] *2

55



Tüm p-değerlerini belirtilen liste değişkenine kaydetme 
(Yalnızca Veri: Liste seçildiğinde.) T  > [Save Probabilities in List]

*1　       > [View Window]'u seçtiğinizde açılan menüyü yalnızca ayar değerlerini kontrol etmek için 
kullanabilirsiniz. Değerleri değiştirirseniz, değişiklikler grafik penceresine yansımaz. 

*2　Detaylar için, "Grafik Penceresi Arka Plan Görüntüsünü Ayarlama (Fade I/O)" (sayfa 81) bölümüne bakın.

 Hassasiyet ve Giriş Aralıkları

•　Aşağıdaki koşullarda, hesaplamaların                                                        olarak gerçekleştirildiğini unutmayın.
-　Kesikli dağılımlarda, seçildiğinde
-　Sürekli dağılımlarda, veya seçildiğinde

•　Kesikli bir dağılımın ters hesaplama sonucu bir tam sayıdır. Girdiğiniz kümülatif olasılık p 10 veya daha fazla 
basamaklıysa hassasiyet azalır.

•　Aşağıdaki koşullar bir hata (Etki Alanı Dışı) meydana getirir.
-　Binom dağılımı: Numtrial için 100.000 veya daha büyük bir değer girdiğinizde 
-　Binom dağılımı: p için 0 < p ≤ 0.00001 veya 0.99999 ≤ p < 1 aralığında bir değer girdiğinizde 
-　Normal dağılım: μ için 1× 10 veya daha büyük ya da 1× 10 veya daha küçük bir değer girdiğinizde

10 −10

-　Normal dağılım: σ için 1×10 veya daha büyük bir değer girdiğinizde
10

-　Poisson dağılımı: λ için 1.000 veya daha büyük bir değer girdiğinizde
-　Geometrik dağılım: p için 0.00001 veya daha küçük bir değer girdiğinizde veya p, 0.99999 ≤ p < 1 

aralığındayken
-　Hipergeometrik dağılım: n için 201 veya daha büyük bir değer girdiğinizde
-　Hipergeometrik dağılım: M veya N için 100.000 veya daha büyük bir değer girdiğinizde
-　χ2 dağılımı: df için 1×10 veya daha büyük bir değer girdiğinizde

16

-　Fdağılımı: n:df veya d:df için 2.000.001 veya daha büyük bir değer girdiğinizde
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Elektronik Tablo Uygulaması
Elektronik Tablo uygulamasını, hücrelere değerler ve formüller girmek, ve elektronik tablo hesaplamaları 
yapmak için kullanabilirsiniz. Hücrelere istatistiksel veriler de girebilir, istatistiksel hesaplamalar yapabilir ve 
istatistiksel grafikler çizebilirsiniz.

Not
•　Elektronik Tablo uygulaması tarafından desteklenen maksimum dosya boyutu yaklaşık 30 KB'dir. 

Bu uygulamadaki elektronik tablo 999 satır ve 26 sütuna sahiptir, ancak dosya boyutu kısıtlamaları 
nedeniyle tüm hücrelere veri girmek mümkün olmayabilir. Maksimum dosya boyutu ayrıca elektronik 
tabloya girilen verinin türüne, biçimlendirmesine ve ana bellekteki mevcut alana bağlıdır. 

•　Elektronik Tablo uygulaması karmaşık sayı girişini desteklemez.

Elektronik Tablo Sekmesini Kullanma
       > Spreadsheet’i seçerek uygulamayı başlatmak, önce Elektronik Tablo sekmesinin görünmesini sağlar. 
Aşağıdaki tablo, bu sekmenin her bir bölümünün adını ve işlevini açıklamaktadır.

 

① Dosya adı Bu, şu anda açık olan dosyanın adıdır. "SHEET" Elektronik Tablo 
uygulamasının başlangıçtaki varsayılan dosyasıdır, uygulamayı ilk kez 
başlattığınızda otomatik olarak bir "SHEET" dosyası oluşturulur.

② Sütun harfi (A'dan Z'ye)      Bu harfler ve sayılar, mevcut imleç konumunu belirtir. Örneğin, "B2" B
sütununun ikinci satırını gösterir. Şu anda seçili olan hücrenin satır 
numarası ve sütun harfi, mavi bir arka plan üzerinde beyaz renkte 
görüntülenir.

③ Satır numarası (1'den 
999'a)

④ İmleç Şu anda seçili olan hücre, kalın bir çerçeve ile belirtilir. Birden fazla hücre 
seçildiğinde, seçilen tüm hücreler kalın bir çerçeve içine alınır.

⑤ Düzenleme kutusu Tek bir hücre seçildiğinde, düzenleme kutusu seçili hücrenin içeriğini 
gösterir. Birden fazla hücre seçildiğinde, düzenleme kutusu seçili hücre 
aralığını gösterir.

Hücreleri Seçme
Bir hücre üzerinde herhangi bir işlem yapmadan önce, onu seçmeniz gerekir. Tek bir hücreyi, bir hücre 
aralığını, bir satırdaki veya sütundaki tüm hücreleri ya da elektronik tablodaki tüm hücreleri seçebilirsiniz.

Bunu seçmek için: Bunu yapın:
Tek bir hücre İmleci istediğiniz hücreye taşımak için imleç tuşlarını kullanın veya 

doğrudan hücreye atlamak için Atla komutunu (sayfa 58) kullanın.

Bir hücre aralığı 1.　İmleci, seçmek istediğiniz hücre aralığının başlangıç noktasına getirin. 
•　İsterseniz başlangıç noktası olarak tüm bir satırı veya sütunu 

seçebilirsiniz.
2.　s0($)          tuşuna basınız.*

•　Bu, imleci normal kalın çerçevenin yerine çift çerçeve sınırına 
dönüştürür.
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3.　İmleci, seçmek istediğiniz hücre aralığının bitiş noktasına taşımak için 
imleç tuşlarını kullanın.
•　Düzenleme kutusu, seçili hücre aralığını gösterir.
•　Hücre seçimini iptal etmek için       basınız. 

Tüm bir satır hücre İmleci, hücrelerini seçmek istediğiniz satırın A sütununa getirin ve ardından

Tüm bir sütun hücre                    İmleci, hücrelerini seçmek istediğiniz sütunun 1. satırına getirin ve 
                                                    ardından       basınız. Bu, imlecin sütun başlığına gitmesini ve tüm sütunu 
                                                    seçmesini sağlar.

Elektronik tablodaki tüm 
hücreler

Tüm A sütunu seçiliyken l'ye veya tüm 1. satır seçiliyken u'   basınız.

*　Bir hücrenin içeriğini düzenleme kutusu ile düzenlerken                    tuşuna basmak, düzenleme kutusundaki 
karakterleri kopyalama veya kesme için bir aralık belirleme işlemi gerçekleştirecektir. Daha fazla bilgi için, 
"İfadeleri Kopyalama, Kesme ve Yapıştırma" (sayfa 10) bölümüne bakın.

İmleci taşımak için Atla komutunu kullanma
İmleci bu hücreye taşımak 
için:

Bunu yapın:

Belirli bir hücre 1.　T    > [Edit] > [Jump] > [Go]'yu seçin. 
2.　Açılan iletişim kutusuna, atlamak istediğiniz hücrenin adını (A1'den 

Z999'a) girin.
3.　O   tuşuna basınız.

Mevcut sütunun en üst satırı T   > [Edit] > [Jump] > [Move to the Top Row]'u seçin.
Mevcut satırın A sütunu T   > [Edit] > [Jump] > [Move to the First Column]'u seçin.
Mevcut sütunun en alt satırı T   > [Edit] > [Jump] > [Move to the Bottom Row]'u seçin. 
Mevcut satırın Z sütunu T   > [Edit] > [Jump] > [Move to the Last Column]'u seçin.

Bir Hücreye Veri Girme
Bir hücreye aşağıda açıklanan veri türlerini girebilirsiniz.
Sabitler:  Bir sabit, girişini tamamladığınız anda değeri sabitlenen bir şeydir. Bir sabit, önünde bir eşit 

işareti (=) bulunmayan bir sayısal değer veya bir hesaplama formülü (7+3, sin(30), A1 × 2 gibi) 
olabilir. Girdiğiniz bir sabit, hücrenin sağına hizalanır.

      Formül: Eşit işareti (=) ile başlayan, örneğin =A1 × 2 gibi bir formül, yazıldığı gibi yürütülür. Girdiğiniz 
                          bir formülün sonucu, hücrenin sağına hizalanır.

Metin: Bir tırnak işareti (") ile başlayan bir karakter dizisi metin olarak ele alınır. Girdiğiniz metin, 
                       hücrenin soluna hizalanır. Ayrıca, bir hücre metin içerdiğinde sol tarafında kalın bir dikey 
                       çizgi görüntülenir. Örneğin, bir hücre "B" metnini içeriyorsa, içeriği bir kalın dikey çizgi ve 
                       ardından               olarak görüntülenir. 
Örnek: A1, A2, A3 hücrelerine A, B, C metinlerini, B1, B2, B3 hücrelerine 10, 10+10, 10 × 3 sabitlerini ve C1, 

C2, C3 hücrelerine soldaki hücredeki değerin ikiye katlanmasını belirten formülleri girin.

Hücre içeriği Giriş sonrası ekran görüntüsü
 

1.　h  > Spreadsheet
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      basınız. Bu, imlecin satır başlığına gitmesini ve tüm satırı seçmesini 
sağlar.



Pk (”)PX (A)E
Pk (”)Pe (B)E
Pk (”)Pj (C)E

Ur  (B1 hücresine taşır.)
10E

10+ 10E
10/ 3E

•　Bu, hesaplama sonuçlarının B2 ve B3 hücrelerinde görünmesini sağlar.

Ur  (C1 hüresine taşır.)
s( (=)Pe (B)1/ 2E

•　Formülü olduğu gibi C1 hücresine girin. Bu, hesaplamanın sayısal sonucunun hücrede görünmesini sağlar.

U  (C1 hücresine taşır)
T  > [Copy & Paste] (C1 hücresindeki formülü kopyalar.)

dO  (C2 hücresine yapıştırır.)
O  (C3 hücresine yapıştırır.)

b  (Kopyalama işlemini iptal eder.)

•　Kopyalama ve yapıştırma işlemleri hakkında detaylar için, "Hücre İçeriğini Kopyalama veya Kesme ve 
Başka Bir Konuma Yapıştırma" (sayfa 61) bölümüne bakın.

Not
•
　
Yukarıdaki 2'den 4'e kadar olan adımlarda      veya 5. adımda      basmak, imlecin bir sonraki alt 
hücreye inmesine neden olur. İsterseniz imlecin bir sonraki sağ hücreye hareket etmesini sağlayacak 
bir ayar yapılandırabilirsiniz. Detaylar için, "Elektronik Tablo Uygulaması Ayarlar Menü Öğeleri" 
(sayfa 74) altındaki S   > [Cursor Moves]'a bakın. 

•　Bir sabiti veya bir formülün parçasını metin yerine A'dan Z'ye bir harf veya r ya da θ karakterleri olarak 
girerseniz, bunlar alfa değişkeni olarak işlem görür. Örneğin, bir hücreye                     girerseniz, A 
harfi bir sabit olarak ele alınır ve hücrede A değişkeninde saklanan değer görünür.

Bir hücre aralığını aynı formülle doldurma (Doldur)
Belirtilen bir hücre aralığına aynı formülü girmek istediğinizde Doldur komutunu kullanın. Göreceli ve mutlak 
hücre adı referanslarını yöneten kurallar, kopyala ve yapıştır işlemleriyle aynıdır. Örneğin, B1, B2 ve B3 
hücrelerine aynı formülü girmeniz gerektiğinde, Doldur komutu size bu formülü B1 hücresine bir kez girerek 
bunu yapma imkanı tanır.

Örnek: B1:B3 hücre aralığına, soldaki hücredeki değerin ikiye katlanmasını sağlayan bir formül girmek için:

•　Bu, Elektronik Tablo sekmesini görüntüler. 

2.　Metni A1, A2, A3 hücrelerine girin.

3.　Sabitleri B1, B2, B3 hücrelerine girin.

4.　Formülü C1 hücresine girin.

5.　Formülü C1 hücresinden kopyalayın ve ardından C2 ve C3 hücrelerine 
yapıştırın.
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1.　Aynı formülü girmek istediğiniz hücre aralığını seçin.
•　Bu adımı atlayabilir ve aşağıdaki 2. adımdan başlayabilirsiniz.

2.　     > [Fill]'i seçin.
•　Bu, Doldur ekranını görüntüler. 

3.　Formül satırını vurgulayın ve ardından istediğiniz formülü (burada =A1×2) seçilen aralığın en üstündeki 
hücreye (burada B1) girin. 

s( (=)PX (A)1/ 2E

4.　1. adımda bir hücre aralığı seçmediyseniz, hücre aralığını burada belirtin.
(1)　 Hücre Aralığı'nı vurgulayın.
(2)　 Pe (B)1s` (:)Pe (B)3E

5.　Seçin                 ve ardından       tuşuna basınız.
•　Bu, formülü belirttiğiniz hücre aralığına girer.

Bir sütunu sayısal bir diziyle doldurma (Sıra)

Örnek: "X +1" fonksiyon ifadesindeki X değişkenine 2'den 10'a kadar 2'şerli artışlarla değerler atandığında 
üretilen sayı dizisini, B1 hücresinden başlayarak B sütununa girmek için:

2

1.　Sayısal dizinin girişinin başlamasını istediğiniz hücreyi seçin.
•　Bu adımı atlayabilir ve aşağıdaki 2. adımdan başlayabilirsiniz.

2.　     > [Sequence]'i seçin.

3.　Sıra işlemini aşağıda açıklandığı gibi yapılandırın. 

Parametre Açıklama
Expression (İfade) Sayı dizisini oluşturan fonksiyon ifadesini girin.
Variable (Değişken) İfade'ye girilen fonksiyon ifadesinde kullanılan değişken adını belirtin.

.
Start/End (Başlangıç/Bitiş) Değişken ile belirtilen değişkene atanan başlangıç/bitiş değerini belirtin. 

.
Increment (Artış) Her adımda değişken değerine eklenmesi gereken değeri belirtin.

1st Cell (1.Hücre) Fonksiyon ifadesinin sonuçlarının eklenmeye başlanacağı başlangıç 
hücresini belirtin.

 

Xi+ 1E
XE 2E 10E 2E

Pe (B)1E

•　Sıra ekranını görüntüler. 
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•　Bir sonraki adımı gerçekleştirmek, sayı dizisini belirtilen hücreden başlayarak otomatik olarak girer. Sayı 
dizisi değerlerinin girileceği hücre aralığında zaten veri içeren herhangi bir hücre varsa, mevcut veriler 
sayı dizisi değerleriyle değiştirilir.

Hücre İçeriğini Kopyalama veya Kesme ve Başka Bir Konuma Yapıştırma
Bir veya birden fazla hücrenin içeriğini kopyalamak veya kesmek ve ardından bunları başka bir hücreye veya 
hücrelere yapıştırmak için aşağıdaki prosedürleri kullanın.
Hücre referansları içeren hücre içeriğini kopyaladığınızda veya kestiğinizde ve bunları başka bir konuma 
yapıştırdığınızda ne olduğu hakkında bilgi için, "Göreceli Hücre Referansı" (sayfa 62) ve "Mutlak Hücre Referansı" 
(sayfa 62) bölümlerine bakın.

 

Tek bir hücrenin içeriğini kopyalama ve başka bir hücreye yapıştırma
1.　İçeriğini kopyalamak istediğiniz hücreyi seçin..

2.　     > [Copy & Paste]'i seçin.
•　Bu, durum çubuğunda "[OK]: Yapıştır"ın görünmesini sağlar. Bu mesaj görüntülenirken yapıştırmaya 

devam edebilirsiniz.

3.　İmleci, içeriği yapıştırmak istediğiniz hücreye taşıyın.

4.　       tuşuna basınız.
•　Kopyaladığınız hücrenin içeriği yapıştırılır ve imleç bir sonraki hücreye aşağı doğru* hareket eder.

5.　Aynı içeriği başka bir hücreye yapıştırmak isterseniz, 3. ve 4. adımları tekrarlayın.
•　İmlecin taşındığı hücreye yapıştırmaya devam etmek isterseniz, sadece 4. adımdaki işlemi tekrarlayın.

6.　Yapıştırma işlemini sonlandırmak için       basınız. 
*　Varsayılan ayar. Hücre hareketinin yönü,        > [Cursor Moves] (sayfa 74)  ayarına göredir.

Bir hücre aralığının içeriğini kopyalama ve elektronik tablonun başka bir yerine yapıştırma
1.　İçeriğini kopyalamak istediğiniz hücre aralığını seçin.

2.　     > [Copy & Paste]'i seçin.
•　Bu, durum çubuğunda "[OK]: Yapıştır"ın görünmesini sağlar. Bu mesaj görüntülenirken 

yapıştırmaya devam edebilirsiniz.

3.　İmleci, yapıştırma hedefi hücre aralığının sol üst köşesi olan hücreye taşıyın.

4.　       tuşuna basınız.
•　Bu, kopyaladığınız hücre aralığının içeriğini yapıştırır.

5.　Aynı içeriği başka bir yere yapıştırmak isterseniz, 3. ve 4. adımları tekrarlayın.

6.　Yapıştırma işlemini sonlandırmak için       basınız.

Tek bir hücrenin içeriğini kesme ve başka bir hücreye yapıştırma
1.　İçeriğini kesmek istediğiniz hücreyi seçin.

2.　T   > [Copy & Paste]'i seçin.
•　Bu, durum çubuğunda "[OK]: Yapıştır"ın görünmesini sağlar.

3.　İmleci, yapıştırmak istediğiniz hücreye taşıyın ve ardından       tuşuna basınız.

4.　Tüm ayarları istediğiniz şekilde yaptıktan sonra, seçin                ve 
ardından       tuşuna basınız.
•　Bu, tüm gerekli hesaplamaları ayarlarınıza göre yapar ve sonuçları 

elektronik tabloya ekler.
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•　Kestiğiniz içeriği yapıştırır. Aynı zamanda, içerik, kesme işlemini gerçekleştirdiğiniz hücreden silinir.

Bir hücre aralığının içeriğini kesme ve elektronik tablonun başka bir yerine yapıştırma
1.　İçeriğini kesmek istediğiniz hücre aralığını seçin.

2.　     > [Cut & Paste]'i seçin.
•　Bu, durum çubuğunda "[OK]: Yapıştır"ın görünmesini sağlar.

3.　İmleci, yapıştırma hedefi hücre aralığının sol üst köşesi olan hücreye taşıyın.

4.　     tuşuna basınız.
•　Bu, kestiğiniz hücre aralığının içeriğini yapıştırır. Aynı zamanda, içerik, kesme işlemini gerçekleştirdiğiniz 

hücreden silinir.

Not
•　S   > [Auto Recalculation] (sayfa 68)  kapalı olsa bile, hücre içeriğini kesme ve yapıştırma işlemi, 

yalnızca yapıştırılan hücredeki/hücrelerdeki formüllerin yeniden hesaplanmasına neden olur.

Bir Hücre Referansı Girme
Bir hücre referansı, başka bir hücre tarafından kullanılmak üzere bir hücrenin değerine atıfta bulunan bir 
semboldür. Örneğin, C2 hücresine = A1 + B1 girerseniz, elektronik tablo A1 hücresinin mevcut değerini B1 
hücresinin mevcut değerine ekler ve sonucu C2 hücresinde görüntüler.
İki tür hücre referansı vardır: göreceli ve mutlak.

Göreceli Hücre Referansı
Bir göreceli hücre referansı, elektronik tablodaki konumuna göre değişir. Örneğin, C2 hücresindeki = A1 
hücre referansı, mevcut hücreden (bu durumda C2) "iki sütun sola ve bir hücre yukarı" konumda bulunan 
hücreye bir referanstır. Bu nedenle, C2 hücresinin içeriğini kopyalayıp D12 hücresine yapıştırırsak, hücre 
referansı otomatik olarak = B11'e dönüşür, çünkü B11, D12 hücresinin iki sütun solunda ve bir hücre 
yukarısındadır. Göreceli hücre referanslarının, kopyala ve yapıştır kullanarak taşıdığınızda her zaman 
bu şekilde dinamik olarak değiştiğini unutmayın.

Mutlak Hücre Referansı
Bir mutlak hücre referansı, nerede bulunduğu veya nereye kopyalandığı ya da taşındığına bakılmaksızın 
değişmez. Aşağıda açıklandığı gibi, bir hücre referansının hem satırını hem de sütununu mutlak yapabilir 
veya yalnızca satırını veya yalnızca sütununu mutlak yapabilirsiniz.

Bu hücre referansı: Bunu yapar:
$A$1 Her zaman A sütunu, 1. satıra atıfta bulunur.
$A1 Her zaman A sütununa atıfta bulunur, ancak bir göreceli hücre 

referansında olduğu gibi taşındığında satır dinamik olarak değişir.

A$1 Her zaman 1. satıra atıfta bulunur, ancak bir göreceli hücre referansında 
olduğu gibi taşındığında sütun dinamik olarak değişir.

Diyelim ki, C1 hücresinde A1 hücresine bir referans var. Aşağıdaki tablo, C1 hücresinin içeriği D12 hücresine 
kopyalandığında yukarıdaki hücre referanslarının her birinin neye dönüşeceğini gösterir.

$A$1 → $A$1 $A1 → $A12 A$1 → B$1

Not
•　Bir kopyala ve yapıştır işleminin sonucu, bir göreceli hücre referansı adının elektronik tablo hücrelerinin 

aralığı dışındaki bir şeye dönüşmesine neden olursa, ilgili sütun harfi ve/veya satır numarası bir soru 
işareti (?) ile değiştirilir ve hücrenin verisi olarak "ERROR" görüntülenir.

Doğrudan giriş kullanarak bir hücre referansı adı girme
Örneğin, = A1+5'i B1 hücresine girmek için, imleci B1 hücresine taşıyın ve aşağıdaki işlemi gerçekleştirin.
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s( (=)PX (A)1+ 5E

Mutlak hücre referansı adı sembolünü ($) girme
C    > [Elektronik Tablo] > [$]'ı seçin.

GRAB komutunu kullanarak bir hücre referansı adı girme
Örneğin, = A1+5'i B1 hücresine girmek için, imleci B1 hücresine taşıyın ve aşağıdaki işlemi gerçekleştirin.
s((=)T                  > **[Grab]**l        (A1 hücresini seçer.) O+5E

Not
•　T   > [Grab]'ı seçmek, durum çubuğunda "[OK]: Bu hücrenin referansını gir"in görünmesini 

sağlar. Bu mesaj görüntülenirken, hücreler arasında gezinmek için imleç tuşlarına ek olarak Atla 
komutunu da kullanabilirsiniz. Atla komutunu kullanmak için, "[OK]: Bu hücrenin referansını gir" 
görüntülenirken T'  basınız. Detaylar için, "İmleci taşımak için Atla komutunu kullanma" (sayfa 58) 
bölümüne bakın. 

 

Özel Elektronik Tablo Uygulaması Komutlarını Kullanma
Elektronik Tablo uygulamasının, bir hücre aralığının toplamını döndüren CellSum() ve dallanma koşullarını 
belirten CellIf(,,) gibi çeşitli özel komutları vardır. Bu özel komutlar formüllerin içinde kullanılabilir.
Bu komutları girmek için C   > [Spreadsheet]'i kullanın. Aşağıda açıklanan komutlar bu menüye dahildir.  

CellIf(,,)
Dallanma koşulu olarak sağlanan eşitlik veya eşitsizlik doğru olduğunda İfade 1'i, yanlış olduğunda ise İfade 
2'yi döndürür.
Sözdizimi: CellIf(eşitlik,ifade 1,ifade 2) veya

     CellIf(eşitsizlik,ifade 1,ifade 2)
Örnek: =CellIf(A1>B1,A1,B1)

{Hücre A1 değeri} > {Hücre B1 değeri} olduğunda A1'in değerini döndürür. Aksi takdirde, B1'in 
değerini döndürür.

CellMin()
Belirtilen bir hücre aralığındaki en küçük değeri döndürür.
Sözdizimi: CellMin(başlangıç hücresi:bitiş hücresi)
Örnek: =CellMin(A3:C5)

A3:C5 hücre aralığındaki verinin en küçük değerini döndürür.

CellMax()
Belirtilen bir hücre aralığındaki en büyük değeri döndürür.
Sözdizimi: CellMax(start cell:end cell)
Örnek: =CellMax(A3:C5)

A3:C5 hücre aralığındaki verinin en büyük değerini döndürür.

CellMean()
Belirtilen bir hücre aralığındaki ortalama değeri döndürür.
Sözdizimi: CellMean(başlangıç hücresi:bitiş hücresi)
Örnek: =CellMean(A3:C5)

A3:C5 hücre aralığındaki verinin ortalama değerini döndürür.

CellMedian()
Belirtilen bir hücre aralığındaki medyan değeri döndürür.
Sözdizimi: CellMedian(başlangıç hücresi:bitiş hücresi)
Örnek: =CellMedian(A3:C5)

A3:C5 hücre aralığındaki verinin medyan değerini döndürür.

CellSum()
Belirtilen bir hücre aralığındaki verinin toplamını döndürür.
Sözdizimi: CellSum(başlangıç hücresi:bitiş hücresi)
Örnek: =CellSum(A3:C5)

A3:C5 hücre aralığındaki verinin toplamını döndürür.
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CellProd()
Belirtilen bir hücre aralığındaki verinin çarpımını döndürür.
Sözdizimi: CellProd(başlangıç hücresi:bitiş hücresi)
Örnek: =CellProd(A3:C5)

A3:C5 hücre aralığındaki verinin çarpımını döndürür.
 

1.　İmleci A4 hücresine taşıyın ve metin olarak "SUM"ı girin. 

Pk (”)P/ (S)P1 (U)P7 (M)E

2.　İmleci B4 hücresine taşıyın ve B1:B3'ün toplamını hesaplamak için formülü girin.
•　B1:B3'ün toplamını hesaplamak istediğimiz için, CellSum() komutunu kullanırız ve =CellSum(B1:B3) gireriz.

s( (=)
C > [Spreadsheet] > [CellSum()]

Pe (B)1s` (:)Pe (B)3
E

3.　İmleci C4 hücresine taşıyın ve C1:C3'ün toplamını hesaplamak için formülü girin.

s( (=)

Pj (C)1s` (:)Pj (C)3
E

Hücre İçeriğini Düzenleme
Aşağıdaki tabloda açıklanan düzenleme işlemlerini, tek tek hücrelerin yanı sıra satırlar, sütunlar ve tüm 
elektronik tablo üzerinde gerçekleştirebilirsiniz.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Tek bir hücrenin içeriğini 
düzenleme

1.　İçeriğini düzenlemek istediğiniz hücreyi seçin ve ardından      > 
[Edit] > [Cell]'i seçin.
•　Bu, hücre içeriğinin ve imlecin düzenleme kutusunda sola hizalı 

olarak görünmesini sağlar.
2.　İmleci istediğiniz konuma taşımak için      /      kullanın ve içeriği 

gerektiği gibi düzenleyin.
3.　Düzenlemeyi bitirdikten sonra, O   tuşuna basınız. 

Tek bir satır veya tek bir sütun 
aralığındaki verileri artan 
veya azalan sırada sıralama

1.　Verilerini sıralamak istediğiniz hücre aralığını seçin.
2.　Aşağıdaki menü öğelerinden birini seçin.

Artan sırada sıralamak için:
T > [Edit] > [Sort Ascending]

Azalan sırada sıralamak için:
T > [Edit] > [Sort Descending]

Bir satır veya sütunu silme*1 1.　İmleci, silmek istediğiniz satırın veya sütunun içindeki bir hücreye 
taşıyın.

Örnek: "Bir Hücreye Veri Girme" (sayfa 58) bölümündeki örnek 
sırasında B1:B3 ve C1:C3 hücrelerindeki değerlerin toplamını 
sırasıyla B4 ve C4 hücrelerine hesaplamak için formülü girme

64

C > [Spreadsheet] > [CellSum()]



•　İsterseniz birden fazla satır veya birden fazla sütun seçebilirsiniz. 
Seçtiğiniz satır(lar) veya sütun(lar) silinecektir.

2.　Aşağıdaki menü öğelerinden birini seçin.
Satır(ları) silmek için:

T  > [Delete] > [Row]
Sütun(ları) silmek için:

T  > [Delete] > [Column]

Bir satır veya sütun ekleme *2 1.　İmleci, satır eklemek istediğiniz satırdaki veya sütun eklemek istediğiniz 
sütundaki bir hücreye taşıyın.
•　İsterseniz birden fazla satır veya birden fazla sütun seçebilirsiniz. 

Seçtiğiniz konuma satır veya sütun eklenecektir.
2.　Aşağıdaki menü öğelerinden birini seçin.

Satır(ları) eklemek için: 
T  > [Insert] > [Row]

Sütun(ları) eklemek için:
T  > [Insert] > [Column]

Bir elektronik tablodaki tüm 
hücrelerin içeriğini silme

1.　a'ya basın veya T    > [Delete] > [All] seçin.
2.　Görüntülenen onay iletişim kutusunda, [OK]'u seçin.

Seçili hücrelerin içeriğini 
temizleme

1.　İçeriğini temizlemek istediğiniz hücre aralığını seçin.
2.　Aşağıdaki menü öğelerinden birini seçin.

Bunu yapmak için: Bu menü öğesini seçin:
Yalnızca içeriği temizle T  > [Clear] > [Content]
Yalnızca biçimlendirmeyi temizle T  > [Clear] > [Format]
Tüm içeriği ve biçimlendirmeyi temizle T  > [Clear] > [All]

*1　Bu işlem aşağıdaki adımlar kullanılarak da gerçekleştirilebilir.
(1)　
(2)　 T   > [Delete]'i seçin.

*2　Bu işlem aşağıdaki adımlar kullanılarak da gerçekleştirilebilir.
(1)　 İmleci, satır veya sütun eklemek istediğiniz satırın veya sütunun başlığına taşıyın.
(2)

Not
•　Bir ekleme işlemi, veri içeren mevcut hücrelerin A1:Z999 aralığının dışına çıkmasına neden olursa 

bir Aralık HATASI meydana gelir. 

Elektronik Tablo Dosya İşlemleri
Elektronik Tablo uygulaması ile, aşağıdaki tabloda açıklanan dosya işlemlerini kullanabilirsiniz.

Bunu yapmak için: Select this menu item:
Şu anda açık olan dosyayı kapat ve yeni bir dosya oluştur. T  > [File] > [New] *1

Şu anda açık olan dosyayı kapat ve başka bir dosya aç T  > [File] > [Open]
Şu anda açık olan dosyayı farklı bir adla kaydet T  > [File] > [Save As]
Bir dosyayı sil T  > [File] > [Delete] *2

*1　Görüntülenen iletişim kutusuna mevcut bir dosyanın adını girmek, yeni bir dosya oluşturmadan mevcut 
dosyayı açar.

*2　Şu anda açık olan ve "SHEET" olmayan bir dosyayı silmek, "SHEET" adlı dosyayı açar. Şu anda açık 
olan "SHEET" dosyasını silmek ise otomatik olarak yeni bir "SHEET" dosyası oluşturur.
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Bir Elektronik Tablo ve CSV Dosyaları Arasında Veri Aktarma
Hesap makinesi belleğinde depolanan veya bir bilgisayardan aktarılan bir CSV dosyasının içeriğini bir elektronik 
tabloya aktarabilirsiniz. Ayrıca, bir elektronik tablonun içeriğini bir CSV dosyası olarak kaydedebilirsiniz. Bir 
elektronik tablo ve CSV dosyaları arasında veri aktarma prosedürü hakkında bilgi için, "CSV Dosyalarını 
Kullanma" (sayfa 244) bölümüne bakın.
Her Bir Hücrenin Metin Rengini ve Dolgu Rengini Belirtme
Her bir hücre için, metin rengini, dolgu rengini ve dolgu rengi yoğunluğunu (Normal veya Daha Açık) 
belirtebilirsiniz.
Her bir hücrenin metin rengini ve dolgu rengini belirtmek için
1.　Metin ve dolgu rengini belirtmek istediğiniz hücre aralığını seçin.

2.　T   > [Color]'u seçin. 

3.　Yukarıdaki iletişim kutusunu aşağıdaki ayarlarla yapılandırın.

Bunu belirtmek için: Bu işlemi gerçekleştirin:
Metin rengini belirtme [Char Color]'u seçin. Görüntülenen menüde, 

istediğiniz rengi seçin.

Hücre rengini belirtme [Area Colur]'u seçin. Görüntülenen menüde, 
istediğiniz rengi seçin.

Hücre renginin yoğunluğunu belirtme [Paint Style]'ı seçin. Görüntülenen menüde, 
[Normal] veya [Lighter]'ı (Daha Açık) seçin.

4.　Yapılandırdığınız ayarları uygulamak için,       basınız. 

Değişkenlere Veri Kaydetme/Değişkenlerden Veri Geri Çağırma
Elektronik tablo verileri değişkenlere kaydedilebilir ve değişkenlerde saklanan veriler bir elektronik tabloya 
geri çağrılabilir. Kaydedilebilecek veya geri çağrılabilecek değişkenler aşağıda açıklanmıştır.
•　Yalnızca kaydetme: alfa değişkenleri
•　Kaydetme ve geri çağırma: vektör değişkenleri, matris değişkenleri, liste değişkenleri, liste dosyaları*

*　 Bir liste dosyası 26 liste değişkenine eşdeğerdir. Detaylar için, "Liste Dosyaları" (sayfa 32) bölümüne 
bakın.

Elektronik tablo verilerini bir değişkene kaydetmek için
1.　Bir değişkene kaydetmek istediğiniz veriyi içeren tek bir hücreyi veya bir hücre aralığını seçin.

•　Kaydedeceğiniz değişken türüne karşılık gelen hücre aralığını aşağıdaki tabloda seçin.

Bu tür bir değişkene kaydetmek için:  Bu aralığı seçin:

Alfa değişkeni Tek hücre
Liste değişkeni veya vektör değişkeni      Tek bir satırda veya tek bir sütunda bir hücre aralığı

Liste dosyası veya matris değişkeni Birden fazla satır ve sütunu kapsayan bir hücre aralığı
•　Bu adımı atlayabilir ve aşağıdaki 2. adımdan başlayabilirsiniz.

2.　T    > [Bellek] > [Depola]'yı seçin.

3.　Görüntülenen menüde, veriyi kaydetmek istediğiniz değişken türünü seçin.

Bu tür bir değişkene kaydetmek için:   Bu menü öğesini seçin:                    Hedef:

Alfa değişkeni [Alpha] A'dan Z'ye, r, veya θ
Liste değişkeni [List] Liste 1'den Liste 26'ya
Liste dosyası [File] Dosya 1'den Dosya 6'ya
Matris değişkeni [Matrix] Mat A'dan Mat Z'ye
Vektör değişkeni [Vector] Vct A'dan Vct Z'ye

4.　Görüntülenen ekranı kullanarak hücre aralığını ve hedef değişkeni belirtin.
•　Bu prosedürün 1. adımında bir hücre aralığı belirttiyseniz, burada tekrar belirtmenize gerek yoktur.
•　Belirtebileceğiniz hedefler için 3. adımdaki tabloda bulunan "Hedef" bölümüne bakın.
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5.　Seçin                ve ardından O   tuşuna basınız.

Not
•　Hücreler bir değişkene kaydedildiğinde metin rengi ve diğer biçimlendirme ayarları dikkate alınmaz.
•　Aşağıda, bir hücre veri içermediğinde, bir hücre metin içerdiğinde veya bir hücrede HATA 

görüntülendiğinde bir değişkene veri kaydetmeye çalışırsanız ne olacağı açıklanmaktadır. 
-　Verileri bir alfa değişkenine atıyorsanız, bir hata oluşur.
-　Verileri bir liste değişkenine, liste dosyasına, matris değişkenine veya vektör değişkenine 

kaydediyorsanız, ilgili hücreye(lere) 0 yazılır.

Bir değişkende depolanan verileri bir elektronik tabloya geri çağırmak için
1.　Değişken verilerini geri çağırmak istediğiniz hücreyi belirtin.

•　Aşağıdaki tabloda gösterildiği gibi, değişkenin türüne göre geri çağırma için bir hücre seçin.

Bu tür bir değişkenden geri 
çağırmak için:

Böyle bir hücre seçin:

Liste değişkeni       > [Cursor Moves] (sayfa 74) için "Aşağı" seçildiğinde: Veriyi 
geri çağırmak istediğiniz aralığın en üstündeki hücreyi seçin. 
Veri, seçilen hücreden başlayarak yukarıdan aşağıya doğru geri 
çağrılır. 
      > [Cursor Moves] için "Sağ" seçildiğinde: Veriyi geri çağırmak 
istediğiniz aralığın en solundaki hücreyi seçin. Veri, seçilen 
hücreden başlayarak soldan sağa doğru geri çağrılır. 

Liste dosyası veya matris değişkeni Veriyi geri çağırmak istediğiniz aralığın sol üst köşesindeki 
hücreyi seçin.

Vektör değişkeni Veriyi geri çağırmak istediğiniz aralığın en solundaki hücreyi (1 
satır ve n sütunlu bir vektör için) veya en üstündeki hücreyi (n satır 
ve 1 sütunlu bir vektör için) seçin.

•　Bu adımı atlayabilir ve aşağıdaki 2. adımdan başlayabilirsiniz.

2.　T     > [Memory] > [Recall]'ı seçin. 

3.　Görüntülenen menüde, verilerini geri çağırmak istediğiniz değişken türünü seçin.

Bu tür bir değişkenden geri 
çağırmak için:

Bu menü öğesini seçin:              Geri çağırma kaynağı:

Liste değişkeni [List] Liste 1'den Liste 26'ya
Liste dosyası [File] Dosya 1'den Dosya 6'ya
Matris değişkeni [Matrix] Mat A'dan Mat Z'ye
Vektör değişkeni [Vector] Vct A'dan Vct Z'ye

4.　Görüntülenen ekranı kullanarak geri çağrılan değişkeni ve hedef hücreyi belirtin.
•　Belirtebileceğiniz değişken türleri hakkında bilgi için 3. adımdaki tabloda bulunan "Geri çağırma kaynağı" 

sütununa bakın. 
•　Bu prosedürün 1. adımında bir hücre seçtiyseniz, burada bir hücre belirtmenize gerek yoktur.

5.　Seçin               ve ardından        tuşuna basınız.

Not
•　Geri çağrılan verinin elektronik tablonun (A1:Z999) aralığına sığmamasına neden olan bir hücre 

belirtirseniz, 5. adımda        tuşuna basmak                 bir hataya neden olur ve geri çağırma işlemi 
gerçekleştirilmez.

•　Geri çağrılan veri, geri çağrıldığı hücrenin varsayılan biçimlendirmesine göre biçimlendirilir.
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Otomatik Yeniden Hesaplama ve Yeniden Hesapla
Elektronik Tablo Uygulamasının ilk varsayılan ayarı (Otomatik Yeniden Hesaplama: Açık) ile, bir dosyayı 
açtığınızda veya Elektronik Tablo uygulamasında bir düzenleme işlemi gerçekleştirdiğinizde bir elektronik
tablodaki tüm formüller otomatik olarak yeniden hesaplanır. Elektronik tablonun içeriğine bağlı olarak, 
otomatik yeniden hesaplama işleminin tamamlanması uzun sürebilir. Otomatik Yeniden Hesaplama devre 
dışı bırakıldığında (Kapalı), gerektiğinde yeniden hesaplamayı manuel olarak yürütmeniz gerekir.

Yeniden hesaplamayı manuel olarak yürütmek için
T     > [Recalculate]'i seçin. 

Not
•
　
Otomatik Yeniden Hesaplama ayarı Açık olsa bile, aşağıdaki durumlarda T   > [Recalculate]'i
yürütmelisiniz. 
-　Ayarlar menüsü açı ayarını değiştirmek için kullanıldığında
-　Bir hücrede bir alfa değişkeni veya bir fonksiyon değişkeni kullanan bir formül bulunduğunda ve ilgili 

değişken güncellendiğinde

İstatistiksel Hesaplamalar ve Grafik Çizimi
Bir elektronik tabloya girilen verileri kullanarak istatistiksel hesaplamalar yapabilir ve istatistiksel grafikler 
çizebilirsiniz.
Veri Girme
İşlenen istatistiksel verilere bağlı olarak, verileri Elektronik Tablo sekmesinin 1, 2 ve 3 numaralı sütunlarına girin.

Frekanssız 2-Değişkenli veri girişi Örnek kurulum (Kurulum sekmesi)
 

Bu istatistiksel veri için: Böyle girin:
1-Değişkenli (frekanssız) Değişken-X verilerini (1VarXCell  ) tek bir sütuna girin.*1

1-Değişkenli (frekanslı) Değişken-X verilerini (1VarXCell  ) ilk sütuna ve frekans verilerini 
(1VarFreq  ) ikinci sütuna girin.

*1

*2

2-Değişkenli (frekanssız) Değişken-X verilerini (2VarXCell  ) ilk sütuna ve değişken-Y 
verilerini (2VarYCell  ) ikinci sütuna girin.*1

*1

2-Değişkenli (frekanslı) Değişken-X verilerini (2VarXCell  ) ilk sütuna, değişken-Y verilerini 
(2VarYCell  ) ikinci sütuna ve frekans verilerini (2VarFreq  ) üçüncü 
sütuna girin.

*1

*1 *2

*1　Elektronik Tablo Uygulaması Kurulum sekmesinde, 1-Değişkenli istatistiksel hesaplama için kullanılan 
verinin hücre aralığını 1VarXCell'e (veya XCellRange), 2-Değişkenli istatistiksel hesaplama için kullanılan 
verinin hücre aralığını ise 2VarXCell, 2VarYCell'e (veya XCellRange, YCellRange) belirtin.

*2　Elektronik Tablo Uygulaması Kurulum sekmesinde, 1-Değişkenli istatistiksel hesaplama için kullanılan 
frekans verisi hücre aralığı 1VarFreq (veya Frequency) olarak görüntülenirken, 2-Değişkenli istatistiksel 
hesaplama için kullanılan frekans verisi hücre aralığı 2VarFreq (veya Frequency) olarak görüntülenir.

Frekanslar
İstatistiksel verileri girmek için iki yol vardır: frekanslı ve frekanssız (tüm veri frekansları için 1 kullanılır). Hangi 
yöntemi kullanmak istediğinizi, Elektronik Tablo sekmesinde >'ya bastığınızda görüntülenen Kurulum sekmesinde, 
aşağıdaki örnekte gösterildiği gibi belirtebilirsiniz.
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A1:A5 hücre aralığını veri olarak kullanma
Tüm veri değerlerinin frekansı: 1

A1:A5 hücre aralığını veri olarak kullanma
B1:B5 hücre aralığını frekans olarak kullanma

Önemli!
•　Frekans verisi olarak kullanılan hücre aralığında yer alan değerler yalnızca 0 veya pozitif değerler 

olmalıdır. Tek bir negatif değer bile bir hataya (Alan Dışı) neden olur. 
•　Frekansı 0 olan istatistiksel veriler, minimum ve maksimum değerlerin hesaplanması için kullanılmaz.

Özet İstatistikleri veya Regresyon Modeli Bilgilerini Görüntüleme
Aşağıdaki prosedürü kullanarak 1-Değişkenli veya 2-Değişkenli istatistiksel verilerden çeşitli özet 
istatistiklerini bulabilir ve görüntüleyebilirsiniz. Bu prosedür, 2-Değişkenli istatistiksel verilere regresyon 
modelleri uygulandığında regresyon denklemi katsayılarını ve belirleme katsayılarını (bu kılavuzda 
"regresyon modeli bilgileri" olarak anılır) görüntülemek için de kullanılabilir.

 

Özet istatistiklerini veya regresyon modeli bilgilerini görüntülemek için
1.　Hesaplamada kullanılacak istatistiksel verileri girin.

•　Detaylar için, "Veri Girme" (sayfa 68) bölümüne bakın.

2.　İstatistiksel hesaplama verilerini girdiğiniz hücre aralığını seçin.
•　Bu adımı atlayabilir ve aşağıdaki 3. adıma geçebilirsiniz.

3.　>'ya basınız.
•　Bu, Tip Seç menüsünün görünmesine neden olursa, bu prosedürün 5. adımına gidin. Aksi takdirde, 4. 

adıma gidin.

6.　Sekmedeki 2. satırı vurgulayın ve ardından O    tuşuna basınız. 

7.　Görüntülenen menüde, yapmak istediğiniz istatistiksel hesaplama türünü seçin.

Bunu yapmak için: Bu menü öğesini seçin:
1-Değişkenli istatistiksel verilere (X) dayalı özet istatistiklerini 
görüntüle

 1-Variable

2-Değişkenli istatistiksel verilere (X, Y) dayalı özet 
istatistiklerini görüntüle

 2-Variable

2-Değişkenli istatistiksel verilere (X, Y) dayalı regresyon 
modeli bilgilerini görüntüle
(Menüden istenen regresyon modelini seçin.)

Linear Regression(a x+b)
Linear Regression(a+bx )
Med-Med Regression
Quadratic Regression
Cubic Regression

4.　Kurulum sekmesinin ilk satırını vurgulayın ve ardından O   tuşuna 
basınız.

5.　[Calculate Summary Statistics]'i seçin.
•　Bu, İstatistikleri Hesapla menüsünün Kurulum sekmesinde 

görünmesine neden olur.
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Quadratic Regression
Logarithm Regression
Exp Regression(a･e^bx)
Exp Regression(a･b^x)
Power Regression
Sinusoidal Regression
Logistic Regression

8.　Hesaplamada kullanılan istatistiksel verileri içeren hücre aralığını gerektiği gibi belirtin.
 
1-Değişkenli istatistiksel veriler için: 
(1)　  [1VarXCell]'i vurgulayın ve ardından O   tuşuna basınız. 
(2)　 Görüntülenen iletişim kutusunu kullanarak X-veri hücrelerinin aralığını girin ve ardından O tuşuna basınız. 
(3)　 [1VarFreq]'i vurgulayın ve ardından O    tuşuna basınız.
(4)　 Frekans verisi kullanmak istemiyorsanız, menüde [1]'i seçin.

Frekans verisi kullanmak istiyorsanız, [Hücre Aralığı]'nı seçin ve ardından 5. adıma geçin.
(5)　 Görüntülenen iletişim kutusunu kullanarak frekans verisi hücrelerinin aralığını girin ve ardından O   tuşuna 

basınız. 
2-Değişkenli istatistiksel veriler için: 
(1)　 [2VarXCell]'i vurgulayın ve ardından O   tuşuna basınız.
(2)　 Görüntülenen iletişim kutusunu kullanarak X-veri hücrelerinin aralığını girin ve ardından O   tuşuna basınız.
(3)　 [2VarYCell]'i vurgulayın ve ardından O   tuşuna basınız.
(4)　 Görüntülenen iletişim kutusunu kullanarak Y-veri hücre aralığını girin ve ardından O   tuşuna basınız.
(5)　 [2VarFreq]'i vurgulayın ve ardından O   tuşuna basınız. 
(6)　 Frekans verisi kullanmak istemiyorsanız, menüde [1]'i seçin.

Frekans verisi kullanmak istiyorsanız, [Hücre Aralığı]'nı seçin ve ardından 7. adıma geçin.
(7)　 Görüntülenen iletişim kutusunu kullanarak frekans verisi hücrelerinin aralığını girin ve ardından O   tuşuna 

basınız.
9.　>'ya basınız. Veya vurgulayın                ve ardından O   tuşuna basınız.

•　Değerlerin anlamı için "Özet İstatistikleri" (sayfa 33) ve "Regresyon Modeli Bilgileri" (sayfa 34) 
bölümlerine bakın.

İstatistik Grafiği Çizme
2-Değişkenli istatistiksel verileri kullanarak saçılım grafikleri ve çeşitli regresyon grafikleri çizebilirsiniz. 
1-Değişkenli istatistiksel veriler ise histogramlar ve kutu-bıyık diyagramları dahil olmak üzere yedi tür grafiği 
çizmek için kullanılabilir. Bir grafik çizdikten sonra, özet istatistiklerini ve regresyon modeli bilgilerini 
görüntüleyebilirsiniz. 
1-Değişkenli İstatistik Grafiği Çizme (Histogram, Kutu-Bıyık Diyagramı, vb.)
Bir elektronik tabloya girdiğiniz 1-Değişkenli istatistiksel verilere dayanarak aşağıdaki işlemleri 
gerçekleştirebilirsiniz.
(1)　 Bir Kutu Grafiği, Histogram, Kırık Çizgi Grafiği, Pasta Grafiği, Çubuk Grafiği, Normal Olasılık Grafiği veya 

Normal Yoğunluk Eğrisi çizin..

(2)　 Grafiği çizdikten sonra özet istatistiklerini görüntüleyin (Pasta Grafiği hariç).
1-Değişkenli bir istatistik grafiği çizmek için
1.　Hesaplamada kullanılacak istatistiksel verileri girin.

•　Detaylar için, "Veri Girme" (sayfa 68) bölümüne bakın. 

•　Seçtiğiniz özet istatistiklerini veya regresyon modeli bilgilerini 
Sonuçlar sekmesinde görüntüler. Pencerenin sağ kenarında bir 
kaydırma çubuğu belirirse, ekranı kaydırmak için       ve       tuşlarını 
kullanın.
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2.　İstatistiksel hesaplama verilerini girdiğiniz hücre aralığını seçin.
•　Bu adımı atlayabilir ve aşağıdaki 3. adıma geçebilirsiniz.

3.　>'ya basınız.
•　Bu, Tip Seç menüsünün görünmesine neden olursa, bu prosedürün 5. adımına gidin. Aksi takdirde, 4. 

adıma gidin.
4.　Kurulum sekmesinin ilk satırını vurgulayın ve ardından O   tuşuna basınız.

5.　Tip Seç menüsünde, [İstatistik Grafiği Çiz]'i seçin.

6.　Çizmek istediğiniz grafik türünü seçin.
(1)　 [Grafik1]'i vurgulayın ve ardından O   tuşuna basınız.

(2)　  O   tuşuna tekrar basınız.
•　Bu, grafik tipini seçmek için bir menü görüntüler.

(3)　 Menüden çizmek istediğiniz grafik tipini vurgulayın ve ardından O   tuşuna basınız. 

7.　Elektronik tabloda istatistiksel veri hücre aralığını belirtin.
 
Kutu Grafiği, Histogram, Kırık Çizgi Grafiği, Normal Olasılık Grafiği veya Normal Yoğunluk Eğrisi için: 
(1)　 [XCellRange]'i vurgulayın ve ardından O   tuşuna basınız.
(2)　 Görüntülenen iletişim kutusunu kullanarak veri hücrelerinin aralığını girin ve ardından O   tuşuna basınız. 
(3)　 [Frequency]'yi vurgulayın ve ardından O   tuşuna basınız. (Normal Olasılık Grafiği hariç)
 
Pasta Grafiği için:
(1)　 [Category]'yi vurgulayın ve ardından O   tuşuna basınız.
(2)　 Görüntülenen iletişim kutusunu kullanarak veri kategori adı hücrelerinin aralığını girin ve ardından O   

tuşuna basınız. 
(3)　 [Data]'yı vurgulayın ve ardından O   tuşuna basınız. 
(4)　 Görüntülenen iletişim kutusunu kullanarak veri hücrelerinin aralığını girin ve ardından O   tuşuna basınız. 
Çubuk Grafiği için:
Bir çubuk grafiği çizmek için en fazla üç veri seti belirtebilirsiniz.
(1)　 [Category]'yi vurgulayın ve ardından O   tuşuna basınız.
(2)　 Görüntülenen iletişim kutusunu kullanarak veri kategori adı hücrelerinin aralığını girin ve ardından O   

tuşuna basınız.
(3)　 [Data1]'i vurgulayın ve ardından O   tuşuna basınız. 
(4)　 Görüntülenen iletişim kutusunu kullanarak veri hücrelerinin aralığını girin ve ardından O   tuşuna basınız. 
(5)　 [Data2] ve [Data3] için yukarıdaki 3. ve 4. adımları tekrarlayın.

•　Data2] ve [Data3]'ü belirtirken, [Data1] verisiyle aynı sayıda satır belirttiğinizden emin olun. Satır 
sayısı farklıysa, bir hata (Boyut HATASI) oluşur.

•　İki veri seti belirtirken, [Data1] ve [Data2] için hücre aralığını belirttiğinizden emin olun. [Data2] "Yok" 
olarak ayarlanmışken [Data1] ve [Data3] için bir hücre aralığı belirtilirse, bir hata (Koşul HATASI) 
oluşur.

8.　Grafik rengini ve diğer ayarları gerektiği gibi belirtin.

•　Bu, İstatistik Grafiği Çiz menüsünün Kurulum sekmesinde 
görünmesine neden olur.

•　Kurulum sekmesi ekranının Grafik1 ayar menüsüne dönüşmesine 
neden olur.
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•　Detaylar için, "Her Bir 1-Değişkenli İstatistik Grafiği Türü İçin Ayar Öğeleri" (sayfa 38) bölümüne bakın.

9.　Grafiği çizmek için, >'ya basınız. Veya vurgulayın                 ve ardından O   tuşuna basınız.
•　Grafik, Grafik sekmesinde görüntülenir. 
•　6-(3). adımda seçtiğiniz grafik bir Histogram veya Kırık Çizgi Grafiği ise, Başlangıç (grafik çizim başlangıç 

noktasının x-koordinatı) ve Genişlik (grafik çizim genişliği) belirtebileceğiniz bir iletişim kutusu görünür. 
Her bir değeri girin, vurgulayın                  ve ardından       tuşuna basınız.

•　Grafik sekmesinde gerçekleştirebileceğiniz işlemler hakkında bilgi için, "Grafik Penceresi İşlemleri" 
(sayfa 41) bölümüne bakın..

10.　Özet istatistiklerini görüntülemek için, >'ya basınız. (Bu işlem bir Pasta Grafiği için kullanılamaz.)
•　Bu, özet istatistiklerinin Sonuçlar sekmesinde görünmesine neden olur. Görüntü içeriğini kaydırmak için 

d    ve u    tuşlarını kullanabilirsiniz.
•　Görüntülenen değerlerin anlamı için "Özet İstatistikleri" (sayfa 33) bölümüne bakın.

2-Değişkenli İstatistik Grafiği Çizme (saçılım grafiği veya regresyon grafiği)
2-Değişkenli istatistiksel verilere dayanarak aşağıdaki işlemleri gerçekleştirebilirsiniz.
(1)　 Bir Saçılım Grafiği, xy Çizgi Grafiği veya regresyon grafiği çizin.
(2)　 Bir grafik çizdikten sonra, özet istatistiklerini veya regresyon modeli bilgilerini görüntüleyin.

(3)　 Yukarıdaki (1) bölümünde açıklanan bir grafiğin üzerine bir regresyon grafiği çizin*
*　(1) bölümündeki yaygın uygulama, bir Saçılım Grafiği çizmek ve ardından üzerine bir regresyon grafiği 

çizmektir. Bir xy Çizgi Grafiğinin veya başka bir regresyon grafiğinin üzerine de bir regresyon grafiği 
çizebilirsiniz.

2-Değişkenli bir istatistik grafiği çizmek için
1.　Hesaplamada kullanılacak istatistiksel verileri girin.

•　Detaylar için, "Veri Girme" (sayfa 68) bölümüne bakın. 

2.　İstatistiksel hesaplama verilerini girdiğiniz hücre aralığını seçin.
•　Bu adımı atlayabilir ve aşağıdaki 3. adıma geçebilirsiniz.

3.　       basınız.
•　Bu, Tip Seç menüsünün görünmesine neden olursa, bu prosedürün 5. adımına gidin. Aksi takdirde, 4. 

adıma gidin.

4.　Kurulum sekmesinin ilk satırını vurgulayın ve ardından O   tuşuna basınız. 

5.　Tip Seç menüsünde, [İstatistik Grafiği Çiz]'i seçin.

6.　Çizmek istediğiniz grafik türünü seçin.
(1)　 [Grafik1]'i vurgulayın ve ardından O   tuşuna basınız.

(2)　 O   tuşuna tekrar basınız.
•　Bu, grafik tipini seçmek için bir menü görüntüler.

(3)　 Menüden çizmek istediğiniz grafik tipini vurgulayın ve ardından O   tuşuna basınız.

7.　Elektronik tabloda istatistiksel veri hücre aralığını belirtin.
(1)　 [XCellRange]'i vurgulayın ve ardından O   tuşuna basınız. 

•　Bu, İstatistik Grafiği Çiz menüsünün Kurulum sekmesinde 
görünmesine neden olur.

•　Bu, Kurulum sekmesi ekranının Grafik1 ayar menüsüne 
dönüşmesine neden olur.
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(2)　 Görüntülenen iletişim kutusunu kullanarak veri hücre aralığını girin ve ardından O   tuşuna basınız. 
(3)　 [YCellRange]'i vurgulayın ve ardından O   tuşuna basınız.
(4)　 Görüntülenen iletişim kutusunu kullanarak veri hücre aralığını girin ve ardından O   tuşuna basınız.
(5)　 [Frequency]'yi vurgulayın ve ardından O   tuşuna basınız. (Bu işlem Sinüzoidal Regresyon Grafiği veya 

Lojistik Regresyon Grafiği ile çalışmaz.) 

8.　Grafik rengini ve diğer ayarları gerektiği gibi belirtin.
•　İşaret Tipi: Grafik tipi olarak Saçılım Grafiği veya xy Çizgi Grafiği seçtiyseniz, çizim için kullanılacak işareti 

belirtin
•　Renk: Grafik çizim rengini belirtir.

9.　Grafiği çizmek için,      basınız. Veya vurgulayın                ve ardından O   tuşuna basınız. 
•　Grafik, Grafik sekmesinde görüntülenir.
•　Grafik sekmesinde gerçekleştirebileceğiniz işlemler hakkında bilgi için, "Grafik Penceresi İşlemleri" 

(sayfa 41) bölümüne bakın. 

10.　Özet istatistiklerini veya regresyon modeli bilgilerini görüntüleyin.
(1)　 >'ya basınız.
(2)　 Aşağıdaki tabloda gösterilen işlemleri gerçekleştirin.

Bu bilgiyi görüntülemek için: Bu menü öğesini seçin:
Özet istatistikleri 2-Variable

Regresyon modeli bilgileri
(İstediğiniz regresyon modelini seçebilirsiniz.)

Linear Regression(a x+b)
Linear Regression(a+b x)
Med-Med Regression
Quadratic Regression
Cubic Regression
Quadratic Regression
Logarithm Regression
Exp Regression(a･e^bx)
Exp Regression(a･b^x)
Power Regression
Sinusoidal Regression
Logistic Regression

(3)　 O    tuşuna basınız.
•　Bu, yukarıdaki (2). adımda seçtiğiniz menü öğesinin detaylarını Sonuçlar sekmesinde görüntüler. 
•　Görüntülenen değerlerin anlamı için "Özet İstatistikleri" (sayfa 33) ve "Regresyon Modeli Bilgileri" 

(sayfa 34) bölümlerine bakın.

11.　>'ya basarak Regresyon Grafiği sekmesine gidin ve bir regresyon grafiği çizin. 

12.　Gerektiğinde regresyon grafikleri ekleyin.
Regresyon Grafiği sekmesine birden fazla regresyon grafiği ekleyebilirsiniz. Bunu yapmak için aşağıdaki adımları 
uygulayın.

 

(1)
　 
T   > [Regresyon Grafiği Çiz]'i seçin.

•　10. adımda regresyon modellerinden birini seçmek, 9. adımda çizilen 
grafiğin üzerine bir regresyon grafiği çizer.
2-Değişkenli'yi seçmek, yalnızca 9. adımda çizilen grafiği görüntüler. 

(2)
　 
Görüntülenen menüden, istediğiniz regresyon modelini seçin ve ardından O   tuşuna basınız.
•　Bu, seçtiğiniz regresyon modelinin grafiğini ekler.
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•　Regresyon Grafiği sekmesinde mevcut olan işlemler için, "Grafik Penceresi İşlemleri" (sayfa 41) 
bölümüne bakın. 

Not
•　Yukarıdaki 5. adımda Kurulum sekmesindeki Grafik1'den Grafik3'e kadar olan detaylar için, "Birden 

Fazla Grafik Kurulumu Kullanarak Grafik Çizme" (sayfa 42) bölümüne bakın.
•　İstatistik grafiği Görünüm Penceresi ayarları, çizilen grafiğe göre otomatik olarak yapılandırılır. Daha 

fazla bilgi için, "İstatistik Grafiği Görünüm Penceresi Ayarları" (sayfa 52) bölümüne bakın.

Elektronik Tablo Uygulaması Ayar Menüsü Öğeleri
Aşağıda açıklanan Ayarlar menüsü öğeleri (sayfa 214), Elektronik Tablo uygulamasına özgüdür. 

S  > [Otomatik Yeniden 
Hesaplama] …

Her veri girişi için otomatik yeniden hesaplama ile yeniden hesaplama 
yapmama arasında geçiş yapar. 

S  > [Düzenleme Kutusu 
Gösterimi] …

Bir hücreye zaten girilmiş olan bir formülün içeriğinin, bir formül olarak mı 
yoksa bir değer olarak mı görüntüleneceğini belirler. Bu ayarla değer 
belirtilmiş olsa bile, hücre içeriği düzenlenirken formül görüntülenir.

S  > [İmleç Hareketi] … Bir hücreye veri girildikten veya yapıştırıldıktan sonra imleç hareket yönünü 
(aşağı veya sağa) seçer.

•　Yukarıdaki 1. ve 2. adımları tekrarlayarak daha fazla regresyon 
grafiği ekleyebilirsiniz.
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Grafik&Tablo Uygulaması
Grafik&Tablo uygulamasını kullanarak çeşitli grafik türlerini çizebilir ve sayısal tablolar oluşturabilirsiniz.

İşlem Akışı
Örnek: y = x ² − 1 ve y = x fonksiyonlarını girme, bir grafik çizme ve sayısal bir tablo oluşturma

1.　h  > Grafik&Tablo

2.　Fonksiyon sekmesinde (sayfa 75), fonksiyonu girin.

(1) y1 satırına x² − 1 girin. 
(2) y2 satırına x girin. 

Xi- 1E
XE

3.　Girdiğiniz fonksiyonun bir grafiğini çizmek için        basınız.
•　Bu, Görünüm Penceresi menüsünü görüntüler. Gerektiği gibi aralık belirtimini değiştirin. Daha fazla bilgi 

için, "Grafik Penceresinin Görüntü Aralığını Belirtme (Görünüm Penceresi)" (sayfa 80) bölümüne bakın.

6.　Fonksiyon sekmesine dönmek için >    veya b     basınız.

Not
•　Grafik&Tablo uygulamasının Fonksiyon sekmesine girilen fonksiyonlar, Dyna Graph uygulamasının 

Fonksiyon sekmesinde de (sayfa 89) görünür. Benzer şekilde, Dyna Graph uygulamasının Fonksiyon 
sekmesine girilen fonksiyonlar da Grafik&Tablo uygulamasının Fonksiyon sekmesinde görünür.

Çizim Aralığı Dışı Grafik Uyarı Mesajı
Bir grafik çizmeye çalıştığınızda pencerede çizilecek bir şey olmadığında "Çizim Aralığı Dışı" uyarı mesajı 
görünür. Bu durumda, görünen menüden istediğiniz işlemi seçin.

Bunu yapmak için: Bu menü öğesini seçin:
Görünüm Penceresi menüsünü görüntüle. [View Window]
Görünüm Penceresi ayarlarını otomatik olarak ayarla ve bir grafik çiz. [Auto Zoom]
Görünüm Penceresi ayarlarını ayarlamadan grafik penceresini görüntüle 
(grafik çizmeden). 

[Cancel]

Fonksiyon Sekmesini Kullanma
Fonksiyon sekmesinde, çeşitli türlerde en fazla 20 fonksiyon girebilirsiniz.

4.　Vurgulayın            ve ardından O   tuşuna basınız.
•　Bu, grafiği Grafik sekmesinde (sayfa 79) çizer. 

5.　Girdiğiniz fonksiyonun sayısal tablosunu görüntülemek için        basınız. 
•　Bu, sayısal tabloyu Tablo sekmesinde (sayfa 86) görüntüler. 
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Kurulum Menüsünü Kullanma
Kurulum menüsünü kullanarak bir fonksiyon türü seçebilirsiniz. Ayrıca bu menüyü, grafik penceresinin ve 
sayısal tablonun aralığını belirlemek için de kullanabilirsiniz.

Kurulum menüsünü görüntülemek için
1.　Fonksiyon sekmesinde, ilk satırı vurgulayın.

•　U   tuşuna basmak her zaman ilk satırı vurgular.

2.　O    tuşuna basın.

Bir fonksiyon türü seçmek için
1.　Kurulum menüsünden [Tür] seçeneğini belirleyin.

•　Bu, Tür menüsünü görüntüler. 

2.　Aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bu fonksiyon türünü seçmek için: Bu menü öğesini seçin:
Kartezyen koordinat türü  ( y= f (x) biçimi) [y=]
Kutupsal koordinat türü (r= f (θ) biçimi) [r=]

Parametrik tür (
= f ( )
= f ( )

 biçimi)
[Param]

Kartezyen koordinat türü ( = f ( ) biçimi) [X=]
Eşitsizlik türü (y> f (x), y< f (x), y≥ f (x), y≤ f (x) biçimi) [y>], [y<], [y≥], [y≤]
Eşitsizlik türü ( > f ( ), < f ( ), ≥ f ( ), ≤ f ( ) biçimi [X>], [X<], [X≥], [X≤]

•　Seçtiğiniz tür, girmek üzere olduğunuz fonksiyona uygulanır. Daha önce girilmiş olan hiçbir fonksiyonu 
etkilemez.

Grafik penceresinin görüntüleme aralığını belirlemek için
Kurulum menüsünden [Görüntüleme Penceresi] öğesini seçin. Ayrıntılar için “Grafik Penceresinin Görüntüleme 
Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80) bölümüne bakın.

Sayısal tablo alanını belirlemek için
Kurulum menüsünden [Bir Tablo Alanı Belirleme] öğesini seçin. Ayrıntılar için “Bir Tablo Alanı Belirleme” 
(sayfa 86) bölümüne bakın.

Fonksiyon Girme ve Düzenleme

Bir fonksiyon girmek için
1.　Girmek istediğiniz fonksiyon türünü seçmek için “Bir fonksiyon türü seçmek için” (sayfa 76) başlığı altındaki 

işlemi kullanın.
2.　Fonksiyon sekmesinde, giriş yapmak istediğiniz satırı vurgulayın ve ardından bir fonksiyon girin. 

•　Seçtiğiniz fonksiyon türüne göre değişkenleri (x, θ, T, Y) girmek için X   tuşuna basın.

Örnek 1: kartezyen koordinat türünün y biçimini girmek içiny 2x2 − 2

2Xi- 2E

Örnek 2: kutupsal koordinat türünü girmek içinr (θ) − 1

vX)- 1E

Örnek 3: Parametrik türü girmek için
＝ 3 ( )
＝ 3 ( )

3vX)E
3cX)E

Örnek 4: kartezyen koordinat türünün X biçimini girmek için2 2 − 5

2Xi- 5E

Yukarıdakilere ek olarak, aşağıda açıklanan özel formatlı giriş yöntemlerini de kullanabilirsiniz.
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Bunu yapmak için: Bu işlemi gerçekleştirin:
Bileşik fonksiyon girme
Örnek: y = x  − 1 ve y = x daha önce girildikten 

sonra y3'e “y1(y2)” bileşik fonksiyonunu 
girmek için

2

*1

y3 satırına “y1(y2)” girin
 > [Fonksiyon]>   [y 1]

 > [Fonksiyon]>   [y 2]

Bir veya daha fazla alfa değişkeni  içeren bir 
fonksiyonu girerken aynı anda fonksiyondaki 
alfa değişkenlerinden birine atanacak değeri 
belirleme

*2

*3*4

Örnek: fonksiyonunun A değişkenine 1, y x2 − 1
*5

Bir y satırına “Ax − 1, [A=1,2,3]” girin.2 *6*7

Bir liste içeren bir fonksiyon girme*3*4

Örnek: girin.y {1,2,3}x2 *8
Bir y satırına “{1,2,3}x2” girin.

C  > [İstatistik] > [{ }] 1 `  2 `  3rXiE

Değişken değerleri aralığına sahip bir fonksiyon girme
Örnek: fonksiyonunun x değerini 0 ≤ x ≤ 2 y x2

Bir y satırına “x , [0,2]” girin.2

Xi`s4 ([)0` 2s5 (])E

*1　Bileşik fonksiyonlar en fazla beş seviyeye kadar iç içe olabilir.
*2　x, θ, T ve Y dışındaki alfa değişkenleri. 
*3　Listede birden fazla değişken veya birden fazla öğe varsa, tek bir giriş fonksiyonuna dayalı olarak aynı 

anda birden fazla grafik çizilecektir.
*4　Bu işlemle çizilen grafiğin rengi ve çizgi türü değiştirilemez.
*5　Atanacak tek bir değer varsa,                       sözdizimi kullanılarak da girilebilir. x2 − 1 ( =1)
*6　Köşeli parantezlerin ([ ]) içine sayısal değerler girdiğinizden emin olun. Buraya alfa değişkenleri giremezsiniz.
*7　Bir fonksiyonda birden fazla değişken olsa bile, değerler yalnızca değişkenlerden birine atanabilir.
*8　Bir fonksiyonda birden fazla liste kullanıldığında, tüm listelerin aynı sayıda öğeye sahip olması gerekir. Örneğin, 

y = {1,2,3}x  − {1,1,1}. Bir listenin diğer listelerle aynı sayıda öğesi yoksa, bir Boyut HATASI (Dimension 
ERROR) oluşacaktır.

2

Eşitsizlikleri Girme ve Dolgu Ayarlarını Yapılandırma

Örnek: ve         eşitsizliklerini girmek içiny ≥ x2 − 1 y < x

1.　[Tür] > [y≥] seçeneğini belirlemek için “Bir fonksiyon türü seçmek için” (sayfa 76) başlığı altındaki 
prosedürü kullanın. 

2.　y1 satırına         , y2 satırına ise x girin. x
2

− 1

3.　y2 satırını vurgulayın ve ardından T   > [Sembolü Değiştir] > [<] 
seçeneğini belirleyin.

4.　       tuşuna basarak grafiği çizin.
•　Varsayılan olarak (     > [Eşitsizlik Bölgesi Türü] > [Birleşim]), 

her bir eşitsizliğin koşullarını sağlayan tüm aralıklar doldurulur.

•　Grafiği çizmek için      > [Eşitsizlik Bölgesi Türü] > [Kesişim] 
seçeneğini belirlerseniz, yalnızca tüm eşitsizliklerin koşullarını 
sağlayan aralık doldurulur. 
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Bir fonksiyonu düzenlemek için
Fonksiyon sekmesinde, düzenlemek istediğiniz satırı vurgulayın ve ardından aşağıdaki işlemi gerçekleştirin.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Daha önce girdiklerinizi düzenleme l   ,  r  veya      tuşuna basın. Bu, girişi düzenleyebilmeniz için 

giriş imlecinin görünmesine neden olur.*

Girişi üzerine yazma Yeniden girmek istediğiniz sayının veya harfin tuşuna basın.*
Bir Kartezyen koordinat türünün veya 
eşitsizlik türünün sembolünü değiştirme

T    > [Sembolü Değiştir] öğesini seçin ve görüntülenen listeden bir 
işaret seçin.

*　Düzenlemeler, düzenledikten sonra     tuşuna basana kadar tamamlanmaz. Herhangi bir değişiklik 
yapmadan düzenlemeyi iptal etmek için,     tuşuna basmadan önce b   tuşuna basın. 

Bir fonksiyonu silmek için
Bunu yapmak için: Bu işlemi gerçekleştirin:
Vurgulanan satırdaki fonksiyonu silme Silmek istediğiniz içeriği içeren satırı vurgulayın* ve ardından  

tuşuna basın. Ya da T   > [Delete] > [Delete Formula] seçeneğini 
 de belirleyebilirsiniz.

Fonksiyon sekmesindeki tüm fonksiyonları 
silme

     tuşuna basın. Ya da     > [Delete] > [Delete All] seçeneğini de 
belirleyebilirsiniz.  

*　Parametrik tür fonksiyonları için, Xt veya Yt satırlarından herhangi birini vurgulayın.

Grafik Çizim Ayarları (Çizgi Türü, Çizgi Rengi)
Fonksiyon sekmesinde, değiştirmek istediğiniz grafik çizim ayarlarını içeren satırı vurgulayın ve ardından 
aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Grafik çizimi için çizgi türünü değiştirme T   > [Line Style] öğesini seçin. Görüntülenen listeyi kullanarak 

bir çizgi stili seçin. 

Grafik çizimi için çizgi rengini değiştirme T   > [Line Color] öğesini seçin. Görüntülenen listeyi kullanarak 
bir renk seçin.

Belirlediğiniz çizgi türü ve rengi, Fonksiyon sekmesindeki her satırın solundaki simgelerle gösterilir. 

Grafikleri Çizme ve Tablolar Oluşturma

Grafik çizmek ve sayısal tablo oluşturmak için bir fonksiyon seçmek için
1.　Fonksiyon sekmesinde, giriş yapılmış bir fonksiyon içeren bir satırı vurgulayın.

2.　T    tuşuna basın. 
•　Bu, [Seç] vurgulanmış bir Araçlar menüsü görüntüler. 

3.　Seçilen fonksiyon için grafik çizimi ve sayısal tablo oluşturmayı etkinleştirmek için [Seç] öğesini (Açık) 
konumuna veya devre dışı bırakmak için (Kapalı)       konumuna getirin. 

4.　Araçlar menüsünü kapatmak için b   tuşuna basın.
•　3. adımın açık/kapalı ayarı, Fonksiyon sekmesindeki her satırın solundaki simgelerle belirtilir. 

… Açık … Kapalı

Not
•　3. adımda etkinleştirdiğiniz (açtığınız) tüm fonksiyonlar, türlerinden bağımsız olarak grafiğe dökülebilir.
•　3. adımda etkinleştirdiğiniz (açtığınız) bir fonksiyon için, Kurulum menüsünde (sayfa 76) [Tür] için 

seçilen fonksiyon türü [y=], [r=] veya [Param] ise, bir sayısal tablo oluşturulabilir.
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Fonksiyon sekmesinden Grafik sekmesine gitmek için (grafik çizmek için)
      tuşuna basın veya vurgulayın                    ve ardından       tuşuna basın. Bu, grafik penceresinin aralığını 
belirleyebilmeniz için Görüntüleme Penceresi menüsünün görünmesine neden olur. Aralık belirtimini gerektiği gibi 
değiştirin. Daha fazla bilgi için “Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” 
(sayfa 80) bölümüne bakın.
Fonksiyon sekmesine geri dönmek için, <    veya b    tuşuna basın. 

Not
•　

.

Fonksiyon sekmesinden Tablo sekmesine gitmek için (sayısal tablo oluşturmak için)
<    tuşuna basın veya vurgulayın                        ve ardından O    tuşuna basın. 
Fonksiyon sekmesine geri dönmek için, >    veya b    tuşuna basın. 

Not
•　Tablo sekmesindeki sayısal tabloya türev katsayıları sütunu eklemek istiyorsanız, S    > [Türev] 

(sayfa 219) seçeneğini açın. x ve y sütunlarına ek olarak, sayısal tabloda türev katsayısı için bir y’ 
sütunu yer alacaktır. 

Grafik Sekmesini Kullanma

Sekmeleri Gösterme ve Gizleme
Grafik sekmesi aktifken, sekmeyi gizlemek ve grafik penceresini genişletmek için     * tuşuna basın. Sekmeyi 
tekrar göstermek için U   tuşuna basın. 

 Pencerenin sağ alt köşesindeki ve       durum çubuğundaki simgeler, gizli bir sekmenin tekrar 
gösterilebileceğini belirtir. 

*　O   , a    veya diğer hemen hemen tüm tuşlara basarak sekmeyi gizleyebilirsiniz. Sekmeler, belirli fonksiyonlar 
(grafik analizi gibi) yürütüldüğünde de otomatik olarak gizlenebilir.      simgesi görüntülenmiyorsa, mevcut 
fonksiyonun yürütülmesi durdurulana kadar sekme tekrar görüntülenemez. 

Grafik Penceresini Ayarlama

Grafik penceresini yukarı, aşağı, sola veya sağa taşımak için
İmleç tuşlarını kullanın.

Grafik penceresini yakınlaştırmak veya uzaklaştırmak için
Yakınlaştırmak için +   tuşuna, uzaklaştırmak için -   tuşuna basın.

Grafik penceresinde ince ayar yapmak için (Araçlar menüsü)
Bunu yapmak için: Bu menü öğesini seçin:            Detaylar:
Görüntüleme aralığını belirleme  > [View Window] “Grafik Penceresinin Görüntüleme 

Aralığını Belirleme (Görüntüleme 
Penceresi)” (sayfa 80)

Grafik penceresini yakınlaştırma 
veya uzaklaştırma

 > [Zoom] “Grafik Penceresi Yakınlaştırma 
Ayarını Değiştirme” (sayfa 81)
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Grafik sekmesine gittiğinizde Görüntüleme Penceresi menüsünün görünmesini engellemek için 
        > [Görün. Pen. Ayar. Göst.] (sayfa 215) seçeneğini kapatın. 



Bir pencere üzerindeki bir noktayı 
kapın ve ekran etrafında sürükleyin.

T  > [Pan] “Bir Pencere Üzerindeki Bir Noktayı 
Kapma ve Ekran Etrafında 
Sürükleme (Kaydırma)” (sayfa 81)

Arka plan görüntüsünü ayarlama T  > [Fade I/O] “Grafik Penceresi Arka Plan 
Görüntüsünü Ayarlama 
(Solma G/Ç)” (sayfa 81)

Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)
Grafik penceresinin görüntüleme aralığını (x ve y ekseni aralığı) belirlemek için Görüntüleme Penceresi 
menüsünü* kullanın. Bu menüyü ayrıca kutupsal ve parametrik tip grafikler çizmek için değer aralığını 
belirlemek için de kullanabilirsiniz.
*
　
Bu menü,       > [Görüntüleme Penceresi] seçeneğini belirlediğinizde Grafik sekmesinde görünür. Aynı zamanda 
Grafik&Tablo uygulaması, Dinamik Grafik uygulaması ve Özyineleme uygulamasındaki diğer sekmelerden de 
görüntülenebilir. Menü içeriği, nerede görüntülendiğine bakılmaksızın aynıdır.

Önceden Ayarlanmış Görüntüleme Penceresi Ayarlarını Kullanma

Bu ayarı kullanmak için: T   > [View Window] > [Önceden Ayarlanmış
Pencereler] öğesini ve ardından bunu seçin: 

Başlangıç hesap makinesi kurulumu [Initialize]

Mevcut açı birimi ayarına göre ön ayarlar (      > [Angle]) [Trigonometric]

Hesap makinesi standart kurulumu [Standard]
Mevcut y-ekseni ayarını sabitleyin ve ekrandaki y-ekseni ve 
x-ekseni ölçek genişliklerinin bire bir olması için x-ekseni 
ayarını değiştirin. 

[Square] > [Y Base]

Mevcut x-ekseni ayarını sabitleyin ve ekrandaki y-ekseni ve 
x-ekseni ölçek genişliklerinin bire bir olması için y-ekseni 
ayarını değiştirin. 

[Square] > [X Base]

Görüntüleme aralığını manuel olarak belirlemek için
Aşağıdaki öğeler için değer girmek üzere Görüntüleme Penceresini kullanın.
•　x Minimum, x Maksimum, x Ölçek (x-ekseni minimum değeri, maksimum değeri, ölçeği) 
•　y Minimum*, y Maksimum, y Ölçek (y-ekseni minimum değeri, maksimum değeri, ölçeği)
•　x Nokta Değeri, x-ekseni yönünde nokta başına düşen değerdir. x Minimum ve x Maksimum değerlerine göre 

belirlenir. x Nokta Değeri değerini değiştirmek, x Maksimum değerini otomatik olarak günceller.
*　Sekme gizlendiğinde, y Minimum tarafından ayarlanan değer, grafik penceresinin alt kenarıdır (aşağıdaki 

kırmızı çerçeve). 

T ve θ değerlerinin ve aralığının (pitch) aralığını belirlemek için
Bu ayarlar, parametrik ve kutupsal grafikler çizilirken uygulanır. Aşağıdaki öğeler için değer girmek üzere 
Görüntüleme Penceresini kullanın.
•　T,θ Minimum, T,θ Maksimum (parametrik tip fonksiyonda T'ye atanan maksimum ve minimum değerler ve 

kutupsal koordinat tip fonksiyonda θ'ya atanacak maksimum ve minimum değerler)
•　T,θ Pitch, grafik çizilirken T ve θ değerlerinin aralığıdır. Aralık değerleri ne kadar küçükse, o kadar ince 

bir grafik çizilir. Daha büyük değerler daha kaba grafikler oluşturur.
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Grafik Penceresi Yakınlaştırma Ayarını Değiştirme (Yakınlaştırma)
Hesap makineniz, grafik penceresinin görüntüleme aralığını değiştirmek için kullanabileceğiniz çeşitli 
kullanışlı yakınlaştırma ayarları sunar.

Grafik penceresi içinde bunu yapmak için: T > [Zoom] öğesini ve ardından bunu  
seçin:

Grafiğin tüm y-ekseni boyunca çizilmesi için ekranı ayarlama [Zoom Auto]
Pencerenin bir bölümünü çevreleme ve ardından orayı 
yakınlaştırma [Zoom Box] *1

Pencerenin merkezini yakınlaştırma veya uzaklaştırma*2 [Zoom In]
[Zoom Out]

x- ve y-ekseni ölçeklerinin 1:1 oranında olması için x-eksenini 
düzeltme [Zoom Square]
İzleme (sayfa 84) kullanılırken görüntülenen x-koordinat 
değerini tam sayı yapma [Zoom Integer] *3

İzleme (sayfa 84) kullanılırken görüntülenen x-koordinat 
değerini uygun sayıda anlamlı basamağa yuvarlama [Zoom Round]

Tüm sonraki yakınlaştırma işlemleri için önceki Görüntüleme 
Penceresi ayarlarını geri yükleme

 [Zoom Original]

Son yakınlaştırma işleminden hemen önce geçerli olan 
Görüntüleme Penceresi ayarlarını sıfırlama [Zoom Previous]

*1　T   > [Zoom] > [Zoom Box] seçeneğini belirlemek, pencerede bir çapraz işaretçi (    ) görüntüler. İşaretçiyi
kutunun köşelerinden birine taşıyın ve ardından O   tuşuna basın. Ardından, işaretçiyi karşı köşeye taşıyın 
ve O   tuşuna basın. 

*2
　
Yakınlaştırma/uzaklaştırma oranı, T   > [Zoom] > [Zoom In/Out Factors] seçeneğini belirlediğinizde görünen 
 iletişim kutusunda belirtilen orandır. 

*3　T   > [Zoom] > [Zoom Integer] seçeneğini belirlemek, pencerede bir işaretçi görüntüler. İşaretçiyi pencerede 
ortalamak istediğiniz koordinata taşıyın ve O   tuşuna basın.

 

Bir Pencere Üzerindeki Bir Noktayı Kapma ve Ekran Etrafında Sürükleme (Kaydırma)
Görünen el simgesini kullanarak grafik penceresini ekran etrafında sürükleyebilirsiniz.

1.　Grafik penceresi görüntülenirken, T   > [Pan] öğesini seçin. 
•　Bu, bir ok işaretçisi (   ) görüntüler.

2.　Ok işaretçisini, pencerede yakalamak istediğiniz noktaya taşımak için imleç tuşlarını kullanın ve ardından 
O   tuşuna basın..
•　Bu, işaretçinin bir oktan (   ) bir ele (   ) dönüşmesine neden olur.

3.　Eli hareket ettirmek ve pencereyi ekran etrafında sürüklemek için imleç tuşlarını kullanın.
•　Pencerenin içeriği elle birlikte hareket eder.

4.　O   tuşuna basın.

 
•　Bu, işaretçiyi bir oka geri döndürür. Gerektiğinde 2. ve 3. adımları tekrarlayabilirsiniz.
•　Pencere içeriğini sürüklemeyi bitirdiğinizde, b   tuşuna basın.

 Grafik Penceresi Arka Plan Görüntüsünü Ayarlama (Fade I/O)
Bu işlemi, arka plan görüntüsünün opaklığını ayarlamak için kullanabilirsiniz. Bu işlem, yalnızca 16-bit renkli 
bir görüntü, grafik penceresi arka plan görüntüsü olarak kullanıldığında gerçekleştirilebilir. Bir arka plan 
görüntüsü görüntüleme hakkında bilgi için, “Arka Plan (Grafik)” (sayfa 219) bölümüne bakın.

1.　Grafik penceresi görüntülenirken, T   > [Fade I/O] öğesini seçin.

2.　Arka plan görüntüsünün opaklığını ayarlamak için l      ve r      tuşlarını kullanın. 

3.　Ayar istediğiniz gibi olduğunda, b    tuşuna basın. 
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Grafik Çözmeyi Kullanma (Grafik Çözme)
Grafik Çözme'yi kullanarak, bir grafikteki köklerin, integrallerin, y-ekseni kesişiminin veya diğer anahtar özellik 
noktalarının koordinatlarını ve diğer değerleri elde edebilirsiniz. Örneğin, bir grafikteki bir fonksiyonun kökünü 
bulmak için aşağıdaki işlemi gerçekleştirin.

1.　Fonksiyonu Fonksiyon sekmesine girin ve grafik çizmek için >   tuşuna basın.

2.　T   > [Graph Solve] > [Root] öğesini seçin.
•　Grafik penceresinde birden fazla grafik varsa, bunlardan biri yanıp sönecektir.

3.　Yanıp sönen imleci kökünü elde etmek istediğiniz grafiğe taşımak için d   ve u   tuşlarını kullanın ve ardından O 
tuşuna basın. 
•　Bu, kökün koordinatlarında bir çapraz işaretçinin (   ) görünmesine ve koordinat değerlerinin pencerenin 

altında görünmesine neden olur. Birden fazla kök varsa, işaretçiyi başka bir köke taşımak için r    ve l    tuşlarını 
kullanabilirsiniz.

4.　Grafik analizinden çıkmak için b   tuşuna basın.
Grafik analizi kullanılarak elde edilebilecek değerler aşağıdaki tabloda gösterilmiştir.

Bu değeri elde etmek için: T   > [Graph Solve] öğesini ve 
ardından bunu seçin:

Bir grafikteki kökler [Root]
Bir grafikteki maksimum değer [Maximum Value ]
Bir grafikteki minimum değer [Minimum Value]

İki grafiğin kesişim koordinatları*1 [Intersection]

Grafikteki belirtilen aralığın integral değeri *2 [∫dx] > [∫dx]

Bir grafikteki birden fazla kök tarafından sınırlandırılan bir 
aralığın integral değeri ve alanı *2*3

 [∫dx] > [Root]

İki grafiğin birden fazla kesişim noktasıyla sınırlanan bir 
aralığın integrali ve alanı*2*4 [∫dx] > [Intersection]

İki grafiğin kesişimi ve bunlardan birindeki bir kök tarafından 
sınırlanan bir aralığın integrali ve alanı*2*5 [∫dx] > [Mixed]

y-ekseni kesişim noktası [y-Intercept]

Belirli bir y değeri için bir grafikteki x-koordinat değeri *6 [x-Call]

Belirli bir x değeri için bir grafikteki y-koordinat değeri [y-Call]
*1　Kartezyen koordinat türü (y= f (x) biçimi) ve eşitsizlik türü (y> f (x), y< f (x), y≥ f (x), y≤ f (x) biçimi) 

grafikleri için hesaplanabilir.
*2　Kartezyen koordinat türü (y= f (x) biçimi) grafikleri için hesaplanabilir.
*3　Belirtilen iki kök arasında 21'den fazla kök varsa bir hata oluşur.
*4　Belirtilen iki kesişim arasında 21'den fazla kesişim varsa bir hata oluşur.
*5　Grafiğin kesişim noktaları veya kökleri yerine, herhangi bir x-koordinat değerini belirlemek için sayı 

tuşlarını da kullanabilirsiniz. 
*6　Parametrik tip grafikler için hesaplanamaz.

Önemli!
•　Aşağıda açıklanan durumlarda, çözüm doğruluğu azalabilir veya çözüm imkansız olabilir.
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-　Çözüm, grafikler arasındaki teğet noktasında veya bir grafik ile x-ekseni arasındaki teğet noktasında 
olduğunda.

-　Çözüm, bir grafiğin büküm noktasında veya bu noktanın yakınında olduğunda.

İşlem Örnekleri:

Örnek 1: y x3 − 2x − 1 ve y -x3 2x −

1.　İki fonksiyonu grafikleyin.

2.　T   > [Graph Solve] > [∫dx] > [Intersection] öğesini seçin.
•　Bu, en soldaki kesişim noktasının koordinatında bir işaretçinin görünmesine neden olur.

3.　Mevcut işaretçi konumunu entegrasyonun alt sınırı yapmak için O   tuşuna basın.

4.　İşaretçiyi sağa doğru iki kesişim noktası taşımak için r    tuşuna iki kez basın. 

5.　Mevcut işaretçi konumunu entegrasyonun üst sınırı yapmak için O    tuşuna basın.
•　Bu, integral aralığını tanımlar ve hesaplama sonucunu görüntüler.

İntegral değeri

Alan

6.　Grafik analizinden çıkmak için b    tuşuna basın. 
Örnek 2:  Yukarıdaki Örnek 1'de çizdiğiniz y = x3 − 2x − 1 grafiğinin y = -0.5 olduğundaki x-değerini hesaplamak 

için 
1.　T   > [Graph Solve] > [x-Call] öğesini seçin.

2.　Yanıp sönen imleci y = x3 − 2x − 1 grafiğine taşımak için d   ve u   tuşlarını kullanın ve ardından O   tuşuna basın. 
•　Bu, y-değerini girmek için bir iletişim kutusu görüntüler. 

3.　-0.5'i girin ve ardından O   tuşuna basın. 
•　Bu, y = -0.5 olan koordinatlardan birinde bir işaretçinin görünmesine neden olacak ve koordinat değeri 

pencerenin altında görünecektir. İşaretçiyi y = -0.5 olan başka bir koordinata taşımak için r    ve    l 
kullanabilirsiniz.

x-koordinat değeri

y-koordinat değeri
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4.　Grafik analizinden çıkmak için b   tuşuna basın. 

İzlemeyi Kullanma (İzleme)
İzleme, belirli bir konumdaki koordinat değerlerini okumak için kullanabileceğiniz, bir grafikte artılı bir 
işaretçi (     ) görüntüler. S   > [Derivative] (sayfa 219) açıkken, koordinat değerleriyle birlikte türev katsayıları  
da görüntülenir.

İzlemeyi etkinleştirmek için
T   > [Trace] öğesini seçin.
İzleme fonksiyonu etkinken gerçekleştirilebilecek işlemler aşağıdaki tabloda açıklanmıştır.

Bunu yapmak için: Bu işlemi gerçekleştirin:
İşaretçiyi grafik boyunca hareket ettirme      veya      tuşuna basın. 
İşaretçiyi grafikte belirli bir x-koordinatına taşıma Bir x-koordinat değeri girmek için sayı tuş-

larını kullanın ve ardından       tuşuna basın. 

Birden fazla grafik olduğunda, işaretçi aralarında hareket 
edecektir

d   veya u   tuşuna basın. 

Bir grafikte koordinat değerleri olan bir nokta çizme* İşaretçiyi koordinat değerleri olan bir 
nokta çizmek istediğiniz konuma taşıyın 
ve ardından O   tuşuna basın.

İzlemeden çıkma b   tuşuna basın.
*　Nokta konumu bir grafiğin koordinatları içindeyse, katı kırmızı bir nokta (   ) olarak görüntülenir. Nokta 

konumu grafiğin koordinatları içinde değilse, kırmızı bir daire (    ) olarak görüntülenir. 

Bir Fonksiyonun Katsayı Değerlerini Değiştirerek Bir Grafiği Değiştirme (Değiştir)
Katsayılarda beş alfa değişkeni içeren (y = Ax + B gibi) bir fonksiyonel ifade girebilir ve ardından grafik 
görüntülenirken değişkenlerin değerlerini (katsayı değerleri) değiştirebilirsiniz. Bu, katsayı değerlerindeki
değişikliklerin grafiğin görünümünü nasıl etkilediğini görmenizi sağlar.

Önemli!
•　Grafik çizimi için birden fazla fonksiyon seçildiğinde, değişken içeren ikiden fazla fonksiyon varsa, 

değiştirme kullanılamaz.

Örnek: ifadesini girin ve katsayı değerleri değiştirildiğinde grafiğin şeklinin nasıl etkilendiğini y = Ax2 + Bx + C
*1

1.　Fonksiyon sekmesinde,                            ifadesini girin. y = Ax2 + Bx + C
•　T   > [Built-In Function] > [y=Ax^2+Bx+C] öğesini seçin ve ardından fonksiyonu girin.*2

2.　Diğer tüm fonksiyon ifadesi grafik çizim ayarlarını kapatın.
•　“Grafik çizmek ve sayısal tablo oluşturmak için bir fonksiyon seçmek için” (sayfa 78) bölümüne bakın.

3.　Grafiği çizmek için >    tuşuna basın.

5.　A’nın değerini değiştirmek için l     ve r     tuşlarını kullanın.

4.　Değiştirmeyi etkinleştirmek için T   > [Modify] öğesini seçin.
•　A, B ve C'nin mevcut değerleri ve adım değeri grafik 

penceresinin sol alt köşesinde görüntülenir. İşaretçinin (    ) şu 
anda bulunduğu değeri değiştirebilirsiniz.

•　İşaretçiyi (    ) yukarı ve aşağı taşımak için d   ve u   tuşlarını 
kullanın.
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•　l     veya r    tuşuna her basış, A değerini adım değeri kadar değiştirir. Değer girmek için sayı tuşlarını da 
kullanabilirsiniz. 

6.　İşaretçiyi (    ) B'ye taşımak için d   tuşuna basın. B'nin değerini değiştirmek için l    ve r    tuşlarını kullanın.

7.　İşaretçiyi (    ) C'ye taşımak için d    tuşuna basın. C'nin değerini değiştirmek için l    ve r    tuşlarını kullanın. 

8.　Değiştirmeden çıkmak için b    tuşuna basın. 
*1　Başlamadan önce A = 1, B = 0 ve C = 0 atayın. “Bir alfa değişkenine bir değer atamak için” (sayfa 18) 

bölümüne bakın.
*2　Aşağıdaki fonksiyonları girmek için T    > [Built-In Function] öğesini kullanabilirsiniz. 

y x

y (x − )2

y x2 x
y x3 x2 x

y ( x )
y ( x )
y ( x )

Not
•　Değiştirme etkinken, o anda görüntülenen grafiğin fonksiyonunu Fonksiyon sekmesindeki herhangi bir 

fonksiyon alanına (o anda çizim için kullanılmakta olan bir fonksiyonun alanı hariç) kopyalayabilirsiniz. 
Fonksiyonu kopyalamak için, T   > [Copy] öğesini seçin ve görüntülenen menüden hedef alanı seçin.

Çizimi Kullanma (Çizim)
Grafik alanında noktalar, çizgiler ve metin çizmek için çizim kullanabilirsiniz. Örneğin, y = x + 1 grafiğine 
bir teğet doğrusu çizmek için aşağıdaki adımları gerçekleştirin.

2

1.　Fonksiyon sekmesinde, y = x + 1 fonksiyonunu girin ve ardından grafiğini çizmek için >   tuşuna basın.
•　Bu örnek sadece y = x + 1 grafiğini çizer.

2.　T   > [Sketch] > [Tangent Line] öğesini seçin. 
•　Bu, y = x + 1 grafiğinin x = 0 noktasındaki teğetini çizer. Teğet noktasının koordinatlarını değiştirmek için

l    veya r    tuşunu kullanabilirsiniz.

2

3.　Teğet noktasının koordinatlarını görüntülemek için O   tuşuna basın. 
•　Bu, teğet doğrusu çizimini yürütür ve teğet noktasında koordinat değerlerine sahip bir nokta 

(   ) görüntüler.
•　Şimdi teğet noktasının koordinatlarını değiştirmek ve O   tuşuna basarak bir teğet doğrusu eklemek için 

l    ve r    tuşlarını kullanabilirsiniz. 

4.　Çizimden çıkmak için b   tuşuna basın.

 Aşağıdaki tablo, çizim ile yapabileceğiniz şeyleri göstermektedir.

Bunu yapmak için: T   > [Skecth] öğesini ve ardından 
bunu seçin:

Çizim kullanılarak çizilmiş tüm noktaları, çizgileri ve metni temizle [Clear Screen]
Bir grafiğe teğet bir doğru çizme [Tangent Line]
Bir grafiğe normal bir doğru çizme [Normal Line]

Bir grafiğin ters grafiğini çizme*1 [Inverse]

Bir noktayı çizme ve silme arasında değiştirme [Plot]
İki nokta belirleme ve aralarında bir doğru parçası çizme               [Line]
Merkez noktasını ve çember üzerindeki bir noktayı belirterek 
bir daire çizme

[Circle]

Dikey bir doğru çizme [Vertical Line]
Yatay bir doğru çizme [Horizantal Line]

Serbest el ile bir çizgi çizme*2 [Pen]
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Metin yaz*3 [Text]

*1　Bir grafik çizildikten sonra çizimden otomatik olarak çıkılır.
*2　İşaretçiyi hareket ettirmek ve bir çizgi çizmek için imleç tuşlarını kullanabilirsiniz.
*3　Giriş, mevcut işaretçi konumundan başlayarak ve grafik penceresinin sağ kenarıyla biterek mümkündür. 

Giriş devam ederken I    tuşu işlemleri göz ardı edilir.

Not
•　Çizim noktaları, çizgileri ve metinleri, S   > [Plot/Line Color] (sayfa 218) ve S    > [Sketch Line] (sayfa

218) ayarların göre çizilir. 

Panoya Kopyalanan Bir Fonksiyonu Grafikleme
Başka bir uygulamadan bir fonksiyonu* kopyalayabilir, Grafik sekmesine yapıştırabilir ve ardından grafikleyebilirsiniz.
*　Bir f(x) biçimi ifadesi (x − 2 gibi) veya bir y = f(x) biçimi denklemi (y = x − 2 gibi). 2

Örnek: (x +  2)(x −  2) ifadesini kopyalamak, Grafik sekmesine yapıştırmak ve ardından grafiklemek için

1.　(x +  2)(x −  2) ifadesini girmek için Hesaplama uygulamasını kullanın ve ardından ifadeyi kopyalayın.
•　Kopyalama işlemiyle ilgili ayrıntılar için, “İfadeleri Kopyalama, Kesme ve Yapıştırma” (sayfa 10) bölümüne 

bakın.
2.　Grafik&Tablo uygulamasını başlatın ve ardından ifadeyi grafiklemek için >    tuşuna basın. 

3.　s.(%)       tuşuna basın.
•　Bu,                                    grafiğini çizer.                    y = (x + 2)(x 2)

Grafik Çizim Ayarı Öğeleri
Grafik çizim işlemi ve grafik çizim görüntüleme alanı için ayarları yapılandırmak üzere Ayarlar menüsünü 
kullanabilirsiniz. Ayrıntılar için, “Ayarlar Menüsü Ayrıntıları” (sayfa 214) bölümüne bakın.

Tablo Sekmesini Kullanma
Tablo sekmesiyle, sayısal bir tablonun x-sütunundaki sayıları düzenleyebilir ve ayrıca T    tuşuna bastığınızda 
görünen menüden aşağıdaki işlemleri gerçekleştirebilirsiniz. 

Bunu yapmak için: Bu menü öğesini seçin:            Ayrıntılar:
Oluşturulan tablonun tanım 
aralığını belirleme  > [Set Table Domain ]

“Bir Tablo Alanını Belirleme” 
(sayfa 86)

Sayısal bir tablonun koordinatlarında 
noktaları gösteren bir grafik çizme  > [Graph Points]

“Sayısal Bir Tabloyu Grafikleme” 
(sayfa 87)Sayısal bir tablonun koordinatlarını 

düz çizgi parçalarıyla birleştiren bir 
grafik çizme

 > [Graph Points (Joined)] 

Grafik penceresinin görüntüleme 
aralığını belirleme  > [View Window]

“Grafik Penceresinin Görüntüleme 
Aralığını Belirleme (Görüntüleme 
Penceresi)” (sayfa 80)

Bir satır ekleme veya ilave etme  > [Row] “Sayısal Bir Tabloyu Düzenleme” 
(sayfa 87)Giriş verilerini düzenleme  > [Edit]

Sayısal bir tablonun bir sütununu 
bir liste değişkenine kaydetme  > [Store List]

“Sayısal Bir Tabloyu Liste 
Değişkenine Kaydetme” (sayfa 87)

Sayısal bir tablonun bir satırını 
veya tüm tabloyu silme  > [Delete] “Sayısal Bir Tabloyu Düzenleme” 

(sayfa 87)

Bir Tablo Alanını Belirleme
Sayısal tablo tanım aralığı, sayısal tabloyu oluşturmak için kullanılan fonksiyona atanan x-değişkeninin (veya θ, T) 
değeriyle belirlenir. Bir tablo tanım aralığını belirlemek için aşağıdaki iki yöntem mevcuttur. 
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Bu yöntemi kullanarak bir tablo tanım 
aralığını belirlemek için:  Bu işlemi gerçekleştirin:

x-değişkeninin başlangıç, bitiş ve 
adım değerlerini girme 

1.　T   > [Set Table Domain] > [Range] öğesini seçin.
2.　Başlangıç değerini [Start] satırına, bitiş değerini [End] 

satırına ve adım değerlerini [Adım] satırına girin.
3.　Vurgulayın                         ve ardından O   tuşuna basın.

Liste değişkeni elemanlarını x-değişkeni 
olarak kullanma

1.　x-değişkeni olarak kullanılacak değerleri listelerden birine Lis-
te 1 ila Liste 26) girmek için Liste Düzenleyiciyi kullanın. Ay-
rıntılar için, “Liste Düzenleyicide Veri Girme” (sayfa 30) bakın..

2.　T   > [Set Table Domain] > [List] öğesini seçin.
3.　1.adımdaki liste değişkenini vurgulayın ve ardından O  basın.
4.　İletişim kutusunu kapatmak için b   tuşuna basın.

Sayısal Bir Tabloyu Grafikleme
1.　Sayısal tablo görüntülenirken, aşağıdaki seçeneklerden birini seçin.

Sadece koordinat noktalarının grafiğini çizmek için: T   > [Graph Point]
Koordinat noktalarını düz çizgi parçalarıyla bağlayarak bir grafik çizmek için: T   > [Graph Points (Joined)] 

2.　Görünen Görüntüleme Penceresi menüsünü, görüntüleme aralığı ayarlarını gerektiği gibi değiştirmek için kullanın.
•　Ayrıntılar için, “Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80) bölümüne bakın. .

3.　Vurgulayın           ve ardından O   tuşuna basın.
•　Bu, grafiği Tablo sekmesinde çizer. 

Not
•　Grafik çizerken Görüntüleme Penceresi menüsünün görünmesini engellemek için S   > [Show V-Win 

Settings] (sayfa 215) seçeneğini kapatın.
•　Bir grafiği görüntülerken gerçekleştirilebilecek işlemler, Grafik sekmesindeki işlemlerle aynıdır 

([Graph Solve] ve [Modify] hariç).

Sayısal Bir Tabloyu Düzenleme
Bunu yapmak için: Bu işlemi gerçekleştirin:
Sayısal bir tablo x-değerinin* üzerine farklı bir 
değerle yazma

Değerini değiştirmek istediğiniz x-sütunu* satırına 
imleci taşıyın ve ardından yeni değeri girin.

Sayısal bir tablo x-değerini* düzenle Düzenlemek istediğiniz x-sütunu* satırına imleci 
taşıyın ve ardından T   > [Edit] öğesini seçin.

İmlecin şu anda bulunduğu satırın altına bir satır 
ekle

T   > [Row] > [Add] öğesini seçin.

İmlecin şu anda bulunduğu satırın üstüne bir satır 
ekle

T   > [Row] > [Insert] öğesini seçin. 

İmlecin bulunduğu satırı sil T   > [Delete] > [Row] öğesini seçin.
Tüm sayısal tabloyu sil ve Fonksiyon sekmesine 
geri dön

T   > [Delete] > [Table] öğesini seçin.

*　x, θ, ya da T

Sayısal Bir Tabloyu Liste Değişkenine Kaydetme
Sayısal tablo verilerinin bir sütunu, numarasıyla belirtilen bir liste değişkenine kaydedilebilir.

1.　İmleci, bir liste değişkenine kaydetmek istediğiniz sayısal tablo sütununa taşıyın.

2.　T   > [Store List] öğesini seçin. 

3.　Görünen iletişim kutusunu kullanarak bir liste değişkeni numarası girin ve ardından O   tuşuna basın.
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Sayısal Tablo ve Grafiği Aynı Anda Görüntüleme
S   > [Table with Graph] açıkken, sayısal tablo penceresi Tablo sekmesinin sağında, grafik penceresi ise 
solunda görüntülenir.
•　Fonksiyon sekmesinden veya Grafik sekmesinden Tablo sekmesine geçtikten hemen sonra grafik penceresinde 

hiçbir şey çizilmez. Grafiği çizmek için aşağıdaki işlemleri kullanın.
-　T   > [Switch Active Window] öğesini seçin.
-　T    'den, [Graph Points] veya [Graph Points (Joined)] öğesini seçin.

•　T   > [Switch Active Window] öğesini her seçtiğinizde, aktif pencere (gerçekleştirdiğiniz işlemlerden etkilenen 
pencere) sayısal tablo penceresi ve grafik penceresi arasında geçiş yapar. İmleç sayısal tabloda görüntülendiğinde, 
sayısal tablo penceresi aktiftir.

•　Sayısal tablo penceresi aktifken aşağıdaki işlemler kullanılabilir.
“Mevcut sayısal tablo imleci konumundaki bir grafikte bir işaretçi görüntülemek için (Grafik-Bağlantısı)” (sayfa 88)
“Bir Tablo Alanını Belirleme” (sayfa 86)
“Sayısal Bir Tabloyu Düzenleme” (sayfa 87)
“Sayısal Bir Tabloyu Liste Değişkenine Kaydetme” (sayfa 87)

•　Grafik penceresi aktifken aşağıdaki işlemleri gerçekleştirebilirsiniz.
“Sekmeleri Gösterme ve Gizleme” (sayfa 79)
“Grafik Penceresini Ayarlama” (sayfa 79) (Pan ve Fade I/O hariç)
“Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80)
“Grafik Penceresi Yakınlaştırma Ayarını Değiştirme (Yakınlaştırma)” (sayfa 81)
“İzlemeyi Kullanma (İzleme)” (sayfa 84)
“Çizimi Kullanma (Çizim)” (sayfa 85)

Mevcut sayısal tablo imleci konumundaki bir grafikte bir işaretçi görüntülemek için (Grafik-Bağlantısı)

1.　S   > [Table with Graph] seçeneğini açın.

2.　Fonksiyon sekmesinde, fonksiyonu girin ve ardından Tablo sekmesine gitmek için <    tuşuna basın.

3.　T   > [Switch Active Window] öğesini seçin.
•　Bu, grafik penceresini aktif hale getirir ve grafiği çizer.

5.　Bu işlemden çıkmak için b    tuşuna basın.

Not
•　Grafik penceresinde hiçbir grafik çizilmemişse, sayısal tablo penceresi aktifken T   > [Grafik-Bağlantısı] 

işlemi gerçekleştirilemez. T   > [Graph-Link], grafik penceresinde bir grafik çizildikten sonra 
etkinleştirilir.

4.　T   > [Graph-Link] öğesini seçin.
•　Bu, sayısal tablo imleci konumuna karşılık gelen koordinatlarda 

grafiğin üzerinde bir artılı işaretçinin görünmesine neden olur.

•　Sayısal tablo imlecini hareket ettirmek için d    ve u    tuşlarını kullanmak, 
grafik işaretçisinin de buna göre hareket etmesine neden olur.
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Dinamik Grafik (Dyna Graph) Uygulaması
Dinamik Grafik uygulamasını, katsayılar olarak alfa değişkenlerini içeren y = Ax + B gibi bir fonksiyonu girmek 
için kullanabilirsiniz. Görüntülenen bir grafik, fonksiyonun belirli bir katsayısının değeri belirli bir aralık içinde 
değiştirildikçe sürekli olarak yeniden çizilir. Bir Dinamik Grafik, katsayı değerlerinin bir grafiğin şekli ve konumu 
üzerindeki etkisini gözlemlemeyi mümkün kılar. 

İşlem Akışı
Örnek: Dinamik Grafik uygulamasının y = Asin Bx + C dahili fonksiyonunu seçmek ve girmek için. Fonksiyonun 

B katsayısının değeri değiştirilirken grafikteki değişikliği gözlemleyin. A ve C için 1 değerini belirleyin.
 

Not
•　Grafik&Tablo uygulamasının Fonksiyon sekmesinde (sayfa 75) zaten fonksiyonlar varsa, bunlar 

aşağıdaki prosedürün 1. adımındaki Dinamik Grafik uygulamasının Fonksiyon sekmesinde de 
görünecektir. Aşağıdaki örnekte gösterilen Fonksiyon sekmesinin başlangıçta fonksiyonsuz olarak 
başladığını unutmayın.

1.　h  > Dyna Graph
•　Bu, Fonksiyon sekmesini görüntüler. 

3.　>   tuşuna basın veya vurgulayın               ve ardından O   tuşuna basın.

4.　Görünen Kurulum sekmesinde, değeri değiştirilecek katsayının değişken adını belirleyin.

5.　Diğer katsayıların her biri için değişkenlere değerler atayın.

d 1E 1E

6.　>   tuşuna basın (veya vurgulayın                 ve ardından O   tuşuna basın).
•　Bu, Görüntüleme Penceresi menüsünü görüntüler. Ayrıntılar için, “Grafik Penceresinin Görüntüleme 

Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80) bölümüne bakın.

7.　Görüntüleme Penceresi ayarlarını yapılandırın ve grafiği çizin.
(1)　 [Pre-Set Windows] > [Trigonometric] öğesini seçin.
(2)　 Vurgulayın            ve ardından O   tuşuna basın.

•　Grafik, B katsayısının değeri 1 ile 5 aralığında, 1'erli artışlarla artırılır veya azaltılırken sürekli olarak 
yeniden çizilir (varsayılan ayar *1).

2.　T   > [Built-In Function] > [y=Asin(Bx+C)] öğesini seçin.
•　Bu, seçtiğiniz fonksiyonu girer.

(1)　 [Değişken] öğesini vurgulayın ve ardından O   tuşuna basın.
(2)　  Görünen menüde, [B] öğesini vurgulayın ve ardından O   

tuşuna basın.
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•　Katsayı değerinin artırılması ve azaltılmasının 10 tekrarından sonra (varsayılan ayar  ) Kurulum 
sekmesi yeniden görünür.

*2

•　Grafiğin yeniden çizimini kesmek ve Kurulum sekmesine geri dönmek için a   tuşuna basın. 
*1　Artış/azalışın başlangıç, bitiş ve adım değerlerini belirleyebilirsiniz. Ayrıntılar için, “Kurulum Sekmesini 

Kullanma” (sayfa 91) bölümüne bakın. 
*2　Grafik çizim işlemi sırasında katsayı değerlerinin otomatik olarak değiştirilme hızını belirleyebilirsiniz. 

Ayrıntılar için, “Kurulum Sekmesini Kullanma” (sayfa 91) bölümüne bakın.

Fonksiyon Sekmesini Kullanma
Fonksiyon sekmesine 20'ye kadar fonksiyon girebilirsiniz.

Not
•　Dinamik Grafik uygulamasının Fonksiyon sekmesine girilen fonksiyonlar, Grafik&Tablo uygulamasının 

Fonksiyon sekmesinde de (sayfa 75) görünür. 

Fonksiyonları Girme ve Düzenleme

Fonksiyon türünü seçmek ve manuel olarak bir fonksiyon girmek için

1.　Fonksiyon sekmesinde, ilk satırı vurgulayın ve ardından O   tuşuna basın.

2.　Görünen Kurulum menüsünde, [Tür] öğesini seçin.
•　Bu, Tür menüsünü görüntüler.

3.　Aşağıdaki tabloda gösterilen işlemleri gerçekleştirin.

Bu fonksiyon türünü seçmek için: Bu menü öğesini seçin:
Kartezyen koordinat türü ( y= f (x) formu) [y=]
Kutupsal koordinat türü (r=f(θ) formu) [r=]

Parametrik tür   (
= f ( )
= f ( )

 formu)
[Param]

•　Seçtiğiniz fonksiyon türü, girmek üzere olduğunuz fonksiyona uygulanır. Daha önce girilmiş herhangi bir 
fonksiyonu etkilemez.

4.　Bir fonksiyon girmek istediğiniz satırı vurgulayın ve ardından onu girin.
•　Seçtiğiniz fonksiyon türüne uygun olarak değişkenleri (x, θ, T) girmek için X   tuşuna basın.

Örnek 1: Kartezyen koordinat türü                    ifadesini girmek içiny x2 −

PX (A)Xi-Pe (B)E

Örnek 2: Kutupsal koordinat türü                          ifadesini girmek içinr θ −

PX (A)vX)-Pe (B)E

Örnek 3: Parametrik türü girmek için
＝ ( ) −
＝ ( ) −

PX (A)vX)-Pe (B)E
PX (A)cX)-Pe (B)E
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Dahili bir fonksiyonu seçmek ve girmek için
1.　Fonksiyon sekmesinde, giriş yapmak istediğiniz satırı vurgulayın.

2.　T   > [Built-In Function] öğesini seçin.

3.　Görünen menüde, girmek istediğiniz fonksiyonu vurgulayın ve ardından O   tuşuna basın. 
•　Aşağıda listelenen fonksiyonları girebilirsiniz.

y x

y (x − )2

y x2 x
y x3 x2 x

y ( x )
y ( x )
y ( x )

Bir fonksiyonu düzenlemek veya silmek için
Mevcut bir fonksiyonu düzenlemek veya silmek için, Grafik&Tablo uygulamasındakiyle aynı işlemi kullanın. Daha 
fazla bilgi için, “Bir fonksiyonu düzenlemek için” (sayfa 78) ve “Bir fonksiyonu silmek için” (sayfa 78) bölümlerine 
bakın.
Grafik çiziminin çizgi rengini değiştirmek için
1.　Fonksiyon sekmesinde, grafiğin çizgisinin rengini değiştirmek istediğiniz fonksiyonu vurgulayın.

2.　T   > [Line Color] öğesini seçin.

3.　Görünen listeyi kullanarak bir renk seçin.

Grafik çizmek için bir fonksiyon seçmek için
1.　Fonksiyon sekmesinde, giriş yapılmış bir fonksiyon içeren bir satırı vurgulayın.

2.　T   tuşuna basın.
•　Bu, [Select] öğesi vurgulanmış bir Araçlar menüsünü görüntüler.

3.　Seçili fonksiyon için grafik çizimini etkinleştirmek üzere [Seç] öğesini (Açık)        olarak veya devre dışı 
bırakmak için (Kapalı)       olarak değiştirin.

4.　Araçlar menüsünü kapatmak için b   tuşuna basın.
•　3. adımdaki açık/kapalı ayarı, Fonksiyon sekmesinin her satırının solundaki simgelerle belirtilir.

… Açık … Kapalı

Not
•　Grafik çizimi için Fonksiyon sekmesinde birden fazla fonksiyon seçilirse, Kurulum sekmesinde “Çok 

Fazla Fonksiyon” mesajı görünecektir.

Kurulum Sekmesini Kullanma
Kurulum sekmesini, T   tuşuna bastığınızda görünen ve aşağıda açıklanan ayarları yapılandırmak için 
kullanabilirsiniz.
Bunu yapmak için: Bu işlemi gerçekleştirin:
Katsayı değerinin değişim 
aralığını belirleme

1.　T   > [Range] öğesini seçin.
2.　2. Başlangıç değerini [Start] satırına, bitiş değerini [End] satırına 

ve adım değerini [Step] satırına girin.
3.　Menüyü kapatmak için b   tuşuna iki kez basın. 

Grafik çizimi sırasında katsayı 
değerinin otomatik olarak 
,değişeceği hızı belirtin

1.　T   > [Speed] öğesini seçin.
2.　2. Görünen menüde, istediğiniz ayarı vurgulayın ve ardından O   

tuşuna basın.
•　Aşağıda açıklanan hızlardan birini seçebilirsiniz.

[Stop&Go]: Katsayı değeri otomatik olarak değil, l    veya r       tuşuna 
her basıldığında değişir. *

[Slow]: Katsayı değeri normal hızın yarısında değişir.
[Normal]: Katsayı değeri normal hızda değişir.
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[Fast]: Katsayı değeri normal hızın iki katı hızında değişir.
3.　Menüyü kapatmak için b   tuşuna iki kez basın.

Görüntüleme aralığını belirle      > [View Windows] öğesini seçin. Ayrıntılar için, “Grafik Penceresinin
Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80) 
 bölümüne bakın.

*　Grafik çizimi için [Stop&Go] seçeneği belirlenmişse, Grafik sekmesinden Kurulum sekmesine dönmek için b 
tuşuna basın.

Dinamik Grafik Uygulaması Ayarlar Menüsü Öğeleri
Aşağıda açıklanan Ayarlar menüsü öğeleri (sayfa 214), Dinamik Grafik uygulamasına özeldir.

etmeyeceğini belirler.
  

S  > [Locus]: Grafik yerinin görüntülenip görüntülenmeyeceğini belirler.
S  > [Processing Speed]: Grafik noktalarını seyrelterek çizimi hızlandırır.
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Konik Grafik Uygulaması
Konik Grafik uygulamasını, dahili Kartezyen, kutupsal veya parametrik fonksiyon denklemlerini kullanarak 
çeşitli konik eğri türlerini (parabol, çember, elips ve hiperbol) grafiklemek için kullanabilirsiniz.

İşlem Akışı

Örnek: Dahili Kartezyen koordinat fonksiyon denklemi X=AY+BY+C'yi kullanarak x = 2y + y − 1 
parabolünü grafiklemek için. Ardından, dahili kutupsal koordinat denklemi R=2Acos(θ)'i kullanarak 
r=4cosθ çemberini grafikleyin.

2

2.　Kartezyen'i vurgulayın ve ardından >    (veya O   ) tuşuna basın.
•　Bu, Kartezyen koordinat fonksiyonu denklemleri menüsüyle birlikte Denklem sekmesini görüntüler.

3.　[X=AY +BY+C] öğesini vurgulayın ve ardından >   (veya O  ) tuşuna basın.2

•　Bu, katsayı değerlerinin girişi için Kurulum sekmesini (sayfa 94) görüntüler. 

4.　 katsayılarının değerlerini girin.x 2y2 y − 1

2E
1E

s- (M )1E

5.　Grafiği çizmek için >    (veya O   ) tuşuna basın. 
•　Bu, Görüntüleme Penceresi menüsünü görüntüler. Aralık belirlemesini gerektiği gibi değiştirin. Daha 

fazla bilgi için, “Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” 
(sayfa 80) bölümüne bakın.

7.　Denklem türü menüsüne geri dönmek için <   (veya b   ) tuşuna üç kez basın.

8.　Kutupsal'ı vurgulayın ve ardından >   (veya O  ) tuşuna basın.
•　Bu, kutupsal koordinat fonksiyonu denklemleri menüsüyle birlikte Denklem sekmesini görüntüler.

9.　[R=2Acos(θ)] öğesini vurgulayın ve ardından >   (veya O  ) tuşuna basın.
•　Bu, katsayı değerlerinin girişi için Kurulum sekmesini (sayfa 94) görüntüler.

10.　r=4cosθ (r=2·2cosθ) katsayılarının değerlerini girin.

2E

1.　h  > Konik Grafik
•　Bu, denklem türleri (Kartezyen, Kutupsal, Parametrik) menüsünü 

görüntüler.

6.　Vurgulayın           ve ardından O   tuşuna basın.
•　Bu, grafiği Grafik sekmesinde (sayfa 94) çizer.
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11.　Grafiği çizmek için >   (veya O  ) tuşuna basın.

Kurulum Sekmesini Kullanma
Fonksiyon denklemlerinin katsayılarının değerlerini girmenin yanı sıra, Kurulum sekmesindeyken aşağıda 
açıklanan işlemleri gerçekleştirmek için Araçlar menüsünü de kullanabilirsiniz.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Görüntüleme aralığını belirle      > [View Window] öğesini seçin. Ayrıntılar için, “Grafik 

Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme
Penceresi)” (sayfa 80) bölümüne bakın.

Grafik çizimi için çizgi rengini değiştir T   > [Line Color] öğesini seçin. Görünen listeyi kullanarak bir 
renk seçin.

Grafik Sekmesini Kullanma
Grafik sekmesindeyken, aşağıda açıklanan işlemleri gerçekleştirmek için Araçlar menüsünü kullanabilirsiniz.

Bunu yapmak için: Bu menü öğesini seçin:            Detaylar:
Görüntüleme aralığını belirle T  > [View Window] “Grafik Penceresinin Görüntüleme 

Aralığını Belirleme (Görüntüleme 
Penceresi)” (sayfa 80)

Bir grafiğin x ekseni veya y ekseni 
kesişiminin veya diğer ana özellik 
noktalarının koordinatlarını elde et

T  > [Graph Solve] “Grafik Çözme'yi Kullanma (Grafik 
Çözme)” (sayfa 94)

Bir grafikte bir işaretçi görüntüle 
ve koordinat değerlerini oku

T  > [Trace] “İzlemeyi Kullanma (İzleme)” 
(sayfa 84)

Fonksiyonunun katsayı değerlerini 
değiştirerek bir grafiği değiştir

T  > [Modify] “Bir Grafiği Değiştirme (Değiştir)” 
(sayfa 96)

Görüntüyü yakınlaştır ve uzaklaştır T  > [Zoom] “Grafik Penceresi Yakınlaştırma 
Ayarını Değiştirme (Yakınlaştırma)” 
(sayfa 81)

Noktalar, çizgiler, karakterler vb. çiz T  > [Skecth] “Çizimi Kullanma (Çizim)” (sayfa 85)*
Bir penceredeki bir noktayı kap ve 
etrafında sürükle

T  > [Pan] “Bir Penceredeki Bir Noktayı Kapma 
ve Etrafında Sürükleme (Kaydırma)” 
(sayfa 81)

Arka plan görüntüsünü ayarla T  > [Fade I/O] “Grafik Penceresi Arka Plan 
Görüntüsünü Ayarlama 
(Solma G/Ç)” (sayfa 81)

*　Konik Grafik uygulamasının Çizim menüsü aşağıdaki öğeleri içermez. Teğet Çizgi, Normal Çizgi, Ters

Grafik Çözme'yi Kullanma (Grafik Çözme)
Şu anda görüntülenen grafik türüne bağlı olarak, belirli koordinat değerlerini (bir çemberin merkez noktasının 
koordinatları gibi) hesaplamak veya belirli çizgileri (bir parabolün doğrultmanı gibi) çizmek için Grafik Çözme'yi 
kullanabilirsiniz. Aşağıdaki tablo, Grafik Çözme ile neler yapabileceğinizi gösterir.

12.　Vurgulayın           ve ardından O   tuşuna basın.

•　Bu, grafiği Grafik sekmesinde (sayfa 94) çizer. 

94



Bunu yapmak için: T   > [Graph Solve] 
öğesini seçin ve 
ardından bunu seçin:

Parabol           Çember            Elips           Hiperbol

Odağı hesapla                 [Focus] Evet - Evet                 Evet
Doğrultmanı çiz               [Directrix] Evet - - -
Köşeyi hesapla                [Vertex] Evet - Evet                 Evet
Simetri eksenini 
çiz [Axis of Symmetry ]  Evet - - -

Odak kirişi uzunluğunu 
hesapla [Latus Rectum] Evet - - -

Merkezi hesapla              [Center] - Evet                Evet                Evet
Yarıçapı hesapla             [Radius] - Evet - -
Asimptotları çiz                [Asymptotes] - - - Evet
Dışmerkezliği 
hesapla [Eccentricity] Evet - Evet                Evet

x-ekseni kesişimini 
hesapla [x-Intercept] Evet               Evet                 Evet                Evet

y-ekseni kesişimini 
hesapla [y-Intercept] Evet               Evet                 Evet                Evet

Örnek: hiperbolünüy2 x2 = 1
Y 0 2

12
X 0 2

12 = 1 grafiklemek ve ardından köşelerini belirlemek için

1.　Tür sekmesinde, [Kartezyen] öğesini vurgulayın ve ardından O   tuşuna basın.

2.　[ Y K 2

A2
X H 2

B2 = 1] öğesini vurgulayın ve ardından O   tuşuna basın. .

3.　Kurulum sekmesinde, fonksiyonun katsayılarını girin. 

1E
1E
0E
0E

4.　      tuşuna basarak grafiği çizin.

6.　Grafik Çözme'den çıkmak için b   tuşuna basın.

Not
•　

•　Bir elipsin köşelerini hesaplarken r    tuşuna basmak, bir sonraki değeri hesaplayacaktır. l    tuşuna 
basmak, önceki değerler arasında geri kaydıracaktır. Bir elipsin dört köşesi vardır.

5.　T   > [Graph Solve] > [Vertex] öğesini seçin.
•　Bu, ilk köşenin koordinatlarında bir artı işaretçisinin (    ) ve 

pencerenin alt kısmında koordinat değerlerinin görünmesine 
neden olur.

•　İkinci köşeyi hesaplamak için l     veya r     tuşuna basın. l     veya  r 
tuşuna basmak, ilk köşeye geri döner.
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Bir elips veya hiperbol grafiği için iki odağı hesaplarken, ikinci odağı hesaplamak için      veya      tuşuna 
basın. l     veya       tuşuna basmak, ilk odağa geri döner.



Bir Grafiği Değiştirme (Modify)
Konik Grafik uygulaması ile, dahili bir fonksiyon denklemi seçebilir, katsayı değerlerini girebilir ve ardından 
bir grafik çizebilirsiniz. Grafik görüntülenirken katsayı değerlerini değiştirerek, her birinin grafiği nasıl 
etkilediğini gözlemleyebilirsiniz.

 

Örnek: Dahili Kartezyen koordinat fonksiyon denklemi Y=A(X−H) +K'yı kullanarak y = 2(x − 1) − 1 
parabolünü grafiklemek için. Ardından, denklem katsayıları A, H ve K'nın değerlerini değiştirirken 
grafiğin nasıl değiştiğini gözlemleyin.

2

1.　Tür sekmesinde, [Kartezyen] öğesini vurgulayın ve ardından O   tuşuna basın.

2.　[Y=A(X−H) +K] öğesini vurgulayın ve ardından O   tuşuna basın.2

3.　Kurulum sekmesinde, fonksiyonun katsayılarını girin.

2E
1E

s- (M )1E

4.　Grafiği çizmek için >   tuşuna basın.

6.　A'nın değerini değiştirmek için l    ve r    tuşlarını kullanın.
•　l    veya r    tuşlarına her basış, A'nın değerini adım değeri kadar değiştirir. Değer girmek için sayı tuşlarını 

da kullanabilirsiniz. 

7.　İşaretçiyi (   ) H'ye taşımak için d   tuşuna basın. H'nin değerini değiştirmek için l    ve r    tuşlarını kullanın.

8.　İşaretçiyi (   ) K'ye taşımak için d   tuşuna basın. K'nın değerini değiştirmek için l    ve r    tuşlarını kullanın.

9.　Değiştirmeden çıkmak için b   tuşuna basın.

5.　Değiştirmeyi etkinleştirmek için T   > [Modify] öğesini seçin.
•　A, H ve K'nın mevcut değerleri ve adım değeri, grafik 

penceresinin sol alt köşesinde görüntülenir. İşaretçinin (   ) 
şu anda bulunduğu değeri değiştirebilirsiniz.

•　İşaretçiyi (   ) yukarı ve aşağı hareket ettirmek için d   ve u 
tuşlarını kullanın.

96

2



3D Grafik Uygulaması (3D Graph)
3D Grafik uygulamasını, x-, y- ve z-koordinatlarını kullanarak üç boyutlu uzayda 3D grafikler çizmek için 
kullanabilirsiniz. Dahili şablonları kullanarak doğruları, düzlemleri, küreleri, silindirleri ve konileri grafikleyebilir 
veya doğrular, eğri yüzeyler, dönel cisimler ve diğer biçimleri çizmek için fonksiyonları manuel olarak 
girebilirsiniz.

 

İşlem Akışı

Grafik Çizmek İçin Dahili Bir Şablon Kullanma
Örnek 1: [Küre] > [ ] dahili şablonunu seçmek ve

küresinin 3D grafiğini çizmek için.

x2 + y2 + z2 = 22

4.　[ ] öğesini seçin.
•　Bu, şablonun sayısal değer giriş penceresini görüntüler.
•　 ifadesini grafiklemek istediğimiz için “x2 + y2 + z2 = 22

a=0, b=0, c=0 ve r=2 değerlerini girin.

0E 0E 0E 2E

6.　Kaydettiğiniz dahili bir şablonu kullanarak bir 3D grafik çizmek için >   tuşuna basın.
•　Bu, Görüntüleme Penceresi menüsünü görüntüler. Aralık belirlemesini gerektiği gibi değiştirin. Daha 

fazla bilgi için, “3D Grafik Çizimi İçin Uzaysal Aralığı ve Çizim Doğruluğunu Belirleme (Görüntüleme 
Penceresi)” (sayfa 102) bölümüne bakın.

1.　h  > 3D Grafik
•　Bu, Fonksiyon sekmesini görüntüler.

2.　Tür menüsünü görüntülemek için O   tuşuna basın (veya 
T   > [Enter Equation] öğesini seçin).

3.　Tür menüsünde, [Templates] > [Sphere] öğesini seçin.
•　Bu, bir küre şablonları listesini görüntüler.

5.　     tuşuna basınız.
•　Bu, girdiğiniz değerlerle birlikte şablon adını (Küre) görüntüler.

7.　Vurgulayın            ve ardından O   tuşuna basın.  
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8.　Fonksiyon sekmesine dönmek için >   veya b   tuşuna basın.
*　 Vurgulanan satır boşsa, Tür menüsünü görüntülemek için sadece O   tuşuna basın. Vurgulanan satır bir 

denklem içeriyorsa, T   > [Enter Equation] öğesini seçmeniz gerekir.

Grafik Çizmek İçin Manuel Olarak Fonksiyon Girme

Örnek 2: Yukarıdaki Örnek 1'den devam ederek, 2 2 − 3 ifadesini manuel olarak girmek ve aynı anda  
iki adet 3D grafik çizmek için.

2.　O   tuşuna basın. Görünen menüde, [Z=] öğesini seçin.
•　Alternatif olarak, T   > [Enter Equation] > [Z=] işlemini de gerçekleştirebilirsiniz.

3.　 2 2 − 3 ifadesini girin.

Xi+P- (Y)i- 3E

5.　Fonksiyon sekmesine dönmek için >   veya b   tuşuna basın.

Çizim Aralığı Dışında Grafik Uyarı Mesajı
Bir grafik çizmeye çalıştığınızda pencerede çizilecek hiçbir şey olmadığında, Çizim Aralığı Dışında uyarı 
mesajı görünür. Böyle bir durumda, görünen menüden istediğiniz işlemi seçin.

Bunu yapmak için: Bu menü öğesini seçin:
Görüntüleme Penceresi menüsünü görüntüle [View Window]
Görüntüleme Penceresi ayarlarını düzenlemeden grafik penceresini 
görüntüle (grafik çizmeden)  

[Cancel]

Fonksiyon Sekmesini Kullanma
3D grafik çizimi için kullanmak istediğiniz şablonları ve fonksiyonları Fonksiyon sekmesini kullanarak 
kaydedebilirsiniz. Toplamda en fazla üç şablon ve/veya fonksiyon kaydedebilirsiniz. Aşağıdaki örnek ekran, 
bir şablon ve iki fonksiyon kaydedildiğinde Fonksiyon sekmesini göstermektedir.

•　Bu, grafiği Grafik sekmesinde çizer.

1.　Fonksiyon sekmesinde "2:"yi vurgulamak için d   tuşunu kullanın.

4.　3D grafiği çizmek için >    tuşuna basın. Ardından, görünen Görüntüleme 
Penceresi menüsünde vurgulayın            ve ardından O   tuşuna basın.
•　Bu, grafikleri Grafik sekmesinde çizer. 
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3D Grafik Şablonlarını Kaydetme ve Düzenleme

Bir şablonu kaydetmek için
1.　Fonksiyon sekmesinde, bir şablon kaydetmek istediğiniz satırı vurgulayın.

3.　Kullanmak istediğiniz şablonu seçin.
•　Ne grafiklemek istediğinizi ve kullanmak istediğiniz grafikleme yöntemini seçmek için şablon menüsünü kullanın.

Bunu grafiklemek için: Bu menü öğesini seçin:

denklemiyle doğru− 0  = − 0  = − 0 [Line] > [ ]

vektör denklemiyle doğru (iki vektör)0 [Line] > [ ]

İki noktanın koordinatlarını belirterek doğru [Line] > [2 nokta üzerinden doğru]

Bir noktanın ve bir yön vektörünün koordinatlarını 
belirterek doğru [Line] >[

Nokta üzerinden (X0,Y0,Z0)
Yön vektörü [a,b,c]

]

 0 denklemini kullanarak düzlem [Plane] > [ ]

vektör denklemini kullanarak0

düzlem (üç vektör)
[Plane] > [ ]

Üç noktanın koordinatlarını belirterek düzlem       [Plane] > [3 nokta üzerinden düzlem]

denklemini kullanarak küre
− 2 − 2 − 2 2 [Sphere] > [ ]

denklemini kullanarak küre

2 2 2 0 [Sphere] > [ ]

Silindir [Cylinder]
Koni [Cone]

•　Yukarıdaki seçeneklerden herhangi birini seçmek, seçilen şablonun değerlerini girmek için bir pencere 
görüntüler.

4.　Seçtiğiniz şablona bağlı olarak, pencerede her hücreye (veya satıra) gerekli değeri girin.

5.　Tüm değerleri girdikten sonra, O   tuşuna basın. 
(3. adımda [Silindir] veya [Koni] öğesini seçtiyseniz, burada vurgulayın                ve ardından O   tuşuna basın.)
•　Bu, Fonksiyon sekmesine geri döner.

2.　T   > [Enter Equation] > [Templates] öğesini seçin.
•　Bu, Şablon Seçme menüsünü görüntüler.
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Not
•　4. adımda yapılan işlemlerin bir hataya neden olacağını unutmayın.

Bu şablon için: Bu tür bir giriş hataya neden olur:

[Line] > [ ] a=0 veya b=0 veya c=0

[Line] > [ ] için X, Y, Z elemanları = 0 v
[Line] > [2 nokta üzerinden doğru] Both points = Identical coordinate values

[Line] >[
Nokta üzerinden (X0 ,Y0,Z0)
 Yön vektörü [a,b,c]

]
Tüm yön vektörü elemanları = 0

[Plane] > [ ] a=0 ve b=0 ve c=0

[Plane] > [ ] •　 ‘den herhangi birinin veya her ikisinin 
de X, Y, Z elemanları = 0

u  ve v

•　u  ve v  = Aynı yönlendirme
[Plane] > [3 nokta üzerinden düzlem] •　Üç noktadan ikisi = Aynı koordinat 

değerleri
•　Üç nokta düz bir çizgi üzerindedir

[Sphere] > [ ] r = 0 veya daha az

[Sphere] > [ ] Girilen değerler a                    koşulunu 
sağlamıyor.

2+b2+c2>4d

[Cylinder] Yarıçap: 0 veya daha az
Zmin ve Zmax için aynı değer[Cone]

Bir şablonu düzenlemek için

1.　Düzenlemek istediğiniz şablonun bulunduğu satırı vurgulayın ve ardından O   tuşuna basın. 
•　Bu, şablonun sayısal giriş penceresini görüntüler.

2.　Mevcut değerlerde gerektiği gibi değişiklik yapın

3.　Her şey istediğiniz gibi olduktan sonra, O   tuşuna basın. 
(Bir [Silindir] veya [Koni] şablonu düzenliyorsanız, burada vurgulayın               ve ardından O   tuşuna basın.)

Bir şablonu silmek içinTo delete a template
Kaydedilmiş bir şablonu silmek için, Grafik&Tablo uygulamasının kaydedilmiş bir fonksiyonunu silmek için 
kullanılanla aynı işlemi kullanın. Ayrıntılar için “Bir fonksiyonu silmek için” (sayfa 78) bölümüne bakın.

 

3D Grafik Çizimi İçin Fonksiyonları Kaydetme ve Düzenleme

Bir fonksiyonu kaydetmek için
1.　Fonksiyon sekmesinde, bir fonksiyon kaydetmek istediğiniz satırı vurgulayın.

2.　T   > [Enter Equation] öğesini seçin.

3.　Aşağıdaki tabloda gösterilen işlemleri gerçekleştirin.

Bu fonksiyon tipini seçmek için: Bu menü öğesini seçin:
Kartezyen koordinat tipi (Z= f (X, Y) formu) [Z=]

Parametrik tip 
Xst＝ f S, T
Yst＝ f S, T
Zst＝ f S, T

 formu [Parametric]

X ekseninde dönel cisim (Y= f (X) formu)*1 [x-Axis Rotate]

Y ekseninde dönel cisim (Y= f (X) formu)*2 [y-Axis Rotate]

100



*1　Bu, Y=f(X) formatını kullanarak XY düzleminde girilen bir üç boyutlu grafiği çizer ve X ekseni etrafında 
360 derece döndürür.

*2　Bu, Y=f(X) formatını kullanarak XY düzleminde girilen bir üç boyutlu grafiği çizer ve Y ekseni etrafında 
360 derece döndürür.

4.　Seçilen türe göre fonksiyonu girin.
•　Seçtiğiniz fonksiyon türüne göre değişkenleri (X veya T) girmek için X   tuşuna basın.
•　Bir Z= form fonksiyonu için "Y" girmek üzere, P-(Y)       tuşuna basın veya C   tuşuna basın ve ardından 

görünen menüyü kullanarak girin. 
•　Parametrik tip bir fonksiyon için "S" girmek üzere, P/(S)       tuşuna basın veya C   tuşuna basın ve ardından 

görünen menüyü kullanarak girin.

Örnek 1: Kartezyen koordinat tipi                   'yi girmek için2 2

T  > [Enter Equation] > [Z=]
Xi+P- (Y)iE

Örnek 2: Parametrik tipi girmek için 
＝ 2
＝ 3
＝ 3

T  > [Enter Equation] > [Parametric]
2cX)E
3vX)E
3cX)E

Örnek 3: X ekseninde dönel cisim tipini                  'yi girmek için2 − 2
T  > [Enter Equation] > [x-Axis Rotate]

Xi- 2E

Not
•　4. adımda C   tuşuna bastığınızda görünen menüyü kullanarak yalnızca Mutlak Değer (sayfa 226) ve 

Hiperbolik Hesaplama (sayfa 237) kategorisindeki fonksiyonları girebilirsiniz.

Bir fonksiyonu düzenlemek veya silmek için
Kaydedilmiş bir fonksiyonu düzenlemek veya silmek için, Grafik&Tablo uygulamasındakiyle aynı işlemi 
kullanın. Daha fazla bilgi için “Bir fonksiyonu düzenlemek için” (sayfa 78) ve “Bir fonksiyonu silmek için
sayfa 78) bölümüne bakın. 
Grafik Çizim Ayarları (Çizgi Rengi, Alan Rengi)
Fonksiyon sekmesinde, değiştirmek istediğiniz grafik çizim ayarlarını içeren satırı vurgulayın ve ardından
aşağıdaki tabloda açıklanan işlemleri gerçekleştirin.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Grafik çizimi için çizgi rengini değiştir T   > [Line Color] öğesini seçin. Görünen listeyi kullanarak 

bir renk seçin.

Grafik çizimi için alan rengini değiştir T   > [Area Color] öğesini seçin. Görünen listeyi kullanarak 
bir renk seçin.

Belirlediğiniz çizgi rengi ve alan rengi, aşağıda gösterildiği gibi Fonksiyon sekmesinin her satırının solundaki 
simgelerle gösterilir.

Alan Rengi

Çizgi Rengi
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Grafik Çizme

Grafik çizmek için bir fonksiyon seçmek
1.　Fonksiyon sekmesinde, bir şablonun veya fonksiyonun kayıtlı olduğu satırı vurgulayın.

2.　T   tuşuna basın.
•　Bu, [Select] vurgulu bir Araçlar menüsü görüntüler.

3.　Seçili şablon veya fonksiyon için grafik çizimi etkinleştirmek üzere [Seç]'i (Açık)         konumuna, devre dışı 
bırakmak için ise (Kapalı)        konumuna getirin.

4.　Araçlar menüsünü kapatmak için b   tuşuna basın.
•　3. adımdaki açma/kapama ayarı, Fonksiyon sekmesinin her satırının solundaki simgelerle belirtilir.

… Açık … Kapalı

Fonksiyon sekmesinden Grafik sekmesine gitmek için (bir grafik çizmek için)
>   tuşuna basın veya vurgulayın               ve ardından O   tuşuna basın. Bu, grafik penceresinin aralığını 
belirleyebilmeniz için Görüntüleme Penceresi menüsünün  görünmesine neden olur. Aralık belirlemesini gerektiği 
gibi değiştirin. Daha fazla bilgi için, “3D Grafik Çizimi İçin Uzaysal Aralığı ve Çizim Doğruluğunu Belirleme 
(Görüntüleme Penceresi)” (sayfa 102) bölümüne bakın. 

 *1*2

.

Fonksiyon sekmesine dönmek için <   veya b   tuşuna basın.
*1　Görüntüleme Penceresi menüsünü Fonksiyon sekmesinde UO     tuşuna basarak da görüntüleyebilirsiniz.
*2　Grafik sekmesine giderken Görüntüleme Penceresi menüsünün görünmesini engellemek için S   > 

[Show V-Win Settings] ayarını kapalı konuma getirin.

Grafik Sekmesini Kullanma

Grafik Penceresini Ayarlama

Grafik penceresini yakınlaştırmak veya uzaklaştırmak için
Yakınlaştırmak için +   tuşuna veya uzaklaştırmak için -    tuşuna basın.

Bir 3D Grafiği manuel olarak döndürmek için
Bir 3D grafiği yukarı, aşağı, sola ve sağa döndürmek için imleç tuşlarını kullanın.

Not
•　Bir 3D grafiği otomatik olarak da döndürebilirsiniz. Bkz. “Bir 3D Grafiği Otomatik Döndürme (Döndürme)” 

(sayfa 106).

Grafik penceresine ince ayar yapmak için (Araçlar menüsü)
Bunu yapmak için: Bu menü öğesini seçin:            Ayrıntılar:
Görüntüleme aralığını belirle T  > [View Window] “3D Grafik Çizimi İçin Uzaysal Aralığı 

ve Çizim Doğruluğunu Belirleme (Gö-
rüntüleme Penceresi)” (sayfa 102)

Grafik penceresini yakınlaştır veya 
uzaklaştır

T  > [Zoom] “Grafik Penceresi Yakınlaştırma Aya-
rını Değiştirme (Yakınlaştırma)” (say-
fa 106)

3D Grafik Çizimi İçin Uzaysal Aralığı ve Çizim Doğruluğunu Belirleme (Görüntüleme 
Penceresi)
3D grafik çizimi için uzaysal aralığı (x-, y- ve z-ekseni aralıkları) ve çizim hassasiyetini belirlemek üzere 
Görüntüleme Penceresi menüsünü kullanabilirsiniz. Bu Görüntüleme Penceresi ayrıca, parametrik tip grafikler 
çizmek için değer aralığını ve bir 3D grafiğin bakış açısını belirlemenizi de sağlar.

Görüntüleme Penceresi menüsünü görüntülemek için
Grafik sekmesinde, T   > [View Window] öğesini seçin.
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Bir 3D grafik çizmek için koordinat aralığını ve çizim hassasiyetini belirlemek
Aşağıdaki öğeler için değerleri girmek üzere Görüntüleme Penceresi'ni kullanın.
•　x Minimum, x Maksimum, x Izgara ( x -ekseni minimum değer*1, maksimum değer*1, ızgara değeri*2*3)
•　y Minimum, y Maksimum, y Izgara ( y
•　z Minimum, z Maksimum ( z -ekseni minimum değer*1, maksimum değer*1)

Parametrik tip bir grafiğin her bir parametresi (S ve T) için aralığı ve çizim hassasiyetini belirlemek
Bu ayarlar, parametrik grafikler çizilirken uygulanır. Aşağıdaki öğeler için değerleri girmek üzere Görüntüleme 
Penceresi'ni kullanın.
•　S Minimum, S Maksimum, S Izgara (parametre S minimum değer*1, maksimum değer*1, ızgara değeri*2*3)
•　T Minimum, T Maksimum, T Izgara (parametre T minimum değeri*1, maksimum değer*1, ızgara değeri*2*3)

Grafik penceresinin bakış açısını ayarlamak
 x-ekseni ve z-eksenine göre grafik görünümünün bakış açısını ayarlamak için aşağıdaki ayarları kullanın. 
Mevcut S   > [Angle] (sayfa 215) açı birimi ayarından bağımsız olarak, her zaman derece cinsinden bir değer belirtin. 
Açı θ :  x-ekseninin pozitif ucundan (0°) bakıldığında, x-ekseninin saat yönünde dönüş açısını belirtir 

(−180°<θ<180°).
Açı φ : z-ekseninin pozitif ucundan (0°) ileriye bakıldığında, z-ekseninin arkaya doğru dönüş açısını belirtir 

(0°<φ<360°). 

Görüntüleme Penceresi ayarlarını başlatmak için
Görüntüleme Penceresi menüsünde, [Pre-Set Windows] > [Initialize] öğesini seçin.
 
*1　Minimum/maksimum değerleri, mutlak değerin 1×10   'den küçük olduğu aralıkta girin.98

*2　Bir ızgara değeri, 2≤ ızgara ≤50 aralığında girin.
*3　Izgara değeri, belirtilen çizim aralığında (minimum değerden maksimum değere) bir grafik çizmek için 

hesaplama noktalarının (bölüm sayısı) sayısını belirtir. Ancak, bir küre ve diğer bazı grafik formları söz 
konusu olduğunda, ızgara değeri çizim aralığının bölüm sayısı değil, grafiğin kendisinin bölüm sayısıdır.

Not
•
　
x Izgara ve y Izgara değerleri ne kadar büyükse, grafik o kadar ayrıntılı olur. Ancak, daha büyük 
değerlerin daha fazla hesaplama gerektirdiğini ve bunun da grafik çizme işleminin daha uzun sürmesi 
anlamına geldiğini de unutmayın.

•　x Izgara ve y Izgara değerleri çok küçükse, grafik çizimi imkansız olabilir.

Bir 3D Grafiğin Kesitini Görüntüleme
Bir 3D grafiğin x-, y- veya z-eksenine göre herhangi bir dikey düzlemle dilimlenmiş kesitini görüntüleyebilirsiniz. 
Bu işlem, bir şablon kullanılarak çizilen doğrular, düzlemler, küreler, silindirler veya koniler için kullanılabilir. 

Bir 3D grafiğin kesitini görüntülemek için
Halihazırda bir 3D grafik gösteren Grafik sekmesinde, aşağıdaki tabloda yer alan işlemleri gerçekleştirin.

Bunu yapmak için: T   > [Graph Solve] > [Draw Cross Sec-] 
tion] öğesini ve ardından bunu seçin:

x-eksenine dik bir düzlemle dilimlenmiş bir 3D grafiğin 
kesitini görüntüle.

[Cross X]

y-eksenine dik bir düzlemle dilimlenmiş bir 3D grafiğin 
kesitini görüntüle.

[Cross Y]

z-eksenine dik bir düzlemle dilimlenmiş bir 3D grafiğin 
kesitini görüntüle.

[Cross Z]

Örnek: "İşlem Akışı" (sayfa 97) bölümündeki Örnek 1 için grafiği çizilen kürenin x-eksenine dik bir düzlemde 
dilimlenmiş bir kesitini görüntülemek için. 
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T  > [Graph Solve] > [Draw Cross Section] > [Cross X]

Not
•　Bir düzlemle kesilmiş 3D bir grafiğin kesit çizgileri, "Alan Rengi" (sayfa 101) ayarında seçilen rengin 

tam zıt rengi ile vurgulanır. Ayrıca, kesitin bu dış çizgisi, grafikte her zaman en öndeki düzlemde
görüntülenir.

•　Düzlemsel bir grafik kesildiğinde, eğer düzlemsel grafik kesme işleminde kullanılan düzlemle 
örtüşüyorsa, düzlemsel grafiğin dış kenarlığı vurgulanır.

Belirli bir yönden kesiti görüntülemek için
Bir kesit görüntülenirken aşağıdaki işlemlerden birini gerçekleştirin.

Şunu yapmak için: Bu menü öğesini seçin:
Pozitif x yönünden görünümü göster T  > [View From pos x Direction]
Pozitif y yönünden görünümü göster T  > [View From pos y Direction]
Pozitif z yönünden görünümü göster T  > [View From pos z Direction]
Görünüm yönünü orijinal görünüme döndür T  > [Zoom Original]

3D bir grafiğin kesitini hareket ettirmek için
U   veya D   tuşlarına basarak ilgili eksendeki bir kesiti hareket ettirin. Ayrıca, ilgili eksendeki bir koordinat 
değerini doğrudan girerek bir kesitin konumunu belirtebilirsiniz.

Doğruların veya Düzlemlerin Kesişimini Belirleme (Yalnızca fx-CG100)
İki doğrunun kesişimini, bir doğru ile bir düzlemin kesişimini veya iki düzlemin kesişimini belirlemek için 
aşağıdaki işlemleri kullanabilirsiniz. Bu işlem, bir şablon kullanılarak çizilmiş doğrular ve/veya düzlemler 
üzerinde gerçekleştirilebilir.
Örnek 1: − 1

1
− 1
1  = − 1

-1   ve − 1
2  = − 1

2  = − 1
2

doğrularını grafikle çizmek ve kesiştikleri noktayı 

belirlemek için

1.　İki doğrunun denklemlerini kaydetmek için Fonksiyon sekmesi şablonlarını kullanın. 
 > [Enter Equation ] > [Templates] >

[Line] > [ ]

1E 1E 1E 1E 1Es- (M )1EE
 > [Enter Equation ] > [Templates] >

[Line] > [ ]

1E 1E 1E 2E 2E 2EE

2.　Grafiği çizmek için >   tuşuna basın.

Örnek 2: İki düzlem olan X+Z=0 ve X+Y=0'ı grafiklemek ve kesişimlerini belirlemek için

1.　İki düzlemin denklemlerini kaydetmek için Fonksiyon sekmesi şablonlarını kullanın. 

3.　T   > [Graph Solve] > [Intersection] öğesini seçin.
•　Bu, iki düzlemin kesişimini görüntüler. Kesişimin koordinatları, 

ekranın sol alt köşesinde gösterilir.
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 > [Enter Equation] > [Templates] >
[Line] > [ ]

1E 0E 1E 0EE
 > [Enter Equation] > [Templates] >

[Line] > [ ]
1E 1E 0E 0EE

2.　   tuşuna basarak grafiği çizin.

Not
•　İki 3D grafik kesişmiyorsa “BULUNAMADI” mesajı görünür.
•　Aşağıda açıklanan durumlarda “ÇAKIŞIK” mesajı görünür. 

-　Ele alınan iki doğru mükemmel şekilde hizalanmışsa
-　Ele alınan iki düzlem tamamen çakışıyorsa
-　Bir doğru ve düzlem ele alınıyorsa ve doğru düzlemin üzerindeyse

•　Üç doğru veya düzlem olduğunda, U  veya D  tuşuna basarak bunların nasıl birleştirileceğini 
değiştirebilirsiniz.

Doğrular veya Düzlemler Arasındaki İlişkiyi Belirleme (yalnızca fx-CG100)
Aşağıdaki kombinasyonları kullanarak iki 3D grafik arasındaki ilişkiyi belirleyebilirsiniz.

Bu kombinasyon için:             Bu tür ilişkileri belirleyebilirsiniz:
Doğru-doğru Kesişen, dikey, paralel, aykırı doğrular veya aynı doğru
Doğru-düzlem Kesişen, dikey, paralel veya doğru düzlemin üzerinde
Düzlem-düzlem Kesişen, dikey, paralel veya aynı düzlem

Bu işlem, bir şablon kullanılarak çizilen doğrular ve/veya düzlemler üzerinde gerçekleştirilebilir.

Örnek: r =
-1
-2
1

+ t
1
1
0

 doğrusunu ve  r =
1
2
0

+ s
1
1
0

+ t
0
1
1

düzlemini grafiklemek ve aralarındaki ilişkiyi 

belirlemek için

1.　Fonksiyon sekmesinde, doğrunun ve düzlemin denklemlerini kaydetmek için şablonları kullanın. 
 > [Enter Equation] > [Templates] >

[Line] > [ ]
s- (M )1Es- (M )2E 1E 1E 1E 0EE

 > [Enter Equation] > [Templates] >
[Plane] > [ ]

1E 2E 0E 1E 1E 0E 0E 1E 1EE

2.　Grafiği çizmek için >    tuşuna basın.

•　Ekranın sol alt köşesinde görünen ilişki mesajlarının anlamları aşağıdaki tabloda gösterilmiştir.

3.　T   > [Graph Solve] > [Intersection] öğesini seçin.
•　Bu, iki düzlemsel grafiğin kesişimini görüntüler. Kesişimin 

parametrik denklemi, ekranın sol alt köşesinde gösterilir.

3.　T   > [Graph Solve] > [Relationship] öğesini seçin.
•　Doğru ve düzlem arasındaki ilişkiyi belirten bir mesaj ekranın 

sol alt köşesinde görüntülenir. Bu örnekte, ilişki “PARALEL” 
olarak gösterilir.
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Mesaj Anlamı
INTERSECT Kesişen nokta veya doğrular

ORTHOGONAL Dikey kesişim
PARALLEL Paralel

SKEW LINES Aykırı ilişki
COINCIDENT  Aynı doğru

ON THE PLANE Doğru düzlemin üzerinde
COINCIDENT Aynı düzlem

Not
•　Üç doğru veya düzlem olduğunda, U  veya D   tuşuna basarak bunların nasıl birleştirileceğini 

değiştirebilirsiniz.

İzleme (Trace) Kullanma
İzleme, belirli bir konumdaki koordinat değerlerini okumak için kullanabileceğiniz bir artı işaretli imleç (    ) 
görüntüler. İzlemeyi etkinleştirmek için T   > [Trace] öğesini seçin.
İzleme işlevi etkinleştirilmişken gerçekleştirilebilecek işlemler aşağıdaki tabloda açıklanmıştır.

Bunu yapmak için: Bu işlemi gerçekleştirin:
İmleci grafik boyunca hareket ettir d   , u   ,      veya      tuşuna basın.
İmleci grafikte belirli bir x- ve y-koordinatına taşı Sayı tuşlarını kullanarak x-koordinatı ve y-koordinatı 

değerlerini girin ve ardından O    tuşuna basın 
(Z= grafikleri ve parametrik tip grafikler için)

Birden fazla grafik görüntülendiğinde imleci 
grafikler arasında hareket ettir

D   veya U   tuşuna basın. *

İzlemeden çık      tuşuna basın.

*　Ekranda yalnızca bir grafik varsa ve artı işaretli imleç (    ) görünüyorsa (T   > [Trace] öğesini 
seçtiğiniz için), D veya U tuşuna basmak imleci başlangıç konumuna geri döndürür.

Grafik Penceresi Yakınlaştırma Ayarını Değiştirme (Zoom)
Grafik penceresi içinde bunu yapmak için: T   > [Zoom] öğesini ve ardından bunu seçin: 

Pencerenin merkezini yakınlaştır veya uzaklaştır [Zoom In][Zoom Out]
Pozitif x-ekseni boyunca görünümü görüntüle [View From pos x Direction]
Pozitif y-ekseni boyunca görünümü görüntüle [View From pos y Direction]]
Pozitif z-ekseni boyunca görünümü görüntüle [View From pos  Direction]]
3D grafiği orijinal (döndürülmemiş, yakınlaştırılmamış) durumuna [Zoom Original]
döndür                                                                       

Bir 3D Grafiği Otomatik Döndürme (Rotate)
Otomatik Döndürme'yi kullanarak bir 3D grafiği otomatik olarak döndürebilirsiniz. Otomatik döndürme, iki 
döndürme işleminden sonra otomatik olarak durur..
1.　Grafik sekmesinde, T   > [Rotate] öğesini seçin.

2.　Görünen menüde, bir döndürme yönü seçin.
•　Otomatik döndürmeyi işlem sırasında durdurmak için a   tuşuna basın.
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Çizim (Sketch) Kullanma
Grafik alanı içinde noktalar ve metin çizmek için çizim özelliğini kullanabilirsiniz. Aşağıdaki tablo, çizim ile 
neler yapabileceğinizi göstermektedir.

Bunu yapmak için: T   > [Skecth] öğesini ve ardından bunu 
seçin: 

Çizim kullanılarak çizilen tüm noktaları ve metni temizle [Clear Screen]

Bir noktayı   çizme ve silme arasında değiştir*1 [Plot]

Metin yaz*1*2 [Text]

*1　Çizim noktaları ve metin, S   > [Plot/Line Color] (sayfa 218)  ayarına göre çizilir.
*2　Giriş, mevcut imleç konumundan başlayarak grafik penceresinin sağ kenarına kadar mümkündür. Giriş 

devam ederken I    tuşu işlemleri yok sayılır.

3D Grafik Uygulama Ayarları Menü Öğeleri
Aşağıda açıklanan Ayarlar menü öğeleri (sayfa 214), 3D Grafik uygulamasına özeldir.
S  > [3D Axes]: Grafik penceresinde Kartezyen koordinat eksenlerini gösterir/gizler.
S  > [Box]: Grafik penceresinde kutu eksenleri gösterir/gizler.
S  > [3D Label]: Grafik penceresinde eksen etiketlerini gösterir/gizler.
 

Örnek Ayarlar

3D Eksenler: Açık
Kutu: Açık

3D Etiket: Açık

3D Eksenler: Kapalı
Kutu: Açık

3D Etiket: Açık

3D Eksenler: Açık
Kutu: Açık

3D Etiket: Kapalı
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Özyineleme (Recursion) Uygulaması
Özyineleme uygulamasını, sayısal dizilerin genel terimleri veya iki veya üç terimli özyineleme formülleriyle 
çalışmak için kullanabilirsiniz. Bu uygulama bir özyineleme formülünden sayısal bir tablo oluşturur ve bir grafik 
çizer. Ayrıca, aynı tipteki iki özyineleme formülüne dayalı bir Faz Grafiği veya iki terimli özyineleme formüllerinin 
yakınsama veya ıraksamasını kontrol etmek için bir Ağ Grafiği de çizebilirsiniz.

İşlem Akışı
Örnek: İlk terimin    =1 ve ikinci terimin     =1 olduğu üç terimli özyineleme formülü (Fibonacci dizisi)

                           çin, n-değişkeninin değeri 1'den 6'ya değişecek şekilde bir sayısal tablo oluşturmak 
ve ardından bu sayısal tablonun bir grafiğini çizmek için:
un + 2 = un + 1 + un

u1 u2

1.　h  > Recursion
2.　Formül tipini, ilk terim tipini ve sayısal tablo alanını belirtin.

(1)　 Dizi sekmesinde, ilk satırı vurgulamak için u    tuşuna basın.
(2)　 O   tuşuna basın ve ardından görünen Kurulum menüsünü kullanarak aşağıda gösterilen ayarları 

yapılandırın.
•　[Type] > [u n+2]
•　[First Term] > [u1]
•　[Set Table Domain] > [Start]： 1 ; [End]： 6

3.　Dizi sekmesinde, un + 2 = un + 1 + un, u1 = 1, u2 = 1ifadelerini girin.

d 2. satırı (      ) vurgular.)un+2

C  > [Recursion] > [ un+1] +

C  > [Recursion] > [ un]
1
1

5.　Bir grafik çizmek için T   > [Graph Points] öğesini seçin.

6.　Sayısal tablo görüntüsüne geri dönmek için b   tuşuna basın.
•　<    tuşuna basmak, Dizi sekmesine geri döner.

Dizi Sekmesini Kullanma
Dizi sekmesinde, aşağıda gösterilen formül tiplerinden birini seçin ve formülü girin.

Bu formül tipi için:                    Bu formülü girin:
un Genel terim (En fazla üç tane: un, vn, wn)

un+1 İki terimli özyineleme formülü (En fazla üç tane:un+ 1, vn + 1, wn + 1)

4.　Sayısal tabloyu görüntülemek için >   tuşuna basın.
•　Sayısal tablo, Tablo sekmesinde görüntülenir.

(1)　        Görünen Görüntüleme Penceresi menüsünü kullanarak [Pre-set 
Windows] > [Standard] öğesini seçin.

(2)　 Sonra, vurgulayın           ve ardından O   tuşuna basın.
•　Bu, sayısal tablonun grafiğinin Tablo sekmesinde görünmesine 

neden olur.
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un+2 Üç terimli özyineleme formülü (En fazla üç tane:un + 2, vn + 2, wn + 2)

un,vn İki genel terim un ve vn

un,vn+1 Genel terim un ve iki terimli özyineleme formülü vn + 1

un+1,vn İki terimli özyineleme formülü un+ 1ve genel terim vn

un+1,vn+1 İki iki-terimli özyineleme formülü un + 1 ve vn + 1

Kurulum Menüsünü Kullanma

Kurulum menüsünü görüntülemek için

1.　Dizi sekmesinde, ilk satırı vurgulamak için u   tuşunu kullanın.
•　U  tuşuna basmak her zaman ilk satırı vurgular.

2.　O   tuşuna basın.

Formül tipini ve ilk terim tipini seçmek için
Bunu seçmek için: Kurulum menüsünden bunu seçin:
Genel terim (un) [Type] > [un]

İki terimli özyineleme formülü (un+ 1) [Type] > [un+1]

Üç terimli özyineleme formülü (un + 2) [Type] > [un+2]

İki genel terim un ve vn [Type] > [un,vn]

Genel terim unve iki terimli özyineleme formülü vn + 1 [Type] > [un,vn+1]

İki terimli özyineleme formülü un + 1ve genel terim vn [Type] > [un+1,vn]

İki iki-terimli özyineleme formülü un + 1 ve vn + 1 [Type] > [un+1,vn+1]

İlk terim tipi u0
* [First Term] > [u0]

İlk terim tipi u1
* [First Term] > [u1]

*　Formül tipi [un+1], [un+2], [un,vn+1], [un+1,vn] veya [un+1,vn+1] olduğunda ilk terim tipi belirtilmelidir.

Sayısal tablo alanını belirtmek için
1.　Kurulum menüsünden (sayfa 109), [Set Table Domain] öğesini seçin. 

2.　[Start] öğesini vurgulayın, bir başlangıç değeri (0 veya pozitif bir tam sayı) girin ve ardından      tuşuna basın.

3.　[End] öğesini vurgulayın, bitiş değerini* (başlangıç değerinden büyük pozitif bir tam sayı) girin ve ardından  
tuşuna basın.

4.　Menüyü kapatmak için b   tuşuna basın. 
*　 Başlangıç değeri artı 998'i aşan bir bitiş değeri belirtmeyin. Bitiş değeri 1×10   'ya eşit veya daha küçük 

olmalıdır.

 

6

Bir ağ grafiği çizmek için başlangıç koordinatlarını belirtmek üzere (Formül tipi:un+1)
Tablo sekmesinde bir ağ grafiği çizmeden önce, önceden çizim için başlangıç koordinatlarını (x-koordinatları) 
belirtin. Başlangıç koordinatlarını belirtmek için, Kurulum menüsünden (sayfa 109) [Ağ Grafiği Başlangıcını Ayarla] 
öğesini seçin. Ağ grafiği çizimi hakkında bilgi için, “Sayısal Bir Dizinin Yakınsama veya Iraksamasını Kontrol Etmek 
için Ağ Grafiği Kullanma” (sayfa 112) bölümüne bakın.

Özyineleme Formüllerini Girme ve Düzenleme

Bir özyineleme formülünü girmek veya düzenlemek için
•　Dizi sekmesinde, bir şey girmek istediğiniz satırı vurgulayın ve ardından girişe başlayın. Zaten girmiş olduğunuz 

bir şeyin bir kısmını düzenlemek için O   , r    veya l    tuşuna basın.
•　n, un, un + 1 (ve vn, vn + 1, wn, wn + 1) girmek için C   > [Özyineleme] öğesini kullanın.
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•　 gibi formül tipi için ilk terimi girin. Formül tipi [[un 1], [un,vn 1], [un 1,vn] veya [un 1,v     ]n 1 un 2] ise, ilk ve ikinci 
terimleri girin.

Not
•　Aşağıda açıklanan kısıtlamalar, formül tipi olarak [ un,vn], [un,vn 1], [un 1,vn] veya [               ] seçildiğindeun 1,vn 1

 geçerlidir.

Bu formül tipiyle:                    Bu tür bir giriş desteklenmez:
un,vn •　Sol taraftaki vn ifadesine un ve sol taraftaki

un

 ifadesine aynı andavn

 girişi
*1

•　 içeren bir ifadenin girişiw
*2

un,vn 1 •

1
•

un 1,vn •

•
un 1,vn 1 •

•

*1　Dizi sekmesinin kendisine giriş mümkündür, ancak bunu yapmak bir tablo oluşturmaya çalıştığınızda bir 
hataya (Döngüsel HATA) neden olur.

*2　Dizi sekmesinin kendisine giriş mümkündür, ancak bunu yapmak bir tablo oluşturmaya çalıştığınızda bir 
hataya (Sözdizimi HATASI) neden olur.

İki Terimli Bir Özyineleme Formülünü ve Genel Bir Terimi Aynı Anda Girme Örneği
Örnek:  İki terimli bir özyineleme formülü          ve bir genel terimden      oluşan aşağıdaki denklemi girmek için. 

Ardından, bir sayısal tablo oluşturun ve tabloyu grafiğe çizin.
un 1 vn

un 1
6un 2
un 5  (yine de u0 8)

vn
un − 2
un 1

1.　Dizi sekmesinde, ilk satırı vurgulamak için u   tuşuna basın.

2.　O   tuşuna basın. Ardından, görünen Kurulum menüsünü kullanarak aşağıda gösterilen ayarları yapılandırın.
•　[Type] > [ un 1,vn]
•　[First Term] > [u0]
•　[Set Table Domain] > [Start]： 1 ; [End]： 6

3.　Giriş yapın: un 1
6un 2
un 5  , u0 8 , vn

un − 2
un 1

d  (2. satırı (         vurgular.un 1)              )
e 6C  > [Recursion] > [ un] 2d

C  > [Recursion] > [un] 5E

8E
eC  > [Recursion] > [ un] 2d

C  > [Recursion] > [ un] 1E

4.　Sayı tablosunu görüntülemek için >   tuşuna basın.
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　Sol taraftaki vn ifadesine un ve sol taraftaki
u

 ifadesine aynı andavn

 girişi
*1

1

n
　 içeren bir ifadenin girişiw

*2

　Sol taraftaki v ifadesine u ve sol taraftaki
u

 ifadesine aynı andavn

 girişi
*1

n 1 n 1

　 içeren bir ifadenin girişiw
*2

　Sol taraftaki v ifadesine u ve sol taraftaki
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5.　Bir grafik çizmek için T   > [Graph Points] öğesini seçin.  

Bir özyineleme formülünü silmek için
“Bir fonksiyonu silmek için” (sayfa 78) bölümüne bakın.

Bir özyineleme formülünden çizilen grafiğin çizgi tipini ve çizgi rengini belirtmek için
“Grafik Çizim Ayarları (Çizgi Tipi, Çizgi Rengi)” (sayfa 78) bölümüne bakın.

Sayısal Bir Tablo Oluşturma
•　Dizi sekmesindeki özyineleme formüllerinden, T   > [Select]'i açık olanlar sayısal tablo oluşturmak için 

kullanılabilir. Mevcut açma/kapama ayarını, özyineleme formülünün solundaki simgeyi kontrol ederek 
belirleyebilirsiniz.

… Açık … Kapalı
•　Sayısal bir tablo oluşturmak için >   veya <   tuşuna basın veya vurgulayın            ve ardından O   tuşuna basın. 
•　S   > [   Display]'i açmak, her terim için sayısal tabloya kümülatif bir toplam sütunuΣ Σun, Σvn, Σwn).

Tablo Sekmesini Kullanma
Tablo sekmesi, bir sayısal tabloyu veya bir grafiği görüntüler. Dizi sekmesinden Tablo sekmesine geçtiğinizde, 
başlangıçta sayısal tablo görüntülenir. T   menüsünü kullanarak sayısal tablo görünümünden grafik görünümüne 
geçiş yapabilirsiniz.

Sayısal Tablo Görüntülenirken Yapılan İşlemler
Hücre vurgusunu hücreler arasında taşımak için imleç tuşlarını ve ayrıca U   ve D  tuşlarını kullanabilirsiniz. 
Ayrıca, T   menüsünden aşağıdaki işlemleri de gerçekleştirebilirsiniz. 

Bunu yapmak için: Bu menü öğesini seçin:
Oluşturulan tablonun alanını belirtin.*1 T  > [Set Table Domain]

Sayısal tablonun koordinatlarında*2 noktalar gösteren bir grafik 
çiz.

T  > [Graph Points]

Sayısal tablonun koordinatlarını*2düz çizgi segmentleriyle 
bağlayan bir grafik çiz.

T  > [Graph Points (Joined)]

Sayısal bir dizinin yakınsama veya ıraksamasını kontrol etmek 
için Ağ Grafiği'ni kullanın.*3

T  > [Web Graph]

İki özyineleme formülüne dayalı bir Faz Grafiği çiz.*4 T  > [Phase Graph]

Bir grafiğin görüntüleme aralığını belirtin.*5 T  > [View Window ]

Sayısal bir tablonun bir sütununu liste değişkenine kaydet. T  > [Store List]
Tüm sayısal tabloyu sil ve Dizi sekmesine geri dön. T  > [Delete]

*1　“Sayısal tablo alanını belirtmek için” (sayfa 109) bölümüne bakın.
*2　 Her koordinat, x-ekseni olarak sayısal tablo n-sütunundan ve y-ekseni olarak un/vn/wn-sütunundan oluşur.

•　Bu, sayısal tabloyu Tablo sekmesinde görüntüler.

(1)　 Görünen Görüntüleme Penceresi menüsünü kullanarak 
[Pre-set Windows] > [Standard] öğesini seçin.

(2)　 Ardından, vurgulayın            ve sonra O   tuşuna basın.
•　Bu, sayısal tablonun grafiğinin Tablo sekmesinde görünmesini 

sağlar.
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*3　Çizim, formül tipi un 1 olarak seçildiğinde mümkündür. “Sayısal Bir Dizinin Yakınsama veya Iraksamasını
 Kontrol Etmek için Ağ Grafiği Kullanma” (sayfa 112) bölümüne bakın..

*4　Çizim, formül tipi un, un 1, veya un 2 olarak seçildiğinde mümkündür. “İki Diziden Faz Grafiği Çizme” 
(sayfa 112) bölümüne bakın.

*5　“Grafik Penceresinin Görüntüleme Aralığını Belirleme (Görüntüleme Penceresi)” (sayfa 80) bölümüne bakın.

İki Diziden Faz Grafiği Çizme
İki özyineleme formülünden sayısal tablolar (diziler) oluşturabilir ve ardından bir formülün değerlerini yatay 
eksen, diğer formülün değerlerini ise dikey eksen olarak kullanarak bir Faz Grafiği çizebilirsiniz.
Örnek: İlk terimlerin sırasıyla                           olduğu iki iki terimli özyineleme formülü                      veun 1 0.9un

vn 1 vn 0.1n − 0.2
u1 1 ve v1 1 

 ifadelerini girmek için. Ardından, n değişkeninin değerini 1'den 10'a değiştiren
diziler oluşturun ve ardından dizileri kullanarak bir Faz Grafiği çizin.

1.　Dizi sekmesinde, ilk satırı vurgulamak için u   tuşuna basın.

2.　O   tuşuna basın ve ardından görünen Kurulum menüsünü kullanarak aşağıda gösterilen ayarları yapılandırın. 
•　[Type] > [un 1]
•　[First Term] > [u1]
•　[Set Table Domain ] > [Start]： 1 ; [End]： 10

3.　Dizi sekmesinde, un 1 0.9un, u1 1, vn 1 vn 0.1n − 0.2, v1 1 ifadelerini girin.

4.　Tablo sekmesine gitmek için >   tuşuna basın.

5.　T   > [Phase Graph] öğesini seçin.

6.　Görünen Görüntüleme Penceresi menüsünde, aşağıda gösterilen değerleri girin.
x Minimum = 0, x Maksimum = 2, x  Ölçek = 1
y Minimum = 0, y Maksimum = 4, y Ölçek = 1

Not
•　Faz Grafiği, un, un 1, veya un 2 formül tipi olarak seçildiğinde çizilebilir.
•　x-ekseni değerleri, Dizi sekmesi listesinde daha yukarıda olan formülün değerleridir; y-ekseni değerleri 

ise daha aşağıda olan formülün değerleridir.
•　Grafiği çizmek için kullanılan renk, Dizi sekmesi listesinde daha yukarıda olan formüle atanan 

renktir.
•　Üç özyineleme formülü ( un, vn, wn ) girildiyse ve üçü de sayısal tablo oluşturmak için seçildiyse, 

yukarıdaki 5. adımda, üçünden ikisini (un-vn, vn-wn, un-wn) seçmenizi isteyen bir menü görünecektir.
•　S   > [   Display] açık ise, yukarıdaki 5. adımda,    (dizi) veya      (dizilerin kümülatif toplamı) kullanarak 

grafik çizmek isteyip istemediğinizi seçmeniz için bir menü görünecektir.
un un

Sayısal Bir Dizinin Yakınsama veya Iraksamasını Kontrol Etmek için Ağ Grafiği Kullanma
Örneğin, 

y f (x) grafiğini çizin. Bunu, 45 derecelik bir eğime sahip düz bir çizgiyle (y=x grafiği) üst üste 
un 1 y ve un xcinsinden ifade edilebilen iki terimli bir özyineleme formülünde, 

olacak şekilde
un 1 ve un

getirin. Bu iki grafiği kullanarak otomatik olarak bir ağ grafiği çizebilirsiniz. 
Aşağıdaki örnek prosedürde [Ağ Grafiği]'ni seçmek, otomatik olarak            ) grafiğini çizer ve 45 derecelik bir 
eğime sahip düz bir çizgi çizer. Ardından, ağ grafiğini çizmek için       tuşuna art arda basmanız yeterlidir. Ağ 
grafiğinin davranışını gözlemleyerek, dizinin yakınsak mı yoksa ıraksak mı olduğunu sezgisel olarak 
kavrayabilirsiniz.

y f (x

7.　Vurgulayın           ve ardından O   tuşuna basın.
•　Faz Grafiği, Tablo sekmesinde görünür.
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Yakınsak Iraksak
Örnek: İki terimli özyineleme formülü denklemi olan                                                            girmek, bir 

ağ grafiği çizmek ve grafiğin yakınsak mı yoksa ıraksak mı olduğunu belirlemek için:
un + 1 = -3un

2 + 3un (ilk terim               )u0 = 0.01

1.　Dizi sekmesinde, ilk satırı vurgulamak için u   tuşuna basın.
2.　O   tuşuna basın ve ardından görünen Kurulum menüsünü kullanarak aşağıda gösterilen ayarları 

yapılandırın.
•　[Type] > [un+1]
•　[First Term] > [u0]
•　[Set Table Domain] > [Start] : 0 ; [End] : 6
•　[Set Web Graph Start] > [unStart] : 0.01*

*　Ağ grafiği çizimi için başlangıç noktasının x-koordinatını     ile aynı değerde yapın.u0

3.　Dizi sekmesinde, un + 1 = -3un
2 + 3un, u0 = 0.01 ifadelerini girin.

4.　Tablo sekmesine gitmek için >   tuşuna basın. 

5.　T   > [Web Graph] öğesini seçin.

6.　Görünen Görüntüleme Penceresi menüsünde, aşağıda gösterilen değerleri girin.
x Minimum = -0.52, x Maksimum = 1.52, x Ölçek = 1
y Minimum = 0, y Maksimum = 1, y Ölçek = 1

8.　O   tuşuna basın.
•　Bu, ağ grafiğinin başlangıç noktasında bir artı işaretli imlecin (    ) yanıp sönmesine neden olur.

Not
•　Ağ grafiği, formül tipi        olarak seçildiğinde çizilebilir.un+1

•　Yukarıda çizilen y=f(x) grafiğinin çizgi tipini ve çizgi rengini belirleyebilirsiniz. Ayrıntılar için, “Grafik 
Çizim Ayarları (Çizgi Tipi, Çizgi Rengi)” (sayfa 78) bölümüne bakın. 

7.　Vurgulayın           ve ardından O   tuşuna basın.
•　Bu,                             grafiğini çizer ve 45 derecelik bir eğime sahip 

düz bir çizgi çizer. 
un + 1 = -3un

2 + 3un

9.　O   tuşuna 20 kez basın.
•　Her O   tuşuna basışınızda, ağ grafiğinin düz çizgileri çizilir. Grafik, 

sayısal dizinin yakınsak olduğunu gösterir.
•　Ağ grafiği çiziminden çıkmak için b   tuşuna basın.
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Grafik Görüntülenirken Yapılan İşlemler
Bunu yapmak için: Bu menü öğesini seçin:   Detaylar:

Görüntüleme aralığını belirtin T  > [View Window] 
“Grafik Penceresinin Görüntüleme 
Aralığını Belirleme (Görüntüleme 
Penceresi)” (sayfa 80)

Bir grafikte bir imleç görüntüle ve 
koordinat değerlerini oku T  > [Trace] “İzleme (Trace) Kullanma” (sayfa 84)

Görünümü yakınlaştır ve uzaklaştır T  > [Zoom]
“Grafik Penceresi Yakınlaştırma 
Ayarını Değiştirme (Zoom)” (sayfa 81)

Nokta, çizgi, karakter vb. çiz T  > [Sketch] “Çizim (Sketch) Kullanma” (sayfa 85)

Bir pencerede bir noktayı tut ve 
görünüm etrafında sürükle T  > [Pan]

“Bir Pencerede Bir Noktayı Tutma ve 
Görüntü Ekranı Etrafında Sürükleme 
(Pan)” (sayfa 81)

Arka plan görüntüsünü ayarla T  > [Fade I/O]
“Grafik Penceresi Arka Plan 
Görüntüsünü Ayarlama (Fade I/O)” 
(sayfa 81)

Sayısal Bir Tabloyu ve Grafiği Aynı Anda Görüntüleme
S   > [Table with Graph] açık olduğunda, sayısal tablo penceresi Tablo sekmesinin sağında, grafik penceresi ise 
solunda görüntülenir. 

•　Dizi sekmesinden Tablo sekmesine geçtikten hemen sonra grafik penceresinde hiçbir şey çizilmez. Grafiği 
çizmek için aşağıdaki işlemleri kullanın:
-　T   > [Switch Active Window] öğesini seçin.
-　T   'den, bir grafik çizmek için menü öğesini seçin.

•　T   > [Switch Active Window] öğesini her seçtiğinizde, etkin pencere (yaptığınız işlemlerden etkilenen 
pencere) sayısal tablo penceresi ile grafik penceresi arasında değişir. İmleç sayısal tabloda görüntülendiğinde
sayısal tablo penceresi etkindir.

•　Sayısal tablo penceresi etkin durumdayken, “Sayısal Tablo Görüntülenirken Yapılan İşlemler” (sayfa 111) 
bölümünde açıklanan işlemleri gerçekleştirebilirsiniz. Grafik penceresi etkin durumdayken, Kaydırma ve 
Solma G/Ç dışındaki “Grafik Görüntülenirken Yapılan İşlemler” (sayfa 114) bölümündeki işlemleri 
gerçekleştirebilirsiniz.
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Denklem (Equation) Uygulaması
Denklem uygulamasını, eşzamanlı doğrusal denklemleri (iki ila altı bilinmeyenli) ve yüksek dereceli denklemleri 
(2 ila 6 derece) çözmek için kullanabilirsiniz. Ayrıca, bir denklemi herhangi bir değişken için çözen bir Çözücü 
fonksiyonuna da sahiptir.

Eşzamanlı Doğrusal Denklemleri Çözme

Örnek: Aşağıdaki denklemleri x ve y için çözmek için:
2x − y 5

x＋ 2y 10

1.　h  > Equation

2.　Tür sekmesinde, [Simultanious] öğesini seçin ve ardından >   veya O   tuşuna basın.

3.　Bilinmeyenler sekmesinde, bilinmeyen sayısını seçin ve ardından >   veya O   tuşuna basın.
•　Burada iki bilinmeyenimiz (x ve y) var, bu yüzden [2 Bilinmeyen] öğesini seçiyoruz.

4.　Düzenleyici sekmesinde, denklemin katsayılarını girin.

2Es- (M )1E 5E
1E 2E 10E

*　S   > [  π Result] açık olduğunda, mümkünse sonuçlar π ve    kesirli biçimde (mümkün değilse ondalık 
biçimde) görüntülenir.
S   > [  π Result] kapalı olduğunda ise, sonuçlar yalnızca ondalık biçimde görüntülenir.

Not
•　Sonsuz çözümler olduğunda "Sonsuz Çözüm" mesajı görüntülenir.
•　Hesap makinesi, doğrusal bir denklem sistemini çözmek için katsayı matrisi M'nin ters matrisini (M  ) 

kullanır. Bu nedenle, katsayı matrisi M'nin determinantı (Det(M)) 0'a yaklaştıkça doğruluk azalabilir.

-1

Yüksek Dereceli Denklemleri Çözme
Örnek: denklemini çözmek için: x2 2x − 2 0

1.　h  > Equation

2.　Tip sekmesinde, [Polinom] öğesini seçin ve ardından >   veya O   tuşuna basın.

3.　Derece sekmesinde, denklemin derecesini seçin ve ardından >   veya O   tuşuna basın.
•　Bir ikinci dereceden denklemi çözdüğümüz için, burada [a2X2+a1X+a0=0] öğesini seçiyoruz.

4.　Düzenleyici sekmesinde, denklemin katsayılarını girin.

5.　Denklemleri çözmek için >   veya O   tuşuna basın.
•　Bu, x ve y için çözümleri Sonuç sekmesinde görüntüler.

Geçerli imleç konumundaki hücredeki değerlere ilişkin ayrıntılar, 
pencerenin sağ alt köşesinde gösterilir.*
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1E 2Es- (M )2E

*　S   > [   π Result] açık olduğunda, mümkünse sonuçlar kesirli    ve π biçiminde (mümkün değilse ondalık 
biçimde) görüntülenir. S   > [   π Result] kapalı olduğunda ise, sonuçlar ondalık biçimde görüntülenir.

Not
•　Denklemin birden fazla çözümü varsa, çözüm sayısı sağda görüntülenir.

Örnek: denkleminin çözümüx3 3x2 3x 1 0

Denklem birden fazla çözüme sahip olduğunda, yüksek dereceli denklem hesaplamaları doğru 
sonuçlar üretmeyebilir veya bir hataya neden olabilir.

•　Denklemin sanal bir çözümü varsa, çözüm S   > [Complex Mode] ayarı tarafından belirtilen biçimde ,
görüntülenir.

•　Sonuç sekmesinde S      tuşu işlemi yok sayılır. S      tuşunu Düzenleyici sekmesinde kullanın.

Çözücüyü Kullanma
Denklemi dönüştürmek veya düzenlemek zorunda kalmadan, denkleme dahil olan herhangi bir değişkenin 
değerini bulabilirsiniz.
Örnek: Bir nesnenin, ilk hızı V ile havaya fırlatıldığını ve T süre sonra H yüksekliğine ulaştığını varsayalım. 

H = 14 (m), T = 2 (saniye) ve yerçekimi ivmesi G = 9.8 (m/s  ) olduğunda, aşağıdaki denklemi kullanarak 
ilk hız V'yi belirleyin.

2

− 1
2

2

1.　h  > Equation

2.　Tür sekmesinde, [Çözücü] öğesini seçin ve ardından >   veya O   tuşuna basın.

3.　Kurulum sekmesinde, denklemi Eq satırına girin.

H = VT -e 1d 2r  GT i

4.　O   tuşuna basın.
•　Bu, denkleme dahil olan değişkenlerin bir listesini görüntüler.

5.　Hangi değişken için çözüm yapmak istediğinizi belirtin.
(1)　 Çözüm için iletişim kutusunu görüntülemek üzere O   tuşuna basın.
(2)　 İlk hız V'yi elde etmek için [V] öğesini seçin ve ardından O   tuşuna basın.

6.　Sırasıyla H=14, T=2 ve ardından G=9.8 değerlerini girin.

5.　Denklemi çözmek için >   veya O   tuşuna basın. 
•　Bu, x için çözümü Sonuç sekmesinde görüntüler. Hücredeki 

geçerli imleç konumundaki değerlere ilişkin ayrıntılar, pencerenin 
sağ alt köşesinde gösterilir.*

116



14E 0E *2E 9. 8E

 

*　Çözülecek değer, ilk tahmin değeridir. Burada, 
ilk tahmin değeri 0'dır.

•　“Üst Limit=” ve “Alt Limit=” satırlarına, gerekirse, istenen çözümün üst ve alt limitlerini girin.

Not
•　x ve X aynı değişken olarak kabul edilir.
•　3. adımdaki “Eq” satırına “=” işareti olmadan bir ifade girerseniz, ifadenin “ifade = 0” olduğu varsayılır.
•　Grafik&Tablo uygulamasına kaydedilmiş fonksiyonlar “Eq” satırına girilebilir. Bunun için T   > 

[Recall] öğesini seçin, girmek istediğiniz fonksiyonu vurgulayın ve ardından O   tuşuna basın. 
•　Çözücü, çözümleri bulmak için Newton'ın yaklaşım yöntemini kullanır. Newton'ın yöntemiyle yapılan 

hesaplama gerçek çözüme göre bir hata verebileceğinden “Sol=” ve “Sağ=” değerleri görüntülenir. 
“Sol=” ve “Sağ=” değerleri arasındaki fark 0'a ne kadar yaklaşırsa, hesaplama sonuçlarındaki hata o 
kadar küçülür.

•　Hesap makinesi, görüntülenen sonuçlar için yakınsamanın yeterli olmadığına karar verdiğinde 
ekranda <              düğmesi belirir.

•　Çözücü yalnızca tek bir çözüm elde eder. Yüksek dereceli bir denklemin a                           birden 
fazla çözümünü elde etme hakkında bilgi için “Yüksek Dereceli Denklemleri Çözme” (sayfa 115) 
bölümüne bakın.

x2+bx+c=0 gibi),

7.　>   tuşuna basın. Veya seçin                ve ardından O   tuşuna basın. 
•　Bu, hesaplama sonuçlarını Sonuç sekmesinde görüntüler.
•　“Sol=” ve “Sağ=” bölümleri, elde edilen sonuç ile denklemin sol ve 

sağ tarafının hesaplanmış sonuçlarıdır.
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Sayısal Eşitsizlik Uygulaması (Sadece fx-CG100)
Sayısal Eşitsizlik Uygulamasını (Num Ineq), 2., 3. veya 4. dereceden bir eşitsizliği çözmek için kullanabilirsiniz.

İşlem Akışı

Örnek: eşitsizliğini çözmek için:x2 2x − 3
4 ≥ 0

3.　Tür sekmesinde, eşitsizlik sembolü tipini ve yönünü (>, <, ≥, ≤) seçin.

•　Burada                                                                                                                                             
ardından O   tuşuna basın.          

x2 2x − 3
4 ≥ 0, ifadesini çözmek istiyoruz, bu yüzden [a2X2+a1X+a0≥0] öğesini seçin ve 

1E 2Es- (M )3e 4E

d

*　S   > [  π Result] açık olduğunda, mümkünse sonuçlar kesirli    ve π biçiminde (mümkün değilse ondalık biçimde) 
görüntülenir.
     > [   π Result] kapalı olduğunda ise, sonuçlar yalnızca ondalık biçimde görüntülenir.

Not
•　Bir eşitsizlik için çözüm olmadığında (örneğin x 2 < 0) Sonuç sekmesinde “Çözüm Yok” mesajı görünür.
•　Bir eşitsizliğin çözümü tüm sayılar olduğunda (örneğin

Değerleri” mesajı görünür.
x2 ≥ 0) Sonuç sekmesinde “X'in Tüm Gerçek 

•　Sonuç sekmesinde S     tuşu işlemi yok sayılır. S     tuşunu Düzenleyici sekmesinde kullanın.

1.　h  > Sayısal Eşitsizlik (Num Ineq)
•　Bu, Derece sekmesini görüntüler. 

2.　Derece sekmesinde,
tuşuna basın. 

   [a2X2+a1X+a0], öğesini seçin ve ardından O   

•　Bu, Tür sekmesini görüntüler.

4.　Görünen Düzenleyici sekmesinde, katsayı değerlerini girin. 

5.　>   veya      tuşuna basın.
•　Bu, çözümü Sonuç sekmesinde görüntüler. Geçerli imleç 

konumundaki hücredeki değerlere ilişkin ayrıntılar, pencerenin sağ 
alt köşesinde gösterilir.*
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Python Uygulaması
Python uygulaması, bu hesap makinesinde çalışacak şekilde uyarlanmış olan MicroPython Sürüm 1.9.4'ü 
destekler.

Önemli!
•　Genel olarak, MicroPython'ın bir bilgisayarda çalışan Python'dan farklı olduğunu unutmayın. Ayrıca, 

Python uygulaması MicroPython'ın tüm fonksiyonlarını, komutlarını, modüllerini ve kütüphanelerini 
desteklemez.

•　Python uygulaması, yürütmeleri MicroPython işleme sistemini kullanarak gerçekleştirir. Bu nedenle, bu 
uygulama tarafından üretilen hesaplama sonuçları ve diğer veriler, diğer fonksiyon uygulamalarının 
yürütme sonuçlarından farklılık gösterebilir.

İşlem Akışı
Örnek: Aşağıda gösterilen betiği oluşturmak ve ardından yürütmek için:

Giriş Anlamı
def f(x,y,z):

if x>0:
t=x+y+z

else:
t=x-y-z

return(t)

f adında, x, y ve z argümanlarına sahip kullanıcı tanımlı bir fonksiyonu tanımlar.
Eğer x değişkeni 0'dan büyükse,
t değişkenini x+y+z işleminin yürütme sonucu olarak tanımlar.
Aksi takdirde (eğer x değişkeni 0 veya daha az ise),
t değişkenini x-y-z işleminin yürütme sonucu olarak tanımlar.
t'yi geri dönüş değeri yapar.

1.　h  > Python
•　

4.　Kullanıcı tanımlı f fonksiyonunu arayın ve ardından sırasıyla x,y ve z argümanları için 1, 2 ve 3 değerlerini 
girin.

(1)　 Değişkenler menüsünü görüntülemek için V   tuşuna basın.
(2)　 f(,,) öğesini seçin ve ardından O   tuşuna basın. 
(3)　  f argümanları olarak 1, 2 ve 3 değerlerini girin.

6.　Düzenleyici'ye dönmek için b   tuşuna basın.

2.　Metni girin.
•　Giriş işlemleri hakkında bilgi için, “Uygulama Alfa Karakteri ve 

Sayısal Giriş” (sayfa 9) ve “Giriş İşlemleri (Düzenleyici ve 
Kabuk için Aynı)” (sayfa 121) bölümlerine bakın. .

3.　Ortaya çıkan betiği yürütmek için >   tuşuna basın.
•　Bu, module.py dosyasını Kabuk'a (Shell) içe aktarır..

5.　    tuşuna basarak f(1,2,3) ifadesini yürütün.
•　x>0 olduğu için t=x+y+z(=1+2+3) işlemi yürütülür ve t=6 değeri 

geri döndürülür.
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Düzenleyiciyi Kullanma
Ana (HOME) ekrandan Python uygulamasına girdiğinizde göreceğiniz ilk şey Düzenleyici'dir. Python 
uygulamasına girdikten hemen sonra “module.py” adlı bir .py dosyası her zaman otomatik olarak açılır.

Betikleri (Scripts) Oluşturma ve Düzenleme
Betiğinizi doğrudan “module.py” dosyasına girebilir veya aşağıdaki işlemleri gerçekleştirerek başka bir .py 
dosyasını düzenleyebilirsiniz.
Bunu yapmak için: Bu menü öğesini seçin:
Şu anda açık olan dosyayı kapatın ve yeni bir dosya 
oluşturun. T  > [File] > [New]
Şu anda açık olan dosyayı kapatın ve başka bir 
dosya açın. T  > [File] > [Open]
Şu anda açık olan dosyayı farklı bir adla kaydedin. T  > [File] > [Save as]

Python uygulaması her dosya için 255 karakter × 300 satıra kadar (metin, fonksiyonlar, komutlar) giriş 
yapmanıza olanak tanır. Metin, fonksiyon ve komutları Düzenleyici'ye girme hakkında bilgi için, “Giriş İşlemleri 
(Düzenleyici ve Kabuk için Aynı)” (sayfa 121) bölümüne bakın.

Alfa Kilidini Açma ve Kapatma
Python uygulamasına her girdiğinizde, Düzenleyici'nin alfa kilidi ayarı küçük harflerdir ve bu durum çubuğunda 
      ile belirtilir. Alfa kilidi ayarını büyük harf girişine değiştirmek için P   tuşuna basın. Bu işlem, durum 
çubuğunda       görünmesini sağlar. Alfa kilidini açmak için P   tuşuna tekrar basın.

Düzenleyici İçinde Betikleri Kopyalama veya Kesme
1.　İmleci kopyalamak veya kesmek istediğiniz aralığın başlangıcına getirin.

2.　    tuşuna basın.
•　Bu, 4. adımda O   tuşuna basana kadar durum çubuğunda      görünmesini sağlar.

3.　İmleci, kopyalamak veya kesmek istediğiniz veri aralığının sonuna getirin.

4.　O   tuşuna bastığınızda görünen menüden [Kopyala] veya [Kes] öğesini seçin.
•　İsterseniz bitiş noktasını önce belirtebilirsiniz.

Düzenleyici İçinde Kopyalanmış veya Kesilmiş Bir Betiği Yapıştırma
1.　Giriş imlecini betiği yapıştırmak istediğiniz konuma getirin.

2.　 tuşuna basın.

İmleci Belirli Bir Satıra Taşıma
T   > [Jump] öğesini seçin. Görünen iletişim kutusunu kullanarak taşıma hedefini belirten bir satır numarası girin.

Şu anda açık olan .py dosyasını kaydetmek ve önceki sürümünün üzerine yazmak için
T   > [File] > [Save] öğesini seçin.

Düzenleyici'deki tüm betikleri silmek için
a   tuşuna basın veya T   > [Delete All] öğesini seçin.

Bir .py Dosyasını Silmek İçin

1.　T   > [File] > [Delete] öğesini seçin.

2.　Görünen dosya listesini kullanarak silmek istediğiniz dosyayı seçin ve ardından O   tuşuna basın.

3.　Görünen onay iletişim kutusuna yanıt olarak [Tamam] öğesini seçin..
•　Bu işlemi, şu anda açık olan bir dosyayı silmek için kullanamazsınız.
•　“module.py” dosyasını silerseniz, Python uygulamasını bir sonraki başlatışınızda otomatik olarak yeni 

bir “module.py” dosyası oluşturulacak ve açılacaktır.

Bir Betiği Yürütme
Şu anda Düzenleyici'de görüntülenen betiği yürütmek için aşağıdaki işlemi kullanın.
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1.　>   (veya <   ) tuşuna basın veya T   > [Run] öğesini seçin.
•　Betik (.py dosyası) zaten kaydedilmişse, bu sizi Kabuk'a (Shell) yönlendirir ve betiği yürütür.

2.　Betik (.py dosyası) kaydedilmemişse, görünen iletişim kutusunu kullanarak bir işlem seçin.

Bunu yapmak için: Bu öğeyi seçin:
.py dosyasını kaydedin, Kabuk'a gidin ve bir betik yürütün [Yes]
.py dosyasını kaydetmeden Kabuk'a gidin ve bir betik yürütün [No]
Betiği yürütmeden Düzenleyici'ye dönün [Cancel]

Giriş İşlemleri (Düzenleyici ve Kabuk (Shell) için Aynı)
Karakter Seçim Menüsünü Kullanarak Karakter Girme
Karakter listesini Düzenleyici'nin alt kısmında görüntülemek için T   > [Character Select] öğesini seçin. 

Bu listeyi alfa karakterleri, semboller ve operatörleri girmek için kullanabilirsiniz. Bir karakter girmek için, 
imleç tuşlarını kullanarak vurguyu girmek istediğiniz karaktere getirin ve ardından O   tuşuna basın. Karakter 
listesini gizlemek için b   veya a   tuşuna basın.

Tuşları Kullanarak Karakter ve Fonksiyon Girme
Aşağıdaki tablo, tuşları kullanarak girebileceğiniz karakterleri ve fonksiyonları gösterir.

Tuş             Giriş Karakteri             Tuş               Giriş Karakteri            Tuş              Giriş Karakteri
0 ‘dan      ’a9 0’dan 9’a ` ， s` (:) :

i **2 / * sv (sin-1) asin()

g ** * / sc (cos-1) acos()

X x + ＋ st (tan-1) atan()

v sin() - － s( (=) =

c cos() k s4 ([) [

t tan() j s5 (]) ]

( ( N s7 (π) pi

) ) sN log() s9 (i) 1j

. ． si (log) log10()   

Düzenleyici'de Giriş Sırasında Otomatik Tamamlama
Düzenleyici'ye giriş yaparken otomatik tamamlama etkindir. Alfa karakterleri girmek, ilgili aday komutların 
ekranda görünmesini sağlar.
Aday girişler görüntülenirken aşağıdaki işlemleri gerçekleştirebilirsiniz.

Bunu yapmak için: Şunu yapın:
Adaylar arasında gezinin (birden fazla aday varken) d    /      tuşlarını kullanın.

Şu anda görüntülenen adayı girin       veya O   tuşuna basın.
Aday girişlerin görüntülenmesini durdurun       tuşuna basın. (Bu, imlecin bir karakter geri 

hareket etmesine neden olur.)
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Not
•　Otomatik tamamlama fonksiyonu yalnızca C   tuşuna basıldığında görünen menüdeki komutları görüntüler.
•　Otomatik tamamlama devre dışı bırakılamaz.

Komutları ve Fonksiyonları Katalog Menüsünden Girme
1.　Girmek istediğiniz öğe için menüyü seçin.

Bunu girmek istediğinizde: Bu menü öğesini seçin:
Yerleşik Python komutları ve fonksiyonları  > [Built-In]
math modülü komutları ve fonksiyonları  > [math]
random modülü komutları ve fonksiyonları  > [random]
matplotlib.pyplot modülü komutları ve fonksiyonları  > [matplotlib.pyplot]
turtle modülü komutları ve fonksiyonları  > [turtle]
casioplot modül (sayfa 137) komutları ve fonksiyonları  > [casioplot]
Semboller ve operatörler  > [Symbol]
Alfabetik bir listedeki komutlar ve fonksiyonlar  > [All] > [a] ila [z]

•　Bu, öğelerin bir listesini görüntüler.

2.　Girmek istediğiniz öğeyi vurgulayın ve ardından O   tuşuna basın. 
•　Öğenin adının ilk karakterlerini girmek için XA   ila 0Z   tuşlarını kullanarak listedeki bir öğeye 

atlayabilirsiniz.
A

Yeni Satırda Otomatik Girinti
Düzenleyici'de bir betiği düzenlerken      tuşuna basmak yeni bir satır oluşturur.
•　Bir satırın sonundaki iki noktadan (:) sonra      tuşuna basmak, yeni satırın başına iki boşluk daha ekler 

(Otomatik Girinti).
•　Girintili bir satırdayken      tuşuna basmak, yeni satıra aynı girintiyi (boşluk) ekler.

İfade Bloğu Girişi
Düzenleyici'ye giriş yaparken, Katalog menüsünden “if:else” veya “for:range()” gibi çok satırlı bir sözdizimine 
sahip bir komut seçmek, satır sonları ve boşluklar içeren bir deyim bloğu girer.
Örnek: “□” sembolünün bir boşluğu gösterdiği, aşağıda gösterilen çok satırlı bağlamı eklemek için “if:else” 

öğesini seçin.
if□:
□□
else:
□□

Kabuk'a (Shell) giriş yaparken, bloğun yalnızca ilk satırı girilir.

Kullanıcı Tanımlı Değişkenleri ve Fonksiyonları Girme

1.　V   tuşuna basarak Değişkenler menüsünü görüntüleyin.

2.　Girmek istediğiniz değişkeni veya fonksiyonu vurgulayın ve ardından O   tuşuna basın.
•　Değişkenler menüsü, değişkenleri ve fonksiyonları aşağıda açıklandığı gibi görüntüler.

      tuşuna Düzenleyici 
görüntülenirken basıldığında

Görüntülenen .py dosyasında tanımlanan genel değişkenleri ve kullanıcı 
tanımlı fonksiyonları görüntüler.

      tuşuna Kabuk (Shell) 
görüntülenirken basıldığında 

Kabuk (Shell) başlatılmadan önce yürütülen son .py dosyasında tanım-
lanan genel değişkenleri ve kullanıcı tanımlı fonksiyonları görüntüler.

*　"Kabuk'u (Shell) Başlatma" (sayfa 123) bölümüne bakın.

Not
•　Aşağıdaki öğeler Değişkenler menüsünde gösterilmez.
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-　Yerel değişkenler, fonksiyonlar içindeki fonksiyonlar, fonksiyon argümanları, kullanıcı tanımlı sınıflar
-　Şu anda açık olan .py dosyasından içe aktarılan bir .py dosyasında bulunan değişkenler ve fonksiyonlar
-　Kabuk (Shell) ile tanımlanan değişkenler
-　Kabuk'tan (Shell) içe aktarılan .py dosyalarında bulunan değişkenler ve fonksiyonlar

•　Diğer uygulamalarda V    tuşuna bastığınızda görüntülenen değişkenler, Python uygulamasında görüntülenmez.

Kabuk (Shell) Kullanımı
Kabuk, etkileşimli bir komut satırıdır. Kabuk'un >>> isteminden komutları  girebilir ve     tuşuna basarak sonucu
 anında alabilirsiniz. Kabuk geçmişi, en son 200 istem ve sonuç satırını depolar.

*1  *2

*3

*1　En fazla 255 karakter. Metinleri, fonksiyonları ve komutları Kabuk'a girme hakkında bilgi için, “Giriş İşlemleri 
(Düzenleyici ve Kabuk için Aynı)” (sayfa 121) bölümüne bakın.

*2　Sonuç çıktısı satır başına en fazla 509 karaktere sahiptir.
*3　T   > [Delete All] öğesini seçene veya başka bir uygulama başlatana kadar. 

Kabuk'u Görüntüleme
Düzenleyici görüntülenirken, bir betiği (sayfa 120) yürütün veya T   > [Shell] öğesini seçin. Bu sırada Kabuk 
başlatılır.

 

*　T   > [Shell] öğesini seçmek, o anda Düzenleyici'de görüntülenen betiği yürütmez.

Kabuk'u Başlatma
Kabuk, en son yürütülen betikte tanımlanan değişkenleri ve fonksiyonları Kabuk yığın alanında (geçici bellek 
alanı) depolar. Kabuk'tan Düzenleyici'ye her geçtiğinizde, o noktaya kadar olan Kabuk yığın alanı içeriği 
temizlenir. Kabuk yığın alanı içeriğinin bu şekilde temizlenmesine "KABUK (SHELL) başlatma" denir. Kabuk 
başlatıldığında, “* KABUK (SHELL) Başlatıldı *” mesajı başlatıldığı satıra eklenir.  

Tüm Kabuk Geçmişi İçeriğini Temizleme
a    tuşuna basın veya T   > [Delete All] öğesini seçin.

matplotlib.pyplot Modülü
matplotlib.pyplot modülü, Python uygulamasıyla grafikler çizmek için fonksiyonlar sağlar. 

Önemli!
•　Python uygulamasının matplotlib.pyplot modülü, bu hesap makinesinde çalışmak üzere oluşturulmuş 

özel bir modüldür. Bilgisayar tabanlı Python'da çalışan matplotlib.pyplot modülünden farklıdır.
•　Bu hesap makinesinin Python uygulamasındaki matplotlib.pyplot modülünde bulunan fonksiyonlar, 

davranış, desteklenen argümanlar ve diğer özellikler açısından bilgisayar tabanlı Python'ın 
matplotlib.pyplot modülündekilerden farklı olabilir. Her fonksiyon yalnızca burada belirtilen formatı ve 
argümanları destekler.

Not
•　matplotlib.pyplot modülündeki fonksiyonları kullanmak için, matplotlib.pyplot modülünü içe aktarmanız 

gerekir. 
Matplotlib.pyplot Modülünü İçe Aktarma

1.　C   > [matplotlib.pyplot] öğesini seçin.

2.　Görünen menüde, aşağıdaki komutları seçin:
-　from matplotlib.pyplot import *
-　import matplotlib.pyplot

 
•　Bu bölümdeki her fonksiyonun sözdiziminde, köşeli parantez ([]) içinde yer alan herhangi bir şey 

atlanabilir.
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Python uygulamasının matplotlib.pyplot modülünde yer alan fonksiyonlar aşağıda açıklanmıştır.

Çizim Ekranını Görüntüleme

show()
Çizim ekranında çizim için belirtilmiş grafikleri, ızgaraları ve eksenleri gösterir.

Sözdizimi: show()     (argüman yok)
 
Çizim ekranını görüntüledikten sonra Kabuk'a (Shell) dönmek için b   tuşuna basın.

Not
•　show  yürütülmesi, yürütmeden önce belirtilmiş olan aşağıdaki öğelerin tümünü temizler.

-　Çizim için belirtilmiş grafikler
-　Eksen (axis) ayarları (İlk varsayılan ayarlara geri döner.)
-　Izgara ayarları (İlk varsayılan ayarlara geri döner.)

•　Bir betik birden fazla show çağrısı içeriyorsa, sondan bir önceki          ile son          arasında tanımlanan
veya yapılandırılan grafikler, ızgaralar ve eksenler çizim ekranında görüntülenir.

show show

Eksen ve Izgara Ayarları

axis() (Eksen)
Bu fonksiyon, bir eksenin görüntüleme aralığını belirlemek ve eksen (axis) ayarlarını değiştirmek için 
kullanılabilir. 

Sözdizimi 1: axis(listxy)
Eksen görüntüleme aralığını list     argümanı için [xmin,xmax,ymin,ymax] biçiminde girin. Ekranın sol alt xy
köşesinin koordinatları                        tarafından belirlenir.xmin ve ymin

xmin x-ekseninin minimum değeri
xmax x-ekseninin maksimum değeri
ymin y-ekseninin minimum değeri
ymax y-ekseninin maksimum değeri

-　listxy tipi: list veya tuple
-　listxy öğe tipi: int veya float
-　İlk varsayılanlar: [0,1,0,1]

xmin xmax

ymin

ymax

 
Sözdizimi 2: axis(opsiyon)
Option (opsiyon) argümanına anahtar kelimelerden birini (tür: str) girerek (axis) eksen ayarını belirtir.

"on": Ekseni göster
"off": Ekseni gizle
"auto": Eksen aralığını grafiğe uyacak şekilde otomatik olarak ayarla*1

 
Sözdizimi 3: axis()     (argüman yok)
Şu anda belirtilen eksenin görüntüleme aralığına geri döner.*2

 
*1　axis("auto") yalnızca grafik çizim fonksiyonundan sonra geldiğinde geçerlidir.

.
*2　Kabuk ile yürütüldüğünde geçerlidir. Bir .py dosyasına yazıp ayar değerlerini çıktılamak için print(axis()) 

yazmanız gerekir.

Not
•　Eksenin görüntüleme rengi her zaman siyahtır.

grid() (Izgara)
Bu fonksiyonu, ızgarayı göstermek veya gizlemek ve ızgara rengini belirtmek için kullanın.
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Sözdizimi 1: grid(option[,color]) (ızgara(opsiyon[,renk]) 
Izgarayı gösterir/gizler. Aynı anda ızgara rengini de belirtebilirsiniz.
•　option argümanı: Izgarayı göster/gizle belirler.

-　str türünü kullanarak belirtmek için aşağıdaki anahtar kelimeleri kullanın.
"on", "True", or "true": Show grid ("açık", "Doğru" veya "doğru": Izgarayı göster)
"off", "False", or "false": Hide grid ("kapalı", "Yanlış" veya "yanlış": Izgarayı gizle)

-　bool türünü kullanarak belirtmek için aşağıdaki terimleri kullanın.
True (doğru): Izgarayı göster.
False (yanlış): Izgarayı gizle.

•　color (renk) argümanı: Izgara rengini belirler.
-　Tür: str
-　Belirtme yöntemi: Izgara rengini belirtmek için grid(option,color="anahtar_kelime") sözdizimini kullanın. 

Anahtar kelime olarak belirtilebilecek metin dizeleri hakkında bilgi için, “Renk Anahtar Kelimeleri” (sayfa 
129) bölümüne bakın.

-　Atlandığında gerçekleşen işlem: Izgara, düz gri çizgilerle çizilir. (Eğer "Izgarayı gizle" argüman seçeneği 
belirtilmişse ızgara gösterilmez.) 

Sözdizimi 2: grid(color) (ızgara(renk))
Izgara rengini belirler. Ayrıca "Izgarayı göster" konumuna geçer. (Bu, Sözdizimi 1'de grid("on") (ızgara 
(”açık”)) belirtildiğinde olduğu gibidir.)
•　color

aynıdır. 
(renk) argümanı: Izgara rengini belirler. Rengi belirtme türü ve yöntemi, Sözdizimi 1'deki ile 

 
Sözdizimi 3:  grid()     (argüman yok)
Izgara ayarını göster ve gizle arasında değiştirir.
•　Örneğin, grid("on") (ızgara (”açık”))dan sonra grid() çağırmak, ızgarayı gösterden gizleye değiştirir.
•　grid("off") (ızgara(”kapalı”))dan sonra grid() çağırmak, ızgarayı gizleden göstere değiştirir. Bu durumda, 

ızgara düz gri olarak çizilir.

Not
•　Ekseni gizlemek için axis() eksen() kullanıldıysa, ızgara da gizlenir.

Grafik ve Metin Dizeleri Çizme

plot() (çizim())
Bir nokta veya doğru parçası çizer.
 

Sözdizimi 1: plot(x,y[,color]) (çizim(x, y[,renk])
Belirtilen koordinatlara bir nokta çizer. Noktanın rengini de belirtebilirsiniz.
•　x, y argümanları: Koordinatları (          belirtir.x , y )

-　Tür: int veya float
•　color (renk) argümanı: Rengi belirtir.

-　Tür: str
-　Belirtme yöntemi: Rengi belirtmek için plot(x,y,"anahtar_kelime") sözdizimini kullanın. Anahtar kelime 

olarak belirtilebilecek metin dizeleri hakkında bilgi için, “Renk Anahtar Kelimeleri” (sayfa 129) bölümüne 
bakın.

-　Atlandığında gerçekleşen işlem: Renk otomatik olarak belirtilir. Ayrıntılar için, “Otomatik Renk Belirleme” 
(sayfa 129) bölümüne bakın.

 Sözdizimi 2: plot([listx,]listy[,color]) (çizim([listex,]listey[,renk]))
Birden fazla belirtilen koordinatı birbirine bağlayan bir doğru parçası çizer. Doğru parçasının rengini de 
belirtebilirsiniz.
•　listx, listy argümanları: Birden fazla koordinatı (x1, y1 ; x2, y2 ; x3, y3 ; …) belirtir.

-　listx, listy türü: list veya tuple
-　listx, listy öğe türü: int veya float
-　Listx atlandığında, x = [0,1,2,3,…] otomatik olarak atanır.
-　Hem listx hem de listy belirtildiğinde, her iki listenin de aynı sayıda öğe içermesi gerekir.

•　Color (renk) argümanı, Sözdizimi 1'deki ile aynıdır.
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Not
•　plot (ızgara) ile belirtilen koordinatlara çizilen noktanın şekli her zaman bir artıdır (+). 
•　axis (eksen) için hiçbir şey belirtmeden plot (ızgara) yürütmek, eksenin otomatik olarak ayarlanmasına 

neden olur. 
•
　
Bilgisayar tabanlı Python tarafından desteklenen bir "şekil anahtar kelimesini" color (renk) argümanı 
için girerseniz, bu anahtar kelime bir hataya neden olmadan göz ardı edilir. Yalnızca bir şekil anahtar 
kelimesini color (renk) argümanı için girerseniz, color argümanı hiçbir argüman girilmemiş gibi kabul 
edilir. Davranış, atlandığında olduğu gibidir.

bar(,) (çubuk(,))
Bir çubuk grafik çizer.
 

Sözdizimi 1: bar(x,y[,width]) (çubuk(x, y[, genişlik])
Tek bir çubuk grafik çizer.
•　x argümanı: Çubuk grafiğin x-koordinatını belirtir.

y argümanı: Çubuk grafiğin yüksekliğini belirtir.
-　x, y türü: int veya float

•　width (genişlik) argümanı: Çubuk grafiğin genişliğini (x ekseni boyunca ölçek genişliği) belirtir. 0 belirtmek, 
bir nokta genişliğinde çizim yapar. 
-　Tür: int or float
-　İlk varsayılan: 0.8 (atlanırsa 0.8 olur.)

 
Sözdizimi 2: bar(listx,listy[,width]) (çubuk(listex, listey[, genişlik])
Bir veya birden fazla çubuk içeren bir çubuk grafik çizer.
•　listx argümanı: Her liste öğesi, her çubuğun x koordinatını belirtir.

listy argümanı: Her liste öğesi, her çubuğun yüksekliğini belirtir.
-　listx, listy türü: list veya tuple
-　listx, listy öğe türü: int veya float
-　listx ve listy içindeki öğe sayısı eşleşmelidir.

•　Width (genişlik) argümanı, Sözdizimi 1'deki ile aynıdır..

Not
•　axis (eksen) için hiçbir şey belirtmeden bar (çubuk) yürütmek, eksenin otomatik olarak ayarlanmasına 

neden olur.
•　bar (çubuk) kullanılarak çizilen bir çubuk grafiğin rengi otomatik olarak belirlenir. Ayrıntılar için, 

“Otomatik Renk Belirleme” (sayfa 129) bölümüne bakın..

scatter(,) (dağılım(,))
Bir dağılım grafiği çizer.
 

Sözdizimi 1: scatter(x,y) (dağılım(x,y))
Belirtilen koordinatlara bir nokta çizer.
•　x, y argümanı: Koordinatları (x, y) belirtir.

-　x, y türü: int veya float
 
Sözdizimi 2: scatter(listx,listy) (dağılım(listx, listy))
Belirtilen tüm koordinatlara noktalar çizerek bir dağılım grafiği çizer.
•　listx, listy argümanları: Birden fazla koordinatı (x1, y1 ; x2, y2 ; x3, y3 ; …) belirtir.

-　listx, listy türü: list veya tuple
-　listx, listy öğe türü: int veya float
-　listx ve listy içindeki öğe sayısı eşleşmelidir.

Not
•　scatter (dağıım) ile belirtilen koordinatlara çizilen noktanın şekli her zaman bir artıdır (+). 
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•　scatter(dağılım) için herhangi bir axis(eksen) belirtmeden yürütme, eksenin otomatik olarak 
ayarlanmasına neden olur.•　
scatter(dağılım) kullanılarak çizilen noktaların rengi otomatik olarak belirtilir. Ayrıntılar için, “Otomatik 
Renk Belirleme” (sayfa 129) bölümüne bakın.

hist() (histogram())
Bu fonksiyon bir histogram (yatay eksenin sınıfları ve dikey eksenin frekansları temsil ettiği bir frekans dağılım 
grafiği) çizer.
 

Sözdizimi 1: hist(x[,bins])     veya     hist(x,listbins)
Veri noktası sayısının 1 olduğu (frekans=1) bir histogram çizer.
•　x argümanı: Bir veri değeri girer.

-　x türü: int veya float
•　bins argümanı:  Histogramdaki kutu sayısını 1'e eşit veya 1'den büyük bir tam sayı olarak belirtir.

-　bins türü: int
-　İlk varsayılan: 10 (bu argüman atlandığında 10 olur)
-　Belirtme yöntemi: Örneğin, dört kutu belirtmek için(x,bins=4), veya hist(x ,4) kullanın.

•　listbins argümanı: Histogram sınıfı bölüm noktaları için birden fazla değer belirtir.
-　listbins türü: list veya tuple
-　listbins öğe türü: int veya float
-　Örneğin, hist(1, [0, 2, 4]) iki aralık (0'dan 2'ye ve 2'den 4'e) ile sonuçlanır.

 
Sözdizimi 2: hist(listx[,bins])    veya    hist(listx,listbins)
Birden fazla veri noktasına sahip bir histogram çizer.
•　listx argümanı: Her öğe için bir veri değeri girer.

-　listx türü: list veya tuple
-　listx öğe türü: int veya float

•　bins ve listbins argümanları, Sözdizimi 1'deki ile aynıdır.

Not
•　axis(eksen) için hiçbir şey belirtmeden hist yürütmek, eksenin otomatik olarak ayarlanmasına neden olur.
•　hist tarafından çizilen histogramın rengi otomatik olarak belirtilir. Ayrıntılar için, “Otomatik Renk 

Belirleme” (sayfa 129) bölümüne bakın..
•　listbins argümanına girilen değerler otomatik olarak artan sırada sıralanır. Örneğin, [4, 0, 2] girişi 

[0, 2, 4] olarak kabul edilir.
•　Bir sınıfın bölüm noktasındaki veri değerleri, maksimum değer 

durumu hariç olmak üzere bölüm noktasının üstündeki sınıfa 
dahil edilir. Örneğin, hist([1,1,2,2,2,3,4,5,7],3) yürütülmesi, 
bins argümanı için 3'ü belirtir, bu nedenle sınıflar 
1-2, 2-3, 3-4, 4-5, 5-6, 6-7'dir. Bölüm noktasındaki 3 veri değeri 
3-4 sınıfına dahil edilir ve 5 veri değeri 5-6 sınıfına dahil edilir. 
Ancak, maksimum değer olan 7, 6-7 sınıfına dahil edilecektir.

arrow(,,,) (ok(,,,))
Bir ok çizer.
 

Sözdizimi: arrow(x,y,dx,dy[,edgecolor[,facecolor[,head_width[,head_length]]]])
•　x, y argümanları: Okun çizim başlangıç noktasının koordinatlarını (x, y) belirtir.x, y
•　dx, dy argümanları: Okun uç noktasını*, (x+dx, y+dy) koordinatlarında olacak şekilde belirtir.

-　x, y, dx, dy türü: int veya float
*　Ok başlığını içermeyen doğru parçasının uç noktası.

 
•　edgecolor (kenar rengi) argümanı: Okun kenar rengini belirtir.
•　facecolor (yüz rengi) argümanı: Ok başlığının ön yüz rengini belirtir.
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-　edgecolor, facecolor türü: str
-　edgecolor ilk değeri: siyah; facecolor ilk rengi: mavi (Bu renkler, bu argümanlar atlandığında kullanılır.)

•　head_width argümanı: Ok başlığının genişliğini belirtir.
•　head_length argümanı: Ok başlığının uzunluğunu belirtir.

-　head_width, head_length türü: int veya float
-　head_width ilk değeri: 0.003; head_length ilk değeri: head_width × 1.5
-　head_width veya head_length için negatif bir değer belirtilirse, değerin mutlak değeri uygulanır.

 
Örnek: Başlangıç noktası olarak (0, 0) koordinatlarına ve bitiş noktası olarak (0.5, 0.5) koordinatlarına sahip 

bir ok çizmek için. Okun kenar rengi için maviyi, ok başlığının ön yüz rengi için kırmızıyı ve başlık 
genişliği ile uzunluğu için 0.5'i belirtin.

matplotlib.pyplot'tan içe aktar *
arrow(0,0,0.5,0.5,edgecolor="mavi",facecolor="kırmızı",head_width=0.5,head_length=0.5)
show()

 
İşlem sonuçları aşağıda gösterilmiştir.

facecolor(yüz rengi) 

Not
•　

•　Renkleri belirtmek için kullanılabilecek mavi, kırmızı vb. anahtar kelimeler için “Renk Anahtar
 Kelimeleri” (sayfa 129) bölümüne bakın.

•
　
arrow(ok) fonksiyonunu axis(eksen) için hiçbir şey belirtmeden yürütürseniz, eksen otomatik olarak 
ayarlanmaz. Ok çizim ekranının dışına uzanırsa, ekseni manuel olarak belirtin.

text(,,) (metin(,,))
Belirtilen koordinatlara bir metin dizesi çizer.
 

Sözdizimi: text(x,y,text) (metin(x, y, metin)
•　x, y argümanları: Dizenin sol ucunun koordinatlarını (x,y) belirtir.

-　x, y tür: int veya float
•　text (metin) argümanı: Bir metin dizesi belirtir.

-　text (metin) argümanının türü üzerinde bir kısıtlama yoktur. Çift tırnak (" ") içine alınarak herhangi bir 
metin dizesi girilebilir.
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edgecolor(kenar rengi) 

head_width(baş_genişliği) head_length(baş_uzunluğu) 

edgecolor, facecolor, head_width ve head_length argümanlarını belirtirken, yukarıdaki Örnekte 
gösterildiği gibi her zaman bir argümanı belirten bir dize (edgecolor= kısmı) yazmalısınız. Her 
argümanı belirten metin dizesi,       > [matplotlib.pyplot] kullanılarak girilebilir.



Not
•　text(metin) fonksiyonunu axis(eksen) için hiçbir şey belirtmeden yürütürseniz, eksen otomatik olarak 

ayarlanmaz. Metin dizesi çizim ekranının dışına uzanırsa, ekseni manuel olarak belirtin. 
•　text(metin) ile çizilen metin dizelerinin rengi her zaman siyahtır.

Renk Anahtar Kelimeleri
Aşağıdaki tablolarda gösterilen anahtar kelimeler, renkleri belirtmek için grid (ızgara), plot ve arrow (ok) 
argümanları olarak kullanılabilir.
Bu rengi belirtmek için:       Bu anahtar kelimeyi 
                                               kullanın:

Mavi "b" veya "blue"
Kırmızı "r" veya"red"
Yeşil "g" veya "green"

Macenta "m" veya "magenta"
Siyah "k" veya "black"

Cam Göbeği "c" veya "cyan"
Sarı "y" veya "yellow"

Bu rengi belirtmek için:   Bu anahtar kelimeyi 
                                           kullanın:

Beyaz "w" or "white"
Gri "grey"

Turuncu "orange"
Mor "purple"

Kahverengi "brown"
Pembe "pink"

Not
•　Renk anahtar kelimeleri, C   > [matplotlib.pyplot] kullanılarak girilebilir. 

Otomatik Renk Belirleme
Bir grafik plot*, bar(çubuk), scatter(dağılım) veya hist fonksiyonlarından birinin tek bir yürütülmesiyle çizildiğinde, 
renk olarak otomatik olarak mavi belirtilir. Bu fonksiyonlar art arda grafik çizmek için yürütüldüğünde, grafik 
renkleri otomatik olarak aşağıdaki sırayla belirtilir:

 
mavi          kırmızı          yeşil           macenta

siyah
  cam 
göbeğisarı

Her show yürütülmesi, otomatik grafik renk sırasının maviye dönmesine neden olur.
*　plot fonksiyonu için, renk yalnızca color (renk) argümanı atlandığında otomatik olarak atanır.
 
Örnek: plot ve bar'ı (çubuk) kullanarak art arda iki grafik çizmek için plot renk argümanını atlayın.

 
matplotlib.pyplot'tan içe aktar *
plot([1,1.5,2.5])
plot([0,0.5,0.2])
bar(1,1)
bar([2,3],[2,3])
show()

 
İşlem sonuçları aşağıda gösterilmiştir.
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plot([1,1.5,2.5])

plot([0,0.5,0.2])

bar(1,1)
bar([2,3],[2,3])

turtle (kaplumbağa) Modülü
turtle modülü, sanal bir "kaplumbağayı" (     ) kalemle manipüle etmek için fonksiyonlar sağlar. Kaplumbağanın 
şekiller ve desenler çizmesini sağlayabilirsiniz.

Önemli!
•　Python uygulamasının turtle modülü, bu hesap makinesinde çalışmak üzere oluşturulmuş özel bir

modüldür. Bilgisayar tabanlı Python'da çalışan turtle modülünden farklıdır.
 

•　Bu hesap makinesinin Python uygulamasındaki turtle modülünde bulunan fonksiyonlar, davranış, 
desteklenen argümanlar ve diğer özellikler açısından bilgisayar tabanlı Python'ın turtle 
modülündekilerden farklı olabilir. Her fonksiyon yalnızca burada belirtilen formatı ve argümanları 
destekler.

Not
•　turtle modülündeki fonksiyonları kullanmak için, turtle modülünü içe aktarmanız gerekir.

turtle Modülünü İçe Aktarma

1.　C   > [turtle] öğesini seçin.

2.　Görünen menüde, aşağıdaki komutları seçin:
-　turtle’dan içe aktarma *
-　turtle içe aktarma

 

 
•　Aşağıdaki fonksiyonlar, yalnızca Kabuk (Shell) ile yürütüldüğünde olduğu gibi yazılabilir. Bunları bir betik 

dosyasına yazıp ayar değerlerini çıktılamak için, print(pencolor()) gibi, print() içinde yazmanız gerekir.
pencolor(), pensize(), width(), shape(), speed(), isvisible(), isdown(), xcor(), ycor(), position(),
distance(,), towards(,), heading()

 
•　Bu bölümde gösterilen her fonksiyonun sözdiziminde, köşeli parantez ([]) içinde yer alan herhangi 

bir şey atlanabilir.

•　turtle modülünü Python uygulamasıyla kullanırken, koordinatlar 
aşağıda gösterildiği gibi sabittir.
Orijin: 0, 0
x-ekseni minimum değeri: -192, maksimum değeri: 191
y-ekseni minimum değeri: -95, maksimum değeri: 96

96

-95

1910-192

Python uygulamasının turtle modülünde bulunan fonksiyonlar aşağıda açıklanmıştır.
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Kalem (Pen) Belirtme

pendown()
Kalemi indirir, çizimi etkinleştirir.
 

Sözdizimi: pendown()       (argüman yok)
•　Kalem indirilmişken turtle’ı (kaplumbağa) hareket ettirdiğinizde, turtle’ın mevcut konumundan 

hedefine bir çizgi çizilir. Turtle’ı hareket ettirmek için “Yön ve İleri/Geri Hareketi Belirtme” (sayfa 132) ve 
“Belirtilen Koordinatlara Gitme” (sayfa 132) altındaki fonksiyonları kullanın.

 

penup()
Kalemi kaldırır, çizimi devre dışı bırakır..
 

Sözdizimi: penup()       (argüman yok)
•　Kalem yukarıdayken, turtle hareket ettirilirse hiçbir şey çizilmez.

 

pencolor() (kalem rengi)
•　Çizgi çizme rengini belirtir veya çizgi çizme renginin değerini döndürür.
 

Sözdizimi 1: pencolor(colorstring) (kalem rengi)
•　colorstring argümanı: Çizgi çizme rengini belirtmek için bir anahtar kelime kullanır.

-　Tür: str
-　Belirtme yöntemi: Rengi belirtmek için pencolor("anahtar_kelime") (kalem rengi) sözdizimini 

kullanın.
siyah, mavi, yeşil, kırmızı, cam göbeği, sarı, macenta, beyaz, turuncu, mor, kahverengi, pembe, gri

 
Sözdizimi 2: pencolor(list) (kalem rengi(liste))
•　liste argümanı: Çizgi çizme rengini belirtmek için RGB değerlerini kullanır.

-　Tür: list veya tuple
-　Öğelerin türü: int veya float
-　Belirtme yöntemi: RGB değerlerini belirtmek için [r, g, b] (0 ≤ r ≤ 1, 0 ≤ g ≤ 1, 0 ≤ b ≤ 1) sözdizimini 

kullanın. Her RGB değeri, aşağıda gösterildiği gibi Sözdizimi 1'deki bir anahtar kelimeye karşılık gelir.

Anahtar Kelime  RGB Değerleri
siyah [0,0,0]
mavi [0,0,1]
yeşil                    [0,1,0]

kırmızı [1,0,0]
cam göbeği [0,1,1]

Anahtar Kelime  RGB Değerleri
 sarı                    [1,1,0]

macenta [1,0,1]
beyaz [1,1,1]
turuncu              [1,0.65,0]
  mor               [0.66,0,0.66]

Anahtar Kelime  RGB Değerleri
kahverengi     [0.75,0.25,0.25]

pembe           [1,0.75,0.8]
  gri            [0.66,0.66,0.66]

 
Sözdizimi 3: pencolor()       (argüman yok)
•　Mevcut çizgi çizme renginin RGB değerlerini (veya varsa anahtar kelimesini) döndürür.

 

pensize(), width() (kalem boyutu), (genişlik)
Çizgi genişliğini belirtir veya mevcut çizgi genişliğinin değerini döndürür.
 

Syntax 1: pensize(n) (kalem boyutu (n))
width(n) (genişlik(n))

•　n argümanı: Çizgi genişliğini 0 ila 5 arasında bir reel sayı olarak belirtir. Sayı ne kadar büyükse, çizgi o 
kadar geniştir.
-　Tür: int veya float

 
Sözdizimi 2: pensize()       (argüman yok)
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width()       (argüman yok)
•　Mevcut çizgi çizme genişliğinin değerini döndürür.

Yönü ve İleri/Geri Hareketi Belirtme

right() (sağ())
Turtle’ı (kaplumbağa), başı istenen bir yönde olacak şekilde belirtilen bir açıyla sağa döndürür.
 

Sözdizimi: right(a)
•　a argümanı: Turtle’ın döndürülmesi gereken açıyı derece cinsinden belirtir (0° ≤ a < 360°).

-　Tür: int veya float
 

left() (sol())
Turtle’ı (kaplumbağa), başı istenen bir yönde olacak şekilde belirtilen bir açıyla sola döndürür.
 

Sözdizimi: left(a)
•　a argümanı, right(sağ) için olanla aynıdır. .

 

•　a argümanı: Kaplumbağanın başının yönünü derece cinsinden belirtir (0° ≤ a < 360°).
-　Tür: int veya float

 

forward() (ileri())
Turtle’ı, başının mevcut yönünde ileri hareket ettirir. Baş yönü değişmez.

 
Sözdizimi: forward(n)
•　n argümanı: Turtle’ın hareket mesafesini belirtir.

-　Tür: int veya float
 

backward() (geri())
Turtle’ı, başının mevcut yönünün zıttı yönde geri hareket ettirir. Baş yönü değişmez.

 
Sözdizimi: backward(n)
•　n argümanı, forward(ileri) için olanla aynıdır. .

Belirtilen Koordinatlara Gitme

goto(,)
Turtle’ı belirtilen koordinatlara hareket ettirir. Baş yönü değişmez.
 

Sözdizimi: goto(x,y)
•　x, y argümanları: Turtle’ın varış noktasının koordinatlarını (x, y) belirtir.

-　x, y tür: int veya float
 

setposition(,)
Turtle’ı belirtilen koordinatlara hareket ettirir. Baş yönü değişmez.

setheading()
Turtle’ın başının mutlak yönünü belirtir; doğu
0° (sağ), 90° kuzey (üst), 180° batı (sol), ve 270° güney
(alt) olur.

Sözdizimi: setheading(a)

90°

270°

0°180°
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Sözdizimi: setposition(x,y)
•　x, y

 

setx()
Turtle’ı, mevcut y-koordinatını değiştirmeden belirtilen x-koordinatına hareket ettirir. Baş yönü değişmez.

 
Sözdizimi:  setx(x)
•　x argümanı: Turtle’ın varış noktasının x-koordinatını belirtir.

- x türü: int veya float
 

sety()
Turtle’ı, mevcut x-koordinatını değiştirmeden belirtilen y-koordinatına hareket ettirir. Baş yönü değişmez.

 
Sözdizimi: sety(y)
•　y argümanı: Kaplumbağanın varış noktasının y-koordinatını belirtir.

-　y türü: int veya float
 

home() (ev())
Turtle’ı orijine (0,0) hareket ettirir ve başını başlangıç yönüne (sağa doğru) döndürür.
 

Syntax: home()       (argüman yok)

Daire ve Metin Çizme

circle() (daire())

 
Sözdizimi: circle(radius[,extent=360])
•　radius argümanı: Bir daire yarıçapı belirtir.

-　Tür: int veya float
•　extent argümanı: Bir yay açısını derece cinsinden belirtir.

-　Tür: int veya float
-　Belirtme yöntemi: Örneğin, extent'i 180 olarak ayarlamak için, circle(radius, extent=180) veya circle

(radius, 180) kullanın.
-
　
İlk varsayılan: 360 (atlandığında 360 olur) 

write() (yazmak())
Mevcut turtle konumundan bir metin dizesi çizer.
 

Sözdizimi: write(text) (yazmak(metin))
•　text argümanı: Bir metin dizesi belirtir.

-　text argümanının türü üzerinde bir kısıtlama yoktur. Çift tırnak (" ") içine alınarak herhangi bir metin 
dizesi girilebilir.

Mevcut turtle konumundan bir daire veya yay çizer. Daire veya yay,
mevcut turtle konumundan saat yönünün tersine çizilir. Sağdaki şekil, 
turtle’ın mevcut konumunun (          ) olduğu varsayıldığında, 
aşağıdaki sözdizimindeki argümanlar ile çizilmekte olan yay arasındaki 
ilişkiyi göstermektedir.

x1 , y1

radius

extent

(x1, y1)
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argümanları, goto için olanlarla aynıdır.



Turtle (Kaplumbağa) Durumunu Belirtme

shape() (şekil())
Bu fonksiyonu, Turtle şeklini belirtmek veya mevcut turtle şeklini döndürmek için kullanın. İki mevcut 
turtle şekli vardır: "klasik" ve "turtle".

"klasik" "turtle"

 
Sözdizimi 1: shape(name) (şekil(isim))
Bu sözdizimini turtle’ın şeklini belirtmek için kullanın.
•　name (isim) argümanı: Turtle şeklini belirtmek için anahtar kelimeleri (klasik, turtle) kullanır.

-　Tür: str
-　Belirtme yöntemi: Örneğin, "klasik" (ok) şeklinde bir turtle istiyorsanız, shape(name="classic") 

(biçim(isim=”klasik”)) veya shape("classic") (biçim(”klasik”)) belirtin.
-　Initial default: "classic"

 
Sözdizimi 2: shape()       (argüman yok)
Şu anda belirtilmiş turtle şeklini döndürür.

 

speed() (hız())
Turtle’ın çizim hızını (kalem indirildiğinde kaplumbağanın hareket etme hızı) belirtir veya şu anda 
belirtilmiş turtle çizim hızını döndürür.
 

Sözdizimi 1: speed(speed) (hız(hız))
Turtle çizim hızını belirtir. Speed argümanı bir reel sayı veya bir anahtar kelime olabilir.
•　Reel sayı ile belirtme: 0 ila 10 arasında bir değer girin. 0 en hızlı hızdır. Sıfır dışındaki değerler için, 

daha büyük bir sayı daha hızlı bir hıza karşılık gelir. İzin verilen aralığın dışında bir değer belirtilirse 
ayar varsayılan olarak 0 olur.
-　Tür: int veya float
-　İlk varsayılan: 5

•　Anahtar kelime ile belirtme: Aşağıdaki tabloda gösterilen anahtar kelime dizelerini kullanın.

Anahtar Kelime Karşılık Gelen Reel Sayı
fastest (en hızlı) 0

fast (hızlı) 10
normal 6

slow (yavaş) 3
slowest (en yavaş) 1

-　Tür: str
-　Belirtme yöntemi: Örneğin, yavaş belirtmek için speed(speed="slow") veya speed("slow") kullanın.
-　İlk varsayılan: speed=None (Hiçbiri)

 
Sözdizimi 2:  speed()       (argüman yok)
Turtle’ın şu anda belirtilen çizim hızına karşılık gelen reel sayıyı döndürür.

 

showturtle()
Turtle’ı çizim ekranında görüntüler.
 

Sözdizimi: showturtle()       (argüman yok)
 

hideturtle()
Çizim ekranındaki turtle’ı gizler.
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Sözdizimi: hideturtle()       (argüman yok)

Durumunu Alma

isvisible() (gizli())
Mevcut turtle’ın göster/gizle durumunu döndürür (Göster: True (doğru), Gizle: False (yanlış)).
 

Sözdizimi: isvisible()       (argüman yok)
 

isdown()
Mevcut kalem durumunu döndürür (Kalem aşağıda: True (doğru), Kalem yukarıda: False (yanlış)).
 

Sözdizimi: isdown()       (argüman yok)
 

xcor()
Turtle’ın mevcut konumunun x-koordinatını döndürür.
 

Sözdizimi: xcor()       (argüman yok)
 

ycor()
Turtle’ın mevcut konumunun y-koordinatını döndürür.
 

Sözdizimi:  ycor()       (argüman yok)
 

position() (konum())
Turtle’ın mevcut konumunu (x, y koordinatları) döndürür.
 

Sözdizimi: position()       (argüman yok)
 

distance(,) (mesafe(,))
Turtle’ın mevcut konumundan belirtilen koordinata olan doğrusal mesafeyi döndürür.
 

Sözdizimi: distance(x,y)
•　x, y argümanları: Turtle’ın mevcut konumundan doğrusal mesafeyi kontrol etmek istediğiniz noktanın 

koordinatlarını (x, y) belirtir.
-　x, y türü: int veya float

 

towards(,)
Mevcut turtle’ın konumu ile belirtilen koordinatlar tarafından oluşturulan açıyı döndürür (Aşağıdaki Nota 
bakın).
 

Sözdizimi: towards(x,y)
•　x, y argümanları: Mevcut turtle konumu ile açıyı kontrol etmek istediğiniz noktanın koordinatlarını (x, y) 

belirtir.
-　x, y türü: int veya float
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Not
•　Eğer mevcut turtle konumu (x  , y  ) ve belirtilen koordinatlar (x,y) ise, aşağıdaki şekilde kesikli 

çizgiyle gösterilen yayın açısı towards(x,y) fonksiyonu tarafından döndürülür.
0

towards(x,y)

(x,y)

(x0, y0)

x0 < x, y0 < y

towards(x,y)

(x,y)

(x0, y0)

x < x0, y0 < y

towards(x,y)

(x,y)

(x0, y0)

x < x0, y < y0

towards(x,y) (x,y)

(x0, y0)

x0 < x, y < y0

 
•　x = x0, y = y0 olduğunda, towards(x,y) 0 döndürür.

 

heading()
Mevcut turtle yönünü döndürür. Turtle yönü hakkında bilgi için “setheading()” (sayfa 132) bölümüne bakın.
 

Sözdizimi: heading()       (argüman yok)

Turtle’ı Sıfırlama ve Çizim Ekranını Temizleme

reset() (sıfırlama()) 
Çizim ekranının içeriğini temizler ve turtle’ı başlatır.
 

Sözdizimi: reset()       (argüman yok)
 
Turtle’ın başlangıç durumu aşağıdaki tabloda gösterilmiştir.

Durum Türü Başlangıç Varsayılanı
Konum (0,0)
Yön 0° (east, right)
Renk (0,0,0) (black)
Kalem aşağıda/yukarıda Down
Kalem çizim genişliği 1
Turtle çizim hızı 5
Turtle göster/gizle Show
Turtle şekli "classic"

 

clear() (temizleme())
Mevcut turtle durumunu korurken çizim ekranının içeriğini temizler.
 

Sözdizimi: clear()       (argüman yok)
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casioplot Modülü

özgü bir modüldür. Bu fonksiyonları girmek için      > [casioplot] öğesini kullanın. Aşağıda açıklanan 

argümanlar atlanabilir.
show_screen() (ekranı göster) (argüman yok)
Çizim ekranını görüntüler. Çizim ekranını görüntüleme, çizim ekranını yenileme ve temizleme zamanlaması 
ve diğer bilgiler hakkında ayrıntılar için “Çizim Ekranı” (sayfa 139) bölümüne bakın.

Örnek:  Çizim ekranını görüntülemek için

casioplot'tan içe aktar *
show_screen()

clear_screen() (ekranı temizle)     (argüman yok)
Çizim ekranındaki tüm çizim içeriğini temizler. Bu fonksiyon, çizim ekranında herhangi bir çizim içeriği olup 
olmadığına bakılmaksızın yürütülür.

set_pixel(x,y[,color]) (pixeli ayarla(x,y[,renk]))
Belirtilen koordinatlarda, belirtilen renkte bir piksel çizer.
 
x argümanı, y argümanı:
Çizilecek pikselin x ve y koordinatlarını belirtir. Yalnızca aşağıdaki aralıklarda yer alan int türündeki değerler 
belirtilebilir: 0 ≤ x ≤ 383, 0 ≤ y ≤ 191
Aşağıdaki şekil, koordinat değerleri ile çizim ekranındaki konumlar arasındaki ilişkiyi göstermektedir.

(0,0) (383,0)

(0,191) (383,191)

color (renk) argümanı:
Çizilecek pikselin rengini belirtir. Bu argüman hakkında ayrıntılar için “Çizim Fonksiyonu color Argümanı” 
(sayfa 139) bölümüne bakın.

 

.
Örnek: Ekranın sol üst köşesinden sağ alt köşesine doğru düz bir çizgi çizmek ve çizim ekranını görüntülemek 

için

i aralığında (192) için:
set_pixel(i*2,i)

show_screen()

Not
•　Eğer x veya y koordinat değeri izin verilen aralığın dışındaysa, fonksiyon yürütülmesi göz ardı edilir 

(hiçbir şey çizilmez, hata oluşmaz).

get_pixel(x,y) (piksel al(x.y))
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casioplot'tan içe aktar *

fonksiyonlar casioplot modülüne dahildir. Fonksiyon sözdizimindeki köşeli parantez ([ ]) içine alınmış 

casioplot modülü, Python uygulamasında piksel ve karakter çizmek için çizim fonksiyonları içeren CASIO'ya 



Çizim ekranındaki belirtilen koordinatlardaki renk bilgisini alır.
 
x argümanı, y argümanı:
Renk bilgisi alınacak pikselin x ve y koordinatlarını belirtir. Belirtilebilecek değer aralığı ve türü, set_pixel 
fonksiyonunun x ve y argümanları ile aynıdır. Alınan renk bilgisi, 256 dereceli bir RGB değeri olarak 
döndürülür. 

Örnek: (0,0) koordinatının (0,0,0) renk bilgisini almak için

casioplot’tan içe aktar *
set_pixel(0,0,(0,0,0))
get_pixel(0,0)

Not
•　Eğer x veya y koordinat değerlerinden herhangi biri izin verilen aralığın dışındaysa, hiçbir şey döndürülmez.

getkey()     (argüman yok)
Bu fonksiyon yürütüldüğünde basılan hesap makinesi tuşunun tuş kodunu döndürür.
Tuşların tuş kodları aşağıda gösterilmiştir.

12 13 14 15 16

21 22 23 24 25 26

31 32 33 34 35 36

41 42 43 44 45 46

51

61 62 63 64

71 72 73 74 75

81 82 83 84 85

91 92 93 94 95

52 53 54 55 56

Örnek: Basılan tuşun tuş kodunu çizim ekranının sol üst köşesinde görüntülemek için. Bu örnekte, 5   tuşuna 
basılı tutulmaktadır.

casioplot’tan içe aktar*
(True)(doğru) iken:

key=getkey()
clear_screen()
draw_string(0,0,str(key))
show_screen()

Not
•　Betik yürütülmesini durdurmak için a   'ya basın. 

draw_string(x,y,s[,color[,size]]) çizim dizesi(x,y,s[,renk[,boyut]])
Belirtilen koordinatlarda, belirtilen renkte bir karakter dizesi çizer.
 
x argümanı, y argümanı:
Çizilecek dizenin ilk karakterinin sol üst köşesinin x ve y koordinatlarını belirtir. Belirtilebilecek değer aralığı ve 
türü, set_pixel fonksiyonunun x ve y argümanları ile aynıdır.
s argümanı:
Çizilecek karakter dizesini bir str türü olarak belirtir. Yalnızca ASCII karakterleri* görüntülenebilir.
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color (renk) argümanı:
Çizilecek karakter dizesinin rengini belirtir. Bu argüman hakkında ayrıntılar için “Çizim Fonksiyonu color 
Argümanı” (sayfa 139) bölümüne bakın.
size (boyut) argümanı:
Çizilecek karakter dizesinin karakter boyutunu aşağıdakilerden birini kullanarak belirtir: “large”, 
“medium”, “small”. Bu argüman atlandığında “medium” uygulanır.
*　A-Z a-z 0-9 ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ boşluk
Örnek: (0,0) koordinatlarına büyük boyutta ve siyah renkte “abc” çizmek ve çizim ekranını görüntülemek için

casioplot’tan içe aktar*
draw_string(0,0,”abc”,(0,0,0),”large”)
show_screen()

Not
•　Eğer hem x hem de y koordinat değerleri izin verilen aralık içindeyse, çizilen karakter dizesi kısmen 

çizim ekranının dışına çıksa bile çizim ekranı aralığında görüntülenecektir. Eğer x veya y koordinat 
değeri izin verilen aralığın dışındaysa, fonksiyon yürütülmesi göz ardı edilir (hiçbir şey çizilmez, hata 
oluşmaz).

Çizim Fonksiyonu color (renk) Argümanı

color argümanı, çizim rengini 256 RGB tonunda belirtir. Örneğin, siyah belirtmek için (0,0,0) veya [0,0,0] girin. 
Beyaz belirtmek için (255,255,255) veya [255,255,255] girin. color argümanı girişi atlanırsa, (0,0,0) uygulanır. 
Ekranın performansından dolayı, görüntülenen rengin belirtilen değere yaklaşık bir değer olabileceğini 
unutmayın.

Çizim Ekranı
show_screen’i yürütmek, set_pixel ve draw_string ile çizilen içeriğin görüntülendiği çizim ekranını görüntüler. 

Çizim Ekranını Güncelleme ve Temizleme
Çizim ekranı, show_screen her yürütüldüğünde güncellenir ve clear_screen yürütüldüğünde veya Kabuk
(Shell) başlatıldığında temizlenir. Şu anda görüntülenen çizim ekranı, betik yürütülmesi sona erdiğinde de 
güncellenir. 
 
Çizim ekranından Kabuğa (Shell) dönmek için b   'ye basın. 

Dosya Uyumluluğu
.py dosyaları hesap makineniz ve bir bilgisayar arasında paylaşılabilir. Hesap makinesi ile oluşturulan bir 
.py dosyası, bir metin düzenleyici veya başka bir yazılımla düzenlenmek üzere bir bilgisayara aktarılabilir. 
Bir bilgisayarda oluşturulan bir .py dosyası ise hesap makinesine aktarılabilir ve çalıştırılabilir.
Python uygulamasında oluşturduğunuz .py dosyaları, hesap makinesinin depolama belleğinde saklanır 
(dosya adı uzantısı .py). Hesap makinesi ile bilgisayar arasında dosya aktarma prosedürü hakkında bilgi için 
“Hesap Makinesini Bir Bilgisayara Bağlama” (sayfa 210) bölümüne bakın.

Bu Hesap Makinesiyle Oluşturulan ve Kaydedilen py Dosyaları
Bu hesap makinesiyle oluşturulan ve kaydedilen .py dosyalarının formatları aşağıda gösterilmiştir.
Karakter Kodu: ASCII kodu
Kullanılan karakterler: ASCII*
Yeni satır kodu: CR+LF
Girinti: Boşluklar (otomatik girinti için iki boşluk)
*　A-Z a-z 0-9 ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ boşluk
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Bu Hesap Makinesinde Harici Olarak Oluşturulmuş Bir py Dosyası Kullanırken Alınacak Önlemler

Bu hesap makinesinin Python uygulamasını kullanarak bir bilgisayardan hesap makinesine aktarılmış bir .py 
dosyasını görüntülemeye (dosya adı veya dosya içeriği), düzenlemeye veya çalıştırmaya çalıştığınızda aşağıdaki 
kısıtlamalar geçerlidir.

Dosya Adları
•　Hesap makineniz yalnızca ASCII karakterlerinden oluşan dosya adlarını tanır. ASCII olmayan karakterler 

içeren bir dosya adı tanınmaz.
*　Aşağıdaki ASCII karakterleri desteklenmez:

\ / : * ? " < > | .
•　Eğer bir bilgisayardan veya başka bir kaynaktan depolama belleğine aktarılan bir .py dosyasının adı sekiz 

karakterden uzunsa, depolama belleği bilgi ekranında görüntülenirken adı sekiz karaktere kısaltılır. 
(Örnek: AAAABBBBCC.py, AAAABB~1.py olacaktır.)

Dosya İçeriğini Görüntüleme ve Düzenleme
Aşağıdaki (A) ve (B) koşullarını karşılayan bir .py dosyasını Python uygulamasında açtığınızda, tüm dosya içeriği 
normal bir şekilde görüntülenir. İçeriği gösteren bir dosya, Python uygulamasında normal şekilde görüntülenebilir 
ve düzenlenebilir.
(A)　 Yalnızca ASCII karakterleriyle yazılmış ve UTF-8 veya diğer ASCII uyumlu kodlar kullanılarak kaydedilmiş 

.py dosyası.
•　Eğer bir dosya ASCII ile uyumlu olmayan karakter kodlarıyla kaydedilirse, Python uygulamasında 

açtığınızda içeriğinin hiçbiri görüntülenmez. Tüm karakterler boşlukla değiştirilebilir veya bozuk 
görünebilir.

(B)　 Her satırı en fazla 255 karakter içeren ve toplamda en fazla 300 satırdan oluşan .py dosyası.
•　Yukarıda belirtilen karakter ve/veya satır sayısını aşan bir .py dosyasının içeriği Python uygulamasında 

görüntülenemez. Eğer bir dosya açılamıyorsa, onu içe aktarmak için aşağıdaki komutu kullanın.
   Dosya adından (filename) içe aktar *

•　Bir .py dosyasındaki tüm sekme kodları, dosya Python uygulamasında açıldığında iki boşlukla değiştirilir.
•　Hiçbir yeni satır kodu türü (LF, CR, CR+LF) Python uygulaması görüntüleme içeriğini etkilemez. Bir .py 

dosyasındaki tüm yeni satır kodları, dosya Python uygulamasında açıldığında CR+LF (Windows standart 
yeni satır kodu) ile değiştirilir. Python uygulamasında düzenlenmiş ve kaydedilmiş bir .py dosyasını,
 bilgisayarda kullanmak üzere aktarmadan önce, yeni satır kodlarını dosyanın kullanılacağı ortama
 uygun türle değiştirin.

py Dosyasını Çalıştırma
T   > [File] > [Open] öğelerini seçtiğinizde görünen dosya listesindeki bir .py dosyası, Python uygulamasıyla 
çalıştırılabilir. Aşağıdaki bilgilere dikkat edin 
•　Hesap makinesinin Python uygulaması tarafından desteklenmeyen komutlar içeren bir .py dosyasını 

çalıştırmak hataya neden olacaktır.
•　Python uygulamasını kullanarak bir bilgisayarda oluşturulmuş bir .py dosyasını açmak, karakterlerin ve yeni 

satır kodlarının değiştirilmesine neden olur. Bu nedenle, bir .py dosyasını Python uygulamasında açmak, 
kaydetmek ve çalıştırmak, içeriğini orijinal .py dosyasından farklılaştırabilir, bu da çalıştırma sonuçlarını 
etkileyebilir. Ayrıntılar için “Dosya İçeriğini Görüntüleme ve Düzenleme” (sayfa 140) bölümüne bakın..
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Base-N Uygulaması
Base-N uygulaması, bir hesaplamanın sonuçlarını onaltılık (hexadecimal), onluk (decimal), sekizlik (octal) ve 
ikilik (binary) biçimde döndürür. Hesaplama, onaltılık, onluk, sekizlik veya ikilik sayılar kullanılarak girilebilir.
Bu bölümde, bir değerin tabanını belirtmek için değerlere alt simgeler eklenmiştir. Örneğin, 1   onaltılık 1 
anlamına gelir.

16

Temel Hesaplama İşlemleri

Hesaplamaya başlamak için
1.　h  > Base-N

•　Bu işlem, uygulama penceresinin sol üst köşesinde giriş imlecinin görünmesini sağlar.

2.　Bir sayı sistemi (taban) seçmek için F   'yi kullanın. 
•　F   'ye her basış, sayı sistemi ayarını [Decimal] → [Hexadecimal] → [Binary] → [Octal] sırasında 

döngüsel olarak değiştirir. Şu anda seçili olan sayı sistemi, uygulama penceresinin ikinci satırında gösterilir. 

3.　Hesaplamayı girin ve ardından     'ye basın. 
•　Hesaplama sonucu Hex (hexadecimal), Dec (decimal), Oct (octal), ve Bin (binary) biçimlerinde görüntülenir.

Değerleri Girme
•　Hexadecimal değerler için A'dan F'ye kadar olan harfler, tuş girişi veya menü girişi kullanılarak girilebilir.

X A, e B, j C, g D, i E, N F veya C  > [Hex Değeri] > [A] , [B], [C], [D], [E], [F]
•　

 > [Base Prefix] > [d], [h], [b], [o] (d: Decimal, h: Hexadecimal, b: Binary, o: Octal)
10 2

•　Decimal (ondalık) kesirlerin ve üslü sayıların girişi desteklenmez. Bir hesaplama sonucu decimal kesir veya 
üslü sayı üretirse, decimal kesir veya üslü sayı kesilerek gösterilir.

Örnek Hesaplama

112 + 12  > [Binary]
11+1

1F16 + 116  > [Hexadecimal]
1N F+ 1E

1010 + 1016 + 102  > [Decimal]
10+

C  > [Base Prefix] > [h]10+
C  > [Base Prefix] > [b]10
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Örnek: d10, 10   olarak ele alınır. b111, 111   olarak ele alınır. 

Bir hesaplamadaki herhangi bir değer için sayı sistemini, değerden önce d, h, b veya o ekleyerek 
belirleyebilirsiniz.



Son Hesaplama Sonucu (Ans)
•　En son hesaplamanın sonucu, Hesapla uygulamasının Ans'sinden bağımsız olan Ans adlı bir değişkende 

saklanır. Ans'yi yeni bir hesaplamaya girmek için PF     (Ans) tuşuna basın.
•　F   'ye basmak, hesaplamayı ve tüm sonuçları temizler, ancak Ans en son hesaplama sonucunu korur.
•　Base-N uygulamasının Ans'si, Base-N uygulamasından her çıktığınızda 0'a sıfırlanır.

Mantıksal İşlemler ve Negatif Sayı Hesaplamaları
Aşağıdaki fonksiyonlar ve komutlar mantıksal (bitwise operations) işlemler ve negatif sayı hesaplamaları 
gerçekleştirebilir.
C  > [Logic Operation] > [Neg()], [Not()], [ve], [veya], [xor], [xnor]

Sözdizimi

Neg(n) n'nin negatif değerini  elde eder.*1

Not(n) n'yi olumsuzlar.*2

n and m n ve m'nin mantıksal birleşimini  elde eder.*3

n or m

n xor m n ve m'nin özel VEYA'sını  elde eder.*3

n xnor m n ve m'nin özel VEYA'sını olumsuzlar.*3

*1　İkiye tümleyen (two’s complement). Negatif ikilik, sekizlik ve onaltılık değerler, 32 bitlik bir ikilik sayının 
ikiye tümleyeni alınarak ve sonuç orijinal sayı tabanına döndürülerek elde edilir. Onluk sayı tabanında, 
negatif değerler bir eksi işaretiyle görüntülenir.

*2　Bire tümleyen (one’s complement) (bitwise (bitsel) tümleyen)
*3　Bitwise AND, bitwise OR, bitwise XOR, bitwise XNOR

Örnek Hesaplama

Mantıksal İşlemler

120                  ‘nın 
sonucunu elde etmek
için

16 ve AD16  > [Hexadecimal]
120  > [Logic Operation] > [and]

X Ag DE

Negatif Sayı Hesaplamaları

110010  ‘nin negatif 
değerini elde etmek için

2  > [Binary]
 > [Logic Operation] > [Neg()]

110010
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n ve m'nin mantıksal ayrışımını  elde eder.*3



Giriş/Çıkış Aralığı
•　Her sayı sistemi için giriş ve çıkış aralıkları aşağıda gösterilmiştir (32 bit).

Taban Giriş/Çıkış Aralığı
Binary Pozitif: 00000000000000000000000000000000 ≤ x ≤

01111111111111111111111111111111
Negatif: 10000000000000000000000000000000 ≤ x ≤

11111111111111111111111111111111
Octal Pozitif: 00000000000 ≤ x ≤ 17777777777

Negatif: 20000000000 ≤ x ≤ 37777777777
Decimal -2147483648 ≤ x ≤ 2147483647
Hexadecimal Pozitif: 00000000 ≤ x ≤ 7FFFFFFF

Negatif: 80000000 ≤ x ≤ FFFFFFFF
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Finans Uygulaması
Finans uygulamasını kullanarak çeşitli finansal hesaplamalar yapabilirsiniz.

Önemli!
•　Bu uygulamada üretilen hesaplama sonuçları ve grafikler yalnızca referans değerler olarak kabul edilmelidir.
•　Gerçek bir finansal işlem gerçekleştirirken, bu hesap makinesi kullanılarak elde edilen herhangi bir hesap-

lama sonucunu, finans kurumunuz tarafından hesaplanan rakamlarla kontrol ettiğinizden emin olun. 
•　Bugünkü değer (PV) veya satın alma fiyatı (PRC) için pozitif veya negatif bir değer kullanıp 

kullanmamanız, gerçekleştirmeye çalıştığınız hesaplama türüne bağlıdır.

İşlem Akışı
Örnek: %5,0 basit faiz oranında 3.000$ yatırım yapıldığında, iki yıl (730 gün)* sonraki toplam anapara 

ve faizi hesaplamak, ardından bir grafik görüntüleyip hesaplama sonuçlarını grafikle 
karşılaştırmak.

*　S  > [Yıldaki Gün Sayısı ] (sayfa 152): 365

3.　Anapara ve faiz toplamını belirlemek istediğimiz için, [Type] (tür) menüsünün [Future Value (SI)] 
(Gelecek Değer (SI)) öğesini seçin.

(1)　 [Type]'ı vurgulayın ve ardından O  'a basın. 
(2)　 Görünen menüde, [Future Value (SI)]'yi seçin ve ardından O  'a basın. 

4.　Aşağıdaki bilgileri girin: n (gün) = 730; I% (yıllık faiz oranı) = 5; PV (bugünkü değer) = -3000. 

d 730E 5Es- (M )3000E

5.　Bu prosedürün 7. adımında grafik için kullanmak istediğiniz rengi belirtin.
(1)　  T   > [Graph Color]'ı seçin.     
(2)　 İstediğiniz rengi seçin ve ardından O  'a basın.

1.　h  > Finance
•　Bu, Finans sekmesini görüntüler.

2.　[Basit Faiz]'i vurgulayın ve ardından O  'a basın.
•　Bu, Basit Faiz Kurulum sekmesini görüntüler.

6.　Hesaplamayı yürütmek için >   'a basın (veya vurgulayıp   
O  'a basın).
•　Bu işlem, gelecek değerin (FV = anapara + faiz) hesaplama 

sonucunu Sonuç sekmesinde görüntüler.
•　Parametreler doğru yapılandırılmamışsa bir hata oluşur.

144



7.　Grafiği görüntülemek için >   'a basın.

9.　Grafik sekmesinden Sonuç sekmesine dönmek için b   veya <   basın.

Finansal Hesaplamalar Yapma
Aşağıdaki tabloda yer alan hesaplamalar Finans uygulamasıyla yapılabilir.

Bu türde bir hesaplama yapmak için: Finans sekmesinde bunu seçin:
Paranın yatırımda kaldığı gün sayısına dayalı, bileşik faizsiz 
faiz

Simple Interest*1

Sizin belirttiğiniz bileşik faiz parametrelerine dayalı faiz Compound Interest*2

Zaman içinde değişken miktarlarda ödenen veya alınan paranın   Cash Flow
değeri 
Bir ödeme veya ödemelerin faiz ve anapara kısımları Amortization*2

Yıl içinde birden çok kez bileşik faizlenen faiz için efektif 
veya nominal faiz oranı

Conversion

Bir ürünün maliyeti, satış fiyatı veya kâr marjı, diğer iki değer 
verildiğinde

Cost/Sell/Margin

İki tarih arasındaki gün sayısı veya başka bir tarihten belirli 
sayıda gün sonraki tarih

Days Calculation*1

Bir ticari giderin belirli bir yılda gelirle ne kadar telafi 
edilebileceği (değer kaybı)

Depreciation

Bir tahvilin satın alma fiyatı veya yıllık getirisi Bond Calculation*1*3

*1　Bir hesaplama yapmadan önce, S  > [Yıldaki Gün Sayısı] (sayfa 152) öğesini belirtin..
*2　Bir hesaplama yapmadan önce, S  > [Ödeme Noktası] (sayfa 152) öğesini belirtin..
*3　Bir hesaplama yapmadan önce, S  >[Ödenen Faiz] (sayfa 152) öğesini belirtin.

Hesaplama Örnekleri
Örnek 1 (Conversion) (Dönüşüm):

İki ayda bir bileşik faizlenen (n = 6) bir tahvilin efektif faiz oranı (I%) %5 olduğunda, yıllık yüzde oranını 
(APR) belirlemek için

1.　Finans sekmesinde, [Conversion]'u vurgulayın ve ardından O  'a basın.
•　Bu işlem, Conversion Kurulum sekmesini görüntüler.

2.　Yıllık yüzde oranını bulmak istediğimiz için, [Type] menüsünden [Annual Percent Rate]'i seçin. 
(1)　 [Type]'ı vurgulayın ve ardından O   'a basın.
(2)　 Görünen menüde, [Annual Percent Rate]'i seçin ve ardından O  'a basın.

3.　Aşağıdaki bilgileri girin: n (bileşik faiz sayısı) = 6; I% (faiz oranı) = 5.

d 6E 5E

8.
　

Grafik üzerindeki hesaplama sonuçlarını kontrol etmek için T   > 
[Trace]'i (izleme) seçin. 
•　Bu işlem, izlemeyi etkinleştirir ve grafik üzerinde artı işaretli 

bir imlecin (    ) görünmesini sağlar.
•　İzleme etkin durumdayken r    'a her basış, görüntülenen değeri 

sırayla değiştirir: bugünkü değer (PV) → basit faiz (SI) → gelecek 
değer (FV).     'a basmak ters yönde döngü yapar. 

•　İzlemeden çıkmak için b   'ye basın. 
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Örnek 2 (Depreciation) (Değer Kaybı):

Faydalı ömrü (n) 5 yıl ve orijinal maliyeti (PV) 12.000$ olan bir kişisel bilgisayar için yılların toplamı 
yöntemini kullanarak ilk yılın değer kaybını hesaplamak. İlk yılki değer kaybı ayı sayısının (Y-1) 12 ay 
olduğunu varsayın. Ayrıca, her yılki değer kaybının bir listesini görüntüleyin.

1.　Finans sekmesinde, [Depreciation]'nı vurgulayın ve ardından O   tuşuna basın. 
•　Bu Depreciation Kurulum sekmesini görüntüler.

2.　Yılların toplamı yöntemini kullandığımız için, [Type] menüsünden [Sum-of-the-Years’-Digits]'i seçin.

3.　Aşağıdaki bilgileri girin: n (faydalı ömür) = 5; PV (orijinal maliyet) = 12000; FV (kalan defter değeri) = 0; j 
(değer kaybı maliyeti hesaplama yılı) = 1; Y-1 (ilk yılki değer kaybı ayı sayısı) = 12.

d 5E 12000E 0E 1E 12E

 
Örnek 3 (Bond Calculation) (Tahvil Hesaplama):

1 Haziran 2024 (d1) takas tarihi olan ve 15 Aralık 2028'de (d2) vadesi dolan altı aylık bir tahvil   satın 
almak istiyorsunuz. Tahvil, yılda 365 gün esasına göre hesaplanır.   Tahvil, nominal değerinin (RDV) 
%100'ünden itfa edilir ve kupon oranı (CPN) %3'tür. Vadeye kadar getiri (YLD) %4 ise, tahvilin fiyatını 
(PRC), birikmiş faizi (INT) ve birikmiş faiz dahil satın alma fiyatını (CST) belirleyin.

*1

*2

*1　S  > [Interest Paid] (sayfa 152): Altı ayda bir
*2　S  > [Number of Days/Year] (sayfa 152): 365

1.　Finans sekmesinde, [Bond Calculation]'yı vurgulayın ve ardından O   'a basın.
•　Bu Bond Calculation Kurulum sekmesini görüntüler.

2.　Tahvilin fiyatını belirlemek istediğimiz için, [Type] menüsünden [Bond’s Price]'ı seçin.

3.　Aşağıdaki bilgileri girin: d1 = 6/1/2024 (ay/gün/yıl); d2 = 12/15/2028 (ay/gün/yıl); RDV = 100; 
CPN = 3; YLD = 4.

4.　Hesaplamayı yürütmek için >    tuşuna basın. 
•　Bu, hesaplama sonucunu Sonuç sekmesinde görüntüler.

4.　Hesaplamayı yürütmek için >   'a basın. 
•　Bu, hesaplama sonucunu Sonuç sekmesinde görüntüler.

5.　Her yılki değer kaybının bir listesini görüntülemek için >   'a basın.
•　Tablo sekmesi, her yıl için değer kaybını (SYD) ve her 

yılınsonunda kalan amortisman değerini (RDV) 
gösterir.

•　Tablo sekmesini görüntülerken, >   'a basarak grafiği 
görüntüleyebilirsiniz.
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dE 6E 1E 2024EE
E 12E 15E 2028EE

100E 3E 4E

Not: Bond Calculation (Tahvil Hesaplama) Memorandum Ekranı
•　Tahvil Hesaplama'nın Sonuç sekmesinde T   > [Raporu Görüntüle]'yi seçmek, hesaplamada kullanılan 

gün sayısı değerlerini aşağıda gösterildiği gibi görüntüler. 
 

•　Rapor ekranı görüntülenirken T    > [Show Coupon Payment Day]'i seçmek, faiz ödeme tarihini 
gösteren bir ekrana geçer (yalnızca S    > [Number of Days/Year] “365” olduğunda). İtfa yılından 
satın alma yılına kadar birden fazla faiz ödeme tarihi varsa, bu ekran görüntülenirken O   'a 
her basışta, her bir faiz ödeme tarihi ilk ödemeye ulaşılana kadar sırayla geri döner.

 

PRD: d1'den d2'ye kadar olan gün sayısı
N: Takas tarihi ile vade tarihi arasındaki kupon ödemelerinin 

sayısı
A: Birikmiş günler
B: Takas tarihinden bir sonraki kupon ödeme tarihine kadar 
                 olan gün sayısı (D − A)
D: Takasın gerçekleştiği kupon dönemindeki gün sayısı

Giriş/Çıkış Terimleri ve Hesaplama Formülleri

Simple Interest (Basit Faiz)

SI: interest (faiz)
n: number of interest periods (faiz dönemi sayısı)
PV : principal (anapara)

I : annual interest rate (yıllık faiz oranı)
FV : principal plus interest (anapara artı faiz)

365-günlük Mod: SI n
365 PV i i I

100

360-günlük Mod: SI n
360 PV i i I

100

SI -SI
FV - PV SI

Compound Interest (Bileşik Faiz)

n: number of compound periods (bileşik faiz dönemi sayısı)

)
I : annual interest rate (yıllık faiz oranı)

PV : present value (bugünkü değer)

PMT : payment (ödeme)

FV: future value (gelecek değer)

P Y : installment periods per year (yıldaki taksit 
dönemleri)

C Y : compounding periods per year (yıldaki bileşik 
faiz dönemleri)

PV, PMT, FV, n hesaplanırken

I ≠ 0 PV - α PMT β FV

PMT - PV β FV
α

FV - PV α PMT
β

4.　Hesaplamayı yürütmek için >   'a basın.
•　Bu, hesaplama sonucunu Sonuç sekmesinde görüntüler. 
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n
1 iS PMT − FV i
1 iS PMT PV i

1 i

I 0 PV - PMT n FV n 0

PMT - PV FV
n n 0

FV - PMT n PV n 0

n - PV FV
PMT

α (1 i S) 1 − β
i 　　β 1 i -n

 > [Payment Point] “Son” olduğunda  > [Payment Point] i“Başlangıç” olduğunda
S 0 1

P Y C Y 1 olduğunda P Y ≠ 1 ve/veya            olduğunda C Y ≠ 1

i I
100 1 I

100 C Y

C Y
P Y

− 1

I% Hesaplanırken
i (effective interest rate) (efektif faiz oranı) Newton Yöntemi kullanılarak hesaplanır.
PV α PMT β FV 0
I  i kullanılarak aşağıdaki formüllerle hesaplanır: 

I i 100 1 i
P Y
C Y − 1 C Y 100

Önemli!
•　Bir hesaplama için hem bugünkü değeri (PV) hem de gelecek değeri (FV) girerken, bunlardan biri 

pozitif, diğeri ise negatif olmalıdır.
•　Yıllık faiz oranı (I%) hesaplamaları, çeşitli hesaplama koşullarından etkilenebilen yaklaşık değerler 

üreten Newton Yöntemi kullanılarak yapılır. Bu uygulama tarafından üretilen faiz hesaplama sonuçları, 
yukarıdakiler akılda tutularak kullanılmalı veya sonuçlar ayrıca teyit edilmelidir.

Cash Flow (Nakit Akışı)
Bu hesap makinesi, sabit bir dönem için nakit akışını toplayarak yatırım değerlemesi yapmak için iskontolu 
nakit akışı (DCF) yöntemini kullanır. Bu hesap makinesi, aşağıdaki dört tür yatırım değerlemesini gerçekleştirebilir

NPV : Net present value (Net bugünkü değer)
IRR: Internal rate of return (İç verim oranı)

NFV : Net future value (Net gelecek değer)
PBP: Payback period (Geri ödeme süresi)

Aşağıda gösterilen gibi bir nakit akışı diyagramı, fonların hareketini görselleştirmeye yardımcı olur.

CF0

CF1

CF2
CF3

CF4

CF5
CF6

CF7

Bu grafikte, ilk yatırım tutarı CF0 ile temsil edilir. Bir yıl sonraki nakit akışı       , iki yıl sonraki         veCF1

bu şekilde devam eder.
CF2
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NPV CF0
CF1
1 i

CF2

1 i 2
CF3

1 i 3 ･･･ CFn

1 i n (i I
100, I : Interest rate, n: 254'e kadar doğal sayı)

NFV NPV 1 i n

IRR aşağıdaki formül kullanılarak hesaplanır:

0 CF0
CF1
1 i

CF2

1 i 2
CF3

1 i 3 ･･･ CFn

1 i n

Bu formülde, NPV = 0'dır ve IRR değeri i ×100'e eşdeğerdir. Ancak, hesap makinesi tarafından otomatik olarak 
gerçekleştirilen sonraki hesaplamalar sırasında küçük ondalık değerlerin birikme eğilimi gösterdiğini, bu nedenle 
NPV'nin hiçbir zaman tam olarak sıfıra ulaşmadığını unutmamak gerekir. NPV sıfıra ne kadar yaklaşırsa, IRR o 
kadar doğru olur. 

PBP
0……………………… CF0 ≥ 0

n − NPVn
NPVn 1 − NPVn

･･･(diğer durumlarda)

NPVn ∑
k 0

n CFk

1 i k
n: koşulları sağlayan en küçük pozitif tam sayı

NPVn ≤ 0, 0 ≤ NPVn 1, or 0

Amortization (Amortisman)

PM1: 1'den n'ye kadar olan taksitlerin ilki n
PM2: 1'den n'ye kadar olan taksitlerin ikincisi n
n: taksit sayısı
I : interest rate (faiz oranı)
PV : principal (anapara)

PMT : her bir taksit için ödeme
FV : son taksitten sonraki bakiye
P Y : yıldaki taksitler
C Y : yıldaki bileşik faizlenme sayısı

a

b

1

c

PM1 PM2

1 ödeme

Last
Ödemelerin sayısı

e

d

1 PM1 PM2

1 ödeme

Last
Ödemelerin sayısı

a: PM1 taksitinin faiz kısmı (INT) INT 1 BAL 1-1 i PMT

b: PM1 taksitinin anapara kısmı (PRN) PRN 1 PMT BAL 1-1 i

a + b = bir geri ödeme (PMT)

c: PM2 taksitinden sonraki anapara bakiyesi (BAL) BAL 2 BAL 2-1 PRN 2

d: PM1 taksitinden PM2 taksitinin ödenmesine kadar 
olan toplam anapara PM2 (ΣPRN) ∑

1

2
PRN PRN 1 PRN 1+1 ･･･ PRN 2

e: PM1 taksitinden PM2 taksitinin ödenmesine kadar 
olan toplam faiz (ΣINT) ∑

1

2
INT INT 1 INT 1+1 ･･･ INT 2

 > [Payment Point] “Son” olduğunda, BAL0 PV .
 > [Payment Point] “Başlangıç” olduğunda, INT1 0 ve PRN1 PMT .

Nominal Interest Rate (Nominal Faiz Oranı) ile Effective Interest Rate (Efektif Faiz Oranı) Arasında 
Dönüştürme
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Nominal faiz oranı (kullanıcı tarafından girilen I% değeri), yıldaki taksit sayısının, bileşik faiz hesaplama 
dönemi sayısından farklı olduğu taksitli krediler için efektif bir faiz oranına (I%’) dönüştürülür. 

I 1 I
100 C Y

C Y
P Y

− 1 100

Nominal faiz oranından efektif faiz oranına dönüştürme işleminden sonra aşağıdaki hesaplama yapılır ve sonuç,
sonraki tüm hesaplamalar için kullanılır.

i I 100

Conversion (Dönüşüm)

EFF: Effective interest rate (Efektif faiz oranı) (%)
APR: Annual percent rate (Yıllık yüzde oranı) (%)

n: number of compoundings (bileşik faizlenme sayısı)
I : Interest rate (Faiz oranı)

EFF 1 APR 100
n

n
− 1 100 APR 1 EFF

100

1
n − 1 n 100

Cost/Sell/Margin (Maliyet/Satış/Kar Marjı)

Cst: Cost price ( Maliyet fiyatı) Sel: Selling price (Satış fiyatı) Mrg: Margin (Kar marjı) (%) 

Cst Sel 1 − Mrg
100

Sel Cst
1 − Mrg

100

Mrg( ) 1 − Cst
Sel 100

Gün Hesaplama
Gün Sayısı               = d2-d1 (d1: gün 1, d2: gün 2)
Sonraki Günler         =d1+D(d1: gün, D: gün sayısı)
Önceki Günler          =d1-D(d1: gün, D:gün sayısı)

Depreciation (Değer Kaybı)

Straight-Line (Normal Amortisman) Methodu (SL)

SLj: depreciation charge for the               (j. yıl için değer kaybı maliyeti) jth year
n: useful life (faydalı ömür)
PV : original cost (basis) (orijinal maliyet (esas))
FV : residual book value (kalan defter değeri)
j: year for calculation of depreciation cost (değer kaybı maliyeti hesaplama yılı)
Y − 1: number of months in the first year of depreciation (ilk yılki değer kaybındaki ay sayısı)

SL1
PV − FV

n
Y − 1

12 SLj
PV − FV

n SLk
PV − FV

n
12 − Y − 1

12 k n 1, Y − 1 ≠ 12
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Fixed-Percent (Sabit Yüzde) Metotu (FP)

FPj: depreciation charge for the jth year (j. yıl için değer kaybı maliyeti)
RDV j: remaining depreciable value at the end of jth year ( j. yılın sonunda kalan amortisman değeri)
I : depreciation ratio (değer kaybı oranı)

FP1 PV I
100

Y − 1
12

FPj RDV j − 1 FV I
100 FPn 1 RDVn Y − 1 ≠ 12

RDV1 PV − FV − FP1 RDV j RDV j − 1 − FPj RDVn 1 0 Y − 1 ≠ 12

Sum-of-the-Years’-Digits (Yılların Toplamı) Metotu (SYD)

SY Dj: depreciation charge for the jth year (j. yıl için değer kaybı maliyeti)
RDV j: remaining depreciable value at the end of jth year (j. yılın sonunda kalan amortisman değeri)

Z n n 1
2 n n − Y − 1

12 Z n 1 n 2 n
2

SY D1
n
Z

Y − 1
12 (PV − FV ) SY Dj

n − j 2
Z (PV − FV − SY D1) j ≠ 1

SY Dn 1
n − n 1 2

Z (PV − FV − SY D1) 12 − Y − 1
12  ({Y − 1} ≠ 12)

RDV1 PV − FV − SY D1 RDV j RDV j − 1 − SY D1

Declining-Balance (Azalan Bakiyeler) Metotu (DB)

DBj: depreciation charge for the jth year (j. yıl için değer kaybı maliyeti)
RDV j: remaining depreciable value at the end of jth year ( j. yılın sonunda kalan amortisman değeri)
I : depreciation factor (değer kaybı faktörü)

DB1 PV I
100n

Y − 1
12

RDV1 PV − FV − DB1 DBj RDV j − 1 FV I
100n

RDV j RDV j − 1 − DBj DBn 1 RDVn Y − 1 ≠ 12 RDVn 1 0 Y − 1 ≠ 12

Bond (Tahvil) Hesaplama

①　 Issue date (İhraç tarihi)
②　 Coupon payment dates (Kupon ödeme tarihleri)
③　 Purchase date (Satın alma tarihi) (d1)
④　 Redemption date (İtfa tarih) (d2)

PRC: price per $100 of face value (nominal değerin 100$'ı başına fiyat)
CPN : coupon rate (kupon oranı) (%)
Y LD: annual yield (yıllık getiri) (%)
M : yıldaki kupon ödemelerinin sayısı (1=yıllık, 2=altı aylık) 
N : takas tarihi ile vade tarihi arasındaki kupon ödemelerinin sayısı
RDV : nominal değerin 100$'ı başına itfa fiyatı veya geri çağırma fiyatı
INT : accrued interest (birikmiş faiz)
CST : price including interest (faiz dahil fiyat)
D: takasın gerçekleştiği kupon dönemindeki gün sayısı
A: accrued days (birikmiş günler)
B: takas tarihinden bir sonraki kupon ödeme tarihine kadar olan gün sayısı  D −A

İtfaya bir veya daha az kupon dönemi kaldığında

D

A B
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PRC -
RDV CPN

M

1 B
D

Y LD 100
M

A
D

CPN
M

Redemption (İtfa) bir kupon döneminden fazla süre kaldığında

PRC - RDV

1 Y LD 100
M

N − 1 B
D
− ∑

k 1

N CPN
M

1 Y LD 100
M

k − 1 B
D

A
D

CPN
M

INT - A
D

CPN
M CST PRC INT

Önemli!
•　Finans uygulaması, çeşitli hesaplama koşullarından etkilenebilen yaklaşık değerler üreten Newton 

Yöntemi'ni kullanarak yıllık getiri (YLD) hesaplamaları yapar. Bu nedenle, bu uygulama tarafından 
üretilen yıllık getiri hesaplama sonuçları yukarıdakiler akılda tutularak kullanılmalı veya sonuçlar ayrıca 
teyit edilmelidir.

Finans Uygulaması Ayarlar Menüsü Öğeleri
Aşağıda açıklanan Ayarlar menüsü öğeleri (sayfa 214), Finans uygulamasına özgüdür.

S  > [Payment Point] ... Ödeme tarihini dönemin başlangıcı (Beginning) veya sonu (End) olarak 
belirtir. Bu ayar, Bileşik Faiz ve Amortisman hesaplamalarını etkiler.

S  > [Number of Days/Year] ... Bir yıldaki gün sayısını 365 veya 360 olarak belirtir. Bu ayar, Basit Faiz, 
Gün Hesaplama ve Tahvil Hesaplama'yı etkiler.

S  > [Interest Paid] ... Tahvil Hesaplaması'nda faiz ödemeleri arasındaki aralığı yılda bir veya altı 
ayda bir olarak belirtir.
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Geometri Uygulaması

Geometri uygulaması, tanımladığınız koşullara göre bir şeklin nasıl değiştiğini izlemenizi sağlayan bir animasyon 
özelliği de içerir.

Not
•　Geometri uygulamasındaki Ayarlar menüsünün Angle (Açı), Grid (Izgara) veya Axes (Eksen) ayarlarında 

yapılan değişiklikler yalnızca Geometri uygulamasını etkiler. Diğer uygulamaları etkilemezler. Tersine, bu 
ayarlara diğer uygulamalarda yapılan değişiklikler Geometri uygulamasını etkilemez.

•　Geometri uygulamasının Açı ayarının ilk varsayılan ayarı Degree (Derece)'dir.
•　Bu bölümdeki örnekler, aksi belirtilmedikçe, Geometri uygulamasının ilk varsayılan ayarlarının 

kullanıldığını varsaymaktadır ("Dosya Menüsünü Kullanma" (sayfa 161) altında açıklandığı gibi yeni bir 
dosya oluşturulduğunda bu ayarlar yapılandırılır).

Nesneleri Çizme ve Düzenleme
Bu bölüm, aşağıdaki işlemlerin nasıl gerçekleştirileceğini açıklar.
•　Plot points (Noktaları işaretleme), draw line (doğru parçaları), polygons (çokgenler), etc. (Çizim menüsü, 

Özel Çizim menüsü)
•　Ekran görüntülerine metin ekleme
•　Bir işlemi geri alma
•　Nesneleri seçme ve seçimini kaldırma, bir nesneyi taşıma, bir nesneyi silme ve diğer düzenleme işlemleri

İmleci (Pointer) Kullanma
Nesneleri çizerken, nesneleri düzenlerken vb., ekran üzerindeki imleci (   ) ekranın etrafında hareket ettirmek 
için aşağıdaki işlemleri kullanabilirsiniz.

İmleci hareket ettirmek için
İmleci ekranın etrafında hareket ettirmek için imleç tuşlarını (d/u/l/r)              ) kullanın. Bir imleç tuşuna basılı 
tutmak, imleci yüksek hızda hareket ettirir.

İmleci belirli bir konuma atlatmak için
Bir rakam tuşuna (1   ila 9   ) basmak, imlecin aşağıda gösterildiği gibi ekranın ilgili konumuna atlamasını 
sağlar.
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bir noktasında teğet olan bir doğru çizebilirsiniz.
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Çizim (Draw) Menüsünü Kullanma
Çizim menüsü; noktalar, doğru parçaları, çemberler vb. gibi temel geometrik unsurları çizmek için menü öğeleri 
içerir.

Bunu yapmak için: Bu menü öğesini seçin: Ve sonra şu noktaları belirtin:*1

Bir nokta işaretleme T  > [Draw] > [Point] Bir nokta *2

Bir doğru parçası çizme T  > [Draw] > [Line Segment] Farklı konumlarda iki nokta (doğru 
parçasının başlangıç ve bitiş noktaları)

Bir düz doğru çizme T  > [Draw] > [Line] Farklı konumlarda iki nokta (düz 
doğrunun geçtiği iki nokta)

Bir ışın çizme T  > [Draw] > [Ray] Farklı konumlarda iki nokta (ışının 
başlangıç noktası ve ışının geçtiği bir 
nokta)

Bir vektör çizme T  > [Draw] > [Vector] Farklı konumlarda iki nokta (vektörün 
başlangıç ve bitiş noktaları)

Bir çember çizme T  > [Draw] > [Circle] Farklı konumlarda iki nokta (çemberin 
merkez noktası ve çemberin çevresindeki 
bir nokta)

Bir yay çizme T  > [Draw] > [Arc] Farklı konumlarda üç nokta*3

Bir yarım çember çizme T  > [Draw] > [Semicircle, by
Diameter]

Farklı konumlarda iki nokta (bir çember 
çapının iki ucu)

*1　Tek bir nokta belirtmek için imleci istediğiniz konuma getirin ve O   'a basın.
*2　Aşağıdaki Örnek 1'e (sayfa 154) bakın.
*3　Aşağıdaki Örnek 2'ye (sayfa 155) bakın.
 
Örnek 1: Bir nokta işaretleme

1.　T   > [Draw] > [Point]'i seçin.

2.　İmleci bir nokta işaretlemek istediğiniz konuma getirin ve ardından O  'a basın.
•　Bu işlem, imlecin konumuna bir nokta işaretler.
•　Ekrandaki       simgesi kalır, bu da isterseniz daha fazla nokta işaretlemek için 2. adımı tekrarlayabileceğiniz 

anlamına gelir.
3.　İstediğiniz tüm noktaları işaretlemeyi bitirdikten sonra, Point aracının seçimini kaldırmak için b   'ye basın.

Not
•　Bazı çizim araçları, Point aracı gibi, bir şey çizdikten sonra da etkin kalır. Bu tür bir aracın seçimini 

kaldırmak için b    veya a   'ye basın.
•　Mevcut bir doğruya, bir çokgenin kenarına, bir çemberin çevresine vb. etiketli bir nokta eklemek için 

aşağıdaki prosedürü kullanabilirsiniz.

(1)　 T   > [Draw] > [Point]'i seçin. 
(2)　  Ekrandaki imleci, etiketli noktayı eklemek istediğiniz doğruya doğru hareket ettirin ve ardından 

O   'a basın.
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Örnek 2: Bir yay çizmek için:

1.　T   > [Draw] > [Arc]'ı seçin.

2.　İmleci yayın merkez noktasının olmasını istediğiniz konuma getirin ve ardından O  'a basın. 

3.　İmleci yayın başlangıç noktasının olmasını istediğiniz konuma getirin ve ardından O  'a basın. 

6.　Yay aracının seçimini kaldırmak için b   'ye basın.

Özel Çizim (Draw Special) Menüsünü Kullanma
Özel Çizim menüsü; üçgenler, dikdörtgenler ve çokgenler çizmek için menü öğelerinin yanı sıra girilen 
fonksiyonlara dayalı grafikler çizmek için menü öğeleri de içerir.

Bunu yapmak için: Bu menü öğesini seçin: Ve sonra şu noktaları belirtin:*1

Bir üçgen çizme T  > [Draw Special] > [Triangle] Farklı konumlarda iki nokta*2

Bir ikizkenar üçgen çizme T  > [Draw Special] > [Isosceles
Triangle]

Bir dikdörtgen çizme T  > [Draw Special] > [Rectangle]
Bir kare çizme T  > [Draw Special] > [Square]
Bir çokgen çizme T  > [Draw Special] > [Polygon] Farklı konumlarda en az üç nokta*3

 

Bunu yapmak için: Bu menü öğesini seçin: Ve sonra bu işlemi gerçekleştirin:
Bir düzgün n-gen çizme T  > [Draw Special] > [Regular n-

gon]
Görünen iletişim kutusuna 3 ile 12 arasın-
da bir tamsayı girin ve ardından O 'a basın.

Bir fonksiyon grafiği 
çizme

T  > [Draw Special] > [Function f(x)] Görünen iletişim kutusuna y=f(x) formunda 
bir fonksiyon girin ve ardından O  'a basın.*4

*1　Tek bir nokta belirtmek için imleci istediğiniz konuma getirin ve ardından O  'a basın.
*2　Aşağıdaki Örnek 1'e (sayfa 155) bakın.
*3　Aşağıdaki Örnek 2'ye (sayfa 156) bakın.
*4　Çizilen grafiğin açı birimi, Ayarlar menüsündeki Angle (Açı) ayarından bağımsız olarak her zaman 

Radyan'dır.
 
Örnek 1: Bir üçgen çizme

1.　T   > [Draw Special] > [Triangle]'ı seçin.

2.　İmleci ekranda herhangi bir konuma getirin ve ardından O  'a basın. 

4.　İmleci ve doğru parçasını, yayın bitiş noktasının olmasını istediğiniz 
konuma getirin.

5.　O  'a basın.
•　Bu işlem, yay başlangıç noktasından bitiş noktasına kadar, 

saat yönünün tersine bir yay çizer.

3.　İmleci başka bir konuma getirin.
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Not
•　Yukarıdaki prosedürde bulunan aynı tipteki iki noktalı seçim sınırı, bir ikizkenar üçgen, dikdörtgen, 

kare veya düzgün n-gen çizerken de kullanılır.
Her durumda, belirtilen ikinci nokta, ilk noktaya çok yakın veya aynı konumdaysa, ortaya çıkan nesne 
ekrana sığan maksimum boyutta olur.

Örnek 2: Bir çokgen çizmek için

1.　T   > [Draw Special] > [Polygon]'u seçin.

2.　Çokgenin bir köşesinin olmasını istediğiniz konuma imleci getirin ve ardından O  'a basın.

4.　Çokgen aracının seçimini kaldırmak için b   'ye basın.
•　Yukarıdaki 3. adımda işlemi gerçekleştirmeden b   'ye basarsanız, şekil olduğu gibi tamamlanır ve kapalı 

olmayan bir şekil oluşur.
 

Ekran Görüntülerine Metin Ekleme

Ekran görüntüsüne metin eklemek için

2.　T   > [Option] > [Text]'i seçin.

•　Bu, çizilecek üçgenin boyutunu gösteren bir seçim sınırı 
oluşmasını sağlar.

4.　O  'a basın.
•　Bu, bir üçgen çizer.

•　Çokgenin diğer köşelerini belirtmek için bu adımı gerektiği 
kadar tekrarlayın.

3.　Çokgeni tamamlamak için imleci ilk köşenin bulunduğu konuma getirin 
ve ardından O  'a basın.

1.　İmleci, metni eklemek istediğiniz konuma getirin.
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Ekran metnini düzenlemek için
1.　Düzenlemek istediğiniz metni seçin.

2.　V   'ye basın.
•　Bu işlem, ekranın altında ölçüm kutusunu görüntüler.

3.　O   'a basın.

4.　Metni düzenleyin ve ardından O   'a basın.

5.　Ölçüm kutusunu kapatmak için b   'ye iki kez basın.

Not
•　Ölçüm kutusu hakkında ayrıntılı bilgi için "Ölçüm Kutusunu Kullanma" (sayfa 168) bölümüne bakın.

Bir İşlemi Geri Alma ve Yineleme

Yaptığınız son işlemi geri almak için
Geri almak istediğiniz işlemi gerçekleştirdikten hemen sonra, /    'e basın veya T   > [Edit] > [Undo/Redo]'yu seçin.

Not
•　T    > [Edit] > [Clear All] işlemleri geri alınamaz. Ayrıca, bir nesne seçme veya seçimi kaldırma işlemini, bir T    > 

[View] menü öğesi işlemini (Görünüm Penceresi ayarları, kaydırma, yakınlaştırma işlemleri) veya bir ayar 
değişikliğini geri alamazsınız.

Bir işlemi yinelemek için
İşlemi geri aldıktan hemen sonra, /    'e basın veya T   > [Edit] > [Undo/Redo]'yu seçin. 

•　Bu, bir metin giriş iletişim kutusu görüntüler ve hesap makinesinin 
tuşlarını otomatik olarak alfa kilidine geçirir.

3.　En fazla 31 karakter metin girin ve ardından O  'a basın.
•　Girdiğiniz metin, imlecin bulunduğu konuma ekran görüntüsüne 

eklenir.

•　Bu, bir metin giriş iletişim kutusunu görüntüler.

•　Bu, yeni düzenlenen metnin ekranda görünmesini sağlar.
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Nesneleri Seçme ve Seçimi Kaldırma
Bir nesneyi düzenlemek (taşıma, silme, renk değiştirme vb.) veya bir nesneyi kullanarak bir çizim oluşturmak 
(örneğin, bir doğru parçasının orta noktasını oluşturmak) için, önce nesnenin bir kısmını veya tamamını 
seçmeniz gerekir. Bu bölüm, nesneleri nasıl seçeceğinizi ve seçimini nasıl kaldıracağınızı açıklar.
Aşağıdaki tabloda gösterilen işlemlere başlamadan önce, ekranın sağ üst köşesinde hiçbir araç simgesinin görüntü-
lenmediğinden emin olun. Bir araç simgesi görüntüleniyorsa, aracı devre dışı bırakmak için b   veya a   'ya basın.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Belirli bir nesneyi seçme    1.　İmleci seçmek istediğiniz nesneye yaklaştırın

•　Bu, nesne üzerinde bir veya daha fazla      işaretin görünmesine neden olur. 
Bu sırada nesne yanıp sönmeye başlar.

2.　O  'a basın.
•　Bu,      simgesinin     simgesine dönüşmesine ve nesnenin dış çizgisinin 

kalın bir çizgi haline gelmesine neden olur, bu da nesnenin seçili olduğunu 
gösterir.

•　Artık isterseniz, diğer nesneleri seçmek için 2. ve 3. adımları tekrarlayabilirsiniz.

Tüm bir çokgeni seçme      1.　İmleci seçmek istediğiniz çokgene yaklaştırın.
•　Bu,      çokgenin bir kısmı (köşe veya kenar) üzerinde işaretlerin 

görünmesine neden olur.
2.　P  'ya basın veya T   > [Edit] > [Select Figure]'u seçin.

•　Bu, tüm çokgeni seçer.

Tüm bir yarım çemberi       Yarım çemberi seçmek için yukarıdaki "Tüm bir çokgeni seçme" altındaki aynı 
seçme                                 işlemi kullanabilirsiniz. 

Tüm bir çemberi seçme      1.　İmleci seçmek istediğiniz çemberin çevresine yaklaştırın. 
•　Bu, çevrede dört      işaretin görünmesine neden olur. Bu sırada çevre yanıp 

sönmeye başlar.
2.　O  'a basın.

•　Bu, tüm çemberi seçer.
Belirli bir nesnenin 
seçimini kaldırma.

1.　İmleci seçimini kaldırmak istediğiniz nesneye yaklaştırın.
•　Bu,      işaretlerin vurgulanmasına neden olur. Bu sırada nesne yanıp 

sönmeye başlar.
2.　O  'a basın.

Not
•　Tüm bir çokgenin yalnızca bir kısmının (köşe veya kenar) seçimini 

kaldırmak için yukarıda açıklanan aynı işlemi kullanabilirsiniz.
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Tüm nesneleri ekranda 
seçmek için

T   > [Edit] > [Select All]'u seçin.

Tüm nesnelerin seçimini 
ekranda kaldırmak için

a    'ya basın veya T   > [Edit] > [Deselect All]'u seçin.

Bir Nesneyi Taşıma ve Silme

Bir nesneyi taşımak için
1.　Taşımak istediğiniz nesneyi seçin..

Not
•　Ekranda hiçbir şey seçili değilken X   'e basarsanız, imleç       simgesine dönüşür ve bu simgeyi tüm 

ekranı kaydırmak (ötelemek) için kullanabilirsiniz.
•　Bazen bir nesnenin istediğiniz gibi hareket etmediğini görebilirsiniz. Bu durum meydana gelirse, taşımayı 

iptal etmek için      'ya basın ve ardından taşımayı tekrar denemek için aşağıdakileri yapın.
-　Nesnenin hareket etmesini istemediğiniz kısımlarını kilitleyin ("Bir Nesnenin Ölçümünü Kilitleme veya 

Kilidini Açma" (sayfa 171) bölümüne bakın).
-　T   > [Option] > [Clear Constraint] (sayfa 172) seçeneğini belirleyerek tüm nesnelerin kilidini geçici 

olarak açın.

Bir Nesneyi Silmek İçin
1.　Silmek istediğiniz nesneyi seçin.

•　Örneğin, bir üçgenin sadece köşelerinden birini taşımak 
istiyorsanız, o köşeyi seçin. Üçgenin sadece bir kenarını 
taşımak için, o kenarı seçin.

•　Aşağıdaki adımların her birinde, bir üçgenin bir kenarı 
seçildiğinde ve taşındığında gösterilen örnek bir ekran 
görüntüsü bulunur.

2.　X  'e basın.
•　Bu işlem, ekranın sağ üst köşesinde       simgesinin görünmesini 

ve imlecin     simgesinden      simgesine değişmesini sağlar. 
Ayrıca, 1. adımda seçtiğiniz nesneyi bir dikdörtgen çevreler.

3.　Nesneyi istediğiniz yönde taşımak için imleç tuşlarını kullanın.

4.　Nesneyi dikdörtgenin mevcut konumuna taşımak için O  'a basın.

159



•　Örneğin, bir üçgenin sadece köşelerinden birini silmek istiyorsanız, o köşeyi seçin. Üçgenin sadece bir 
kenarını silmek için, o kenarı seçin.

2.　I   'ya basın veya T   > [Edit] > [Delete]'i seçin.
•　Bu, seçili nesneyi siler.

Ekrandaki Tüm Nesneleri Silmek İçin

Önemli!
•　Aşağıdaki işlemi gerçekleştirmek, ekranda o anda bulunan tüm nesneleri siler. Bu işlem geri 

alınamaz.

1.　T   > [Edit] > [Clear All]'u seçin.

2.　Görünen onay iletişim kutusuna yanıt olarak [OK]'u seçin.

 Not
•　Ekranda hiçbir şey seçili değilken a   'ye iki kez basarak da tüm nesneleri silebilirsiniz.

Nesneleri Gizleme ve Gösterme

Bir nesneyi gizlemek için
1.　Gizlemek istediğiniz nesneyi seçin.

2.　T   > [Option] > [Hide]'ı seçin.
•　Bu, seçili nesneleri gizler.

Gizli tüm nesneleri göstermek için
T   > [Option] > [Show All]'u seçin. Bu, o anda gizlenmiş tüm nesneleri gösterir.

Nesnelerin Görüntüleme Önceliğini Değiştirme
Geometri uygulamasında çizdiğiniz nesneler, çizilme sıralarına göre istiflenir (en yeni çizim en üsttedir). 
Çizilmiş bir nesneyi istifin en üstüne veya en altına taşımak için aşağıdaki işlemleri kullanabilirsiniz. Ayrıca, 
isterseniz tüm metni ön plana da taşıyabilirsiniz.
•　Belirli bir nesneyi ön plana taşımak için T   > [Properties] > [to the front]'u seçin.
•　Belirli bir nesneyi arka plana taşımak için T   > [Properties] > [to the back]'i seçin.
•　Tüm metni ön plana taşımak için T   > [Properties] > [All Text]'i seçin.

Bir Nesnenin Rengini ve Çizgi Kalınlığını Belirleme

Metin rengini belirlemek için
1.　Rengini belirlemek istediğiniz metni seçin.

2.　T   > [Color Select] > [Char Color]'u seçin. Görünen menüden istediğiniz rengi seçin.

•　Bir noktaya eklenmiş bir etiketin (örneğin, bir çemberin merkez
noktasının veya bir çokgenin köşesinin) metin rengini belirlemek 
için, etiketin eklendiği noktayı seçin.

3.　Yapılandırdığınız ayarları uygulamak için b   'ye basın. 
•　Tüm nesnelerin seçimini kaldırmak için a    'ya basın.
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Bir çizginin rengini ve kalınlığını belirlemek için
1.　Rengini ve kalınlığını belirlemek istediğiniz çizgiyi seçin.

2.　T   > [Color Select] > [Line Style]'ı seçin. Görünen menüden istediğiniz çizgi stilini seçin.

3.　T   > [Color Select] > [Line Color]'u seçin. Görünen menüden istediğiniz rengi seçin.

Kapalı bir şeklin (çokgen, çember vb.) dolgu rengini ve yoğunluğunu belirlemek için
1.　Dolgu rengini ve yoğunluğunu belirlemek istediğiniz kapalı şekli seçin.

•　Bir çokgeni veya yarım çemberi doldurmak için, tüm şekli seçmek üzere P   'ya basın. Bir çemberi 
doldurmak için ise çevresini seçin. 

2.　T   > [Color Select] > [Area Color]'u seçin. Görünen menüden istediğiniz rengi seçin.

3.　T   > [Color Select] > [Paint Style]'ı seçin. Görünen menüden “Normal” veya “Daha Açık”ı seçin.

Not
•　Ayrıca, üç keyfi noktayı (bir çokgenin köşeleri, bir çemberin merkezi, 

bir doğru parçasının kenarı vb.) seçebilir ve üç noktanın içinde 
kalan alanın dolgu rengini ve yoğunluğunu belirleyebilirsiniz. 
Yukarıdaki 1. adımda üç noktayı seçin.

 
Bu işlemin sadece üç nokta seçildiğinde mümkün olduğunu 
unutmayın. Dört veya daha fazla nokta seçilirse bu işlem 
gerçekleştirilmez.

Dosya (File) Menüsünü Kullanma
Aşağıdaki tablo, Geometri uygulamasıyla gerçekleştirebileceğiniz dosya işlemlerini göstermektedir.

Bunu yapmak için: Bu menü öğesini seçin:
Mevcut çizimi temizle ve yeni bir dosya oluştur T  > [File] > [New]
Mevcut çizimi temizle ve Ana Bellek'te kayıtlı Geometri 
uygulaması dosyasını aç

T  > [File] > [Open] > [Main Memory]

Mevcut çizimi temizle ve Depolama Belleği'nde kayıtlı arka 
plan görüntüsüne sahip bir resim dosyasını (.g4p veya .g3p) 
veya Geometri uygulaması dosyasını (.g4p)  aç

*1

*2

T  > [File] > [Open] > [Storage Memory]

Mevcut çizimi adlandır ve kaydet T  > [File] > [Save As]
Ana Bellek'te kayıtlı Geometri uygulaması dosyasını sil T  > [File] > [Delete] > [Main Memory]

•　Bir çokgenin tüm kenarlarının rengini ve kalınlığını aynı anda 
belirlemek istiyorsanız, tüm çokgeni seçmek için P  'ya basın 
("Nesneleri Seçme ve Seçimi Kaldırma" altındaki "Tüm bir 
çokgeni seçme" bölümüne bakın (sayfa 158)).

4.　Ayarladığınız ayarları uygulamak için b   'ye basın.
•　Tüm nesnelerin seçimini kaldırmak için a    'ye basın.

4.　Ayarladığınız ayarları uygulamak için b   'ye basın.
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Arka plan görüntüsü Depolama Belleği'nde kayıtlı olan bir resim 
dosyasını (.g4p veya .g3p)   veya Geometri uygulaması dosyasını 
(.g4p)  silme

*1  
*2

T  > [File] > [Delete] > [Storage Memory]

*1　
Bir g4p veya g3p dosyasını açabilir ve onu bir Geometri uygulaması çizimi için arka plan görüntüsü olarak 
kullanabilirsiniz. Bir g4p veya g3p dosyasını açmaya çalışmak aşağıdaki mesajın görünmesine neden ola-
bilir: “Görünüm penceresi değeri uygun değil. Başlangıç değeri ayarlansın mı?”. Dosyayı Geometri uygula-
ması Görünüm Penceresi ilk varsayılan değerini kullanarak açmak için [OK]'i seçin. g4p ve g3p dosyaları 
hakkında bilgi için "Depolama Belleği Sekmesinde Görüntülenen Dosyalar" (sayfa 196) bölümüne bakın. 

*2　Ayrıntılar için "Geometri Uygulaması Ekran Arka Plan Görüntüsü Görüntüleme" (sayfa 162) bölümüne bakın. 

Not
•　Geometri uygulamasında her yeni dosya oluşturulduğunda, Görünüm Penceresi ayarları (sayfa 162) 

başlatılır. Buna ek olarak, aşağıdaki Ayarlar menüsü ayarları ilk varsayılan ayarlarına döner (parantez 
içinde belirtilmiştir).

Angle (Degree) Angle Unit (On) Length Unit (Off)
Grid (Off) Grid Space (1) Axes (Off)

Geometri Uygulaması Ekran Arka Plan Görüntüsü Görüntüleme
Geometri uygulamasında, bir resim dosyasını (.g4p veya .g3p) açabilir ve onu bir Geometri uygulaması çizimi 
için arka plan görüntüsü olarak kullanabilirsiniz. Bir g4p veya g3p dosyasını açar, bir şeyler çizer ve ardından 
sonucu bir dosyaya kaydederseniz, dosya, Geometri uygulaması verileriyle birlikte g4p formatında kaydedilir.

Not
•　Kaydedilen g4p dosyasındaki Geometri uygulaması verilerini (uygulama ile çizilen nesneler) daha sonra 

düzenleyebilirsiniz. Ancak, sonucu bir g4p dosyasına kaydettikten sonra, dosyanın arka plan 
görüntüsünü değiştiremez veya kaldıramazsınız.

Arka plan görüntüsünün opaklığını ayarlamak için (Karartma G/Ç) (Fade I/O)
Bu işlem yalnızca 16 bit renkli bir görüntü arka plan görüntüsü olarak kullanıldığında gerçekleştirilebilir.

1.　T   > [Properties] > [Fade I/O]'yu seçin.

2.　Arka plan görüntüsünün opaklığını ayarlamak için l     ve r     tuşlarını kullanın.

3.　Ayar istediğiniz gibi olduğunda O   'a basın.

Görünüm (View) Menüsünü Kullanma
Aşağıdaki işlemleri gerçekleştirmek ve çizim ekranının görüntüleme alanını ayarlamak için Görünüm 
menüsünü kullanabilirsiniz.
•　Görüntüleme aralığını sayısal olarak belirleme veya varsayılan ayarları geri yükleme (View Window) 
•　Görüntüleme aralığını yukarı, aşağı, sola, sağa kaydırma (Pan, Scroll)
•　Görüntüleme aralığını yakınlaştırma (Zoom Box, Zoom In, Zoom Out, Zoom to Fit)

Görünüm Penceresi Ayarlarını Yapılandırma
Ekranın sol kenarının (X Minimum) ve sağ kenarının (X Maksimum) koordinatlarını belirtmek için Görünüm 
Penceresi ayarlarını yapılandırabilirsiniz. y ekseninin uzunluğu otomatik olarak 1:2 (y ekseni:x ekseni) 
oranında yapılandırılır, ancak y ekseninin hangi kısmının ekranın ortasında olacağını (Y Orta) 
belirtebilirsiniz. 
Görünüm Penceresi ayarlarını yapılandırmak için
1.　T   > [View] > [View Window]'u seçin.

•　Bu, Görünüm Penceresi menüsünü görüntüler.

2.　X Minimum, X Maksimum, Y Orta için değerleri girin.
•　Bu ayarları ilk varsayılanlarına döndürmek istiyorsanız, [Pre-set Windows] > [Initialize]'ı seçin.

3.　Tüm ayarlar istediğiniz gibi olduğunda,                'i seçin ve ardından O   'a basın.
•　Değiştirdiğiniz ayarlardan hiçbirini uygulamadan Görünüm Penceresi menüsünü kapatmak için, 3. adımı 

gerçekleştirmek yerine b   'ye basın.
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Ekran Görüntüsünü Kaydırmak ve Ötelemek için Scroll ve Pan Kullanma

Ekranı panlamak (ötelemek) için

1.　T   > [View] > [Pan]'ı seçin.
•　Bu, ekranın sağ üst köşesindeki       simgesiyle belirtilen pan moduna girer.

2.　İmleci ekranda yakalamak istediğiniz konuma getirin ve ardından O  'a basın.
•　Bu, imlecin    simgesinden      simgesine dönüşmesine neden olur.

3.　İmleç     simgesini gösterirken, ekranı istediğiniz yönde kaydırmak için imleç tuşlarını kullanın.

 

•　Pan modunda, O  'a her basış, imlecin şeklini     ve     arasında değiştirir. İmleç     simgesini gösterirken, 
onu ekranın başka bir konumuna taşımak için imleç tuşlarını kullanabilirsiniz. İmleç      simgesini gösterirken 
imleç tuşlarına basmak, ekran içeriğini kaydırır (öteler).

4.　Pan modundan çıkmak için b   'ye basın. 

Ekranı kaydırmak (scroll) için

1.　.   'ya basın veya T    > [View] > [Scroll]'u seçin.
•　Bu, ekranın sağ üst köşesindeki       simgesiyle belirtilen kaydırma moduna girer. Bu sırada imleç ekrandan

kaybolur.

2.　Ekranı istediğiniz yönde kaydırmak için imleç tuşlarını kullanın.

3.　Scroll modundan çıkmak için b   'ye basın.

Yakınlaştırma (Zooming)

Zoom box kullanarak yakınlaştırmak için

1.　T  > [View] > [Zoom Box]'ı seçin.
•　Bu, ekranın sağ üst köşesinde        simgesinin görünmesine neden olur.

2.　İmleci, zoom box alanı olarak seçmek istediğiniz alanın bir kenarındaki ekrandaki konuma 
getirin ve ardından O   'a basın.

3.　İmleci, zoom box alanının karşı kenarları yönünde hareket ettirin.
•　Siz hareket ettirdikçe, hesap makinesi imleci hareket ettirdiğinizde genişleyen bir seçim sınırı görüntüler.

4.　İstediğiniz zoom box alanını seçtikten sonra O   'a basın.
•　Zoom box alanının içindeki alan, tüm ekranı dolduracak şekilde genişler.

.Yakınlaştırmak ve uzaklaştırmak için
Görüntülenen görüntünün boyutunu iki katına çıkarmak için       'ya basın veya T   > [View] > [Zoom In]'i seçin.
Görüntülenen görüntünün boyutunu yarıya indirmek için       'ye basın veya T   > [View] > [Zoom Out]'u seçin.  

Ekran görüntüsünü pencere alanına sığacak şekilde yakınlaştırmak için
F    'ye basın veya T   > [View] > [Zoom to Fit]'i seçin.
•　Bu, mevcut görüntülenen görüntüyü ekranı dolduracak şekilde büyütür veya küçültür.
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Not
•　Yukarıdaki işlem, T   > [Draw Special] > [Function f(x)] kullanılarak çizilen bir grafikte geçerli 

değildir.

Oluştur (Construct) Menüsünü Kullanma
Aşağıdaki tabloda açıklandığı gibi, önceden çizilmiş bir şekle dayalı bir çizim oluşturmak için Oluştur 
(Construct) menüsünü kullanabilirsiniz.

Bunu oluştur-
mak için:

Aşağıdaki geometrik unsurlardan birini veya 
ikisini seçin:

T   > [Construct]'ı seçin ve 
ardından bunu seçin:

Bir dik 
kenarortay

Bir doğru parçası, bir çokgenin kenarı veya iki nokta*1 [Perpendicular Bisector] 

Bir dik doğru Bir nokta  artı aşağıdaki geometrik unsurlardan biri: 
Bir doğru parçası, bir düz doğru, bir çokgenin kenarı

*1 [Perpendicular Line]

Bir orta nokta Bir doğru parçası, bir çokgenin kenarı veya iki nokta*1 [Midpoint]

Bir kesişim 
noktası

Aşağıdakilerden herhangi ikisi (veya aynı türden 
ikisi): doğru parçası,  düz doğru, ışın, vektör, bir 
çokgenin kenarı, çember, yay

*2
[Intersection Point]

Bir açıortay Aşağıdakilerden herhangi ikisi (veya aynı türden 
ikisi): doğru parçası, düz doğru, ışın, vektör, bir 
çokgenin kenarı

[Angle Bisector]
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Bir paralel 
doğru

Aşağıdaki geometrik unsurlardan birini: bir doğru 
parçası, bir düz doğru, bir ışın, bir vektör, bir 
çokgenin kenarı, artı bir nokta*1

[Parallel Line]

*3

Bir teğet Bir çember, yarım çember, yay veya fonksiyon 
grafiği*4

[Tangent]
*4

*1　Bir çokgenin köşeleri, bir çemberin merkez noktası veya bir şekli oluşturan diğer herhangi bir nokta.
*2　Kesişim noktası olmayan iki doğru parçası seçilirse, iki doğru parçasının uzatıldığında en sonunda 

kesiştiği konumda bir kesişim noktası oluşturulur.
*3　Paralelliği gösteren bir simge (>) seçilen doğru parçasının, doğrunun, ışının veya çokgenin her iki 

ucunda ve çizilen paralel doğru üzerinde görünür.
*4　Bir teğet çizerken, önce bir şekil seçmenize gerek yoktur. T   > [Construct] > [Tangent]'i seçtikten sonra,

 imleci teğet doğru çizmek istediğiniz şeklin üzerindeki bir noktaya getirin ve ardından O  'a basın.

Bir Şekle Açı (Angle) Ölçümü Ekleme
İki doğru parçasını veya bir çokgenin iki kenarını seçebilir ve bunlara bir açı değeri ekleyebilirsiniz.
Örnek: Bir çokgenin iki kenarını seçmek ve bir açı değeri eklemek için

1.　Bir üçgen çizin ve iki kenarını seçin.

•　“Select Display Position” (Görüntüleme Konumunu Seçin) mesajı görüntülenirken, seçili iki kenar için 
hangi açı ölçümünün görüntüleneceğini belirtmek üzere imleç tuşlarını kullanabilirsiniz.

3.　Bir açı ölçümünün görüntüleme konumunu belirlemek için O  'a basın.

Transformations (Dönüşümler) Menüsünü Kullanma
Nesne yansıtma, nesne döndürme vb. gibi çeşitli dönüşüm işlemlerini gerçekleştirmek için Transformations
(Dönüşümler) menüsünü kullanabilirsiniz.

Bir Nesneyi Yansıtma
Bir doğru parçasını, doğruyu, ışını, bir çokgenin bir kenarını veya x eksenini ya da y eksenini yansıtma ekseni 
olarak belirleyebilirsiniz.

2.　T   > [Construct] > [Attached Angle]'ı seçin.
•　Bu, açı ölçümünü şekle ekler.
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Örnek:  x ekseni boyunca simetrik olarak yansıtılmış bir üçgen çizmek için

1.　S   > [Axes] > [Scale]'i seçin.
•　Bu, x eksenini ve y eksenini bir ölçekle görüntüler.

2.　Bir üçgen çizin ve ardından tüm üçgeni seçmek için P  tuşunu kullanın. 
•　Üçgeni nasıl seçeceğinize dair daha fazla bilgi için "Nesneleri Seçme ve Seçimi Kaldırma" altındaki 

"Tüm bir çokgeni seçme" (sayfa 158) bölümüne bakın. 

3.　T   > [Transformations] > [Reflection]'ı seçin.
•　Bu, “Select Axis” (Ekseni Seçin) mesajının görünmesine neden olur.

Mevcut Bir Vektörü Kullanarak Bir Nesneyi Öteleme
Örnek: Bir üçgeni, bir vektörün yönüne ve büyüklüğüne göre ötelemek için

1.　Bir üçgen çizin ve ardından öteleme için bir vektör çizin.

2.　Tüm üçgeni seçmek için P  'yi kullanın. Üçgeni nasıl seçeceğiniz hakkında daha fazla bilgi için "Nesneleri 
Seçme ve Seçimi Kaldırma" altındaki "Tüm bir çokgeni seçme" (sayfa 158) bölümüne bakın.

3.　T   > [Transformations] > [Translation (Select Vector)]'u seçin.
•　Bu, Select Vector (Vektörü Seçin) mesajının görünmesine neden olur.

4.　İmleci, ucunun x eksenine değdiği bir konuma getirin. 
•　İmleci, x ekseni üzerinde orijinden uzak bir konuma getirin.

 

5.　O   'a basın.
•　Bu, üçgeni x ekseni üzerinde simetrik olarak yansıtarak çizer.

4.　Vektörün üzerinde işaretler görünene kadar      imleci vektöre yaklaştırın. 

5.　O  'a basın.
•　Üçgen, seçilen vektöre göre ötelenir.
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Not
•　Yukarıdaki prosedürün 3. adımını gerçekleştirmeden önce bir nesnenin yalnızca bir kısmını seçerseniz, 

sadece seçilen kısım ötelenir.

Diğer Transformations (Dönüşüm) İşlemleri
Aşağıdaki tabloda gösterilen işlemlerden herhangi birine başlamadan önce, dönüştürmek istediğiniz şekli çizin ve 
ardından şeklin tamamını seçin. Bir nesnenin yalnızca bir kısmını seçerseniz, sadece seçilen kısım dönüştürülür.

Bunu yapmak için:   Bu menü öğesini seçin:   Ve sonra bu işlemi gerçekleştirin:
Bir nesneyi belirtilen 
değerlere göre 
öteleme

T  > [Transformations]
> [Translation (Enter
Vector)]

1.　Görünen Öteleme ekranında, x ekseni boyunca 
öteleme mesafesi ve y ekseni boyunca öteleme 
mesafesi için değerleri girin. 

2.　               ‘i seçin ve ardından O  'a basın.
Bir nesneyi 
döndürme

T  > [Transformations] >
[Rotation]

1.　“Select Center of Rotation” (Döndürme Merkezini Seçin)
mesajı görüntülenirken, imleci döndürme merkezi 
olarak belirtmek istediğiniz konuma getirin ve ardından 
     'a basın.

2.　

Bir nesneyi 
ölçeklendirme

T  > [Transformations] >
[Dilation]

1.　“Select Center of Dilation” mesajı görüntülenirken,
ölçeklendirme merkezi olarak belirtmek istediğiniz 
konuma getirin ve ardından O  'a basın.

2.　Görünen iletişim kutusunda,                        aralığında 
bir ölçek değeri girin ve ardından O  'a basın.

0.1 ≤ | x | ≤ 10 

•　Ölçeklendirme işlemi sırasında kullanılan terimlerin 
anlamları hakkında ayrıntılı bilgi için aşağıdaki Not 
bölümündeki şekle bakın.

Bir nesneyi belirli bir 
nokta üzerinde 180 
derece döndürme

T  > [Transformations] >
[Point Reflection]

“Select Center Point” mesajı görüntülenirken, imleci 
döndürme merkezi olarak belirtmek istediğiniz konuma 
getirin ve ardından O  'a basın. 
•　Bu, şekli seçilen nokta üzerinde 180 derece döndürülmüş 

olarak çizer. Ayrıca, merkez noktasına bir nokta çizilir.

Not
•　Aşağıdaki şekil, yukarıdaki ölçeklendirme prosedüründe kullanılan terimlerin anlamlarını göstermektedir.

Ölçeklendirme Merkezi

Orijinal Obje

Ölçek: -1 Ölçek: 0.5 Ölçek: 2
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Ölçüm Kutusu (Measurement Box) Kullanma

Bir Nesnenin Ölçümlerini (Measuremenet) Görüntüleme

Aşağıdaki tablo, her bir simgeyi seçtiğinizde ölçüm kutusunda görünen bilgileri ve her bir simgenin ne zaman 
seçilebilir olduğunu açıklamaktadır.

Ölçüm (Measurement) Simgesi Tablosu

Simge*1 Bu simge, şu durumda seçilebilir: Bu simgeyi seçmek, şunu 
görüntüler:

Coordinates

( )
Tek bir nokta seçildiğinde. Noktanın koordinatları

Distance/Length

( ) İki nokta seçildiğinde veya tek bir doğru 
parçası veya vektör seçildiğinde.

İki nokta arasındaki mesafe, bir doğ-
ru parçasının veya vektörün uzunluğu

Slope

( ) Tek bir doğru, ışın, doğru parçası veya 
vektör seçildiğinde.

Doğrunun, ışının, doğru parçasının 
veya vektörün eğimi

Angle

( )

Aşağıdaki çizgi unsurlarından herhangi 
ikisi herhangi bir kombinasyonda 
seçildiğinde: doğrular, doğru parçaları, 
ışınlar veya vektörler.*2

İki nesne tarafından oluşturulan açı 
ve onun bütünleyeni

Supplementary
Angle

( )

Radius

( ) Tek bir çember, yarım çember veya 
yay seçildiğinde.

Çemberin, yarım çemberin veya 
yayın yarıçapı

Circumference

( )*3 Tek bir çember, yarım çember veya yay 
seçildiğinde. Çevre uzunluğu

Perimeter

 
Tek bir çokgen seçildiğinde. Kenarların uzunluklarının toplamı

Area

( )*3 Tek bir çember, yarım çember, yay veya 
çokgen seçildiğinde veya herhangi üç 
nokta seçildiğinde.

Alan *4

Equation

 Tek bir doğru veya doğru parçası, ışın, 
çember, yarım çember, yay veya 
fonksiyon grafiği seçildiğinde.

Nesnenin fonksiyonu (dikdörtgen 
koordinatlar kullanılarak)

Vector

( )
Tek bir vektör seçildiğinde. Vektör bileşenleri

Tangency

( ) İki çember, iki yay, bir doğru ve çember 
veya bir doğru ve yay seçildiğinde. İki nesnenin teğet olup olmadığı

V    tuşuna basmak, ekranın altında bir ölçüm kutusu görüntüler. Ölçüm 
kutusunu gizlemek için b   'ye iki kez basın.
Measurement box’ı bir nesnenin ölçümlerini görüntülemek, bir nesnenin 
ölçümünü belirtmek, bir nesnenin ölçümünü kilitlemek veya bir nesneyi 
adlandırmak için kullanabilirsiniz.

Ölçüm kutusunda görüntülenebilecek bilgi türü, ekranda o anda seçili 
olan nesneye bağlıdır. Yan taraftaki ekran, bir çember seçildiğinde bir 
örnek göstermektedir.
Görüntülenen bilgi türünü, ölçüm kutusunun solundaki yukarı ok düğmesini 
vurgulayarak, O  'a basarak ve ardından görünen simge paletinde uygun 
simgeyi vurgulamak için imleç tuşlarını kullanarak değiştirebilirsiniz.
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Congruence

( )
İki doğru parçası seçildiğinde. Doğru parçalarının aynı uzunlukta 

olup olmadığı.

Incidence

( ) Bir nokta ve doğru, bir nokta ve yay, bir 
nokta ve çember veya bir nokta ve 
vektör seçildiğinde.

Noktanın doğru/eğri üzerinde olup 
olmadığı.

Rotation angle

 Rotation (Döndürme) (sayfa 167) komutuy-
la oluşturulan iki nokta seçildiğinde. Döndürme açısı.

Scale of dilation

 Dilation (Ölçeklendirme) (sayfa 167) komu-
tuyla oluşturulan iki nokta seçildiğinde. Ölçeklendirme ölçeği.

Label/Text

 Etiketi olan bir nokta veya yapıştırılmış bir 
ölçüm   veya adlandırılabilecek bir nesne 
seçildiğinde.

*5 Etiket metni.

Expression

 Tek bir ifade seçildiğinde (“EXPR=” 
nesnesi). Hesaplama ifadesi.

*1　Simgenin sağındaki “     ” işareti, ölçümün kilitlenebilir olduğunu gösterir. Kilitleme işlemleri hakkında bilgi 
için "Bir Nesnenin Ölçümünü Kilitleme veya Kilidini Açma" (sayfa 171) bölümüne bakın.

*2　İki vektör seçildiğinde, ölçüm kutusunda (meauserement box) görüntülenen açı, iki vektör tarafından 
matematiksel olarak oluşturulan açı anlamına gelmez. Sadece vektörler iki doğru olsaydı oluşacak basit 
açıyı gösterir.

*3　Çevre uzunluğu ve alan ölçümleri sadece bir çember seçildiğinde kilitlenebilir.
*4　Çizgileri kesişen bir nesnenin alanını gösteren bir değer, değerin solundaki çift yıldızla (        ) belirtilir. Bu, 

değerin doğru alanı göstermeyebileceğini gösterir. 
*5　Ölçümleri Ekran Görüntüsüne Yapıştırma" (sayfa 172) bölümüne bakın.

Bir doğru parçasının ölçümlerini görüntülemek için
1.　Bir doğru parçası çizin ve seçin.

4.　Diğer ölçümleri görüntülemek için simge paletindeki simgeleri seçin.
•　Örneğin, doğru parçası durumunda, onun uzunluğunu, eğimini ve denklemini görüntüleyebilirsiniz.

Eğim Denklem

5.　Ölçüm kutusunu kapatmak için b   'ye iki kez basın. 

2.　Ölçüm kutusunu görüntülemek için V   tuşuna basın.
•　Bu, doğru parçasının uzunluğunu görüntüler.

3.　Ölçüm kutusunun solundaki yukarı ok düğmesini vurgulamak için l    'a
basın ve ardından O   'a basın.
•　Bu, bir simge (icon) paleti görüntüler.
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Bir Nesnenin Ölçümünü Belirtme ve Kilitleme
Aşağıdaki örnek, bir üçgenin açısının nasıl belirtileceğini ve kilitleneceğini gösterir. Örneğin,    ABC'nin 
   ACB'sini 90 derecede kilitlemek, köşe noktası nereye taşınırsa taşınsın ∠ACB'nin 90 derecede kalmasını 
sağlar. Aşağıdaki örnekte, S   > [Angle] ayarı “Degree” (Derece) olarak ayarlanmıştır.

 

∠
△

Bir üçgenin açısının ölçüsünü belirtmek ve kilitlemek için
1.　Bir üçgen çizin ve ardından AC kenarını ve BC kenarını seçin.

4.　B köşesini hareket ettirmeyi deneyin (∠ACB'nin 90 derecede kilitlendiğinden emin olun).
(1)　 Ölçüm kutusunu gizlemek için b   'ye iki kez basın.
(2)　 Tüm nesnelerin seçimini kaldırmak için a  tuşuna basın.
(3)　 İmleci B köşesine getirin ve ardından X  tuşuna basın. Daha fazla bilgi için "Bir nesneyi taşımak için" 

(sayfa 159) bölümüne bakın. 

(4)　 B köşesini istediğiniz konuma getirmek için imleç tuşlarını kullanın ve O   'a basın.
•　∠ACB'nin 90 dereceyi koruması için A köşesi hareket eder.

Not
•　Düzenlemekte olduğunuz dosyada (veya bir tümünü temizleme işleminden (T   > [Edit] > [Clear All]) 

hemen sonra) aşağıdaki ölçümlerden herhangi birini ilk kez belirtmek, ortaya çıkan nesnenin 
görüntüleme alanına sığacak şekilde yeniden boyutlandırılmasına neden olur.
-　Bir üçgenin bir kenarının uzunluğu
-　Bir doğru parçasının veya vektörün uzunluğu
-　Bir dikdörtgenin, karenin, çokgenin veya düzgün n-genin bir kenarının uzunluğu
-　Bir çemberin çevre uzunluğu veya bir yayın uzunluğu
Görünüm Penceresi (View Window) ayarları otomatik olarak yeniden yapılandırıldığından, ekrandaki 
nesnenin boyutu çok fazla değişiyor gibi görünmeyebilir. Aşağıdaki örnek, ilk varsayılan Görünüm 
Penceresi ayarlarıyla (ekran genişliği 10 olan) çizilen bir üçgenin tabanının uzunluğu 50 olarak 
değiştirildiğinde ne olduğunu gösterir.

2.　V  tuşuna basarak ölçüm kutusunu görüntüleyin.
•　Bu, ölçüm kutusunda ∠ACB'nin ölçüsünü görüntüler.
•　Bu sırada, ölçüm kutusunun sağındaki simge (kilidi açık) 

durumundadır.

3.　Ölçüm kutusuna 90 girin ve     tuşuna basın.
•　Bu, ∠ACB'nin ölçüsünü 90 derece olarak belirtir ve kilitler.

•　Bu, ölçüm kutusunun sağındaki simgenin      (kilitli) olarak 
değişmesine neden olur ve açının kilitlendiğini gösterir.

170



Görünüm Penceresi (View Window) ayarları, bir nesnenin ölçüsünü belirtmenin onu ekrana sığmayacak 
kadar büyük veya göremeyecek kadar küçük yapmamasını sağlamak için yeniden yapılandırılır.
Ekranda o anda bulunan diğer tüm nesnelerin de, ölçüsü belirtilen nesneyle aynı miktarda yeniden 
boyutlandırıldığını unutmayın.

•　Bir nesnenin bir ölçüsünü belirttikten sonra, başka bir ölçüsünü belirtirseniz daha fazla yeniden 
boyutlandırılmaz.

Bir Nesnenin Ölçümünü Kilitleme veya Kilidini Açma
“Bir Nesnenin Ölçümünü Belirtme ve Kilitleme” (sayfa 170) bölümünde açıklandığı gibi, bir ölçüm sayısal 
olarak belirtilir belirtilmez otomatik olarak kilitlenir. Bu bölüm, sayısal bir değer belirtmeden bir ölçümün 
nasıl kilitleneceğini veya kilidinin nasıl açılacağını açıklar.

Not
•　“Bir Nesnenin Ölçümünü Belirtme ve Kilitleme” (sayfa 170) bölümünde açıklandığı gibi, bir ölçüm sayısal 

olarak belirtilir belirtilmez otomatik olarak kilitlenir. Bu bölüm, sayısal bir değer belirtmeden bir ölçümün 
nasıl kilitleneceğini veya kilidinin nasıl açılacağını açıklar..

Belirli bir ölçümü kilitlemek için
Örnek 1: Bir doğru parçasının uzunluğunu veya eğimini kilitlemek için

1.　Bir doğru parçası çizin ve seçin.

2.　Ölçüm kutusunu görüntülemek için V   tuşuna basın.

3.　Ölçüm kutusunun solundaki yukarı ok düğmesini vurgulamak için l    'a basın ve ardından O  'a basın.

4.　Görünen simge paletinde, kilitlemek istediğiniz ölçümün simgesini (       veya       ) vurgulayın ve ardından 
O  'a basın.

5.　▲ simgesini vurgulamak için r    'ı kullanın ve O  'a basın. *
•　Simge, ölçümün kilitlendiğini gösteren ▲ olarak değişir.

Uzunluk kilitlendi Eğim kilitlendi
 
*　5. adımın yerine aşağıdaki adımları da gerçekleştirebilirsiniz.

(1)　     Simgenin sağındaki yukarı ok düğmesini vurgulayın ve O  'a basın.
(2)　 Görünen menüde [Lock]'ı (Kilitle) seçin ve ardından O  'a basın.

 
 
Örnek 2: Bir üçgenin iki kenarını eşit uzunlukta kilitlemek için

1.　Bir üçgen çizin ve ardından AC kenarını ve BC kenarını seçin.

2.　Ölçüm kutusunu görüntülemek için V    tuşuna basın.

3.　Ölçüm kutusunun solundaki yukarı ok düğmesini vurgulamak için l    'a basın ve ardından O   'a basın.

4.　Görünen simge paletinde, ■    simgesini vurgulayın ve ardından O  'a basın. 

•　Bu, ölçüm kutusunda “No” (Hayır) ifadesinin görünmesine neden olur.

5.　■  simgesini vurgulamak için r    'ı kullanın ve O  'a basın. 
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Belirli bir ölçümün kilidini açmak için
Aşağıdaki işlemlerden herhangi birini gerçekleştirerek belirli bir ölçümün kilidini açabilirsiniz.
•　Ölçüm kutusunun sağındaki simge ▲  ise, simgeyi vurgulamak için l    ve r    'ı kullanın ve O   'a basın. Bu, 

ölçümün kilidinin açıldığını gösteren simgenin ▲  olarak değişmesine neden olur.
•　     Simgenin sağındaki yukarı ok düğmesini vurgulamak için l    ve r    'ı kullanın ve O   'a basın. Görünen 

menüde [Unlock]'ı (Kilidi Aç) seçin ve ardından O   'a basın.

Ekrandaki Tüm Nesnelerin Kilidini Açmak İçin
T   > [Option] > [Clear Constraint]'i seçin. Bu, tüm kilitli ayarların kilidini açar.

Not
•　Yukarıdaki işlem, hem sizin manuel olarak kilitlediğiniz ölçümlerin hem de otomatik olarak kilitlenen 

nesnelerin kilidini açar.
Örneğin, yukarıdaki işlem aşağıdaki kilidin kilidini açar:
-　İkizkenar bir üçgen (ABC) çizdiğinizde, AB kenarını ve BC kenarını eşit tutan kilit (AB kenarı ve BC 

kenarı eşlik kilidi)

Ölçümleri Ekran Görüntüsüne Yapıştırma
Nesne ölçümlerini ekrandaki görüntüye yapıştırmak için aşağıdaki prosedürleri kullanabilirsiniz. Nesneyi 
manipüle ettikçe ölçümler dinamik olarak değişir.

Örnek: Bir iç açı ölçümünü ekran görüntüsüne yapıştırmak için

2.　Ölçüm kutusunu görüntülemek için V   tuşuna basın.

3.　Ölçüm kutusunun sağ tarafındaki yukarı ok düğmesini vurgulamak için r    'ı kullanın ve ardından O  'a basın.

4.　Görünen menüde [Paste]'i (Yapıştır) seçin.
•　Bu, ölçüm kutusundaki ölçümün ekran görüntüsüne yapıştırılmasına neden olur. Bu sırada, yapıştırılan 

ölçüm metni seçili duruma gelir.

5.　İsterseniz metni ekranda başka bir konuma taşıyın.
•　X   tuşuna basın ve ardından yapıştırılan ölçümü ekranın etrafında hareket ettirmek için imleç tuşlarını 

kullanın. Ayrıntılar için "Bir nesneyi taşımak için" (sayfa 159) bölümüne bakın.

Not
•　Yukarıdaki prosedürün 2. adımında ölçüm kutusu vurgulanmışken s(%)         tuşlarına basarak da o 

anda ölçüm kutusunda bulunan ölçümü ekran görüntüsüne yapıştırabilirsiniz.

•　Bu, simgenin ■  olarak değişmesine neden olur ve ölçümün 
kilitlendiğini gösterir. Ayrıca, ölçüm kutusunun içeriği “Yes” 
(Evet) olarak değişir.

1.　Bir üçgen çizin ve iki kenarını seçin.
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•　Aşağıdaki ölçüm türleri ekran görüntüsüne yapıştırılabilir: koordinatlar, mesafe/uzunluk, 
eğim, yarıçap, çevre uzunluğu, çevre, alan, açı, bütünleyici açı, denklem, vektör bileşenleri.

•　Yapıştırılan ölçüm, türüne bağlı olarak bir ad (veya sembol) ile öneklendirilir. Yukarıdaki örnekte, bir 
açıyı belirtmek için ∠: eklenir. Bir alanı belirtmek için Area: ve bir denklemi veya vektör bileşenlerini 
belirtmek için Eq: eklenir. Eklenen bir adı (veya sembolü) düzenlemek için ölçüm kutusunu 
kullanabilirsiniz. Düzenleme işlemleri hakkında bilgi için “Bir Etiketi Değiştirme veya Bir Nesneye 
Ad Ekleme” (sayfa 173) bölümüne bakın.

Bir Etiketi Değiştirme veya Bir Nesneye Ad Ekleme
Aşağıdaki örnekte açıklandığı gibi, bir noktanın, vektörün veya yapıştırılmış ölçümün etiket adını değiştirebilir 
veya her bir elemente bir ad ekleyebilirsiniz.

Örnek: Bir çemberin merkezinin etiket adını “A”dan “Center”a (Merkez) değiştirmek için

2.　V   tuşuna basarak ölçüm kutusunu görüntüleyin. 
•　Bu, ■    simgesinin görünmesine neden olursa, bu prosedürün 6. adımına geçin.

3.　Ölçüm kutusunun solundaki yukarı ok düğmesini vurgulamak için l    'a basın ve ardından O  'a basın.

4.　Görünen simge paletinde, ■    simgesini vurgulayın ve ardından O  'a basın.

5.　Ölçüm kutusunu vurgulamak için r    'a basın ve ardından O  'a basın. 

Ekran Ölçüm Değerlerini Kullanan Bir Hesabın Sonucunu Görüntüleme
Bu bölümdeki prosedürü kullanarak, bir nesneye eklenmiş açı değeri, doğru uzunluğu ve diğer ölçüm 
değerlerini kullanarak hesaplamalar yapabilir ve sonucu ekranda görüntüleyebilirsiniz.
 
Örnek 1: Bir üçgenin bir açısının ve onun bütünleyici açısının toplamını belirleyen ifadeyi girmek ve sonucu 

ekrana yapıştırmak için.

1.　Çemberi çizin ve ardından merkez noktasını seçin.

6.　Görünen etiket (label) düzenleme iletişim kutusunda, “Center” 
(Merkez) yazın. 
•　Etiket (label) adı için en fazla 14 karakter girebilirsiniz.
•　Etiket (label) adını silmek için a   tuşuna basın.

7.　O  'a basın.
•　Bu, değiştirilen adı burada gösterildiği gibi ekranda 

görüntüler.

1.　Bir üçgen çizin ve ∠BAC açısının ve bütünleyici açısının ölçümlerini 
ekrana yapıştırın.
•　Ekrana ölçüm yapıştırma hakkında bilgi için “Ölçümleri Ekran 

Görüntüsüne Yapıştırma” (sayfa 172) bölümüne bakın.
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3.　Şimdi, ölçüm kutusuna girdiğiniz hesaplamada ölçüm değerlerini belirtmek için etiketleri 
kullanabilirsiniz.
•　Ölçüm kutusuna bir ölçüm değeri girmek için, “@” sembolünü, ardından değerin sayısal etiketini girin: 

@1, @2, vb. Burada açının (@1) ve bütünleyici açının (@2) toplamını hesaplamak istediğimiz için şunu 
girersiniz: @1+@2.

•　“@” sembolünü, C  tuşuna ve ardından O  'a basarak girebilirsiniz.

5.　Ölçüm kutusunu gizlemek için b   'ye iki kez basın.

Not
•　Bir ölçüm bir koordinat veya vektör bileşeni olduğunda, etiket formatı “@1X”, “@1Y”, vb. olur. “@1X”, 

bir koordinatın x değerini veya bir vektörün x bileşeni değerini gösterirken, “@1Y” bir koordinatın y 
değerini veya bir vektörün y bileşeni değerini gösterir.

Örnek 2: △ABC'yi çizmek ve ardından △ABC'nin her kenarının uzunluğunu ikiye katlayarak △A’B’C’yi çizmek 
için. Sonrasında, △A’B’C’nin alanını △ABC'nin alanına bölün.

Bu örnekte, doldurulmuş bir şeklin alanının bir formüle girilmesini sağlayan Alan Hesapla komutu kullanılır. 

2.　T   > [Option] > [Expression]'ı seçin.
•　Bu, imleç konumunda “EXPR=” ifadesini ve ölçüm kutusunu 

görüntüler.
•　Yukarıdaki işlem ayrıca ekranda bulunan her bir ölçüm için etiketler 

(@n, burada n bir seri numarasıdır) görüntüler.

4.　Hesaplama ifadesini girdikten sonra O  'a basın.
•　Hesaplama sonucu, “EXPR=” ifadesinin sağında görüntülenir.

6.　B köşesini ekranın başka bir yerine taşımayı deneyin.
•　Bu şekilde, girilen ifadeye ait hesaplama sonuçlarının sabit 

olduğunu doğrulayabilirsiniz.
•　Bir noktayı taşıma hakkında bilgi için “Bir nesneyi taşımak için” 

(sayfa 159) bölümüne bakın. 

1.　△ABC'yi çizin ve seçin, ardından iki kat ölçekli **△A’B’C’**yi çizmek
için T   > [Transformations] > [Dilation] (Ölçeklendirme) komutunu kullanın.
•　Ölçeklendirme işleminin kullanımı hakkında ayrıntılı bilgi için, 

"Diğer Dönüşüm İşlemleri" (sayfa 167) bölümüne bakın.

2.　△ABC için dolgu rengi olarak sarıyı ve △A’B’C’ için dolgu rengi olarak 
camgöbeği (cyan) rengini belirtin. 

△

•　Şekillerin dolgu rengini değiştirme hakkında bilgi için, "Kapalı bir 
şeklin (çokgen, çember vb.) dolgu rengini ve yoğunluğunu 
belirtmek için" (sayfa 161) bölümüne bakın.
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3.　T   > [Option] > [Area Calc]'ı seçin.
•　Bu, doldurulmuş üçgenlerden birini (bu durumda △ABC'yi) seçer ve durum çubuğunda “[←][→]: 

Select Figure” (Şekli Seçin) mesajını görüntüler.

5.　'e    ve ardından u   tuşuna basın.
•　Bu, durum çubuğunda “[←][→]: Select Figure” (Şekli Seçin) mesajının yeniden görünmesine neden olur.

8.　 tuşuna basınız.

Bu, △ABC'nin alanını temsil eden “@2” ifadesini ölçüm kutusuna girer.

Bir Ölçümün Sayı Formatını Belirtme
Ekrandaki her bir ölçüm için sayı formatını belirleyebilirsiniz.

Not
•　Başlangıçtaki varsayılan sayı formatı “Fix2: 0.12”dir. Sayı formatı seçenekleri hakkında ayrıntılı bilgi 

için “Ekran (Genel)” (sayfa 218) bölümüne bakın.

 

.
•　Mevcut sayı formatı ayarından bağımsız olarak, tam sayı değerleri her zaman ondalık kısımları kesilmiş 

olarak görüntülenir. 

Örnek: "Ekran Ölçüm Değerlerini Kullanan Bir Hesabın Sonucunu Görüntüleme" (sayfa 173) bölümündeki 
Örnek 1'i tamamladıktan sonra, iki açı ölçümünün görüntü formatını Fix0: 0. (bir ondalık basamağa 
yuvarlanmış) olarak değiştirin.

4.　**△A’B’C’**yi seçmek için l    ve r    'ı kullanın ve ardından O   'a basın.
•　Bu, △A’B’C’nin alanını temsil eden “@1” ifadesini ölçüm kutusuna

girer.

6.　△ABC'yi seçmek için l    ve r    'ı kullanın ve ardından O   'a basın. 
•　

Ölçüm kutusunun içeriği “@1÷@2”den “△A’B’C’÷△ABC”ye değişir ve 
hesaplama sonucu ekranın sol üst köşesinde görünür. 

7.　O  'a basın.
•　Ölçüm kutusunun içeriği “@1÷@2”den değişir. 

1.　Sayı formatını değiştirmek istediğiniz ölçümleri seçin.
•　Burada, iki açının (∠BAC ve onun bütünleyici açısı) ölçümlerini 

seçiyoruz.

2.　T   > [Option] > [Number Format] > [Fix0: 0.]'ı seçin.
•　Seçili ölçümler, o anda belirtilen sayı formatına göre 

görüntülenir.
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Animasyonlarla Çalışma
Bir animasyon, eğrinin bir doğru parçası, çember, yarım çember, yay veya fonksiyon olabileceği bir veya 
daha fazla nokta/eğri çiftinden oluşur. Bir nokta/eğri çiftini seçip ardından bir animasyona ekleyerek bir 
animasyon oluşturursunuz.

Bir Animasyon Oluşturma ve Çalıştırma

Bir animasyon eklemek ve çalıştırmak için
Örnek 1: Bir çember ve onun yarıçapını (AC doğru parçası) çizmek ve yarıçap üzerine D noktasını çizmek 

için. Sonrasında, C noktasını çevre üzerinde ve D noktasını AC doğru parçası üzerinde aynı anda 
hareket ettiren bir animasyon oluşturmak için.

1.　Bir çemberi ve onun yarıçapı olan AC doğru parçasını (A: merkez, C: çevre üzerindeki nokta) çizin ve 
D noktasını yarıçap üzerine çizin.

3.　T   > [Animate] > [Add Animation]'ı (Animasyon Ekle) seçin.
•　Bu, C noktasını çevre üzerinde hareket ettiren bir animasyon ekler.

4.　Tüm şekillerin seçimini kaldırmak için a   tuşuna basın, ardından D noktasını ve AC doğru parçasını seçin.

5.　T   > [Animate] > [Add Animation]'ı (Animasyon Ekle) seçin. 
•　Bu, D noktasını AC doğru parçası üzerinde hareket ettiren bir animasyon ekler.

6.　Animasyonu çalıştırmak için T   > [Animate] > [Go(once)] (Git(bir kez)) veya [Go(repeat)] (Git(tekrarla)) 
seçeneğini seçin. 
•　C noktası çevre üzerinde, D noktası ise AC doğrusu üzerinde aynı anda hareket eder.

7.　Animasyonu durdurmak için b   veya a    tuşlarına basın. 

Örnek 2:                             kübik fonksiyonunun grafiğini çizmek ve grafiğe teğetler çizmek için. Ardından, f
kübik fonksiyonunun grafiğini çizmek ve grafiğe teğetler çizmek için. Ardından, temas noktalarını 
grafikte hareket ettiren ve teğet doğrusundaki değişimi gözlemleyen bir animasyon oluşturun.

(x) 0.1x3 − 1.5x 

1.　f (x) 0.1x3 − 1.5x'in grafiğini çizin ve grafiğe teğetler çizin.
•　Grafiği çizmek için, T   > [Draw Special] > [Function f(x)] (sayfa 155) komutunu kullanın. 
•　Teğet doğrusunu çizmek için, T   > [Construct] > [Tangent]  (sayfa 164) komutunu kullanın. 

3.　T   > [Animate] > [Add Animation]'ı seçin.

4.　Animasyonu çalıştırmak için T   > [Animate] > [Go(once)] seçeneğini seçin. 
•　Bu, A noktasının (temas noktası) grafik üzerinde hareket etmesine ve teğet doğrusunun da buna göre 

hareket etmesine neden olur.

2.　C noktasını ve çevreyi seçin.

2.　A noktasını (temas noktası) ve grafiği seçin.
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Not
•　Bir nokta ve eğri seçiliyken, T   > [Animate] > [Replace Animation]'ı (Animasyonu Değiştir) seçmek, 

mevcut animasyonları atar ve yeni nokta ve eğri seti için bir animasyon ayarlar.
•　Bir animasyon gerçekleştiriliyorsa, hesap makinesinin otomatik kapanma özelliği gücü kapatır. Bir 

animasyon gerçekleştirilirken hesap makinesinin gücü kapatılırsa (otomatik kapanma veya manuel 
olarak), animasyon durur.

Noktaların Geometrik Yerini Çizmek İçin
Örnek 1: Trace (İzleme) kullanarak bir parabol çizmek için

1.　Gerekli doğru parçalarını çizmek için aşağıdaki adımları kullanın.

Aşağıdaki 2'den 4'e kadar olan adımlarda ölçüm kutusunun nesneleri kilitlemek için nasıl kullanılacağı 
hakkında bilgi için, “Bir Nesnenin Ölçümünü Kilitleme veya Kilidini Açma” (sayfa 171) bölümüne bakın.

(2)　 i) C noktasını seçin. ii) Ölçüm kutusunu görüntüleyin. iii)        Simgesini seçin ve koordinatları kilitleyin. 
iv) Ölçüm kutusunu kapatın. 

(3)　 i) a   tuşuna basın ve ardından AB doğru parçasını ve DE doğru parçasını seçin. ii) Ölçüm kutusunu 
görüntüleyin. iii)       Simgesini seçin ve iki doğru arasındaki açıyı 90 derecede kilitleyin. iv) Ölçüm 
kutusunu kapatın.

 

(4)　

2.　a  tuşuna basın, E noktasını ve AB doğru parçasını seçin ve ardından T   > [Animate] > [Add Animation]'ı 
seçin.

3.　a  tuşuna basın, D noktasını seçin ve ardından T   > [Animate] > [Trace]'i seçin. 
•　Bu, D noktasını “trace point” (izleme noktası) olarak belirler.

 
Örnek 2: Trace (İzleme) kullanarak bir sinüs eğrisi çizmek için.

1.　Bir şekil çizmek için aşağıdaki adımları kullanın.

(1)　

•　DE doğru parçasını çizerken, E noktasını AB doğru parçası 
üzerine yerleştirin.

Sağdaki örnek ekranda gösterildiği gibi üç doğru parçası AB, 
CD, DE'yi çizin.

4.　T   > [Animate] > [Go(once)]'ı seçin.
•　Bu, ekranda bir parabolün izlenmesine neden olmalıdır.

Unutmayın ki AB doğru parçası, parabolün doğrultmanı ve 
C noktası da odak noktasıdır.

i) a   tuşuna basın ve ardından DE doğru parçasını ve CD doğru parçasını seçin. ii) Ölçüm kutusunu 
görüntüleyin. iii) Her iki parçanın uzunluğunu aynı uzunlukta kilitlemek için        simgesini seçin. 
iv) Ölçüm kutusunu kapatın.

(1)　Sağdaki örnek ekranda gösterildiği gibi AB doğru parçasını, bir çemberi ve 
E noktasını çizin.
•　Çemberin merkezini (C noktası), AB doğru parçası üzerine yerleştirin.
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Aşağıdaki (2)'den (4)'e kadar olan adımlarda ölçüm kutusunun nesneleri kilitlemek için nasıl kullanılacağı 
hakkında bilgi için, “Bir Nesnenin Ölçümünü Kilitleme veya Kilidini Açma” (sayfa 171) bölümüne bakın.

(2)　 Çemberin çevresini seçin ve ardından ölçüm kutusunu görüntüleyin.

(3)　 Simgesini seçin ve yarıçapın uzunluğunu kilitleyin.

(4)　  Ölçüm kutusunu kapatın.
5'ten 7'ye kadar olan adımlarda dik doğrular ve kesişimler çizme hakkında bilgi için “Oluştur Menüsünü 
Kullanma” (sayfa 164) bölümüne bakın.

2.　C noktasını ve AB doğru parçasını seçin, ardından T   > [Animate] > [Add Animation]'ı seçin.

3.　a   tuşuna basın, E noktasını ve çemberin çevresini seçin ve ardından T   > [Animate] > [Add Animation]'ı 
(Animasyon Ekle) seçin.

4.　a   tuşuna basın, F noktasını seçin ve ardından T   > [Animate] > [Trace]'i (İzle) seçin.
•　Bu, F noktasını “trace point” (izleme noktası) olarak belirler.

Not
•　Ekran üzerinde o anda seçili olan tüm noktalar, T   > [Animate] > [Trace]'i (İzle) seçtiğinizde izleme 

noktası haline gelir.
•　Yeni bir trace noktası belirtmek, o anda belirtilmiş olan tüm trace noktalarının atılmasına neden olur.
•　Trace kullanılarak çizilen tüm izler, bir animasyon her çalıştırıldığında temizlenir.
•　Trace kullanılarak çizilen izler seçilebilir ve silinebilir, ancak taşınamazlar.

Bir animasyonu düzenlemek için
Aşağıdaki adımlar, “Noktaların Geometrik Yerini Çizmek İçin” (sayfa 177) bölümündeki Örnek 1'in 
prosedüründen devam etmektedir.

2.　Animasyonu aşağıdaki prosedüre göre düzenleyin.
•　Times (Zamanlar):

•　Çemberin çevresi üzerine E noktasını çizin.

(5)　 AB doğru parçasına dik olan ve C noktasından geçen bir 
doğru çizin.

(6)

(7)　 F noktasında kesişen iki dik doğru çizin.
•　Sağdaki ekran, (5)'ten (7)'ye kadar olan adımlar tamamlandıktan 

sonra ekranın nasıl görünmesi gerektiğini göstermektedir.

5.　T   > [Animate] > [Go(once)]'ı seçin. 
•　Bu, ekranda bir sinüs eğrisinin izlenmesine neden olmalıdır.

1.　Düzenlemek istediğiniz animasyon ekrandayken, T   > [Animate] 
> [Edit Animation]'ı (Animasyonu Düzenle) seçin.
•　Bu, Animasyonları Düzenle ekranını görüntüler.

(3). adımda çizdiğiniz doğruya dik olan ve E noktasından geçen 
bir doğru çizin.
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T   > [Animate] > [Go(repeat)] (Git(tekrarla)) seçeneğini seçtiğinizde animasyonun kaç kez yürütüleceğini 
bu ayar belirtir. Başlangıçtaki varsayılan değer 10'dur ve 0'dan 20'ye kadar bir değerle değiştirilebilir. 
Buraya 0 girilmesi, siz durdurmak için b   veya a   'ye basana kadar animasyonun tekrarlanmasına neden olur.

 

•　Adımlar:
Bu ayar, E noktasının AB doğru parçasını hareket ettirmek için kaç adım atacağını belirtir. Başlangıçtaki 
varsayılan değer 20'dir ve 2'den 100'e kadar bir değerle değiştirilebilir.

•　Animasyonlar:
“Animasyonlar” altındaki “E”, E noktasının animasyon tarafından hareket ettirilen nokta olduğunu gösterir. 
Birden fazla animasyon oluşturduğunuzda, ilgili tüm noktaların bir listesi burada görünür. Bir harf 
vurgulanmışken T   > [Delete]'i (Sil) seçmek, ilgili animasyonu siler. “Animasyonlar” vurgulanmışken 
  T   > [Delete]'i seçmek, tüm animasyonları siler.
“t0” ve “t1”, E noktasının AB doğru parçası üzerindeki hareket aralığını belirtir. Başlangıçtaki varsayılan 
değerler t0 = 0 ve t1 = 1'dir. Animasyon sırasında, AB'nin uzunluğu bir birim olarak kabul edilir. Varsayılan 
değerler, E noktasının hareketinin başlangıç noktası A'dan (uzunluğun 0'a eşit olduğu nokta) bitiş noktası
 B'ye (uzunluğun 1'e eşit olduğu nokta) kadar olduğunu belirtir. t0 ve t1 için -10'dan 10'a kadar bir sayı 
girebilirsiniz.
t0'ın değerini 0.5 olarak değiştirmek, E noktasının AB doğru parçasının ortasından B noktasına hareket 
etmesine neden olur. t0'ın değerini -1 olarak değiştirmek, E noktasının AB doğru parçasının dışında bir 
noktadan başlamasına (bu durumda, A noktasından E noktasına olan uzaklık AB doğrusunun uzunluğuna 
eşittir) ve B noktasında bitmesine neden olur. Değerleri t0 = 1, t1 = 0 olarak değiştirmek, E noktasının B 
noktasından A noktasına hareket etmesine neden olur.

•　Traces (İzler):
Bu öğe, belirtilen izleme noktasını gösterir. Bir harf vurgulanmışken T   > [Delete]'i (Sil) seçmek, ilgili 
izleme noktası ayarını iptal eder. “İzler” vurgulanmışken T   > [Delete]'i seçmek, tüm izleme noktası 
ayarlarını iptal eder.

 3.　Tüm ayarlar istediğiniz gibi olduktan sonra b   'ye basın.

Bir Animasyon Tablosu Oluşturma

Varsayılan ayarlara göre, bir animasyon, belirtilen bir noktanın belirtilen bir doğru parçası, çember, yay veya 
fonksiyon boyunca 20 adımda hareket etmesine neden olur. Hesap makinesini, her adımın koordinatlarını, 
doğru parçasının uzunluğunu, nesnenin alanını vb. kaydeden bir “animasyon tablosu” adı verilen bir tablo 
oluşturacak şekilde yapılandırabilirsiniz. Aşağıdaki verilerden herhangi biri animasyon tablosuna eklenebilir: 
koordinatlar (x, y), mesafe/uzunluk, eğim, yarıçap, çevre uzunluğu, çevre, alan, açı, bütünleyici açı, vektör 
parçaları (x, y) ve ifade. Animasyon tablosunun tek bir sütununu da seçip liste olarak kaydedebilir veya tüm 
animasyon tablosunu elektronik tablo verisi olarak kaydedebilirsiniz. Kaydedilen veriler daha sonra İstatistikler 
uygulaması veya Elektronik Tablo uygulaması ile analiz için kullanılabilir.

Animasyon tablosuna sütunlar eklemek için
Aşağıdaki adımlar, “Noktaların Geometrik Yerini Çizmek İçin” (sayfa 177) bölümündeki Örnek 2'nin 
prosedüründen devam etmektedir. İlk olarak, F noktasının koordinatları animasyon tablosuna eklenir. Ardından, 
E noktasını ve C noktasını birleştiren EC ve AB doğru parçalarının açıları animasyon tablosuna eklenir. 

1.　Burada, F noktasının koordinatları (x, y) için bir animasyon tablosu oluşturacağız, bu yüzden önce F 
noktasını seçin.

3.　Ölçüm kutusunun sağ tarafındaki yukarı ok düğmesini vurgulamak için r    'ı kullanın ve ardından O  'a basın.

4.　Görünen menüde [Add Table] (Tablo Ekle)'yi seçin ve ardından O  'a basın.

2.　Ölçüm kutusunu görüntülemek için V    tuşuna basın.*1

•　        (Koordinatlar) simgesi ekranın sol kenarında görünmezse, 
ölçüm kutusunun solundaki yukarı ok düğmesini vurgulayın ve 
ardından O  'a basın. Görünen simge paletinde,        simgesini 
seçin. 
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5.　Animasyon tablosu ekranını kapatmak için b   'ye basın.

6.　Çizim ekranını etkinleştirmek için b   'ye iki kez basın.

7.　a  tuşuna basın ve ardından E noktasını C noktasına bağlayan bir doğru parçası (CE doğru parçası) çizin.

10.　Animasyon tablosu ekranından çıkmak için b   'ye basın. 
*1　Ölçüm kutusunu kullanmak yerine, T   > [Animate] > [Add Table]'ı (Tablo Ekle) seçerek de bir animasyon 

tablosu ekleyebilirsiniz. Ancak, bu işlem tabloya eklenecek ölçüm türünü belirtmenize izin vermez.
Ölçüm kutusu görüntülendiğinde ilk görünen ölçüm eklenir. 

*2　Animasyon tablosuna açı ve bütünleyici açı eklendiğinde, açı birimi ekleme anında geçerli olan S   > [Angle] 
(Açı) ayarını takip eder. S   > [Angle] ayarını değiştirmek, zaten eklenmiş olan animasyon tablosundaki 
değerleri etkilemez.

Not
•　Bir animasyon tablosuna en fazla 26 sütun ekleyebilirsiniz.
•　Animasyon tablosu içeriği, aşağıdaki işlemlerden biri gerçekleştirildiğinde temizlenir.

-　Animasyonu değiştirmek için Animasyonları Düzenle ekranını kullanmak
-　Bir animasyon eklemek veya değiştirmek
-　Yeni bir trace point (izleme noktası) belirtmek
-　Bir animasyonda kullanılan bir geometrik öğeyi (doğru parçası, nokta vb.) silmek
-　Geometri uygulaması dışında bir uygulama başlatmak

Animasyon tablosunu görüntülemek için
“Animasyon tablosuna sütunlar eklemek için” (sayfa 179) bölümündeki prosedürle oluşturduğunuz animasyon 
tablosunu görüntülemek için T   > [Animate] > [Display Table]'ı (Tabloyu Görüntüle) seçin.

Bir animasyon tablosu sütununu bir listeye kaydetmek için
1.　Animasyon tablosunu görüntüleyin.

2.　Liste verisi olarak kaydetmek istediğiniz sütunu vurgulamak için l    ve r    'ı kullanın. 

3.　T   > [Store] > [List]'i (Listeye Kaydet) seçin.

4.　Görünen iletişim kutusunu kullanarak bir liste numarası girin ve ardından O  'a basın.

•　Bu, animasyonun her adımında F noktasının koordinatlarını 
“X” ve “Y” etiketli sütunlarda gösteren bir animasyon tablosu 
görüntüler.

8.　CE ve AB doğru parçalarını seçin ve ardından V    tuşuna basın.*1

•　       (Açı) simgesi ekranın sol kenarında görünmezse, ölçüm 
kutusunun solundaki yukarı ok düğmesini vurgulayın ve ardından 
O   'a basın. Görünen simge paletinde,       simgesini seçin. 

9.　Yukarıdaki 3'ten 4'e kadar olan adımları uygulayın.
•　Yukarıdaki 4. adımda eklenen “X” ve “Y” sütunlarının sağına bir 

“Angle” (Açı) sütunu eklenir.*2
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Not
•　Yukarıdaki işlem sırasında kaydedilen listeler, İstatistikler 

uygulamasının Liste Düzenleyicisi kullanılarak görüntülenebilir. 
Örneğin, “Animasyon tablosuna sütunlar eklemek için” (sayfa 
179) bölümündeki 9. adımı takiben, animasyon tablosunun her bir 
sütununu Liste 1'den Liste 3'e kadar bir listeye kaydedebilir ve 
ardından İstatistikler uygulamasını başlatarak sağdaki örnek 
ekranda gösterildiği gibi bir listeyi görüntüleyebilirsiniz.

Tüm animasyon tablosunu bir elektronik tablo dosyası olarak kaydetmek için
1.　Animasyon tablosunu görüntüleyin.

2.　T   > [Store] > [Spreadsheet]'i (Elektronik Tablo) seçin.

3.　Görünen iletişim kutusunu kullanarak dosya adı için en fazla sekiz karakter girin ve ardından O  'a basın.

Not
•　Yukarıdaki işlemle kaydedilen elektronik tablo dosyası,

Elektronik Tablo uygulamasını bir sonraki başlattığınızda 
otomatik olarak açılır. Örneğin, “Animasyon tablosuna sütunlar 
eklemek için” (sayfa 179) bölümündeki 9. adımı takiben 
animasyon tablosunu bir elektronik tablo dosyasına 
kaydederseniz, Elektronik Tablo uygulamasını başlatmak, 
tabloyu sağdaki örnek ekranda gösterildiği gibi görüntüler.

Bir animasyon tablosundan belirli bir sütunu silmek için
1.　Animasyon tablosunu görüntüleyin.

2.　Silmek istediğiniz sütunu vurgulamak için l    ve r    'ı kullanın.

3.　T   > [Delete] > [Delete]'i (Sil) seçin.

Bir animasyon tablosundaki tüm sütunları silmek için
1.　Animasyon tablosunu görüntüleyin.

2.　T   > [Delete] > [Delete All]'ı (Tümünü Sil) seçin.

3.　Görünen onay iletişim kutusuna yanıt olarak [OK]'i seçin.

Tuş (Key) Yardımını Kullanma
0 tuşuna basmak veya T   > [Key Help]'i (Tuş Yardımı) seçmek, Geometri uygulamasındaki her tuşa atanan 
fonksiyon hakkında bilgi sağlayan Tuş Yardımı penceresini görüntüler. Tuş Yardımı penceresinde gösterilen 
tuş işlemlerinin sadece çizim ekranı için geçerli olduğunu unutmayın. 

Geometri Uygulaması Ayar Menüsü Öğeleri
Aşağıda açıklanan Ayarlar menüsü öğeleri (sayfa 214), Geometri uygulamasına özeldir.

S  > [Angle Unit] … (Açı Birimi) … Çizim ekranındaki bir şeklin açılarını görüntülerken birimleri dahil 
edip etmeyeceğini belirtir.

S  > [Length Unit] … (Uzunluk Birimi) … Çizim ekranındaki bir şeklin uzunluklarını görüntülerken 
birimleri dahil edip etmeyeceğini belirtir.

S  > [Grid Space] … (Izgara Aralığı) … Çizim ekranındaki ızgara noktalarının ve çizgilerinin aralığını 
belirtir.
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Database (Veritabanı) Uygulaması
Veritabanı uygulaması, element ve fiziksel sabit verilerini içerir. Saklanan verilere göz atabilir, değerleri 
düzenleyebilir ve değerleri diğer uygulamalarda kullanabilirsiniz.*
*　 Atom ağırlıkları ve fiziksel sabitlerin değerleri alfa değişkenlerine kaydedilebilir. Ayrıca, element verilerini 

Elektronik Tablo uygulaması verileri olarak toplu olarak kaydedebilirsiniz.

Not
•　Element ve fiziksel sabit gösterimleri ile değerleri değişebilir. Bu hesap makinesinin uyduğu orijinal 

veriler için bu bölümün her bir kısmının başına (Bkz: “Periyodik Tablo” (sayfa 182) ve “Temel 
Fiziksel Sabitler” (sayfa 185)) bakın.

•　Veritabanı uygulamasının, kaydedilen atom ağırlığı ve fiziksel sabit değerlerini düzenleme ve kaydetme 
fonksiyonu vardır. Düzenlediğiniz ve kaydettiğiniz değerler, Veritabanı uygulamasını daha yeni bir 
sürüme güncelleseniz bile korunur. Kaydedilmiş değerleri güncellenmiş sürümün değerleriyle 
değiştirmek için, atom ağırlığı ve fiziksel sabit değerlerini başlangıçtaki varsayılan değerlerine geri 
yüklemek üzere “Tüm Atom Ağırlığı Değerlerini Başlatma” (sayfa 183) ve “Tüm fiziksel sabit değerlerini 
başlatmak için” (sayfa 187) altındaki işlemleri kullanın.

Periodic (Periyodik) Tablo
Elementlerin periyodik tablosundan bir element seçebilir ve onunla ilgili bilgileri görüntüleyebilirsiniz. Ayrıca 
elementleri ada veya atom ağırlığına göre de arayabilirsiniz.

Not
•　Veritabanı uygulaması tarafından görüntülenen atom ağırlıkları, IUPAC (International Union of Pure 

and Applied Chemistry), 2021'e uygundur.
•　Veritabanı uygulaması tarafından görüntülenen elektron konfigürasyonu, CRC Handbook of Chemistry 

and Physics, 91. Baskı ile uyumludur.

Bilgilerini Görüntülemek İçin Periyodik Tablodan Bir Element Seçme
Örnek: Periyodik tabloda, detaylı bilgilerini görüntülemek için altın (element sembolü: Au), atom numarası 

79'u seçin.

1.　h  > Database

2.　[Periyodik Tablo]'yu vurgulayın ve ardından O   veya r    'a basın.
•　Bu, periyodik tabloyu görüntüler. Bu durumda, imleç 

(①) atom numarası 1 olan hidrojende (element sembolü: H) 
görünür. İmleç konumundaki elementin sembolü, atom numarası 
numarası ve atom ağırlığı da      konumunda görüntülenir.②

.3.　İmleci atom numarası 79'a taşımak için imleç tuşlarını kullanın.
•　İmleci taşımak için imleç tuşlarını kullanmak yerine, bir 

elementi ad veya atom numarasına göre de arayabilirsiniz.
Aşağıda, atom numarasına göre arama yapma örneği 
verilmiştir.

(1)　 T  > [Search] > [Atomic No.]'yu seçin.
(2)　

4.　İmlecin bulunduğu elementin detaylı bilgilerini görüntülemek için O  'a
basın.
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*　Kararlı izotopları olmayan elementlerin atom ağırlıkları kare parantez ([ ]) içine alınır. Örneğin, [209] 
gibi bir sayı, o elementin en uzun ömürlü izotopunun kütle numarasını gösterir. Ancak, toryum (Th), 
protaktinyum (Pa) ve uranyum (U) karakteristik bir karasal izotopik bileşime sahip olduklarından, atom 
ağırlıkları kare parantez içine alınmaz. Atom ağırlıkları kare parantez içinde olan elementlerin adlarının 
yanında bir yıldız işareti (*) bulunur.

5.　Periyodik tabloya geri dönmek için b   veya O  'a basın.

Periyodik Tabloda Belirli Bir Sınıflandırmaya Ait Elementleri Vurgulama
Belirli bir sınıflandırmaya ait elementleri vurgulamak için aşağıdaki işlemleri kullanabilirsiniz.

Bu sınıflandırmanın elementlerini vurgulamak için:  Bu menü öğesini seçin:
Geçiş Elementleri T  > [Series] > [Transition]
Alkali Metaller T  > [Series] > [Alkali Metals]
Alkali Toprak Metalleri T  > [Series] > [Alkaline Earth Metal]
Halojenler T  > [Series] > [Halogens]
Soy Gazlar T  > [Series] > [Noble Gases]
Nadir Toprak Elementleri T  > [Series] > [Rare Earth]

Bir sınıflandırmanın vurgusunu kaldırmak için T   > [Clear]'ı (Temizle) seçin.

Not
•　Elementlerin sınıflandırması kesin değildir. Veritabanı uygulaması tarafından görüntülenen 

sınıflandırmalar, bu uygulamanın geliştirildiği zamanda genel olarak kabul görenlerdir.

 
Periyodik Tablo Bilgilerini Elektronik Tablo Dosyası Olarak Kaydetme
Periyodik tablo bilgilerini bir elektronik tablo dosyası olarak kaydetmek için aşağıdaki işlemi kullanabilirsiniz.

1.　T   > [Store]'u (Depola) seçin.

2.　Görünen iletişim kutusunu kullanarak dosya adı için en fazla sekiz karakter girin ve ardından O  'a basın.
•　Elektronik tablo dosyası, aşağıda belirtilen bilgileri A'dan D'ye kadar olan sütunlarda, o sırayla içerir.

Atom numarası (sayısal), element sembolü (metin), elektron dizilimi (metin), atom ağırlığı (sayısal) *

*　Atom ağırlığı değeri değiştirildiyse, yeni değer kaydedilir. Atom ağırlığı değerini değiştirme hakkında bilgi için 
“Bir atom ağırlığı değerini düzenlemek için” (sayfa 184) bölümüne bakın.

Tüm Atom Ağırlığı Değerlerini Başlatma
“Bir atom ağırlığı değerini düzenlemek için” (sayfa 184) altındaki işlemle düzenlenmiş olan tüm atom ağırlığı 
değerlerini, başlangıçtaki Veritabanı uygulaması değerlerine geri yüklemek için aşağıdaki işlemi kullanabilirsiniz.

1.　T   > [Initialize Weight]'ı (Ağırlığı Başlat) seçin.

2.　Görünen onay iletişim kutusuna yanıt olarak [OK]'i seçin.

Bir Element Arama
Bir element aramak için aşağıdaki tabloda gösterilen yöntemleri kullanabilirsiniz. Aradığınız element bulunursa, 
imleç elemente atlar.

•　Bu, element hakkında detaylı bilgileri görüntüler. Aşağıda 
görünen detaylı bilgiler yer almaktadır.

①　 Atom numarası, element sembolü, element adı, özellikleri
②　 Elektron konfigürasyonu
③　 Elementin görseli ve görselin açıklaması

④　 Atom ağırlığı *
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Buna göre arama               Bu işlemi gerçekleştirin: 
yapmak için: 
Element Adı 1.　T  > [Search] > [Name] seçeneğini seçin.

2.　Alfabetik listeden   istediğiniz element adını seçin ve ardından O  'a 
basın.

*1

Element sembolü 1.　T  > [Search] > [Symbol] seçeneğini seçin.
2.　Alfabetik listeden   bir element sembolü seçin ve ardından O  'a basın.*1

Atom numarası 1.　T  > [Search] > [Atomic No.] seçeneğini seçin.
2.　Görünen iletişim kutusunu kullanarak bir atom numarası girin ve ardından 

O  ’a basın. 
Atom ağırlığı 1.　

2.　Görünen iletişim kutusunu kullanarak en fazla 12 basamak uzunluğunda 
(ondalık nokta dahil) bir atom ağırlığı girin ve ardından O  'a basın. *2

*1　Alfabetik liste görüntülenirken, bastığınız tuşun harfi için listenin başına atlamak üzere XA  'dan 
0Z   'ye kadar bir tuşa basabilirsiniz.

*2　Bu, girilen değere eşit veya ondan daha büyük olan en küçük atom ağırlığına sahip elementi arar.

Periyodik Tabloyu Büyütme
Periyodik tabloyu görüntülerken +   veya <    tuşlarına basmak, geçerli imleç konumunun yakınındaki alanı 
yakınlaştırır. -, , ,      veya b   tuşlarına basmak tam tablo ekranına geri döner. Periyodik tablo yakınlaştırılmışken 
T   tuşu işleminin devre dışı bırakıldığını unutmayın.

Detaylı Bilgi Ekranını Kullanma
Periyodik tablo görüntülenirken O  'a basmak, imlecin o anda bulunduğu elementin detaylı bilgi ekranına geçer. 
Detaylı bilgi ekranının görüntü içeriği hakkında bilgi için “Bilgilerini Görüntülemek İçin Periyodik Tablodan 
Bir Element Seçme” (sayfa 182) bölümüne bakın. Bu bölüm, detaylı bilgi ekranı görüntülenirken 
gerçekleştirebileceğiniz işlemleri açıklamaktadır. 

Bir atom ağırlığı değerini düzenlemek için
1.　Atom ağırlığı değerini düzenlemek istediğiniz elementin detaylı bilgi ekranını görüntüleyin.

2.　T   > [Edit] (Düzenle) seçeneğini seçin veya r    'a basın.*
•　Bu, geçerli atom ağırlığı değerinin solunda imlecin görünmesine neden olur.

3.　İmleci düzenlemek istediğiniz basamağa taşımak için l    ve r    'ı kullanın ve ardından gerektiği gibi düzenleyin.
•　Atom ağırlığı için yalnızca sayı ve ondalık nokta girebilirsiniz, bu da en fazla 12 basamak uzunluğunda olabilir.
•　Düzenleme işlemini iptal etmek için burada b   'ye basın. 

4.　Düzenlenmiş bir değeri kaydetmek için O  'a basın.
*　 Bu işlemi gerçekleştirmek yerine, düzenlemeye başlamak için bir sayı tuşuna da basabilirsiniz..

Atom ağırlığı değeri kare parantezlerini göster/gizle
1.　Kare parantezlerini göstermek veya gizlemek istediğiniz elementin detaylı bilgi ekranını görüntüleyin.

2.　T  > [1 ⇔ [1]]'i seçin.
•　Bu işlemi her gerçekleştirdiğinizde, atom ağırlığı değerinin etrafındaki kare parantezler ([ ]) göster/gizle 

arasında geçiş yapar.
•　Bir atom ağırlığının etrafındaki kare parantezlerin anlamı hakkında bilgi için “Bilgilerini Görüntülemek 

İçin Periyodik Tablodan Bir Element Seçme” (sayfa 182) bölümündeki 4. adıma bakın..

Düzenlenen atom ağırlığı değerlerini başlangıçtaki varsayılan Database uygulaması değerlerine geri 
yüklemek için
T  > [Initialize]'i (Başlat) seçin.
Bu, atom ağırlığı değerini ve kare parantezleri göster/gizle ayarını Database uygulaması başlangıç varsayılan 
ayarlarına döndürür.

Bir atom ağırlığı değerini alfa değişkenine depolamak için
1.　Atom ağırlığı değerini depolamak istediğiniz elementin detaylı bilgi ekranını görüntüleyin.
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2.　T   > [Store]'u (Depola) seçin.

3.　Görünen iletişim kutusunu kullanarak A'dan Z'ye kadar bir harf girin ve ardından O  'a basın.
•　Bu, atom ağırlığı değerini girdiğiniz harfin alfa değişkenine depolar.
•　Alfa değişkenleri hakkında detaylı bilgi için “Alfa Değişkenlerini Kullanma” (sayfa 18) bölümüne bakın..

Fundamental Physical (Temel Fiziksel) Sabitler
Veritabanı (Database) uygulaması, aşağıdaki tabloda gösterilen fiziksel sabitlerin değerlerini tutar ve bunları 
kategoriye göre gruplandırılmış bir listede görüntüler. Fiziksel sabit değerlerini düzenleyebilir ve diğer 
uygulamalarda kullanmak üzere bir alfa değişkenine depolayabilirsiniz.

Not
•　Veritabanı uygulamasına dahil edilen fiziksel sabitlerin değerleri ve adları 2022 CODATA'ya

 dayanmaktadır.

Kategorize Edilmiş Fiziksel Sabitler Listesi
Kategori Sembol    Ad

Evrensel

c boşlukta ışık hızı
μ0 boşluğun manyetik geçirgenliği 4παħ/(e2c)

ε0 boşluğun elektriksel geçirgenliği 1/μ 0c2

Z0 boşluğun karakteristik empedansı μ0/ε0 = μ0c

G Newton'ın kütle çekim sabiti
h Planck sabiti
ħ indirgenmiş Planck sabiti
mP Planck kütlesi (ħc/G)1/2

lP Planck uzunluğu ħ/mPc = (ħG/c3)1/2

tP Planck zamanı lP/c = (ħG/c5)1/2

Elektromanyetik

e temel yük
Ф0 manyetik akı kuantumu 2πħ/2e

G0 iletkenlik kuantumu 2e2/2πħ
KJ Josephson sabiti 2e/h

RK von Klitzing sabiti μ0c/2α = 2πħ/e2

μB Bohr magnetonu eħ/2me

μN nükleer magneton eħ/2mp

Atomik & Nükleer

α ince yapı sabiti e2/4πε0ħc

R∞ Rydberg sabiti

a0 Bohr yarıçapı ħ/αmec = 4πε0ħ
2/mee2

me elektron kütlesi

μe elektron manyetik momenti

mμ müon kütlesi

μμ müon manyetik momenti

tau kütlesi

mp proton kütlesi

μp proton manyetik momenti

mn nötron kütlesi
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μn nötron manyetik momenti

Fizikokimyasal

NA Avogadro sabiti

mu atomik kütle sabiti m(12C)=2hc/R∞α2c2Ar(e)

F Faraday sabiti N Ae

R molar gaz sabiti R=NAk

k Boltzmann sabiti
Vm ideal gazın molar hacmi RT/p (273.15K, p=100kPa)

σ Stefan-Boltzmann  sabiti (π2/60)k4/ħ3c2

Kabul Edilen Değerler

KJ−90 Josephson sabitinin geleneksel değeri

RK−90 von Klitzing sabitinin geleneksel değeri

gn standart yerçekimi ivmesi

Bir Fiziksel Sabiti ve Bilgilerini Görüntüleme

•　Hangi kategoriye hangi fiziksel sabitlerin dahil olduğu hakkında bilgi için “Kategorize Edilmiş Fiziksel 
Sabitler Listesi” (sayfa 185) bölümüne bakın.

•　Fiziksel sabit değerlerini hesaplamalar için kullanan işlemler hakkında bilgi için “Bir Hesaplamada Fiziksel 
Sabit Kullanma” (sayfa 187) bölümüne bakın.

5.　Kategori listesine geri dönmek için b   'ye basın.

Bir Fiziksel Sabit Değerini Düzenleme

Bir fiziksel sabit değerini düzenlemek için
1.　Değerini düzenlemek istediğiniz fiziksel sabiti vurgulamak için “Bir Fiziksel Sabiti ve Bilgilerini Görüntüleme” 

(sayfa 186) bölümündeki prosedürün ilk üç adımını uygulayın.

2.　T   > [Edit] (Düzenle) seçeneğini seçin veya r    'a basın.*
•　Bu, giriş imlecinin fiziksel sabitin değerinin solunda görünmesini sağlar.

3.　İmleci düzenlemek istediğiniz basamağa taşımak için l     ve r    'ı kullanın ve ardından gerektiği gibi düzenleyin.
•　15'ten fazla basamak girseniz bile, yalnızca en fazla 15 anlamlı basamak kaydedilir.
•　Bir sabiti yanlış giriş kullanarak düzenlemeye çalıştığınızda bir hata (Söz Dizimi HATASI) oluşur.

1.　h  > Database

2.　[Fundamental Physical Constants] (Temel Fiziksel Sabitler)'i vurgulayın 
ve ardından O   veya r    'a basın.
•　Bu, Fiziksel Sabitler kategorilerinin bir listesini görüntüler.

3.　Değerlerini görüntülemek istediğiniz fiziksel sabit kategorisini vurgulayın 
ve ardından O   veya      ’a basın. Örneğin, Bohr magnetonu (μB) 
değerini görüntülemek için [Electromagnetic] (Elektromanyetik)'i 
vurgulayın ve ardından O   veya r    'a basın.

•　Bu, Elektromanyetik kategorisi fiziksel sabitlerinin bir listesini 
ve değerlerini görüntüler.

4.　Bohr magnetonu hakkında bilgi görüntülemek için, [μ  ] satırını vurgula-
yın ve ardından O  ’a basın veya T   > [Description] (Açıklama)'ı seçin.

B

•　Bu, ilgili bilgileri (ad, sembol, birimler) içeren bir iletişim kutusu 
görüntüler. İletişim kutusunu kapatmak için O   veya b   'ye basın.
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•　Bir sabiti düzenlerken matematiksel olarak yanlış bir ifade girerseniz bir hata (Matematik HATASI) oluşur.
•　Düzenleme işlemini iptal etmek için burada b   'ye basın.

4.　Düzenlenmiş bir değeri kaydetmek için O  'a basın.
*　Bu işlemi gerçekleştirmek yerine, düzenlemeye başlamak için bir sayı tuşuna da basabilirsiniz.

Tek bir fiziksel sabit değerini başlatmak için
1.　Değerini başlatmak istediğiniz fiziksel sabiti vurgulamak için “Bir Fiziksel Sabiti ve Bilgilerini Görüntüleme” 

(sayfa 186) bölümündeki prosedürün ilk üç adımını uygulayın.

2.　T > [Initialize] > [Selected Constant] (Başlat > Seçili Sabit) seçeneğini seçin.

Tüm fiziksel sabit değerlerini başlatmak için

1.　Fiziksel sabit listesi ekranı görüntülenirken, T   > [Initialize] > [All] (Başlat > Tümü) seçeneğini seçin

2.　Görünen onay iletişim kutusuna yanıt olarak [OK]'i seçin.

Bir Hesaplamada Fiziksel Sabit Kullanma
Fiziksel sabit değerleri, Hesaplama ve diğer uygulamalar tarafından hesaplamalarda kullanılmak üzere alfa 
değişkenlerine depolanabilir.

Örnek: Işığın Güneş'ten Dünya'ya ulaşması için gereken süreyi hesaplamak için. Bu hesaplama, Güneş'ten 
Dünya'ya olan ortalama mesafeyi (1 au = 149.597.870.700 m) ve hesap makinesinin varsayılan değeri 
olan boşlukta ışık hızını (c = 299.792.458 m/s) kullanır.

1.　Fiziksel Sabitler kategori listesinde, [Universal] (Evrensel)'i seçin ve ardından O  'a basın.

3.　A'dan Z'ye kadar bir harf girin ve ardından O  'a basın. 
•　Burada, değeri alfa değişkeni C'ye depolayan jCO       tuşlarına basın.

4.　Hesaplama uygulamasını başlatmak için h    > [Calculate]'i seçin.

149597870700*Pj (C)E

•　Hesaplama sonucu, ışığın Güneş'ten Dünya'ya ulaşmasının yaklaşık 499 saniye sürdüğünü göstermektedir.
•　Alfa değişkenleri hakkında detaylı bilgi için “Alfa Değişkenlerini Kullanma” (sayfa 18) bölümüne bakın..

My Drawer'ı Kullanma
Sık kullanılan fiziksel sabitleri depolamak için My Drawer'ı kullanabilirsiniz.

Bir fiziksel sabiti My Drawer'a kaydetmek için
1.　My Drawer'a kaydetmek istediğiniz fiziksel sabiti vurgulamak için “Bir Fiziksel Sabiti ve Bilgilerini 

Görüntüleme” (sayfa 186) bölümündeki prosedürün ilk üç adımını uygulayın.

2.　T   > [Store in My Drawer] (My Drawer'a Depola)'yı seçin.

2.　[c] (boşlukta ışık hızı)'nı vurgulayın ve ardından T   > [Store Const. as 
Variable] (Sabiti Değişken Olarak Depola)'yı seçin.
•　Bu, alfa değişkeni depolama hedefinin belirtilmesi için bir iletişim 

kutusu görüntüler.

5.　Hesaplamayı yürütün.

187



My Drawer'a kaydedilen fiziksel sabitleri görüntülemek için
Fiziksel Sabitler kategori listesinde, [My Drawer]'ı seçin.

My Drawer'a Kaydedilmiş Tek Bir Fiziksel Sabiti Silmek İçin
1.　Fiziksel Sabitler kategori listesinde, [My Drawer]'ı seçin.

2.　My Drawer'dan silmek istediğiniz fiziksel sabiti vurgulayın.

3.　T   > [Delete] > [Selected Constant] (Sil > Seçili Sabit) seçeneğini seçin.

My Drawer'a Kaydedilmiş Tüm Fiziksel Sabitleri Silmek İçin
1.　Fiziksel Sabitler kategori listesinde, [My Drawer]'ı seçin.

2.　T   > [Delete] > [All] (Sil > Tümü) seçeneğini seçin.

3.　Görünen onay iletişim kutusuna yanıt olarak [OK]'i seçin.
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Prob Sim (Olasılık Simülasyonu) Uygulaması
Prob Sim (Olasılık Simülasyonu) uygulaması, aşağıda açıklanan altı tür simülasyonu gerçekleştirir.
•　Coin Toss (Yazı Tura)
•　Dice Roll (Zar Atışı)
•　Spinner (Çark)

•　Marble Grab (Misket Çekme)
•　Card Draw (Kart Çekme)
•　Random Numbers

Sayılar (Rastgele Tam Sayılar))
 (Random Integers) (Rastgele 

İşlem Akışı
Adım 1: Bir simülasyon türü seçin (Olasılık sekmesi).

2.　Çalıştırmak istediğiniz simülasyon türünü vurgulayın ve ardından >   (veya O  ) tuşuna basın.
•　Bu, seçtiğiniz simülasyon türünün ayarlarını gösteren Kurulum (Setup) sekmesini görüntüler.

Adım 2: Simülasyon deneme sayısını belirtin ve diğer ayarları yapılandırın (Kurulum sekmesi).
3.　Simülasyon deneme sayısını belirtin.

(2)　 Görünen iletişim kutusuna 1 ile 999 arasında bir tam sayı girin ve ardından O  'a basın.

4.　 Diğer ayarları yapılandırın.

Belirli Simülasyon Türlerine Özgü Ayar Öğeleri
Tür                    Öğe Açıklama Ayar *1

Coin Toss Coins Madeni para sayısını belirtir. 1, 2, 3
Dice Roll Dice Zar sayısını belirtir. 1, 2, 3

Die Sides Her bir zar için yüz sayısını belirtir.                     4, 6, 8, 12, 20
Spinner Sections Çark üzerindeki bölüm sayısını belirtir. 2, 3, 4 to 8

Marble Grab Marble Types Misket türlerini belirtir. Bu ayar için 2'yi 
                                                           seçmek A, B; 5'i seçmek ise A, B, C, D, E 
                                                           misket türlerini belirtecektir.

2, 3, 4, 5

Replacement  Çekilen bir misketin çekildikten sonra geri 
                                   konulup konulmayacağını belirtir (Açık: 
                                   Konulur, Kapalı: Konulmaz). Geri koyma için 
                                   Açık seçildiğinde, sonuç ekranının sol üst  
                                   köşesinde “   ” görüntülenir.

On, Off

Card Draw Decks Kart destesi sayısını belirtir. 1, 2, 3
Deck Size Bir destedeki kart sayısını belirtir.                       32, 52
Replacement Çekilen bir kartın çekildikten sonra geri 
                                  konulup konulmayacağını belirtir (Açık: Konu-
                                  lur, Kapalı: Konulmaz). Geri koyma için Açık 
                                  seçildiğinde, sonuç ekranının sol üst köşesinde 
                                  “     ” görüntülenir.

On, Off

1.　h  > Prob Sim
•　Bu, bir simülasyon türü seçmek için bir menü görüntüler.

(1)　 [# of Trials] (Deneme Sayısı)'nı vurgulayın ve ardından O  'a 
basın. 
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Random
Numbers

# of RanNums Oluşturulacak random sayı sayısını belirtir. 1 to 6

Range Start               Random sayı oluşturma aralığının alt sınırını 
                                  belirtir.

0, 1 to 98

Range End  Random sayı oluşturma aralığının üst sınırını 
                                   belirtir.

1 to 40 to 99

Repeat*2 Aynı değerin tekrar tekrar oluşturulup oluşturu-
lamayacağını belirtir (Açık: Oluşturulabilir, Ka-
palı: Oluşturulamaz). Tekrar için Açık seçildi-
ğinde, sonuç ekranının sol üst köşesinde “    ” 
görüntülenir. 

On, Off

Tüm Simülasyon Türleri İçin Ortak Ayar Öğeleri
Öğe Açıklama Ayar *1

Refresh Freq Sonuç ekranının ne sıklıkta (sonuç sayısına 
göre) yenileneceğini belirtir. Burada “After Last 
Trial” (Son Denemeden Sonra) belirtmek, ekra-
nın son denemeden sonra yenilenmesini sağlar.

After 1 Trial, After
20 Trials, After 50
Trials, After Last
Trial

Random Seed Sözde rastgele sayıların oluşturulması için 
kullanılacak bir tohum değeri belirtir.

1 ila 99999

*1　Altı çizili ayarlar, başlangıçtaki varsayılanları gösterir.
*2　Tekrar ayarı için Kapalı belirtildiğinde, rastgele sayı aralığı, oluşturulacak rastgele sayı sayısından daha 

büyük bir değere ayarlanmalıdır.

Not
•　Tüm Kurulum sekmesi ayar öğelerini başlangıç varsayılan ayarlarına geri yüklemek için T   > [Initialize] 

(Başlat) seçeneğini seçin.
 

•　
Yazı Tura, Zar Atışı, Çark ve Misket Çekme için bir oluşum oranı sapması (örneğin, Yazı Tura'nın yazı 
veya tura gelme olasılığı) belirtebilirsiniz. Detaylar için “Bir Oluşum Oranı Sapması Belirtme (Bias)” 
(sayfa 191) bölümüne bakın.

Adım 3: Simülasyonu çalıştırın ve sonuçlarını görüntüleyin (Result (Sonuç) sekmesi).

5.　Kurulum sekmesinde, >   tuşuna basın veya vurgulayın                ve ardından O  'a basın.
•　Simülasyonun sonuçları Sonuç sekmesinde görüntülenir. Her bir simülasyon türü için görüntülenen 

sonuçlar hakkında bilgi için “Sonuç Sekmesini Kullanma” (sayfa 192) bölümüne bakın.

Example simulation result display:

Dice Roll Random Numbers
•　Tablonun en sol sütunu deneme sayısını gösterir.
•　Bir tabloda yukarı ve aşağı kaydırmak için u   ve d   'yı kullanabilirsiniz. Bir grafikte sol ve sağa kaydırmak 

için l    ve r    'ı kullanabilirsiniz.
•　şağıdaki tablo, Sonuç sekmesinde gerçekleştirebileceğiniz işlemleri göstermektedir.

Bunu yapmak için: Bu işlemi gerçekleştirin:
Orijinaliyle aynı sayıda deneme için bir simülasyonu 
yeniden çalıştırın.

O  'a basın.

Belirli sayıda deneme için simülasyonu yeniden         Bir sayı tuşuna bastığınızda veya T   > [Increase
çalıştırın. trials (n)] (Deneme Sayısını Artır (n)) seçeneğini 

seçtiğinizde görünen iletişim kutusuna, istenen 
deneme sayısını girin ve ardından O  'a basın.
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Sonuç görüntüleme formatı olarak Tablo, Grafik 
veya Grafik + Tablo seçin*1

T   > [Results Display] (Sonuçları Görüntüle)'yi 
seçin.

Simülasyon sonuçlarını bir liste değişkenine depolayın T   > [Store] (Depola)'yı seçin.*2

Mevcut simülasyon sonuçlarını silin ve Kurulum 
sekmesine dönün 

T   > [Delete] (Sil)'i seçin.

Bir nişangah işaretçisi (    ) görüntüleyin ve çubuk 
grafik değerlerini okuyun (frekans ve olasılık)*3

T   > [Trace] (İzle)'yi seçin.

*1　Bu işlem Yazı Tura, Zar Atışı, Çark ve Misket Çekme için gerçekleştirilebilir.
*2　Detaylar için “Simülasyon sonuçlarını bir liste değişkenine depolamak için” (sayfa 192) bölümüne bakın.
*3　Bu işlem T   > [Results Display] > [Graph] (Sonuçları Görüntüle > Grafik) seçiliyken gerçekleştirilebilir. 

Daha fazla bilgi için “Çubuk grafik frekans ve olasılık değerlerini okumak için” (sayfa 193) bölümüne bakın.

6.　Kurulum sekmesine geri dönmek için <   (veya b   ) tuşlarına basın.
•　Mevcut simülasyon sonuçlarını silmek isteyip istemediğinizi soran görünen bir iletişim kutusuna yanıt 

olarak [OK]'i seçin.

Bir Oluşum Oranı Sapması Belirtme (Bias)
Gerçek hayatta, bir madeni paranın bir tarafı diğer tarafa göre daha sık görünme eğilimindedir ve bir zarın bir 
sayısı diğerlerine göre daha sık görünme eğilimindedir. Bu, madeni paranın veya zarın fiziksel şeklinden veya 
ağırlık merkezinin kaymasından kaynaklanır. Ayrıca, Misket Çekme misketlerinin sayısı, misket türüne bağlı 
olarak farklılık gösterebilir. Bu tür bir oluşum oranı sapması, her bir simülasyon türü için belirtilebilir. Oluşum 
oranı sapması, Yazı Tura, Zar Atışı, Çark ve Misket Çekme için belirtilebilir.

Yazı Tura, Zar Atışı veya Çark için Sapma Belirtmek İçin
1.　Yazı Tura, Zar Atışı veya Çark için Kurulum sekmesini görüntüleyin. 

3.　Her bir sonuç için Weight (Ağırlık) veya Prob (Olasılık) değerini değiştirin.

Weight: 0 ile 999 arasında bir değer belirtin (başlangıç varsayılanı: 1). Bir sonucun Ağırlığını 
değiştirmek, tüm sonuçların Olasılık değerlerinin buna göre yeniden hesaplanmasına 
neden olur.

Prob: En fazla dört ondalık basamağa sahip bir değer belirtin. Bir sonucun Olasılığını 
değiştirmek, tüm sonuçların Olasılık ve Ağırlık değerlerinin buna göre yeniden 
hesaplanmasına neden olur. 

•　Tüm Ağırlık ve Olasılık değerlerini başlatmak için T   > [Initialize] (Başlat)'ı seçin.

4.　Her şey istediğiniz gibi olduktan sonra, düzenleme ekranını kapatmak için b   'ye basın. 

Misket Çekme İçin Sapma Belirtmek İçin
1.　Misket Çekme için Kurulum sekmesini görüntüleyin.

3.　Her bir misket türü için, 0 ile 999 arasında bir misket sayısı belirtin (başlangıç varsayılanı: 10).
•　Bu ayarı başlatmak için T   > [Initialize] (Başlat)'ı seçin.

4.　Her şey istediğiniz gibi olduktan sonra, düzenleme ekranını kapatmak için b   'ye basın.

2.　T   > [Bias] (Sapma)'yı seçin.
•　Bu, belirli bir sonucun ağırlığını (Ağırlık) ve olasılığını (Olasılık) 

değiştirmek için bir ekran görüntüler.

2.　T   > [Bias] (Sapma)'yı seçin.
•　Bu, her bir misket türünün sayısını düzenlemek için bir ekran 

görüntüler.
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Sonuç (Result) Sekmesini Kullanma
Aşağıdaki tablo, her bir simülasyon türü için Sonuç sekmesinin içeriğini göstermektedir.

Tür Tablo Grafik
Coin Toss 1 coin Birden fazla atışta kümülatif tura 
(Yazı Tura)       (1 madeni para)  sayısı

Birden fazla atışta yazı/tura 
frekansları

2 coins/3 coins  Tek bir atışta tura sayısı                       Birden fazla atışta tura sayılarının
kümülatif frekansları

Dice Roll 1 die (zar)
(Zar Atışı)

Tek bir atışta gelen sayı                       Birden fazla atışta her bir sayının
frekansları

2 dice/3 dice  Tek bir atışta gelen sayıların 
                           toplamı

Birden fazla atışta atış toplamlarının 
frekansları

Spinner (çark) Tek bir çevirmede gelen çark               Birden fazla çevirmede her bir 
numarası sayının frekansları

Marble Grab (Misket Çekme) Tek bir çekmede gelen misket türleri   Birden fazla çekmede her bir misket
türünün frekansları

Card Draw (Kart Çekme) Çekilen kartın değeri ve türü -
Random Numbers (Sayılar) Oluşturulan rastgele tam sayı -

Simülasyon sonuçlarını bir liste değişkenine depolamak için
Örnek 1: 3 madeni parayla 20 atışlık bir simülasyonun sonuçlarını bir liste değişkenine depolamak için

1.　Yazı Tura için Kurulum sekmesini görüntüleyin.

2.　[# of Trials] (Deneme Sayısı)'nı vurgulayın, “20” girin ve ardından O  'a basın..

3.　[Coins] (Madeni Para Sayısı)'nı vurgulayın ve ardından O  'a basın.

4.　Görünen menüde, [3]'ü seçin ve ardından O  'a basın.

5.　> tuşuna basın.
•　Simülasyonun sonuçları Sonuç sekmesinde görüntülenir.

7.　Gerekirse, her bir veri satırının depolanacağı hedefi belirtmek için liste değişkeni numarasını 
değiştirin.

(1)　 Değiştirmek istediğiniz satırı vurgulayın ve ardından O  'a basın.
(2)　 Görünen iletişim kutusunu kullanarak bir liste numarası girin ve ardından O  'a basın.

•　Başka bir satırda zaten belirtilmiş bir liste numarası girerseniz, “Data is in use” (Veriler kullanımda) 
mesajı görünür. Mesajı kapatmak için O  'a basın ve ardından farklı bir liste numarası belirtin.

8.　Vurgulayın                ve ardından O  'a basın.
•　Bu, simülasyon sonuçlarını belirtilen liste değişkenine depolar.

Not
•　Nelerin depolandığını, İstatistik uygulamasını başlatarak ve Liste Düzenleyici'yi görüntüleyerek kontrol 

edebilirsiniz.

6.　T   > [Store]'u (Depola) seçin. 
•　Bu, depolama hedefi liste değişkenini belirtmek için bir ekran 

görüntüler.
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•　Kart Çekme sonuçları için, Değer (rank) ve Tür sonuçları ayrı 
listelerde depolanır. Ayrıca, A, J, Q ve K değerleri ile kupa, sinek, 
maça ve karo türleri aşağıda gösterilen değerler olarak depolanır.

A = 1, J = 11, Q = 12, K = 13
 = 1,  = 2,  = 3,  = 4

Çubuk Grafik Frekans ve Olasılık Değerlerini Okumak İçin
Örnek 2: Örnek 1'in simülasyon sonuçlarının tam ekran çubuk grafiğini görüntülemek ve her bir çubuk için 

frekans ve olasılık değerlerini görüntülemek

1.　Örnek 1'in 1'den 5'e kadar olan adımlarını gerçekleştirin.

2.　T   > [Results Display] > [Graph] (Sonuçları Görüntüle > Grafik) seçeneğini seçin.
•　Bu, tam ekran bir çubuk grafik görüntüler.

4.　Çubuk grafikteki işaretçiyi temizlemek için b   'ye basın.

Prob Sim (Olasılık Simülasyonu) Uygulaması Ayarlar Menüsü Öğeleri
Aşağıda açıklanan Ayarlar menüsü öğeleri (sayfa 214), Olasılık Simülasyonu uygulamasına özgüdür.

S  > [Maximum Scale] … (Maksimum Ölçek) … Sonuç sekmesindeki dikey eksenin maksimum değerinin 
grafikte gösterilip gizleneceğini belirtir.

S  > [Animation] … (Animasyon) … Bir simülasyon gerçekleştirildiğinde, sonuçlardan önce bir 
animasyonun görüntülenip görüntülenmeyeceğini belirtir.

3.　T   > [Trace] (İzle)'yi seçin.
•　Bu, en soldaki çubukta bir nişangah işaretçisinin (    ) görünmesini 

sağlar ve ekranın üst kısmında frekans (Frek) ve olasılık (Prob) 
değerleri belirir.

•　İşaretçiyi sola ve sağa hareket ettirmek için l    ve r    'ı 
kullanabilirsiniz.
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Memory (Bellek) Uygulaması
Hesap makinenizin Ana Bellek (Main Memory) ve Depolama Belleği (Storage Memory) adında iki veri 
depolama alanı vardır. Bu iki bellek alanını yönetmek için Bellek uygulamasını kullanabilirsiniz.
 
Main Memory : Bu alan, İstatistik ve Grafik&Tablo gibi uygulamalar için giriş verilerini, değişkenleri 

ve yapılandırma verilerini depolamak için kullanılır..
Storage Memory:  Bu alan, görüntü dosyaları ve py dosyaları gibi nispeten büyük hacimli verileri 
                                            depolamak için kullanılır. Bu alan ayrıca Ana Bellek verilerinin yedek dosyalarını 
                                            oluşturmak için de kullanılabilir. 
Bellek uygulamasını başlatmak için h   > Memory'yi seçtiğinizde, ilk olarak Ana Bellek sekmesi içeriği görünür. 
Ana Bellek sekmesi ile Depolama Belleği sekmesi arasında gezinmek için <    ve >     tuşlarını kullanabilirsiniz.

Main Memory (Ana Bellek) Sekmesini Kullanma

Ana Bellek Sekmesinde Görüntülenen Veriler
Ana Bellek sekmesi, hesap makinesi verilerini aşağıda gösterilen adları kullanarak gösterir.

Veri Adı İçerikler
 ALPHA MEM Alfa değişkenleri

 CONICS Konik Grafikler uygulaması verileri

 DIST Dağılım uygulaması verileri

 DYNA MEM Dinamik Grafik uygulaması verileri

 EQUATION Denklem uygulaması verileri

 FINANCE Finans uygulaması verileri

 LISTFILE Liste değişkeni grubu

 LIST n Liste değişkenleri ( n = 1 to 26 and ANS)

 LISTFILE n Liste dosyaları  (n = 1 to 6)

 MAT_VCT Matris ve vektör değişken grubu

 MAT n Matris değişkenleri (n = A to Z and ANS)

 VCT n Vektör değişkenleri  (n = A to Z and ANS)

 NUMINEQ (fx-CG100) Sayısal Eşitsizlik uygulaması verileri

 RECURSION Özyineleme uygulaması verileri

 SETUP Ayarlar verileri ve diğer kurulum verileri

 STAT İstatistik uygulaması verileri

 SYSTEM İşletim sistemi ve paylaşılan uygulama verileri (pano, hesaplama geçmişi, vb.)

 S-SHEET Elektronik tablo uygulaması grubu

 _SETTING Elektronik tablo uygulaması ayar verileri

 SHEET Elektronik tablo uygulaması verileri (“SHEET” başlangıç varsayılan 
elektronik tablo dosya adıdır.)

Her bir “spreadsheet” adı Elektronik tablo uygulaması verileri

 TABLE Grafik&Tablo uygulaması tablo verileri

 Y=DATA Fonksiyon değişkenleri
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 3DGRAPH 3D Grafik uygulaması grubu

 3DGRAPH 3D Grafik uygulaması verileri

 DBASE Database (Veritabanı) uygulaması grubu

 Periodic Veritabanı uygulaması periyodik tablo verileri

 Adopted, Atomic, Electoro,
Physico, Univers, User

Veritabanı uygulaması temel fiziksel sabitler verileri

 GEOM Geometri uygulaması grubu

 @IMAGE Geometri uygulaması mevcut verileri

 Her bir geometri dosya adı Geometri uygulaması verileri

 PROBSIM Prob Sim (Olasılık Simülasyonu) uygulaması grubu

 PROBSIM Olasılık Simülasyonu uygulaması verileri

Main Memory (Ana Bellek) Sekmesi İşlemleri

Tüm verilerin yedek dosyasını oluşturmak için
Tüm Ana Bellek verilerinin yedek dosyasını Depolama Belleği'ne kaydetmek için aşağıdaki prosedürü kullanın. 
Dosyanın adı her zaman “BACKUP.g4m”dir ve değiştirilemez. Kaydetme hedefi klasörü oluşturmak isterseniz, 
Depolama Belleği sekmesine gidin ve klasörü önceden oluşturun.

1.　T   > [Backup] > [Save Backup Data] (Yedekle > Yedek Veri Kaydet)'i seçin.
•　Bu, veriyi kaydetmek için bir klasör seçmenizi sağlayan bir iletişim kutusu görüntüler.

2.　Kaydetme hedefi klasörünü seçmek için aşağıdaki işlemi kullanın.

Bu klasörü seçmek için:          Bu işlemi gerçekleştirin:
Root directory (kök dizin) [ROOT]'u (KÖK) vurgulayın ve ardından O  'a basın.
Diğer klasörler (1)　 Seçmek istediğiniz klasörü vurgulayın ve ardından O  'a basın. Bu 

sizi seçilen klasöre götürecektir. 

(2)　  Klasörün adını vurgulayın ve ardından tekrar O  'a basın. 

Tüm verileri bir yedek dosyasından geri yüklemek için
Ana Bellek'teki tüm verileri Depolama Belleği'nde depolanan bir yedek dosyasından geri yüklemek için 
aşağıdaki prosedürü kullanabilirsiniz.

1.　T   > [Backup] > [Load Backup Data] (Yedekle > Yedek Veri Yükle)'yi seçin.
•　Bu, yedek dosyasının depolandığı klasörü seçmek için bir iletişim kutusu görüntüler.

2.　Yedek dosyasının depolandığı klasörü seçmek için aşağıdaki işlemi kullanın.

Bu klasörü seçmek için:          Bu işlemi gerçekleştirin:
Root directory (kök dizin) [ROOT]'u (KÖK) vurgulayın ve ardından O  'a basın. *

Other folders (1)　 Seçmek istediğiniz klasörü vurgulayın ve ardından O  'a basın. Bu 
sizi seçilen klasöre götürecektir. 

(2)　 Klasörün adını vurgulayın ve ardından tekrar O  'a basın. *

•　Bu, mevcut verilerin üzerine yazmak isteyip istemediğinizi soran bir onay mesajı görüntüler.

3.　Ana Bellek'teki tüm mevcut verilerin yedek dosyasının içeriğiyle üzerine yazılması için [OK]'u veya işlemi 
iptal etmek için [Cancel] (İptal)'i seçin.

*　Seçilen klasör bir yedek dosyası içermiyorsa, “No Data” (Veri Yok) mesajı görünecektir.

Belirli verileri veya grupları tek bir dosya olarak Storage Memory’e (Depolama Belleği) kaydetmek için
1.　Bir dosyaya kaydetmek istediğiniz veriyi veya grubu vurgulayın.

2.　T   > [Save As] (Farklı Kaydet)'i seçin.
•　Bu, veriyi kaydetmek için bir klasör seçmenizi sağlayan bir iletişim kutusu görüntüler.
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3.　Kaydetme hedefi klasörünü seçmek için aşağıdaki işlemi kullanın.

Bu klasörü seçmek için:          Bu işlemi gerçekleştirin:
Root directory (kök dizin) [ROOT]'u (KÖK) vurgulayın ve ardından O  'a basın. 
Diğer Klasörler (1)　 Seçmek istediğiniz klasörü vurgulayın ve ardından O  ’a basın. Bu 

sizi seçilen klasöre götürecektir. 

(2)　 Klasörün adını vurgulayın ve ardından tekrar O  'a basın.

4.　Görünen iletişim kutusunu kullanarak dosya adı için en fazla sekiz karakter girin ve ardından O  'a basın.
•　Kaydedilen dosyanın dosya adı uzantısı .g4m'dir..
•　Kaydedilen dosyalar, Depolama Belleği sekmesindeki işlemler kullanılarak Ana Bellek'e yüklenebilir. 

Detaylar için “Bir g4m dosyasını Ana Bellek'e yüklemek için” (sayfa 197) bölümüne bakın.

Belirli verileri veya grupları silmek için
1.　Silmek istediğiniz veriyi veya grubu vurgulayın.

2.　T   > [Delete] (Sil)'i seçin. 
•　Bu, bir silme onay mesajının görünmesine neden olur.

3.　Silmek için [OK]'u seçin. İşlemi iptal etmek için [Cancel] (İptal)'i seçin.

Depolama Belleği Sekmesini (Storage Memory Tab) Kullanma

Depolama Belleği Sekmesinde Görüntülenen Dosyalar
Hesap makinesiyle oluşturulan dosyalar ve bilgisayardan hesap makinesine aktarılan dosyalar, Depolama 
Belleği sekmesinde görüntülenir. 

Dosya Uzantısı Açıklama
 .g4m Ana Bellek verilerini içeren dosya.

 .g4p*1 Hesap makinesiyle yakalanan bir ekran görüntüsünü içeren dosya.*2

 .bmp Bitmap formatı görüntü dosyası.

 .g3p*1 Daha önceki bir Renkli Grafik bilimsel hesap makinesiyle yakalanan bir 
ekran görüntüsünü içeren dosya.

 .py Python betik dosyası (py dosyası)
 .csv CSV dosyaları

 Diğer dosya adı uzantıları Bu dosyalar bu hesap makinesi tarafından desteklenmez, ancak bunları 
silmek için bu hesap makinesini kullanabilirsiniz.

*1　Bu formatlardaki dosyalar, grafik pencerelerinin arka plan görüntüleri (sayfa 219) olarak kullanılabilir.
*2　Arka plan görüntüsüne sahip Geometri uygulaması verileri de bir g4p dosyası olarak kaydedilir. Daha 

fazla bilgi için “Bir Geometri Uygulaması Ekranı Arka Plan Görüntüsü Görüntüleme” (sayfa 162) 
bölümüne bakın.

.

Not
•　Depolama Belleği sekmesinde klasörler      simgesi ile gösterilir.
•　Bilgisayarınızdan Depolama Belleği'ne aktarılan bir dosyanın adı sekiz karakterden uzunsa, adı 

Depolama Belleği sekmesinde görüntülendiğinde sekiz karaktere kısaltılacaktır (Örnek: 
AAAABBBBCC.py > AAAABB~1.py). Ayrıca, bir dosya adı uzantısı üç karakterden fazlaysa, dosya 
adı uzantısının üçüncü karakterden sonrası kesilecektir.

 

•　Klasör başına en fazla 200 dosya Depolama Belleği sekmesinde görüntülenebilir. Bir klasörde 200'den 
fazla dosya varsa ve hepsini görüntülemeniz gerekiyorsa, bunları birden fazla klasöre ayırarak tek bir 
klasördeki toplam dosya sayısının 200'ü geçmemesini sağlayın.

•
　
Bilgisayarınızda Depolama Belleği'nde üç seviyeden daha fazla iç içe geçmiş klasörler oluşturabilmenize 
rağmen, bu hesap makinesi yalnızca üçüncü seviyeye kadarını görüntüleyecektir.
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•　Aşağıdakiler, dosya adlarında ve klasör adlarında kullanılabilecek tek baytlı karakterlerdir.
A-Z, a-z, 0-9, !, #, $, %, ,(virgül), (, ), +, –, ., ;, =, @, [, ], ^, _, `, boşluk
Dosya adlarının ve uzantılarının büyük/küçük harfe duyarlı olmadığını unutmayın.

Depolama Belleği Sekmesi (Storage Memory Tab Operations) İşlemleri

Bir g4m dosyasını Ana Bellek'e yüklemek için
Aşağıdaki işlemi kullanarak g4m dosyalarını* Ana Bellek'e yükleyebilirsiniz.
*　Ana Bellek sekmesi işlemleriyle oluşturulan yedek dosyalar veya Ana Bellek sekmesi işlemleriyle bireysel 

olarak kaydedilen dosyalar. 

Önemli!
•　Aşağıdaki prosedürün 2. adımında aşağıdaki veri öğelerinin kopyaları bulunursa, mevcut verilerin 

üzerine yazmak isteyip istemediğinizi soran bir onay mesajı görünecektir. 
DYNA MEM, LIST n, LISTFILE n, MAT n, VCT n, Elektronik tablo uygulaması verileri, DBASE 
grubundaki veriler, GEOM grubundaki veriler

Aşağıdaki veri öğelerinin üzerine her zaman bir onay mesajı görüntülenmeden yazılır.
ALPHA MEM, CONICS, DIST, EQUATION, FINANCE, NUMINEQ (yalnızca fx-CG100), RECURSION, 
SETUP, STAT, SYSTEM, S-SHEET (_SETTING), TABLE, Y=DATA, 3DGRAPH, PROBSIM

Veri içerikleri hakkında detaylar için “Ana Bellek Sekmesinde Görüntülenen Veriler” (sayfa 194) 
bölümüne bakın.

1.　Ana Bellek'e yüklemek istediğiniz g4m dosyasını vurgulayın. .

Not
•　Aşağıda açıklanan durumlarda, 2. adımda T   > [Load] seçeneğini belirlediğinizde yükleme işlemi 

başlamaz.
-　Pil gücü düşükken (Low Battery error) (Düşük Pil hatası)
-　Ana Bellek'te yeterli boş alan yokken (Memory Full error) (Bellek Dolu hatası)
-　Ana Bellek'te çok fazla veri öğesi varken (Too Much Data error) (Çok Fazla Veri hatası)
-　g4m dosyası olmayan bir dosya seçildiğinde (Invalid Type error) (Geçersiz Tür hatası)

Bir klasör oluşturmak için
1.　Bir klasör oluşturmak istediğiniz konumu (kök dizinde (root directory) veya klasörde) görüntüleyin.

•　Klasörleri en fazla üç seviye iç içe yerleştirebilirsiniz.

2.　T   > [Folder] > [Make Folder] (Klasör > Klasör Oluştur)'u seçin.

3.　Görünen iletişim kutusunu kullanarak klasör adı için en fazla sekiz karakter girin ve ardından O  'a basın. 

Bir klasörü yeniden adlandırmak için
1.　Yeniden adlandırmak istediğiniz klasörü vurgulayın.

2.　T   > [Folder] > [Rename Folder] (Klasör > Klasörü Yeniden Adlandır)'ı seçin.

3.　Görünen iletişim kutusunu kullanarak klasör adı için en fazla sekiz karakter girin ve ardından O  'a basın.

2.　T   > [Yükle]'yi seçin. 
•　Bu, yükleme işlemini başlatır. Yükleme sırasında, sağdaki gibi bir 

onay mesajı görünebilir. Daha fazla bilgi için, yukarıdaki “Önemli!” 
bölümüne bakın. Üzerine yazmak için [OK]’u seçin. İşlemi iptal 
etmek için [Cancel] (İptal)'i seçin.

•　Yükleme işlemi tamamlandığında, ekranda “Complete!” (Tamamlandı!)
mesajı görünür.
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Bir dosya hakkında detaylı bilgi görüntülemek için
1.　Detaylarını görüntülemek istediğiniz dosyayı vurgulayın.

2.　T   > [Detail] (Detay) seçeneğini seçin. 
•　Bu, detaylı bilgi ekranını görüntüler.
•　Bir g4p veya g3p dosyasıyla, r   'a basarak görüntüleri önizleyebilirsiniz.
•　Detaylı bilgi ekranı (veya görüntü önizleme ekranı) görüntülenirken u   veya d    'ya basmak, Depolama 

Belleği sekmesindeki dosyaların sıralandığı dizideki bir sonraki dosyanın detaylı bilgi ekranına (veya görüntü 
önizleme ekranına) yukarı veya aşağı kaydırma yapacaktır.

Bir dosya veya klasörü silmek için
1.　Silmek istediğiniz dosyayı veya klasörü vurgulayın.

2.　T   > [Delete] (Sil) seçeneğini seçin.
•　Bu, bir silme onay mesajının görünmesine neden olur.

3.　Silmek için [OK]'u seçin. İşlemi iptal etmek için [Cancel] (İptal)'i seçin.
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System (Sistem) Uygulaması
Hesap makinesini sıfırlamak veya genel hesap makinesi çalışmasını etkileyen ayarları değiştirmek için Sistem 
uygulamasını kullanın.

System Manager (Sistem Yöneticisi) Menüsü

Sistem Yöneticisi Menü Öğeleri

Hesap Makinesini Sıfırlama (Reset)
1.　Sistem Yöneticisi menüsünden [Reset] (Sıfırla)'yı seçin.

2.　erçekleştirmek istediğiniz sıfırlama işlemi türü için menü öğesini seçin.

Bunu sıfırlamak/silmek için: Bu menü öğesini seçin:
Ana Bellek KURULUM (sayfa 194) içeriği
Aşağıda listelenen Sistem uygulaması ayarları:

CSV Formatı
[Settings] (Ayarlar)

Tüm Ana Bellek verileri
Ana Bellek KURULUM (sayfa 194) içeriği

[Main Memory] (Ana Bellek)

Tüm Depolama Belleği verileri [Storage Memory] (Depolama Belleği)

Tüm Ana Bellek ve Depolama Belleği verileri
Ana Bellek KURULUM (sayfa 194) içeriği

[Main&Storage] 
(Ana&Depolama)

Tüm Ana Bellek ve Depolama Belleği verileri
Ana Bellek KURULUM (sayfa 194) içeriği
Aşağıda listelenen Sistem uygulaması ayarları:
Display Settings (Ekran Ayarları), Auto Power Off (Otomatik Kapanma), 
Battery Settings (Pil Ayarları), CSV Formatı, Capture Formatı

[Initialize All] (Tümünü Başlat)

•　Bir menü öğesi seçmek, seçtiğiniz sıfırlama türü için bir onay mesajının görünmesine neden olur.

3.　Sıfırlamak için [OK]'u seçin. İşlemi iptal etmek için [Cancel] (İptal)'i seçin.

Önemli!
•　[Initialize All] (Tümünü Başlat)'ı seçtikten sonra, hesap makinesini ilk kez açtığınızda yapacağınız gibi 

birkaç başlangıç kurulum işlemi gerçekleştirmeniz gerekir. Kurulum ekranları otomatik olarak aşağıdaki 
sırayla görünür. Her ekrandaki ayarları yapılandırın.
-　Display language selection (Görüntüleme dili seçimi) (sayfa 200) 
-　Country Setting (Ülke Ayarı) (yalnızca fx-CG100) (sayfa 200)
-　Display brightness adjustment (Ekran parlaklığı ayarı) (sayfa 200)
-　Auto power off and backlight duration settings (Otomatik kapanma ve arka ışık süresi ayarları) (sayfa 200)
-　Battery type selection (Pil türü seçimi) (sayfa 201)

Uygulamayı başlatmak için h   > System'ı seçtikten sonra, ilk olarak 
Sistem Yöneticisi menüsü görünür. Bu bölümde açıklanan tüm işlemler 
bu menüden başlar.
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Sürüm Bilgilerini Görüntüleme (Version)
Sistem Yöneticisi menüsünden [Version] (Sürüm)'ı seçtiğinizde görünen Sürüm bilgileri ekranında hesap 
makinesinin işletim sistemi sürümünü görüntüleyebilirsiniz.

Not
•
　Sürüm bilgileri ekranı görüntülenirken, T   tuşuna basmak [OS Update] (İS Güncellemesi) menü öğesini 
görüntüleyecektir.

Görüntüleme Dili Seçme (Language)
1.　Sistem Yöneticisi menüsünden [Language] (Dil)'i seçin.

•　Bu, şu anda seçili olan dili görüntüler.

2.　O  'a basın.

3.　Görünen menüden, istediğiniz görüntüleme dilini seçin.

Ülke Ayarını Değiştirme (Ülke) (Country) (yalnızca fx-CG100)
Ülke ayarı için mevcut dört seçenek aşağıda gösterilmiştir. Varsayılan ayar “International” (Uluslararası)'dır.

•　International (Uluslararası)
•　Portugal (Portekiz)

•　United Kingdom (Birleşik Krallık)
•　United States (Amerika Birleşik Devletleri)

 
Ülke ayarı, bu hesap makinesini aşağıda açıklandığı gibi etkiler.
•　HOME (ANA) ekranı uygulama simgelerinin düzeni 
•　Catalog (Katalog) menüsü yapılandırması ve içeriği

-　Kategorilerin menüde göründüğü görüntüleme sırası
-　Her kategoriye dahil edilen öğeler ve göründükleri sıra (Tüm kategorisi hariç)

•　Exam (Sınav) Modu uygulamasıyla seçilebilen Sınav Modları ve menüde göründükleri sıra.

Not
•　Bu hesap makinesini belirli ülkelerde kullanmak için gerektiği gibi Ülke ayarını değiştirin. Aksi takdirde, 

varsayılan ayarı (Uluslararası) kullanın.

Ülke ayarını değiştirmek için aşağıdaki işlemi kullanın.

1.　Sistem Yöneticisi menüsünden [Country] (Ülke)'yi seçin.
•　Bu, şu anda seçili olan Ülke ayarını görüntüler.

2.　O  ’a basın.
•　Bu, Ülke ayarı seçeneklerinin bir menüsünü görüntüler.

3.　İstediğiniz seçeneği vurgulayın ve ardından O  'a basın.

Ekran Parlaklığını Ayarlama (Ekran Ayarları) (Display Settings)
1.　Sistem Yöneticisi menüsünden [Display Settings] (Ekran Ayarları)'nı seçin.

2.　Ekran parlaklığını ayarlamak için l    ve r    'ı kullanın.

Otomatik Kapanma ve Arka Işık Süresi Ayarlarını Yapılandırma (Güç Özellikleri) (Power Properties)

1.　Sistem Yöneticisi menüsünden [Power Properties] (Güç Özellikleri)'ni seçin.

2.　İstediğiniz ayarı yapılandırmak için aşağıdaki işlemlerden birini gerçekleştirin.

Bu ayarı yapılandırmak için:   Bu işlemi gerçekleştirin:
Auto Power Off duration 
(Otomatik Kapanma süresi)

(1)　 [Auto Power Off]'u vurgulayın ve ardından O  'a basın.
(2)　  Görünen menüden, yaklaşık 10 dakikayı belirtmek için [10 Min.]'i 

(10 Dak.) veya yaklaşık 60 dakikayı belirtmek için [60 Min.]'i (60 
Dak.) seçin.
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Backlight illumination duration
(Arka ışık aydınlatma süresi)

(1)　 [Backlight] (Arka Işık)'ı vurgulayın ve ardından O  'a basın. 
(2)　 Görünen menüden, [30 Sec.] (30 Sn.), [1 Min.] (1 Dak.) veya [3 Min.] 

(3 Dak.)'i seçin.

Pil Türünü Belirtme (Pil Ayarları) (Battery Settings)

Önemli!
•　Pilleri değiştirdikten sonra, yeni pillerin pil türünü seçmek için aşağıdaki işlemi mutlaka gerçekleştirin.

1.　Sistem Yöneticisi menüsünden [Battery Settings] (Pil Ayarları)'nı seçin.

2.　O  'a basın.

3.　Görünen menüden, [Alkaline batteries] (Alkalin piller) veya [Ni-MH]'i seçin.
•　Ekranda görünen uyarı mesajını okuyun.

4.　Seçilen pil türünü kaydetmek için [OK]'i seçin. İşlemi iptal etmek için [Cancel] (İptal)'i seçin.

CSV Dosyası İçe ve Dışa Aktarma Formatını Belirtme (CSV Formatı)
Bir bilgisayardan hesap makinesine aktarılan bir CSV dosyasını içe aktarırken, ayırıcı sembolü ve ondalık 
noktayı, CSV dosyasını dışa aktarırken uygulamada belirttiğiniz ayarlara göre belirtin. Ayırıcı için virgül 
(comma) ( , ) veya noktalı virgül (semi-colon) ( ; ), ondalık nokta için ise nokta (period) ( . ) veya virgül ( , ) 
belirtilebilir.

1.　Sistem Yöneticisi menüsünden [CSV Format]'ı seçin. 

2.　Vurguyu [Separator] (Ayırıcı)'ya taşımak için u   ve d   'yı kullanın ve ardından O  'a basın.

3.　Görünen menüden, [Comma] (Virgül) veya [Semi-Colon] (Noktalı Virgül)'i seçin ve ardından O  'a basın.

4.　Vurguyu [Decimal Separator] (Ondalık Ayırıcı)'ya taşımak için u   ve d   'yı kullanın ve ardından O  'a basın.

5.　Görünen menüden, [Period] (Nokta) veya [Comma] (Virgül)'i seçin ve ardından O  'a basın.
•　 Yukarıdaki 2. adımda [Comma] (Virgül)'ü seçtiyseniz, burada [Comma] (Virgül)'ü seçemezsiniz.

Görüntü Yakalama Formatını Belirtme (Capture Formatı)
Ekran yakalama (sayfa 13) kullanılarak kaydedilen bir görüntünün formatını belirtmek için aşağıdaki prosedürü 
kullanın. 
1.　Sistem Yöneticisi menüsünden [Capture Format] (Yakalama Formatı)'nı seçin.

•　Bu, şu anda seçili olan görüntü formatını görüntüler.

2.　O  'a basın.

3.　Görünen menüden, [Memory] (.g4p formatında kaydetmek için) veya [Bitmap] (.bmp formatında kaydetmek 
için)'i seçin.

Kullanıcı Adı Kaydetme (User Name)
Hesap makinenize bir kullanıcı adı ve kuruluş adı kaydedebilirsiniz. Kayıtlı kullanıcı adı ve kuruluş adı, hesap 
makinesini kapattığınızda ekranda görüntülenir.

1.　Sistem Yöneticisi menüsünden [User Name] (Kullanıcı Adı)'nı seçin. 

2.　“User Name” (Kullanıcı Adı) altındaki satırı vurgulayın. 

3.　Kullanıcı adı için en fazla 19 karakter girin ve ardından O  'a basın.

4.　“Organization” (Kuruluş) altındaki satırı vurgulayın.

5.　Kuruluş adı için en fazla 19 karakter girin ve ardından O  'a basın.

•　Bu, şu anda seçili olan pil türünü görüntüler.
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Not
•　Bu ekrandaki tüm girişleri silmek için T   > [Delete All] (Tümünü Sil)'i seçin.
•　Kullanıcı adınızı ve kuruluş adınızı kaydettiğiniz ekranın alt kısmındaki “ID”, cihazın kimlik numarasını 

gösterir.
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Exam (Sınav) Modu Uygulaması (fx-CG100 için)
Sınav Modu, hesap makinesi fonksiyonlarına bazı sınırlar getirerek bir sınav veya test sırasında kullanılmasına 
olanak tanır. Sınav Moduna yalnızca gerçekten bir sınava veya teste girdiğinizde girin.
Hesap makinenizin dört* farklı Sınav Modu vardır.
•　IB (International Baccalaureate) (Uluslararası Bakalorya)
•　Portugal (Portekiz)
•　United Kingdom (Birleşik Krallık)
•　Texas (USA) (Teksas (ABD))

*　Sistem uygulaması için “International” (Uluslararası) (varsayılan ayar) seçiliyken dört Sınav Modu arasından 
seçim yapabilirsiniz. Ülke için farklı bir ayar seçerseniz, yalnızca o ülkeye özgü olan Sınav Modu ve IB 
seçilebilir.

Exam (Sınav) Modundayken Kısıtlamalar
Sınav Moduna girmek, hesap makinesi çalışmasını aşağıda açıklandığı gibi etkiler.
•　Bazı uygulamalar ve fonksiyonlar devre dışı bırakılır. Daha fazla bilgi için, aşağıdaki işlemi 

gerçekleştirdiğinizde görünen yardıma başvurun.

(2)　 Kısıtlamalarını görüntülemek istediğiniz Sınav Modunu seçin ve ardından O  'a basın.

(1)　 Sınav Modu Yöneticisi menüsünde, [Exam Mode Help] > [Apps & 
Functions] (Sınav Modu Yardımı > Uygulamalar ve Fonksiyonlar)'ı seçin.
•　Bu, Sınav Modu türünü seçmek için bir menü görüntüler.

•　Sınav Moduna girdiğinizde, hesap makinesi kullanıcı verilerini (ana bellek) yedekler. Yedeklenen veriler, 
mevcut Sınav Modundan çıktığınızda geri yüklenecektir. Sınav Modundayken oluşturduğunuz veriler, moddan 
çıktığınızda silinir.

•　Aşağıdaki bilgiler Python uygulaması işlemleri için geçerlidir.
-　Bir py dosya adı için en fazla beş karakter girebilirsiniz.
-　Bir py dosya adı için tek baytlı sayısal ve alfabetik karakterleri (yalnızca küçük harf) kullanabilirsiniz.
-　py dosyaları, hesap makinesinin ana belleğinde depolanır.
-　Ana bellek kapasitesi düşük olduğunda “Memory ERROR” (Bellek HATASI) mesajı görünür. Bu durumda, 

mevcut boş alanı artırmak için gereksiz dosyaları silin.
•　Sınav Moduna girmeden önce yalnızca aşağıdaki ayarlar kaydedilir.

Angle, Complex Mode, Display, Fraction Result,  π Result, Key, Show Option Numbers, FORMAT
Key, pinned input history, Q1Q3 Type, Language, Country, Battery Settings
Ancak, bazıları Sınav Modundayken aşağıda gösterildiği gibi değişmeye zorlanır.
-　Sistem uygulaması Otomatik Kapanma ayarı: Her zaman “60 Min.” (60 Dak.)
-　Sistem uygulaması Kullanıcı Adı (User name) ve Kuruluş (Organization) girişleri: Her zaman boş
Yukarıdaki her iki öğe de Sınav Modundan çıktığınızda önceki ayarlarına geri yüklenir.

Önemli!
•　Sınav Modunu kullanmadan önce pilleri yeni bir set ile değiştirmeniz önerilir. .

 

Bu menüyü, Sınav Modlarından herhangi birine girmek veya başka bir 
hesap makinesinin Sınav Modunun kilidini açmak için kullanabilirsiniz.
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•　Sınav Modundayken, hesap makinesinde yaklaşık 30 saniye boyunca herhangi bir işlem yapmazsanız, 
arka ışık parlaklık seviyesi otomatik olarak en koyu ayara değişecektir. Sınav Modunda arka ışığın 
kapanmayacağını, bu nedenle pil gücünün daha hızlı tükeneceğini unutmayın. Sınav Modunu kullanmayı 
bitirdikten sonra mümkün olan en kısa sürede çıkın.

Exam (Sınav) Moduna Girme 
1.　h  > Exam Mode

•　

2.　[Enter Exam Mode] (Sınav Moduna Gir)'i vurgulayın ve ardından O  'a basın. 

3.　Görünen menüden, girmek istediğiniz Sınav Modunu seçin.

.4.　O  'a basın.
•　Bu, hesap makinesinde “Enter Exam Mode?” (Sınav Moduna Girilsin mi?) iletişim kutusunu görüntüler.

5.　O  'a basın.

Exam (Sınav) Modu Hesap Makinesi İşlemleri
•　Sınav Modu ekranları, ekranın etrafındaki bir sınır ve sağ üst köşedeki yanıp sönen bir simge ile tanımlanır. 

Sınırın rengi ve simgenin türü Sınav Moduna bağlıdır. .

Sınav Modu Sınır Rengi Simge
IB Yeşil
Portekiz Mavi
Birleşik Krallık Macenta
Teksas (ABD) Camgöbeği

Sınav Moduna girdikten yaklaşık 15 dakika sonra simgenin yanıp sönme aralığı yavaşlar.
•　Sınav Modunda, Otomatik Kapanma ( Auto Power Off ) tetikleme ayarı yaklaşık 60 dakikaya sabitlenir.  
•　Sınav Modu Yöneticisi menüsünden [Elapsed Time] (Geçen Süre)'yi seçmek, aşağıda gösterilen iletişim 

kutusunun görünmesine neden olur.
İletişim kutusu, Sınav Modundaki geçen süreyi gösterir.

Aşağıdaki işlemlerden birini gerçekleştirerek geçen süre sayacını yeniden başlatabilirsiniz.
-　RESTART düğmesine basın.
-　Hesap makinesinin pillerini çıkarın.
-　Ana Bellek verilerini silin.
-　Zaten bir Sınav Modundaysanız, tekrar girin.*

*　Zaten bir Sınav Modundaysanız, diğer Sınav Moduna giremezsiniz. Diğer Sınav Moduna geçmek için, 
mevcut Sınav Modundan çıkın ve ardından diğerine girin.

•　Aşağıdaki tablo, belirli işlemlerin Sınav Modunu nasıl etkilediğini göstermektedir.

•　Bu prosedürün 3. adımında IB dışında herhangi bir Sınav Modu 
seçerseniz, bu sırada bir uyarı iletişim kutusu görünecektir. İşleme 
devam etmek ve 3. adımda seçtiğiniz Sınav Moduna girmek için 
[OK]'u seçin. Bir IB sınavına girecekseniz, 3. adıma geri dönmek 
için [Cancel] (İptal)'i seçin ve ardından IB'yi seçin.

•　Yaklaşık üç saniye boyunca “Entering Exam Mode.” (Sınav Moduna 
Giriliyor.) mesajı görüntülendikten sonra, hesap makinesi yukarıdaki 
3. adımda seçtiğiniz Sınav Moduna girer ve Sınav Modu Yöneticisi 
menüsünü görüntüler.
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Bunu yaparsanız: Hesap makinesi Sınav 
Modunda kalır.

Sınav Moduna girilen veriler 
korunur.

Gücü kapatıp tekrar açma Evet Evet
RESTART düğmesine basma Evet Hayır
Hesap makinesinin pillerini çıkarma Evet Hayır
Ana Bellek verilerini silme Evet Hayır

Mevcut Olduğunuz Sınav Moduna Tekrar Girme (Re-entering the Exam Mode)
Şu anda bir Sınav Modunda olsanız bile, bu Sınav Moduna tekrar girebilirsiniz. Bu işlem, mevcut Sınav 
Modundayken girdiğiniz tüm verileri ve yapılandırdığınız ayarları atar ve onları, Sınav Moduna ilk girdiğiniz 
zamanki hallerine geri döndürür.*
*　 Yalnızca Sistem uygulamasındaki Pil Ayarları korunur.

1.　Sınav Modundayken, [Re-Enter Exam Mode] (Sınav Moduna Tekrar Gir)'i vurgulayın ve ardından O  'a basın.
•　Bu, hesap makinesinde “Re-Enter Exam Mode?” (Sınav Moduna Tekrar Girilsin mi?) iletişim kutusunu 

görüntüler.

2.　O  'a basın.
•　“Re-Entering Exam Mode.” (Sınav Moduna Tekrar Giriliyor.) mesajı yaklaşık üç saniye boyunca 

görüntülendikten sonra, hesap makinesi otomatik olarak yeniden başlar ve Sınav Moduna tekrar girer.

Sınav Modundan Çıkma
Sınav Modundan çıkmanın üç yolu vardır.

(1) Bilgisayara Bağlanarak Sınav Modundan Çıkma

1.　Sınav Modunda olan hesap makinesini bir USB kablosu   kullanarak bir bilgisayara bağlayın.*1

•　Bu, hesap makinesinde “Select Connection Mode” (Bağlantı Modu Seç) iletişim kutusunu görüntüler.

2.　[USB Flash / Unlock Exam Mode] (USB Flash / Sınav Modu Kilidini Aç)'ı vurgulayın ve ardından O  'a basın.
•　Hesap makinesi ekranında “Preparing USB” (USB hazırlanıyor) mesajı görünecektir. Bekleyin ve hesap 

makinesinde herhangi bir işlem yapmayın.

3.　Bilgisayarda, hesap makinesi sürücüsünü (calculator drive) açın.

4.　 Bilgisayarda, hesap makinesi sürücüsünde bulunan herhangi bir dosyayı kopyalayın veya silin.

5.　Bilgisayarda, hesap makinesi ile bilgisayar arasındaki bağlantıyı sonlandırın.

•　Bir bağlantıyı sonlandırmak, hesap makinesinin otomatik olarak yeniden başlamasına neden olur. Bu, 
hesap makinesinin Sınav Modundan çıkmasına ve Sınav Moduna girilmeden önceki durumuna dönmesine 
neden olur.

*1　Orijinal bir CASIO USB kablosu kullanılması önerilir. Piyasada bulunan bir USB kablosu kullanmayı 
düşünüyorsanız, veri aktarabilen bir kablo kullandığınızdan emin olun.

(2) 12 Saatin Dolmasını Bekleyerek Sınav Modundan Çıkma
Sınav Moduna girdikten yaklaşık 12 saat sonra, hesap makinesini açmak, Sınav Modundan otomatik olarak 
çıkmasına neden olacaktır.

Önemli!
•　Hesap makinesini açmadan önce RESTART düğmesine basarsanız veya pilleri değiştirirseniz, 12 saat 

dolmuş olsa bile açıldığında Sınav Moduna tekrar girecektir.

(3) Başka Bir Hesap Makinesine Bağlanarak Sınav Modundan Çıkma
1.　Sınav Modunda olan hesap makinesinde (Calculator A), Sınav Modu Yöneticisi menüsünü görüntüleyin.

•　Hesap makinesi ile bilgisayar arasında bir bağlantı kurulduğunda, 
sağda gösterilen ekran görünür.
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2.　2.5mm'lik bir fiş kablosu   kullanarak Sınav Modunda olan Calculator A'yı Sınav Modunda olmayan 
başka bir hesap makinesine (Calculator B) bağlayın.

*2

3.　Calculator A'da, [Unlocked Exam Mode]'u (Sınav Modu Kilidini Aç) vurgulayın ve ardından O  'a basın.

4.　Calculator B'de, h   > Exam Mode'u seçin, [Unlock Exam Mode]’u vurgulayın ve ardından O  'a basın.
•　Calculator B'de “Complete!” (Tamamlandı!) mesajı göründüğünde, Calculator A otomatik olarak

yeniden başlar. Calculator A Sınav Modundan çıkar ve Calculator A'daki veriler Sınav Moduna 
girilmeden önceki durumuna döner.

*2　İsteğe bağlı olarak sunulan SB-2000 paketine dahildir (USB kablosu ve 2.5mm'lik fiş kablosu).

Not
•　Hesap makinenizi, Sınav Modu olan başka bir hesap makinesi modeline de bağlayabilir ve kendi hesap 

makinenizin Sınav Modunun kilidini diğer modelden açabilir veya diğer modelin Sınav Modunun kilidini 
kendi hesap makinenizden açabilirsiniz.
Diğer modelde gerekli işlemle ilgili detaylar için, aşağıdaki bilgilere bakın.
-　Sınav Modu Yöneticisi menüsünün [Exam Mode Help] > [How to Exit] (Sınav Modu Yardımı > 

Nasıl Çıkılır) kısmı
-
　
Diğer hesap makinesi modelinin kullanım kılavuzu
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Exam (Sınav) Modu Uygulaması (fx-1AU GRAPH için)
Sınav Modu, hesap makinesi fonksiyonlarına bazı sınırlar getirerek bir sınav veya test sırasında kullanılmasına 
olanak tanır. Sınav Moduna yalnızca gerçekten bir sınava veya teste girdiğinizde girin.

Sınav Modundayken Kısıtlamalar
Sınav Moduna girmek, hesap makinesi çalışmasını aşağıda açıklandığı gibi etkiler.
•　Bazı uygulamalar ve fonksiyonlar devre dışı bırakılır. Detaylar için, Sınav Modu Yöneticisi menüsünde [Exam 

Mode Help] > [Apps & Functions] (Sınav Modu Yardımı > Uygulamalar ve Fonksiyonlar)'a bakın.
•　Hesap makinesi, Sınav Moduna girdiğinizde kullanıcı verilerini (ana bellek) yedekler. Yedeklenen veriler, 

Sınav Modundan çıktığınızda geri yüklenir. Sınav Modundayken oluşturduğunuz veriler ise moddan çıktığınızda 
silinir. 

•　Sınav Moduna girmeden önce yalnızca aşağıdaki ayarlar kaydedilir.
Angle, Complex Mode, Display, Fraction Result,  π Result, Key, Show Option Numbers, FORMAT
Key, pinned input history, Q1Q3 Type, Language, Battery Settings
Ancak, bazıları Sınav Modundayken aşağıda gösterildiği gibi değişmeye zorlanır.
-　Sistem uygulaması Otomatik Kapanma (Auto Power Off) ayarı: Her zaman “60 Min.” (60 Dak.)
-　Sistem uygulaması Kullanıcı Adı (User Name) ve Kuruluş (Organization): Her zaman boş
Yukarıdaki her iki öğe de Sınav Modundan çıktığınızda önceki ayarlarına geri yüklenir.

Önemli!
•　Sınav Modunu kullanmadan önce pilleri yeni bir set ile değiştirmeniz önerilir.
•　Sınav Modunda, hesap makinesinde yaklaşık 30 saniye boyunca herhangi bir işlem yapmazsanız arka 

ışık parlaklık seviyesi otomatik olarak en koyu ayara değişecektir. Sınav Modunda arka ışığın 
kapanmayacağını, bu nedenle pil gücünün daha hızlı tükeneceğini unutmayın. Sınav Modunu 
kullanmayı bitirdikten sonra mümkün olan en kısa sürede çıkın.

Sınav Moduna Girme
1.　h  > Exam Mode

•　Bu, Exam Mode Manager (Sınav Modu Yöneticisi) menüsünü görüntüler.

2.　[Enter Exam Mode] (Sınav Moduna Gir)'i vurgulayın ve ardından O  'a basın.
•　Bu, hesap makinesinde “Enter Exam Mode?” (Sınav Moduna Girilsin mi?) iletişim kutusunu görüntüler.

3.　O  'a basın.

Sınav Modu Hesap Makinesi İşlemleri
•　Sınav Moduna girmek, tüm ekranın etrafının yeşil bir sınırla çevrelenmesine neden olur. Ekranda ayrıca yanıp 

sönen bir simge (   ) de görünecektir. Sınav Moduna girdikten yaklaşık 15 dakika sonra simgenin yanıp sönme 
hızı yavaşlar.

Bu menüyü, Sınav Modu'na girmek veya başka bir hesap makinesinin 
Sınav Modu kilidini açmak için kullanabilirsiniz.

•　Yaklaşık üç saniye boyunca “Entering Exam Mode.” (Sınav 
Moduna Giriliyor.) mesajı görüntülendikten sonra, hesap 
makinesi Sınav Moduna girer ve Sınav Modu Yöneticisi menüsünü 
görüntüler.
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•　Sınav Modunda, Otomatik Kapanma tetikleme ayarı yaklaşık 60 dakika olarak sabittir.
•　Sınav Modu Yöneticisi menüsünde [Elapsed Time] (Geçen Süre)'yi seçmek, geçen süreyi gösteren bir iletişim 

kutusunun görünmesine neden olur. 

Geçen süre sayacını aşağıdaki işlemlerden biriyle yeniden başlatabilirsiniz.
-　RESTART düğmesine basma.
-　Hesap makinesinin pillerini çıkarma.
-　Ana Bellek verilerini silme.
-　Sınav Modunda zaten bulunuyorsanız, tekrar girme.

•　TAşağıdaki tablo, belirli işlemlerin Sınav Modunu nasıl etkilediğini gösterir:.

Bunu yaparsanız: Hesap makinesi Sınav 
Modunda kalır.

Sınav Moduna girilen veriler 
korunur.

Gücü kapatıp tekrar açma Evet Evet
RESTART düğmesine basma Evet Hayır
Hesap makinesinin pillerini çıkarma Evet Hayır
Ana Bellek verilerini silme Evet Hayır

Sınav Moduna Tekrar Girme
Sınav Modundayken bile, moda tekrar girebilirsiniz. Bu işlem, mevcut Sınav Modundayken girdiğiniz verileri 
ve yapılandırdığınız ayarları atar ve onları, moda ilk girdiğiniz zamanki hallerine geri döndürür. 

 

*　Sistemin Pil (Battery) Ayarları dışındaki tüm ayarlar sıfırlanır.

1.　Sınav Modundayken, [Re-Enter Exam Mode] (Sınav Moduna Tekrar Gir)'i vurgulayın ve O  'a basın.
•　Bu, hesap makinesinde “Re-Enter Exam Mode?” (Sınav Moduna Tekrar Girilsin mi?) iletişim kutusunu 

görüntüler.

2.　O  'a basın.
•　Yaklaşık üç saniye boyunca “Re-Entering Exam Mode.” (Sınav Moduna Tekrar Giriliyor.) mesajı 

görüntülendikten sonra, hesap makinesi otomatik olarak yeniden başlar ve Sınav Moduna tekrar girer.

Sınav Modundan Çıkma
Sınav Modundan çıkmanın üç yolu vardır.

(1) Bilgisayara Bağlanarak Sınav Modundan Çıkma

1.　Sınav Modunda olan hesap makinesini bir USB kablosu   kullanarak bir bilgisayara bağlayın.*1

•　Bu, hesap makinesinde “Select Connection Mode” (Bağlantı Modu Seç) iletişim kutusunu görüntüler.

2.　[USB Flash / Unlock Exam Mode] (USB Flash / Sınav Modu Kilidini Aç)'ı vurgulayın ve O  'a basın.
•　“Preparing USB” (USB hazırlanıyor) mesajı ekranda görünecektir. Bekleyin ve herhangi bir işlem 

yapmayın.

3.　Bilgisayarda, hesap makinesi sürücüsünü (calculator drive) açın.

4.　Bilgisayarda, hesap makinesi sürücüsünde bulunan herhangi bir dosyayı kopyalayın veya silin.

5.　Bilgisayarda, hesap makinesi ile bilgisayar arasındaki bağlantıyı sonlandırın.
•　Bağlantıyı sonlandırmak, hesap makinesinin otomatik olarak yeniden başlamasına neden olur. Bu, hesap

makinesinin Sınav Modundan çıkmasına ve moda girmeden önceki durumuna dönmesine yol açar.
*1　Orijinal bir CASIO USB kablosu kullanılması önerilir. Piyasada bulunan bir USB kablosu kullanmayı 

düşünüyorsanız, veri aktarabilen bir kablo kullandığınızdan emin olun.

•　Hesap makinesi ile bilgisayar arasında bir bağlantı kurulduğunda, 
sağda gösterilen ekran görünür.
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(2) 12 Saatin Dolmasını Bekleyerek Sınav Modundan Çıkma
Sınav Moduna girdikten yaklaşık 12 saat sonra, hesap makinesini açtığınızda Sınav Modu'ndan otomatik 
olarak çıkacaktır.

Önemli!
•　Hesap makinesini açmadan önce RESTART düğmesine basar veya pilleri değiştirirseniz, 12 saat 

geçmiş olsa bile açıldığında Sınav Modu'na tekrar girecektir.

(3) Başka Bir Hesap Makinesine Bağlanarak Sınav Modundan Çıkma
1.　Sınav Modunda olan hesap makinesinde (Calculator A), Sınav Modu Yöneticisi menüsünü görüntüleyin.

2.　2.5mm'lik bir fiş kablosu   kullanarak Calculator A'yı Sınav Modunda olmayan başka bir hesap
 makinesine (Calculator B) bağlayın.

*2

3.　Calculator A'da, [Unlocked Exam Mode]'u vurgulayın ve ardından O  'a basın.

4.　Calculator B'de, h   > Exam Mode'u seçin, [Unlock Exam Mode]'u vurgulayın ve ardından O  'a basın.
•　Calculator B'de “Complete!” (Tamamlandı!) mesajı göründüğünde, Calculator A otomatik 

olarak yeniden başlar. Calculator A Sınav Modu'ndan çıkar ve Calculator A'daki veriler moda 
girilmeden önceki durumuna geri döner.

*2　 İsteğe bağlı olarak sunulan SB-2000 paketine dahildir (USB kablosu ve 2.5mm'lik fiş kablosu).

Not
•　Kendi hesap makinenizin Sınav Modu kilidini, Sınav Modu olan başka bir hesap makinesi 

modelinden açabileceğiniz gibi, diğer modelin kilidini de kendi hesap makinenizden açabilirsiniz.
Diğer modelde gerekli işlemle ilgili detaylar için, aşağıdaki bilgilere bakın.
-
　
Sınav Modu Yöneticisi menüsünün [Exam Mode Help] > [How to Exit] (Sınav Modu Yardımı 
> Nasıl Çıkılır) kısmı

-　Diğer hesap makinesi modelinin kullanım kılavuzu

209



Diğer Bilgiler

Hesap Makinesini Bilgisayara Bağlama
Hesap makinenizi bir bilgisayara bağlayarak aralarında veri aktarımı yapabilir veya hesap makinesinin işletim 
sistemini güncelleyebilirsiniz

Önemli!
•　Veri iletişimi devam ederken USB kablosunun fişlerine ve hesap makinesinin ekranına asla 

dokunmayın.

Bilgisayara Bağlantı Kurma ve Bağlantıyı Kesme

Hesap Makinesi ile Bilgisayar Arasında Bağlantı Kurma
Bağlantı için orijinal bir CASIO USB kablosu kullanılması önerilir. Piyasada bulunan bir USB kablosu 
kullanacaksanız, veri aktarımı yapabildiğinden emin olun.

1.　USB kablosunu kullanarak bilgisayarınızı hesap makinesine bağlayın.
•　Bu, hesap makinesinde “Select Connection Mode” (Bağlantı Modu Seç) iletişim kutusunu görüntüler.

2.　[USB Flash]'ı vurgulayın ve ardından O  'a basın.
•　Hesap makinesi ekranında “Preparing USB” (USB hazırlanıyor) mesajı görünecektir. Bekleyin ve hesap 

makinesinde herhangi bir işlem yapmayın.

3.　Bilgisayarda hesap makinesi sürücüsünü açın.
•　Bilgisayarınızın ayarlarına bağlı olarak, hesap makinesi ile bilgisayar arasında bir bağlantı kurulduğunda 

otomatik olarak bir hesap makinesi sürücü penceresi açılabilir. Bu pencere, hesap makinesi belleğinde 
depolanan dosya ve klasörleri gösterir.

•　Hesap Makinesi Penceresi otomatik olarak açılmazsa, bilgisayarınızın işletim sistemine karşılık gelen 
aşağıdaki talimatları izleyin.
Windows: Dosya Gezgini'ni kullanarak “PC” altında bulunan hesap makinesi sürücüsünü açın. İşletim 
                  sistemi sürümüne bağlı olarak “PC”'nin adı farklı olabilir. 
macOS: Masaüstündeki Hesap Makinesi Sürücüsü simgesine çift tıklayarak hesap makinesi sürücü 
                  penceresini açın.

4.　Hesap Makinesi Sürücüsü penceresini kullanarak dosya ve klasörleri gerektiği gibi yönetin.
•　Dosya ve klasörleri kopyalayabilir ve silebilirsiniz. Bu işlemler için normalde bilgisayarınızda kullandığınız 

işlemleri kullanın.
•　Hesap Makinesi Sürücüsü penceresinde görüntülenen dosya ve klasörler hakkında bilgi için “Hesap 

Makinesi Sürücüsü İçeriği” (sayfa 211) bölümüne bakın..

Önemli!
•　Hesap makinesi sürücüsünü bir bilgisayardan formatlamayın. Bu işlem, hesap makinesi belleğindeki 

tüm verileri siler. Hesap makinesi ile bilgisayar arasındaki USB bağlantısı kesilirse, hesap makinesi 
ekranında “File System ERROR” (Dosya Sistemi HATASI) mesajı görünecektir. Ne yapmanız gerektiği 
hakkında daha fazla bilgi için “Hata Mesajı Tablosu” (sayfa 247) bölümüne bakın.

•　Hesap makinesi ile bilgisayar arasında bir bağlantı kurulduğunda, 
sağda gösterilen ekran belirir. Aynı anda, hesap makinenizin 
depolama belleği bilgisayarda bir USB sürücüsü olarak takılır. 
Burada, bu USB sürücüsüne “hesap makinesi sürücüsü” 
(calculator drive) olarak atıfta bulunulmaktadır.
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5.　İşlemleriniz bittikten sonra hesap makinesi ile bilgisayar arasındaki bağlantıyı sonlandırın.
•　"Hesap Makinesi ile Bilgisayar Arasındaki Bağlantıyı Sonlandırma" (sayfa 213) bölümüne bakın.

.
Not
•
　
USB kablosunu, ekranın durum çubuğunda      simgesi görünürken ya da bir grafik, geometri uygulaması 
şekli veya başka bir şekil ekranda yanıp sönerken hesap makinesine bağlarsanız, “Select Connection 
Mode” (Bağlantı Modu Seç) iletişim kutusu görünmez.      simgenin kaybolmasını bekleyin veya 
grafiğin yanıp sönmesini durdurmak için gerekli işlemi yapın ve ardından USB kablosunu tekrar 
bağlamayı deneyin.

•　Hesap makinesini bilgisayara bağlamaya çalışırken “Storage Memory Full” (Depolama Belleği Dolu) 
mesajı görünürse, bu durum hesap makinesinin depolama belleğinde yeterli boş alan olmadığı 
anlamına gelir. Böyle bir durumda, belleği boşaltmak için artık ihtiyacınız olmayan depolama belleği 
dosyalarını silin ve tekrar bağlanmayı deneyin.

•　Bir dosyayı bilgisayarınızın yerel diskinden hesap makinesi sürücüsüne kopyalarken, kopyalamanın 
başlaması birkaç dakika sürebilir. Bunun nedeni, kopyalama işleminin hesap makinesinin depolama 
belleğini otomatik olarak optimize etmesidir. Bu bir arıza belirtisi değildir.

•　Bilgisayarın güç koruma moduna, uyku moduna veya başka bir bekleme durumuna girmesi halinde 
hesap makinesi ile bilgisayar arasındaki USB bağlantısı otomatik olarak sonlandırılabilir.

İşletim Sistemi (OS) Güncellemesi
Hesap makinesinin işletim sistemini güncellemek için bir bilgisayar kullanırken, Select Connection Mode 
(Bağlantı Modu Seç) iletişim kutusunda [OS Update] (İşletim Sistemi Güncellemesi)'i seçin.* Detaylar için, 
yeni bir işletim sistemi sürümü yayınlandığında çıkan metinlere bakın.
*　"Hesap Makinesi ile Bilgisayar Arasında Bağlantı Kurma" (sayfa 210) bölümündeki 1. adıma bakın.

Hesap Makinesi Sürücüsü (Calculator Drive) İçeriği
Hesap makineniz, verileri depolamak için bir ana belleğe ve bir depolama belleğine sahiptir. Her bellek 
alanının içeriğini görüntülemek için Memory (Bellek) uygulamasını (sayfa 194) kullanabilirsiniz.
 Hesap makinesinin depolama belleği içeriğini bir bilgisayar ekranında görüntülemek için de hesap makinesi 
sürücüsünü kullanabilirsiniz. Hesap makinesi sürücüsünün ana dizini, aşağıda açıklanan dosya ve klasörleri 
gösterir.
•　@MainMem folder ... Bu klasör, hesap makinesi ana belleğindeki verileri içerir. “@MainMem klasör içeriği” 

(sayfa 211) bölümüne bakın. Bu klasörün içeriği, hesap makinesi USB aracılığıyla bir bilgisayara her 
bağlandığında ana bellekten depolama belleğine kopyalanır.*

•　Capt folder ...  Bu klasör, bir ekran görüntüsü yakaladığınızda (sayfa 13) yakalanan görüntüyü kaydetmek için
otomatik olarak oluşturulur. BMP formatında kaydedilen yakalanan görüntüler bir bilgisayar ekranında 
görüntülenebilir.

•　module.py ... Bu dosya, Python uygulamasını (sayfa 119) başlattığınızda otomatik olarak oluşturulur..
•　Diğer ... Hesap makinesi verileri (.g4m dosya uzantısı), py dosyaları, csv dosyaları vb. içeren diğer dosyalar 

da görüntülenir. Detaylar için “Depolama Belleği Sekmesinde Görüntülenen Dosyalar” (sayfa 196) bölümüne 
bakın
*　Bu kopyalama işlemini gerçekleştirmek için yeterli depolama belleği alanı yoksa, USB ile bağlandığınızda 

“Storage Memory Full” (Depolama Belleği Dolu) mesajı görünür ve kopyalama işlemi gerçekleştirilmez. 
Böyle bir durumda, belleği boşaltmak için artık ihtiyacınız olmayan depolama belleği dosyalarını silin ve
tekrar bağlanmayı deneyin.

@MainMem Klasör İçeriği
Aşağıdaki dosyaların tümü, hesap makinesinin ana belleğindeki verilere karşılık gelir. Veri içeriğiyle ilgili 
detaylar için “Ana Bellek Sekmesinde Görüntülenen Veriler” (sayfa 194) bölümüne bakın..
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Klasör adı Dosya adı*

@3DGRAPH 3DGRAPH.g4m
@GEOM @IMAGE.g4m

<Data name>.g4m
@DBASE Adopted.g4m, Atomic.g4m, Electoro.g4m, Periodic.g4m, Physico.g4m,

Univers.g4m, User.g4m
@PROBSIM PROBSIM.g4m
LISTFILE FILEx.g4m (LISTFILE x), LISTxx.g4m, LISTANS.g4m (LIST ANS)
MAT_VCT MATx.g4m, MATANS.g4m (MAT ANS), VCTx.g4m, VCTANS.g4m (VCT ANS)
SSHEET _SETTINGS.g4m, SHEET.g4m, <Data name>.g4m
ROOT ALPHAMEM.g4m (ALPHA MEM)

CONICS.g4m
DIST.g4m
DYNAMEM.g4m (DYNA MEM)
EQUATION.g4m
FINANCE.g4m
NUMINEQ.g4m (fx-CG100 only)
RECUR.g4m (RECURSION)
SETUP.g4m
STAT.g4m
SYSTEM.g4m
TABLE.g4m
Y=DATA.g4m

*　Dosya adı uzantıları, hesap makinesinin Bellek uygulamasının Ana Bellek sekmesinde görüntülenmez. 
Adları parantez içinde olan dosyalar için, Ana Bellek sekmesi parantez içindeki adı gösterir.

USB Bağlantısı Kesildiğinde Ana Bellek Verilerinin Güncellenmesi
Hesap makinesi ile bilgisayar arasında bir USB bağlantısı varken, bilgisayarı kullanarak @MainMem klasör 
içeriğini klasör ve dosya silme, dosya ekleme vb. yollarla düzenleyebilirsiniz. USB bağlantısını sonlandırdığınızda, 
hesap makinesinin ana bellek verileri, @MainMem klasörünün mevcut içeriğiyle güncellenir. Aşağıdaki önemli 
noktalara dikkat edin.
•　@MainMem klasörünü silmek, hesap makinesinin ana belleğindeki tüm verilerin başlatılmasına neden olur.
•　@MainMem klasörünü güncellemek, depolama belleği kök klasörünün içindeki en fazla üç klasör düzeyini etkiler.

SMEM ← Storage memory root folder (Depolama belleği kök klasörü)

@MainMem (Level 1)

Folder (Level 2)

Folder (Level 3) ← Updating affects files up to this. 
                               (Güncelleme, dosyaları buraya kadar etkiler.) 

3. level’den sonraki tüm klasörler ve dosyalar, depolama belleğindeki “SAVE-F” adlı bir klasöre taşınır.
•　Hesap makinesi ile bilgisayar arasında bir USB bağlantısı varken @MainMem klasörüne bir g4m dosyası 

eklemek, g4m dosyasında bulunan veri öğelerinin hesap makinesinin ana belleğine kopyalanmasını sağlar. 
@MainMem klasöründeki g4m dosya adlarına karşılık gelen ana bellek veri öğesi adlarıyla ilgili detaylar için 
“@MainMem klasör içeriği” (sayfa 211) bölümüne bakın. g4m dosyasında bulunan veri öğelerine karşılık 
gelen bir klasör ana bellekte yoksa, ilgili bir klasör otomatik olarak oluşturulur ve veri öğeleri bu klasöre 
kopyalanır.
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•　Veri türüne bağlı olarak, @MainMem klasöründen kopyalanan verilerle hesap makinesinin ana belleğinde 
aynı ada sahip veriler zaten varsa, üzerine yazma onay mesajı görünecektir. Hangi veri türlerinin bir onay 
mesajının görünmesine neden olduğu hakkında bilgi için “g4m dosyasını Ana Belleğe yüklemek için” (sayfa 
197) bölümündeki “Önemli!” başlığına bakın.

•　Hesap makinesi tarafından desteklenmeyen bir dosya veya klasörü @MainMem klasörüne yerleştirirseniz, 
bu dosya hesap makinesinin depolama belleğindeki “SAVE-F” adlı bir klasöre aktarılır ve ana bellekte 
gösterilmez.

•　@MainMem klasöründeki verilerin boyutu ana belleğin mevcut kapasitesini aşarsa, USB bağlantısını 
sonlandırdığınızda hesap makinesinde “Memory ERROR” (Bellek HATASI) mesajı görünecek ve ana bellek 
güncellenmeyecektir.

Hesap Makinesi ile Bilgisayar Arasındaki Bağlantıyı Sonlandırma

Önemli!
•　Aşağıdaki 4. adımda işlemi tamamladığınızda Sistem Yöneticisi menüsü görünene kadar hesap 

makinesini bilgisayara bağlayan USB kablosunu asla çıkarmayın.

1.　Hesap makinesi bir Windows bilgisayarına bağlıysa, hesap makinesi sürücüsüne atanan sürücü harfini 
(E, F, G, vb.) not alın.

2.　Bilgisayarınızın işletim sistemine bağlı olarak, aşağıdaki işlemlerden birini gerçekleştirin.
Windows: Ekranın sağ alt köşesindeki görev çubuğunda bulunan “Donanımı Güvenle Kaldır” simgesine 
                  tıklayın. Görünen menüden, yukarıdaki 1. adımda not aldığınız hesap makinesi sürücü harfiyle 
                  eşleşen sürücüyü seçin. “Donanım Güvenle Kaldırılabilir” (Safe To Remove Hardware) mesajının 
                  görüntülendiğinden emin olun.
macOS: Hesap makinesi sürücüsü simgesini Çıkar (Eject) simgesine (Çöp Kutusu simgesi) sürükleyin.  
                  Hesap makinesi sürücüsü simgesinin artık masaüstünüzde olmadığından emin olun.

3.　Hesap makinesinde “Updating Main Memory” (Ana Bellek Güncelleniyor) mesajı görüntülenirken bekleyin ve 
herhangi bir işlem yapmayın.

4.　Hesap makinesi ekranında “Complete!” (Tamamlandı!) mesajı göründüğünde, O  'a basın.
•　Bu, System (Sistem) uygulamasının Sistem Yöneticisi (System Manager) menüsünü görüntüler.
•　Bu aşamada hesap makinesini bilgisayara bağlayan USB kablosunu çıkarabilirsiniz.
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Settings (Ayarlar) Menüsü Detayları

Ayarlar Menüsü ve Alt Menüleri
Ayarlar menüsünde görünen öğelerin sayısı, yapılandırdığınız uygulamaya bağlıdır. Aşağıda açıklandığı gibi 
birkaç farklı öğe türü vardır.

Öğe Türü Açıklama
General Bu öğeler çoğu uygulama için ortaktır.
Graph Bu öğeler Graph&Table uygulaması için görüntülenir. Bu öğelerin bazıları ayrıca 

Recursion, 3D Graph, Dyna Graph, Conic Graphs, Statistics, Distribution, Financial 
ve Geometry uygulamalarında da görünür.

Statistics Bu öğeler Statistics (İstatistik) uygulaması için görünür.
Spreadsheet Bu öğeler Spreadsheet (Elektronik Tablo) uygulaması için görünür.
Financial Bu öğeler Financial (Finans) uygulaması için görünür.
Prob Sim Bu öğeler Prob Sim (Olasılık Simülasyonu) uygulaması için görünür.
Dyna Graph Bu öğeler Dyna Graph (Dyna Grafik) uygulaması için görünür.
3D Graph Bu öğeler 3D Graph (3D Grafik) uygulaması için görünür.
Geometry Bu öğeler Geometry (Geometri) uygulaması için görünür.
Specific Bu öğeler belirli uygulamalar için görünür.

Aşağıdaki bölümlerde, her öğenin türü, öğe adından sonra parantez içinde gösterilmiştir. Aşağıdaki 
bölümlerdeki elmas işareti (  ) her öğenin ilk varsayılan ayarını belirtir.◆

Otomatik Yeniden Hesaplama (Spreadsheet) (Elektronik Tablo) 
Spreadsheet uygulamasının her veri girildiğinde otomatik yeniden hesaplama yapıp yapmayacağını seçer.

 On (Açık)◆ Formüller, her veri girildiğinde otomatik olarak yeniden hesaplanır.

 Off (Kapalı) Formüller, veri girildiğinde yeniden hesaplanmaz.

Edit Box (Düzenleme Kutusu) Gösterimi (Spreadsheet) (Elektronik Tablo) 
İmleç, bir formül içeren hücredeyken Elektronik Tablo uygulamasının düzenleme kutusunun ne göstereceğini belirtir. 

Formula (Formül)◆ Hücre içeriğini bir formül olarak görüntüler.

Value (Değer) Hücre içeriğini bir değer olarak görüntüler.

Cursor Moves (İmleç Hareketi) (Spreadsheet) (Elektronik Tablo) 
Veri girildikten veya bir ElektronikTablo uygulaması hücresine yapıştırıldıktan sonra imlecin hareket edeceği yönü belirtir.

Down (Aşağı)◆ Bir hücre aşağıya doğru hareket eder.

Right (Sağ) Bir hücre sağa doğru hareket eder.

Payment Point (Ödeme Noktası) (Financial) (Finans)
Bu ayar, Finans uygulaması Bileşik Faiz ve Amortisman hesaplamalarını etkiler.

Beginning (Başlangıç) Dönemin başlangıcını ödeme tarihi olarak belirtir.

End (Bitiş)◆ Dönemin sonunu ödeme tarihi olarak belirtir.

Number of Days/Year (Yıldaki Gün Sayısı) (Financial) (Finans)
Bu ayar, Finans uygulaması Basit Faiz, Gün Hesaplama ve Tahvil Hesaplamalarını etkiler.

365◆ Hesaplamalar için yıldaki gün sayısını 365 olarak belirtir.

360 Hesaplamalar için yıldaki gün sayısını 360 olarak belirtir.

214



Interest Paid (Ödenen Faiz) (Finans)
Bu ayar Finans uygulaması Tahvil Hesaplaması (Bond Calculation)'nı etkiler.

Annually◆ Yıllık faiz ödeme aralığını belirtir.

Semi-annually Yarı yıllık faiz ödeme aralığını belirtir.

Maximum Scale (Maksimum Ölçek) (Prob Sim)
Prob Sim uygulamasının Sonuç sekmesindeki dikey eksenin maksimum değerinin grafikte gösterilip 
gösterilmeyeceğini belirtir.

 On Maksimum değeri gösterir.

 Off◆ Maksimum değeri gizler.

Animation (Animasyon) (Prob Sim)
Prob Sim uygulamasında bir simülasyon gerçekleştirildiğinde, sonuçlardan önce bir animasyonun gösterilip 
gösterilmeyeceğini belirtir.

 On◆ Sonuçları görüntülemeden önce bir animasyon oynatır.

 Off Animasyon olmadan yalnızca sonuçları görüntüler.

Looping (Döngü) (Dyna Graph) (Dinamik Grafik) 
Dinamik Grafik uygulamasıyla grafik çizerken, uygulamanın belirtilen sayıda yinelemeden sonra otomatik 
olarak Kurulum sekmesine dönüp dönmeyeceğini veya çizmeye devam edip etmeyeceğini belirtir.

 On a   tuşuna basana kadar çizim devam eder. 

 Off◆ Katsayı değerinin 10 kez artırılıp azaltılmasından sonra ekran otomatik olarak 
Kurulum sekmesine döner. 

Locus (Dyna Graph) (Dinamik Grafik)
Dinamik Grafik uygulamasıyla çizilen tüm grafiklerin lokuslarının gösterilip gösterilmeyeceğini belirtir.

 On Locileri gösterir.

 Off◆ Locileri gizler.

Processing Speed (İşlem Hızı) (Dyna Graph) (Dinamik Grafik)
Dinamik Grafik uygulamasının tüm x ekseni noktalarını mı yoksa her bir diğer noktayı mı çizeceğini belirtir. 
Bu ayar yalnızca y= türü fonksiyonlar grafiklenirken etkindir.

High Her bir diğer x ekseni noktasını çizer. Bu, Normal hıza göre daha hızlı grafik çizimi sağlar.

Normal◆ Tüm x ekseni noktalarını çizer. 

Angle (Açı ) (Genel)
Giriş ve çıkış için açı birimini seçer.
Degree, Radian◆, Gradian  (Derece, Radyan, Gradyan)*

*　Geometry (Geometri) uygulamasında “Gradian” seçeneği yoktur.

Table with Graph (Grafikli Tablo) (Grafik)

 On Tablo sekmesinde hem sayısal tabloyu hem de grafiği görüntüler.

 Off◆ Tablo sekmesinde yalnızca sayısal tabloyu görüntüler.

Show V-Win Settings (V-Pencere Ayarlarını Göster) (Grafik)

 On◆ Bir grafik çizme işlemi başlatıldığında Görünüm Penceresi iletişim kutusunun 
görünmesine neden olur.*
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 Off Bir grafik çizme işlemi başlatıldığında Görünüm Penceresi iletişim kutusu görünmez. 
Bunun yerine, mevcut Görünüm Penceresi ayarları uygulanır.

*

*　Bir grafik çizme işlemi, Graph&Table uygulamasının Fonksiyon sekmesinde >   tuşuna bastığınızda başlar, 
vb.

3D Axes (3D Eksenler) (3D Grafik)
3D Grafik uygulamasının grafik penceresinde Kartezyen koordinat eksenlerini gösterip göstermeyeceğini belirtir.

 On◆ Kartezyen koordinat eksenlerini gösterir.

 Off Kartezyen koordinat eksenlerini gizler.

Box (Kutu) (3D Grafik)
3D Grafik uygulamasının grafik penceresinde kutulu eksenleri gösterip göstermeyeceğini belirtir.

 On◆ Kutulu eksenleri gösterir.

 Off Kutulu eksenleri gizler.

3D Label (3D Etiket) (3D Grafik)
3D Grafik uygulamasının grafik penceresinde eksen etiketlerini gösterip göstermeyeceğini belirtir.

 On◆ Eksen etiketlerini gösterir.

 Off Eksen etiketlerini gizler.

View Window (Görünüm Penceresi) (İstatistik)

Auto◆ Görünüm Penceresi ayarları, çizdiğiniz grafik türüne göre otomatik olarak ayarlanır.

Manual  Görünüm Penceresi ayarları, çizdiğiniz grafik türüne bakılmaksızın normalde uygula-
nır. Ancak, bir pasta grafiği veya hipotez testi grafiği durumunda, hesap makinesi her 
zaman otomatik olarak oluşturulan Görünüm Penceresi ayarlarını kullanır.

Q1Q3 Type (Türü) (İstatistik)
Birinci ve üçüncü çeyrekleri (Q1 ve Q3) nasıl hesaplayacağınızı seçmek için bu ayarı kullanın.

Standard◆ Bu yöntemle, veri seti medyan (%50'lik dilim veya Q2) noktasında ikiye ayrılır ve daha 
sonra üst ve alt veri setleri, sırasıyla Q1 (%25'lik dilim) ve Q3 (%75'lik dilim) 
belirlemek için ikiye ayrılır.

OnData Veriden belirlenen %25'lik kümülatif frekans yüzdesi a ve %75'lik yüzdesi b 
olduğunda, bu yöntem, Q1 olarak a'ya en yakın ve üzerindeki veri değerini ve Q3 
olarak b'ye en yakın ve üzerindeki veri değerini döndürür.

Sub Name (Alt Ad) (İstatistik)

 On◆ Liste Düzenleyicisinin SUB (alt ad) satırını gösterir.

 Off Liste Düzenleyicisinin SUB (alt ad) satırını gizler.

List File (Liste Dosyası) (İstatistik)
Altı dosyadan herhangi biri (File1  'den File6'ya kadar) “Liste Dosyaları” (sayfa 32) olarak seçilebilir.◆

Coord (Koordinat) (Grafik)
Bu, grafik analizi ve izleme fonksiyonlarını kullanırken, izleme işaretçisi bir grafikte görüntülendiğinde ne 
olacağını kontrol eden bir görüntü ayarıdır.

 On◆ Mevcut izleme işaretçisi konumunun koordinatlarını gösterir.
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 Off Mevcut izleme işaretçisi konumunun koordinatlarını gizler.

Angle Unit (Açı Birimi) (Geometri)
Geometri uygulaması çizim ekranındaki bir şekil için açıları görüntülerken birimleri dahil edip etmeyeceğini belirtir.

 On◆ Açıları birimleriyle birlikte görüntüler.

 Off Açıları birimsiz görüntüler.

Length Unit (Uzunluk Birimi) (Geometri)
Geometri uygulaması çizim ekranındaki bir şekil için uzunlukları görüntülerken birimleri dahil edip etmeyeceğini belirtir. 

mm, cm, m, km, in,
ft, yd, mile

 Uzunlukları birimleriyle birlikte görüntüler.

Off◆ Uzunlukları birimsiz görüntüler.

Grid (Izgara) (Grafik)
Grafik alanındaki ızgara noktalarını veya ızgara çizgilerini göstermek veya gizlemek için bu ayarı kullanın.

On  Izgara noktalarını gösterir.

Off* Izgara noktalarını ve çizgilerini gizler.

Line◆ Izgara çizgilerini gösterir.

*　Geometri uygulaması için ilk varsayılan ayar “Off”'tur. 

Grid Space (Izgara Boşluğu) (Geometri)
Geometri uygulaması çizim ekranındaki ızgara noktalarının ve çizgilerinin aralığını (boşluğunu) belirtir.
0.01'den 1  'e kadar (varsayılan değer) 1000'e kadar 0.01'lik artışlarla bir değer belirtebilirsiniz.◆

Axes (Eksenler) (Grafik)
Grafik alanındaki koordinat eksenlerini (x ekseni ve y ekseni) göstermek veya gizlemek için bu ayarı kullanın.

On Koordinat eksenlerini gösterir.

Off* Koordinat eksenlerini gizler.

Scale◆ Her bir eksende bir ölçekle birlikte koordinat eksenlerini gösterir.

*　Geometri uygulaması için ilk varsayılan ayar “Off”'tur.

Label (Etiket) (Grafik)

 On◆ x ekseni, y ekseni ve başlangıç (0) etiketlerini gösterir.

 Off Etiketleri gizler.

Show Equation (Denklemi Göster) (Grafik)
Bu, grafik analizi ve izleme fonksiyonlarını kullanırken, izleme işaretçisi bir grafikte görüntülendiğinde ne 
olacağını kontrol eden bir görüntü ayarıdır.

 On◆ İzleme işaretçisinin şu anda bulunduğu grafiğin denklemini gösterir.

 Off İzleme işaretçisinin şu anda bulunduğu grafiğin denklemini gizler.

Graph Simultaneously (Eş Zamanlı Grafik Çizimi) (Grafik)
Birden fazla grafik çizerken grafik çizme yöntemini belirtir.

 On Tüm grafikler aynı anda çizilir.

 Off◆ Grafikler tek tek çizilir.
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Plot/Line Color (Nokta/Çizgi Rengi) (Grafik)
İzleme ve çizim (sketch) ile çizilen noktaların ve çizgilerin rengini belirtir.
Black, Blue, Red, Magenta, Green◆, Cyan, Yellow (Siyah, Mavi, Kırmızı, Macenta, Yeşil , Camgöbeği, Sarı)

Sketch Line (Çizim Çizgisi) (Grafik)
Çizim (sketch) ile çizilen çizgi tipini belirtir.
Normal◆, Thick, Broken, Dot, Thin (Normal  , Kalın, Kesikli, Noktalı, İnce)

Draw Type (Çizim Tipi) (Grafik)

Connect◆ Grafiği sürekli bir çizgi kullanarak çizer.

Plot Grafiği bireysel noktalar çizerek oluşturur.

Complex Mode (Karmaşık Mod) (Genel)
Bu ayar, gerçek ve sanal sayıların hesaplama aralıklarını ve karmaşık sayıların görüntüleme formatını 
belirtir.

Real◆
Gerçek sayıların aralığını hesaplar.
Çözümü sanal olan gerçek sayılarla argümanı olan bir fonksiyon terimi bile 
içeriyorsa bir hata görüntülenir. Ancak, “Real” seçiliyken bir karmaşık sayı argüman 
olarak belirtilirse, karmaşık sayı hesaplaması yapılır. Karmaşık sayı içeren bir 
hesaplamanın sonucu karmaşık bir sayı ise, a+bi şeklinde görüntülenir.

a+bi Gerçek ve sanal sayıların aralığını hesaplar. Karmaşık sayı hesaplamasının sonucu 
dikdörtgen (rectangular) formda görüntülenir.

r∠θ Gerçek ve sanal sayıların aralığını hesaplar. Karmaşık sayı hesaplamasının sonucu 
polar formda görüntülenir.

Display (Görüntüleme) (Genel)
Bu ayar, hesaplama sonuçlarının görüntüleme formatını (basamak sayısı) belirtir. Ayrıca, hesaplama 
sonuçlarına eklenen mühendislik sembollerini de belirtir.

Fix0: 0. - Fix9:
0.123456789

Hesaplama sonuçları için ondalık basamak sayısını (0'dan 9'a) belirtir. Hesaplama 
sonuçları, belirtilen basamağı takip eden bir sonraki basamağa yuvarlanır.

Sci1: 1×10-1 - Sci10:
1.234567890×10-1

Hesaplama sonuçlarının anlamlı basamak sayısını (1'den 10'a) ve üssünü belirtir. 
Hesaplama sonuçları, belirtilen basamağı takip eden bir sonraki basamağa yuvarlanır.

Norm1: 1.23×10-3◆,
Norm2: 0.00123

Hesaplama sonuçlarını, aşağıda belirtilen aralıklarda olduklarında üstel formda görüntüler.

Norm1: 1.23×10-3： |x| < 10-2, 1010 ≤ |x|
Norm2: 0.00123： |x| < 10-9, 1010 ≤ |x|

Engineer (Mühendislik) Sembolü

 On Hesaplama sonuçlarını mühendislik sembolleri* kullanarak görüntüler.

 Off◆ Hesaplama sonuçlarını mühendislik sembolleri olmadan görüntüler.

*　m, μ, n, p, f, k, M, G, T, P, E

Fraction (Kesir) Sonucu (Genel)
◆ Kesir hesaplamasının sonucunu bileşik kesir olarak görüntüler.

Bir kesir hesaplamasının sonucunu tam sayılı kesir olarak görüntüler.
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 π Result (Sonuç) (Özel)
Bu ayar, Calculate, Num Ineq (yalnızca fx-CG100) ve Equation uygulamalarının     ve/veya π içeren sonuçları 
görüntüleyip görüntülemediğini belirtir.

, 

 On◆ Mümkün olduğunda hesaplama sonuçlarını     ve/veya π içeren bir biçimde görüntüler.

 Off Hesaplama sonuçlarını,      ve/veya π içeren bir biçimde görüntülemek mümkün olsa 
bile ondalık biçimde görüntüler. 

Background (Arka Plan) (Grafik)
Bu ayar, grafik penceresi için bir arka plan resmi seçer.

None◆ Arka plan resmi görüntülenmez.

Open Bu öğeyi seçmek, bir arka plan resmi seçmek için kullanabileceğiniz bir iletişim kutusu 
görüntüler. Arka plan olarak kullanılabilecek resimler hakkında bilgi için “Depolama 
Belleği Sekmesini Kullanma” (sayfa 196) bölümüne bakın..

Key (Tuş) (Genel)
Bu ayar, k    tuşunun işlevini belirtir. k    tuşunun işleyişine bir örnek için “Bilimsel Fonksiyon Hesaplamaları” 
(sayfa 19) bölümüne bakın.

 

 (Power) k    tuşuna basmak, ^10                 tuşuna basmakla aynı giriş sonucunu verir.

 (Sci Notation) k    tuşuna basmak,       fonksiyonunu girer. Bu fonksiyon,           (n bir tam sayıdır) 
şeklinde öncesinde ve sonrasında argümanlar alır ve       'nin a ile çarpımının 
sonucunu döndürür.

a n

10n

 (Sci Notation)◆ k    tuşuna basmak,        fonksiyonunu girer. Bu fonksiyon, öncesine ve sonrasına 
        (n bir tam sayıdır) şeklinde argümanlar alır ve       'in a ile çarpımının sonucunu 
döndürür.
a n 10n

ΣDisplay (Görüntüleme) (Özel)
Bu ayar, Recursion uygulamasının Tablo sekmesindeki bir kümülatif toplamlar sütununu gösterir veya gizler.

 On Tablo sekmesinde kümülatif toplam sütununu gösterir.

 Off◆ Tablo sekmesinde kümülatif toplam sütununu gizler.

Ineq Region Type (Eşitsizlik Bölge Tipi) (Grafik)
Bu ayar, birden fazla eşitsizlik grafiğinin nasıl renklendirileceğini belirtir.

Intersection Yalnızca grafiklenen tüm eşitsizliklerin koşullarının karşılandığı alanları renklendirir.

Union◆ Grafiklenen her bir eşitsizliğin koşullarının karşılandığı tüm alanları renklendirir.

Derivative (Türev) (Grafik)
Bu ayar, Graph&Table uygulamasının Tablo sekmesinde bir diferansiyel katsayı sütununu gösterir veya gizler. 
Bu ayar ayrıca, Graph&Table uygulaması veya Conic Graphs uygulaması Grafik sekmesindeki izleme 
işaretçisi konumundaki diferansiyel katsayıların görüntülenip görüntülenmeyeceğini de etkiler.

 On Tablo sekmesinde bir diferansiyel katsayı sütunu gösterir. Bu ayar seçildiğinde, 
Grafik sekmesindeki izleme işaretçisi konumundaki diferansiyel katsayılar da 
görüntülenir.*

 Off◆ Hem Tablo sekmesindeki hem de Grafik sekmesindeki diferansiyel katsayıları gizler.

*　İzleme işaretçisi konumundaki diferansiyel katsayıların görüntülenmesi yalnızca      > [Coord] ayarı açıkken
etkinleştirilir.

Simplify (Sadeleştir) (Özel)
Bu ayar, Calculate uygulaması tarafından hesaplama sonuçları olarak üretilen kesirlerin sadeleştirilip 
sadeleştirilmeyeceğini belirtir.
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Auto◆ Kesirli hesaplama sonuçlarını otomatik olarak sadeleştirir.

Manual Kesirli hesaplama sonuçlarını sadeleştirmeden görüntüler.*
*　 Kesirli sonuçlar başlangıçta sadeleştirilmeden görüntülenir, ancak daha sonra onları sadeleştirebilirsiniz. 

"Sadeleştirme" (sayfa 223) bölümüne bakın..

Show Option Numbers (Seçenek Numaralarını Göster) (Genel)
Bu ayar, menülerde ve iletişim kutularında Seçenek Numaralarının (menü öğelerinin solundaki sayılar ve 
harfler) gösterilip gösterilmeyeceğini belirtir. Seçenek Numaraları hakkında detaylar için "Menü ve İletişim 
Kutusu İşlemleri (Seçenek Numaralarını Kullanma)" (sayfa 11) bölümüne bakın.

 On◆ Seçenek Numaralarını gösterir.

 Off Seçenek Numaralarını gizler.

FORMAT Key (Tuşu) (Genel)
F   tuşuna basıldığında ne olacağını, aşağıda açıklanan iki işlem arasında değiştirebilirsiniz.

 Decimal◆
(Toggle)

 F   tuşuna her basıldığında, görüntülenen hesaplama sonucunu kesir/π/     ve ondalık 
biçim arasında değiştirir. Format Menüsünü (sayfa 17) görüntülemek için sF      basın. 

Format Menu
(Menu)

F    tuşuna basmak Format Menüsünü (sayfa 17) görüntüler. sF      'ye her basıldığın-
da, görüntülenen hesaplama sonucunu kesir/π/     ve ondalık biçim arasında değiştirir.
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Catalog (Katalog) Menüsü Detayları
C   tuşuna bastığınızda görünen Katalog menüsü, hesap makinesinde bulunan tüm fonksiyonların, komutların, 
uygulama değişkenlerinin* ve sembollerin kapsamlı bir listesidir. Hesap makinesinde istediğiniz öğeyi 
seçebilir ve bir hesaplamaya veya ifadeye girebilirsiniz.

 

C    > [All] (Tümü) ile oluşturulan liste, hesap makinenizin desteklediği tüm öğeleri içerir. Alfabetik liste 
görüntülenirken, bastığınız harfle başlayan öğelerin bir listesini görüntülemek için XA 'dan 0Z  'ye kadar bir 
tuşa basabilirsiniz.

[A]'dan [Z]'ye kadar olan bir gruba dahil olmayan fonksiyonlara ve sembollere C   > [All] > [Symbol] (Sembol) 
ile erişilebilir.
*　C   > [Variable Data] (Değişken Veri) içinde yer alan öğeler (bir uygulamada kullanılan giriş/çıkış değişkenleri)

Not
•　Python uygulaması veya Base-N uygulaması kullanılırken C   tuşuna basmak, her uygulamaya özgü bir 

Katalog menüsü görüntüler. Detaylar için, her uygulamayı açıklayan bölümlere bakın.
•　

Giriş Geçmişini Kullanma
Katalog menüsünden son zamanlarda girilen en son 10 fonksiyon ve komut*, giriş geçmişi olarak tutulur. Giriş 
geçmişini görüntülemek için C   > [History (Pin     )] (Geçmiş (Sabitleme ))'i seçin.
*　Sabitlenmiş giriş geçmişi dahil.

Giriş Geçmişini Sabitleme
Giriş geçmişini görüntülerken, sabitlemek istediğiniz öğeyi seçin ve ardından T   tuşuna basın. Bu, öğenin 
solunda bir sabitleme sembolünün görünmesine neden olur.
Giriş geçmişini bir sonraki açışınızda, sabitlenmiş öğe listenin en üstünde olacaktır.

Bir öğenin sabitlemesini kaldırmak için, sabitlemesini kaldırmak istediğiniz öğeyi seçin ve T   tuşuna basın.
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Katalog menüsü, menülerdeki fonksiyonların ve komutların adlarını kategoriye göre (örneğin, 
İntegrasyon (∫) vb.) görüntüler.       > [All] ve Giriş Geçmişi menülerinde, fonksiyonlar ve komutlar satır 
içi giriş sözdiziminde (örneğin, ∫(,,) vb.) görüntülenir.



Kategoriye Göre Gruplandırılmış Öğe Listesi
Birim Dönüştürme (Unit Conversions) kategorisindekiler hariç, fonksiyonların ve komutların sözdizimi hakkında
aşağıdaki noktalara dikkat edin.
•　Bir fonksiyon için doğal giriş sözdizimi ve satır içi giriş sözdizimi farklıysa, önce doğal giriş sözdizimi, ardından 

satır içi giriş sözdizimi gösterilir.
•　Bir sözdiziminde isteğe bağlı olan her şey köşeli parantez içinde [ ] gösterilir.                        sözdiziminde, 

tol argümanı atlanabilir, bu da
∫( f (x),a,b[,tol])

∫( f (x),a,b) sonucunu verir.

Not
•　Bu bölümde listelenen kategoriler ve her kategoriye dahil olan fonksiyonlar, komutlar, uygulama 

değişkenleri* ve semboller, System (Sistem) uygulamasında [Country] > [International] seçildiğinde 
göründükleri sırayla sunulur.

•　Modelden (fx-CG100 veya fx-1AU GRAPH) veya yapılandırmadan bağımsız olarak, C   > [All] (Tümü) 
içindeki öğeler aynıdır. Bu kılavuzda listelenen tüm öğeler alfabetik sırayla görüntülenir. 

*　C   > [Variable Data] (Değişken Veri) içinde yer alan öğeler (bir uygulamada kullanılan giriş/çıkış değişkenleri)

Fonksiyon Analizi

1st Derivative (1. Türev) (d/dx)      d/dx(,)
x = a noktasındaki f(x)'in birinci dereceden diferansiyel katsayısını belirlemek için yaklaşık hesaplama kullanır. 

Sözdizimi: : ddx ( f (x))|x a  d dx( f (x),a)

Bu sözdiziminde izin verilmeyenler: d dx, d2 dx2, ∫dx, , FMin, FMax, Solve, RndFix

Örnek: d
dx ( f (x3 4x2 x − 6))|x 3 52

Önlemler
•　f(x) bir trigonometrik fonksiyonsa, açı birimi için S    > [Angle] > [Radian]'ı seçtiğinizden emin 

olun.
•　Aşağıdakilerden herhangi biri yanlış sonuçlara ve hatalara neden olabilir:

-　x değerlerinde süreksiz noktalar
-　x değerlerinde aşırı değişiklikler
-　x değerlerinde yerel maksimum ve yerel minimum noktalarının dahil edilmesi
-　x değerlerinde büküm noktalarının dahil edilmesi
-　x değerlerinde diferansiyeli alınamayan noktaların dahil edilmesi 
-　Sıfıra yaklaşan hesaplama sonuçları

2nd Derivative (2. Türev) (d 2 /dx2)      d2/dx2(,)
x = a noktasındaki f(x)'in ikinci dereceden diferansiyel katsayısını belirlemek için yaklaşık hesaplama kullanır..

Sözdizimi: d2

dx2 ( f (x))|x a  d2 dx2( f (x),a)

Bu sözdiziminde izin verilmeyenler ve alınacak önlemler d/dx ile aynıdır. 

Integration (İntegrasyon) (∫)      ∫(,,)
a ≤ x ≤ b aralığındaki f(x)'in integralini belirlemek için yaklaşık hesaplama kullanır. Bu fonksiyon, f(x) pozitif 
aralıkta olduğunda pozitif bir değer, f(x) negatif aralıkta olduğunda ise negatif bir değer döndürür. (Örnek: 

∫2
3x2 − 4dx 7

3 ; ∫1
2x2 − 4dx -5

3  ).

Sözdizimi: ∫a
b f (x)dx  ∫( f (x),a,b[,tol])

•　tol için, izin verilebilir hata (tolerans) aralığını girin. Varsayılan değer: Atlanırsa ve doğal giriş için: 1 × 10 -5

Bu sözdiziminde izin verilmeyenler: d dx, d 2 dx2, ∫dx, , FMin, FMax, Solve, RndFix

Örnek: ∫1
52x2 3x 4dx 404

3
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Önlemler
•　f(x) bir trigonometrik fonksiyonsa, açı birimi için S   > [Angle] > [Radian] seçeneğini seçtiğinizden 

emin olun.
•　Nümerik entegrasyon kullanıldığından, f(x) içeriği, integrasyon aralığındaki pozitif ve negatif değerler 

veya entegre edilen aralık nedeniyle hesaplanan integral değerlerinde büyük hatalar oluşabilir. 
(Örnekler: Süreksiz noktalara veya ani değişikliğe sahip bölümler olduğunda. Entegrasyon aralığı 
çok geniş olduğunda.) Bu gibi durumlarda, integrasyon aralığını birden fazla parçaya bölmek ve 
ardından hesaplamaları yapmak hesaplama doğruluğunu artırabilir.

Summation (Toplam) (Σ)       Σ(,,,)
Belirli bir f(x) aralığı için toplamı elde eder.

Sözdizimi: 
x=a

b
( f (x))       ( f (x),x,a,b[,n])       a, b, n = integers (tam sayılar), a < b

•　x herhangi bir alfa değişkeni olabilir. n, adım aralığını belirtir. Varsayılan değer: Atlanırsa ve doğal giriş 
için 1'dir.

Bu sözdiziminde izin verilmeyenler: d /dx, d2/dx2, ∫dx, Σ, FMin, FMax, Solve, RndFix

Örnek: 
x=2

6
(x2 3x + 5) = 55

Solve Equation (Denklemi Çöz) (SolveN)      SolveN()
Bir denklemin birden fazla çözümünü elde eder.

Sözdizimi: SolveN( f (x  [= right side (sağ taraf)] [, x] [,lower limit,upper limit] (,alt limit,üst limit))
•　[= sağ taraf] atlanırsa, f(x) = 0 olduğu varsayılır. [,x] için herhangi bir alfa değişkeni belirleyin ve f(x) için 

aynı değişkeni kullanın. [,x] atlanırsa, x değişkeni kullanılır. 
•　Liste biçiminde en fazla 10 çözüm döndürülür.
•　Çözüm yoksa “No Solution” (Çözüm Yok) döndürülür.
•　Sağlanan çözüm(ler)den farklı bir çözüm mevcut olabileceği durumlarda, ekranda “More solutions may 

exist.” (Daha fazla çözüm mevcut olabilir.) mesajı görünür. 

Bu sözdiziminde izin verilmeyenler: d2/dx2, Σ, FMin, FMax, Solve

Örnek: SolveN(x2 5x 6) = {-1,6}

Solve Equation (Denklemi Çöz) (Solve)      Solve(,)
f(x) = 0 için tek bir çözümü yaklaşık olarak bulur. Bu fonksiyon, Equation uygulamasının “Çözücü Kullanma” 
(sayfa 116) ile aynı işlevselliğe sahiptir. 

Sözdizimi: Solve( f(x), initial estimate (ilk tahmin) [,lower limit,upper limit]) [,alt limit,üst limit])
Bu sözdiziminde izin verilmeyenler: d2/dx2, Σ, FMin, FMax, Solve

Remainder of Integer÷Integer (Tam Sayı÷Tam Sayı Kalanı )      Rmdr
Bir tam sayı başka bir tam sayıya bölündüğünde kalanı elde eder.

Sözdizimi: dividend Rmdr divisor (bölünen Rmdr bölen)
Örnek: 17 Rmdr 7 = 3

Integer Part of Int÷Int (Tam Sayı÷Tam Sayı Tam Kısmı)      Int÷
Bir tam sayının başka bir tam sayıya bölümünün tam kısmını elde eder.

Sözdizimi: dividend Int÷ divisor (bölünen Int÷ bölen)
Örnek: 17 Int÷ 7 = 2

Simplification (Sadeleştirme) Simp
Bir kesri en küçük terimlerine indirger. Calculate uygulamasıyla kullanmak için aşağıdaki ayarları kullanın.
S  > [Simplify] > [Manual] S  > [Complex Mode] > [Real]
ISimp için aşağıdaki sözdizimlerinden birini kullanın:

Sözdizimi 1: Fraction (Kesir)      Simp
Argümandaki kesri, bölünebilecek en küçük asal sayıya bölerek otomatik olarak sadeleştirir. Asal 
sayı ve sadeleştirme sonucu ekranda gösterilir.

Sözdizimi 2: Fraction (Kesir)     Simp n
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Argümandaki kesri, n ile belirtilen bölene bölerek sadeleştirir. Bölme sonucu ekranda gösterilir.

Örnek 1: 15
60 = 5

20 = 1
4

15e 60r
C  > [Function Analysis] > [Simplification]E

C  > [History (Pin )] > [I Simp]E

Örnek 2: 15
60 = 3

12  (5'lik bir bölen belirtir.)

15e 60r
C  > [Function Analysis] > [Simplification]5E

Önlemler
•　S   > [Complex Mode] (Karmaşık Mod) için [a+bi] veya [r∠θ] seçildiğinde, S   > [Simplify] (Sadeleştir) 

[Manual] (Manuel) olarak ayarlanmış olsa bile, kesir hesaplama sonuçları her zaman sadeleştirilerek 
görüntülenir.

Fonksiyon Minimumu      FMin(,,)
a ≤ x ≤ b aralığındaki f(x)'in minimum değerlerinin koordinatlarını liste biçiminde döndürür. 

Sözdizimi: FMin( f x ,a,b[,n])      n: Hesaplama doğruluğu (n = 1'den 9'a kadar tam sayı)
Bu sözdiziminde izin verilmeyenler: d /dx, d2/dx2, ∫dx, Σ, FMin, FMax, Solve, RndFix

Örnek: FMin(x2,-2,1) = {0,0}

Önlemler
•　Süreksiz noktalar veya ani dalgalanmaya sahip bölümler, doğruluğu olumsuz etkileyebilir veya bir 

hataya neden olabilir.
•　n için daha büyük bir değer girilmesi, hesaplamanın doğruluğunu artırır, ancak hesaplamayı 

gerçekleştirmek için gereken süreyi de artırır. 

Fonksiyon Maksimumu      FMax(,,)
a ≤ x ≤ b aralığındaki f(x)'in maksimum değerlerinin koordinatlarını liste biçiminde döndürür. 

Sözdizimi: FMax( f x ,a,b[,n]) n: Hesaplama doğruluğu ( n = 1'den 9'a kadar tam sayı)
Bu sözdiziminde izin verilmeyenler ve alınacak önlemler, FMin için olanlarla aynıdır.

Probability (Olasılık)

Factorial (Faktöriyel) (!)        !     
0 veya pozitif bir tam sayının faktöriyelini elde eder.

Sözdizimi: n!       n = tam sayı

Permutation (Permütasyon) (P)       P     
n kümesinden alınan r permütasyonlarının toplam sayısını elde eder.

Sözdizimi: nPr       n, r = tam sayılar
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Combination (Kombinasyon) (C)       C     
n kümesinden alınan r kombinasyonlarının toplam sayısını elde eder.

Sözdizimi: nCr       n, r = tam sayılar

Random Number (0 to 1) (Rastgele Sayı (0 - 1))       Ran#     
Her çalıştırmada 10 basamaklı bir rastgele sayı (0'dan 1'e) döndürür.

Sözdizimi: Ran# [a]       1 ≤ a ≤ 9 (a = tam sayı)
•　a: Rastgele sayı dizisini belirtir. Atlanırsa, gerçek bir rastgele sayı döndürülür. Belirtilirse, ilgili hesap 

makinesi rastgele sayı dizisi çağrılır ve sabit bir rastgele sayı döndürülür. Örneğin, dizileri* başlattıktan 
sonra Ran# 1'i çalıştırmak her zaman Seri 1'den sıralı olarak rastgele sayılar döndürür (0.701320948, 
0.9297706456, 0.2939058016, ...).

*　Dizileri başlatmak için Ran# 0'ı çalıştırın. Bu aynı zamanda RanList#'deki dizileri de başlatır. Diziler, Ran# 
veya RanList# kullanarak en son çalıştırılan seriden farklı bir rastgele sayı serisi üreterek veya gerçek bir 
rastgele sayı üreterek de başlatılabilir.

Random Integer (n to m) (Rastgele Tam Sayı (n - m))         RanInt#(,,)     
Belirtilen iki tam sayı n ve m arasında bir tam sayı rastgele sayı üretir.

Sözdizimi: RanInt#( n,m[,a])       n < m, |n| < 1×1010, |m| < 1×1010, m ‒ n < 1×1010, 1 ≤ a ≤ 999
•　a: Rastgele sayı sayısını belirtir. Atlanırsa, bir rastgele sayı döndürülür. Belirtilirse, belirtilen sayıda rastgele 

sayıyı liste biçiminde döndürür.

Random Number (Rastgele Sayı) (Normal)          RanNorm#(,,)     
Belirtilen ortalama μ ve standart sapma σ'ya dayalı olarak normal dağılımı kullanarak 10 basamaklı bir rastgele 
sayı üretir.

Sözdizimi: RanNorm#(σ, μ[,n])      σ > 0, 1 ≤ n ≤ 999
•　n: Rastgele sayı sayısını belirtir. Atlanırsa, bir rastgele sayı döndürülür. Belirtilirse, belirtilen sayıda rastgele 

sayıyı liste biçiminde döndürür.

Örnek: Ortalama boyu 68 cm olan bir yaşından küçük çocuk grubunun normal dağılıma göre elde edilen boy 
değerlerinin rastgele bir sayısını oluşturmak için. Standart sapmanın 8 olduğunu varsayın: 
RanNorm#(8,68)

Random Number (Rastgele Sayı) (Binomial) (Binom)         RanBin#(,,)      
Belirtilen deneme sayısı n'ye ve olasılık p'nin değerine dayalı olarak binom dağılımını kullanarak bir rastgele tam 
sayı üretir.

Sözdizimi: RanBin#( n,p[,m])       1 ≤ n ≤ 100000, 1 ≤ m ≤ 999, 0 ≤ p ≤ 1
•　m: Rastgele sayı sayısını belirtir. Atlanırsa, bir rastgele sayı döndürülür. Belirtilirse, belirtilen sayıda rastgele 

sayıyı liste biçiminde döndürür.

Random Num (0 to 1) to List (Rastgele Sayı (0 - 1) Listesi)          RanList#()     
Her çalıştırmada, liste biçiminde, belirtilen sayıda rastgele sayı (0'dan 1'e, 10 basamaklı) döndürür.

Sözdizimi: RanList#( n[,a])       1 ≤ a ≤ 9, 1 ≤ n ≤ 999 (a, n = integers)
•　n: Deneme sayısını belirtir. Bu parametre, üretilecek rastgele sayı sayısını belirtir.
•　a: Ran# ile aynıdır.

Örnek: (Ran# 0 çalıştırıldıktan hemen sonra) RanList#(3,1) =
{0.701320948,0.9297706456,0.2939058016}

Random Sample from List (isteden Rastgele Örneklem)       RanSamp#(,,)        
Bir listeden rastgele öğeleri örnekler ve sonucu liste biçiminde döndürür.

Sözdizimi: RanSamp#(List,n[,m])
•　List: Bir liste değişkeni (List 1'den List 26'ya veya List Ans)* veya bir liste
*　Liste değişkenleri, alt adlar (sayfa 27) kullanılarak da belirtilebilir. .

•　n: Deneme sayısı (m = 0 olduğunda 1 ≤ n ≤ 999, m = 1 olduğunda 1 ≤ n ≤ Listedeki öğe sayısı) 
•　m: 0 veya 1 belirtir (atlanırsa 0). m = 0 olduğunda, her öğe birden fazla kez çıkarılabilir. m = 1 olduğunda, 

her öğe yalnızca bir kez çıkarılabilir.

Örnek: {1,3,6,7}'den iki rastgele öğe çıkarmak için: RanSamp#({1,3,6,7},2,1)
{1,3,6,7}'den beş rastgele öğe çıkarmak için: RanSamp#({1,3,6,7},5)
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Sayısal Hesaplamalar (Numeric Calc)

GCD      GCD(,)
Birden çok tam sayının en büyük ortak bölenini elde eder.

Sözdizimi: GCD(n,m)

LCM      LCM(,)
Birden çok tam sayının en küçük ortak katını elde eder.

Sözdizimi: LCM( n,m)

Absolute Value (Mutlak Değer)      Abs()
n argümanının mutlak değerini bulur.

Sözdizimi: |n|       Abs(n)

Integer Part (Tam Kısım)      Int()
n argümanının tam kısmını ayıklar.

Sözdizimi: Int( n)
Örnek: Int(-3.5) = -3

Fraction Part (Kesirli Kısım)      Frac()
n argümanının kesirli kısmını ayıklar.

Sözdizimi: Frac(n)
Örnek: Frac(-3.5) = -0.5

Round Off (Yuvarlama)      Rnd
Bu fonksiyon, "Hesapla" uygulamasının "Hesaplama" sekmesinde bulunur. Son hesaplama sonucunu (Ans), 
S   > [Display] (Ekran) ayarına göre yuvarlar.

 

Sözdizimi: Yuvarla (argüman almaz, yalnızca önceki hesaplama sonucu için geçerlidir)
Örnek:  [Display] > [Fix3: 0.123] olarak ayarlandığında, 10'u 3'e bölmek ve sonra sonucu 3 ile çarpmak için:

Rnd (Yuvarla) kullanılmadığında: 10* 3E
/ 3E

Rnd (Yuvarla) kullanıldığında:

10* 3E
 > [Numeric Calc

Off]E
/ 3E

•　[Display] > [Fix3: 0.123] ayarı ile 10÷3=3.333 olarak gösterilir, ancak dahili olarak 15 basamak saklanır, 
bu yüzden Ans×3=10.000 olur. Eğer 10÷3'ün sonucu Yuvarla fonksiyonu ile gösterildiği gibi yuvarlanırsa, 
Ans×3=9.999 olur.
Largest Integer (En Büyük Tam Sayı)      Intg()

n argümanını aşmayan en büyük tam sayıyı döndürür. 
Sözdizimi: Intg(n)

Örnek: Intg(-10.56) = -11

Round Internal (Dahili Yuvarlama)      RndFix()
n argümanını, m ile belirtilen ondalık basamak sayısından sonraki basamağa göre yuvarlar (0'dan 9'a kadar).

Sözdizimi: RndFix(n[,m])
•　m atlanırsa, S    > [Display] ayarına göre, Rnd fonksiyonuyla aynı şekilde yuvarlama yapılır.

Bu sözdizimi içinde izin verilmeyenler: d /dx, d2/dx2, ∫dx, Σ, FMin, FMax, Solve, RndFix, logab
Örnek: RndFix(1.23456,3) = 1.235

Division Remainder (Bölüm Kalanı)      MOD(,)
Bu fonksiyon bir bölme işleminin kalanını elde eder. n'nin m'ye bölünmesinden sonra kalan değeri döndürür.

Sözdizimi: MOD(n,m)       (n, m = integers)
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Örnek: MOD(17,3) = 2

Remainder Exponentiation (Kalanlı Üs Alma)      MOD_Exp(,,)
Bu fonksiyon, bir modüler üs hesaplar. n sayısının p kuvvetinin m'ye bölümünden kalanı döndürür.

Sözdizimi: MOD_Exp( n,p,m)       (n, p, m = integers)
Örnek: MOD(2,4,3) = 1

Vektör (Vector)
Vct n ve Vct m, vektörler veya vektör değişkenleri olabilir.
Örnekte listelenen vektörler (örn., 1 2)       > [m×n] kullanılarak girilir. Ayrıntılar için "Hesaplamaya Vektör 
Girme" (sayfa 22) bölümüne bakınız.

Not
•　İki vektörün nokta çarpımını, çapraz çarpımını veya aralarındaki açıyı hesaplarken, iki vektörün 

boyutları aynı olmalıdır.

Vector (Vektör)      Vct
"Vct" girer. Ardından, A'dan Z'ye bir harf veya Ans girerek bir vektör değişkeni belirtir. 

Dot Product (Nokta Çarpımı)      DotP(,)
İki vektörün nokta çarpımını elde eder.

Sözdizimi: DotP(Vct n,Vct m)
Örnek: DotP( 1 2 , 3 4 ) = 11

Cross Product (Çapraz Çarpım)      CrossP(,)
İki vektörün çapraz çarpımını elde eder.

Sözdizimi: CrossP(Vct n,Vct m) (Vct n ve Vct m'nin boyutları 1 × 2, 1 × 3, 2 × 1 veya 3 × 1 olmalıdır.)
Örnek: CrossP( 1 2 , 3 4 ) = 0 0 -2

2-Vector Angle (2-Vektör Açısı)      Angle(,)
İki vektör arasındaki açıyı elde eder.

Sözdizimi: Angle(Vct n,Vct m)

Örnek: S  > [Angle] > [Radian]  olarak ayarlandığında,  Açı( 1 1 , -1 1 ) = 12π

Unit Vector (Birim Vektör)      UnitV()
Argümanla belirtilen vektörün birim vektörünü hesaplar.

Sözdizimi: UnitV(Vct n)

Örnek: UnitV( 5 5 ) = 2
2

2
2

Vector Norm (Vektör Normu)      Norm()
Belirtilen vektör veya matrisin normunu (büyüklüğünü) hesaplar.

Sözdizimi: Norm(Vct n) ; Norm(Mat n) (Mat n = matris veya matris değişkeni) 

Örnek: Norm( 1 3 ) = 10 ; Norm(
1 3
2 4

) = 30

Matris (Matrix)
Mat n ve Mat m, matrisler veya matris değişkenleridir.

Örnekte gösterilen matrisler (örn.,          )       > [m×n] kullanılarak girilir. Ayrıntılar için "Hesaplamaya 

Matris Girme" (sayfa 25) bölümüne bakınız.

0 -1
1 0  
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Not
•　Determinants (belirleyiciler) ve ters matrisler, basamak kaybı nedeniyle hatalara maruz kalabilir.
•　Satır basamak formu ve indirgenmiş satır basamak formu işlemleri, basamak kaybı nedeniyle doğru 

sonuçlar üretmeyebilir.

Matrix (Matris)      Mat
"Mat" girer. Ardından, bir matris değişkeni belirlemek için A'dan Z'ye bir harf veya Ans (önceki cevap) girin. 

Inverse Matrix (Ters Matris)     -1

Belirtilen kare matrisin tersini elde eder.
Sözdizimi: Mat n-1

Örnek: 
0 -1
1 0

-1
 = 

0 1
-1 0

Önlemler
•　Determinant’ı (belirleyici) sıfıra yakın olan matrisler için hesaplama hassasiyeti olumsuz etkilenir.

Determinant (Belirleyici)      Det()
Belirtilen kare matrisin determinantını elde eder.

Sözdizimi: Det(Mat n)

Örnek: Det(
1 3
2 4

) = -2

Matrix Transpose (Matris Devriği)      Trn()
Belirtilen matrisin devriğini (transpozesini) elde eder.

Sözdizimi: Trn(Mat n)

Örnek: Trn(
1 2
3 4
5 6

) = 
1 3 5
2 4 6

Not
•　"Tm" komutu vektörler ile de kullanılabilir. 1-satır × n-sütun vektörü, n-satır × 1-sütun vektörüne veya 

m-satır × 1-sütun vektörü, 1-satır × m-sütun vektörüne dönüştürür. 

Matrix Identity (Birim Matris)      Identity()
Belirtilen satır ve sütun sayısına sahip bir birim matris oluşturur.

Sözdizimi: Identity(n)       (n = integer)

Örnek: Identity(2) = 
1 0
0 1

Row Echelon (Satır Basamak) Formu      Ref()
Bu komut, bir matrisin satır basamak formunu bulmak için Gauss eleme algoritmasını kullanır.

Sözdizimi: Ref(Mat n)

Örnek: Ref(
1 2 3
4 5 6

) = 
1 5

4
3
2

0 1 2

Reduced Row Echelon (İndirgenmiş Satır Basamak) Formu      Rref()
Belirtilen matrisin indirgenmiş satır basamak formunu elde eder.

Sözdizimi: Rref(Mat n)

Örnek: Rref(
1 3 5
2 4 6

) = 
1 0 -1
0 1 2
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Matrix Augment (Matris Birleştirme)      Augment(,)
Aynı sayıda satıra sahip iki matrisi (veya vektörü) tek bir matriste birleştirir.

Sözdizimi: Augment(Mat m,Mat n) ; Augment(Vct m,Vct n)
•　Matrislerden biri veya her ikisi (Mat m, Mat n), sırasıyla Vct m, Vct n ile değiştirilebilir. 

Örnek: Augment(
1 3
2 4

,
2 6
4 8

) = 
1 3 2 6
2 4 4 8

 ; Augment(
1
2

,
2 6
4 8

) = 
1 2 6
2 4 8

Fill Matrix (Matris Doldurma)      Fill(,)
Bir matris değişkenindeki (veya vektör değişkenindeki) tüm elemanları belirtilen m değeriyle değiştirir..

Sözdizimi: Fill(m,Mat n) ; Fill(m,Vct n)

Dimensions (Boyutlar)      Dim()
(1) Bir matrisin (veya vektörün) boyutlarını elde eder ve liste biçiminde çıktı verir.

Sözdizimi 1: Dim(Mat n) ; Dim(Vct n)
•　Dimension komutunun sonucu bir liste olduğu için, Ans Listesi'nde saklanır.

(2) Boyutları liste biçiminde belirterek, tüm elemanları sıfır olan bir matris (veya vektör) oluşturur.
Sözdizimi 2: {a,b} → Dim(Mat n)　(a, b = tam sayılar, 1 ≤ a ≤ 999, 1 ≤ b ≤ 999) ;

{ a,b} → Dim(Vct n)　(a, b = tam sayılar, 1 ≤ b ≤ 999 olduğunda  a = 1, 1 ≤ a ≤ 999 olduğunda b = 1)

Karmaşık Sayı (Complex Number)
Aşağıdaki yazım kurallarında z harfi bir karmaşık sayıyı temsil eder. Arg,    r∠θ ve    a+bi kullanılarak yapılan 
hesaplamalar, S    > [Angle] (Açı) ayarından etkilenir.

Not
•　Hesap makinesi, a+bi biçimindeki bir karmaşık sayıyı Gauss düzleminde bir koordinat olarak kabul 

eder ve mutlak değeri |z| ile argümanı Arg(z)'yi buna göre hesaplar.

Norm of a Complex Number (Karmaşık Sayının Normu)      Abs()
Bir karmaşık sayının mutlak değerini elde eder.

Sözdizimi: |z |  Abs(z)

Örnek: |1+i| = 2

Argument (Argüman)      Arg()
Bir karmaşık sayının argümanını elde eder.

Sözdizimi: Arg(z)

Örnek: Arg(1+i) = 14π  (S  > [Angle] > [Radian])

Complex Conjugate (Karmaşık Eşlenik)      Conjg()
Eşlenik karmaşık sayıyı elde eder.

Sözdizimi: Conjg(z)
Örnek: Conjg(1+i) = 1−i

Real Part (Gerçek Kısım)      ReP()
Bir karmaşık sayının gerçek kısmını ayıklar.

Sözdizimi: ReP(z)
Örnek: ReP(1+2i) = 1

Imaginary Part (Sanal Kısım)      ImP()
Bir karmaşık sayının sanal kısmını ayıklar.

Sözdizimi: ImP( z)
Örnek: ImP(1+2i) = 2

r∠θ      r∠θ
Dikdörtgen formundaki bir değeri kutupsal forma dönüştürür.
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Sözdizimi: z r∠θ

Örnek: 1 + 3iI r∠θ = 2∠1
3π      (S  > [Angle] > [Radian])

I a+bi       I a+bi
Dikdörtgen formundaki bir değeri kutupsal forma dönüştürür.

Sözdizimi: zI a+bi

Örnek: 2∠1
3πI a+bi = 1 + 3i      (S  > [Angle] > [Radian])

İstatistik (Statistics)
Aşağıdaki tüm yazım kurallarında, "Liste n" ve "Liste m", listeler veya liste değişkenleridir. Liste değişkenleri 
için, n, m, 1'den 26'ya kadar bir değer veya Ans olabilir. Liste değişkenleri, alt isimler kullanılarak da belirtilebilir 
(sayfa 27).

.

{}     {}
Yeni bir liste girmek için küme parantezleri ({ }) kullanır.

Liste     List
"Liste" kelimesini girer. Ardından, bir liste değişkeni belirtmek için 1'den 26'ya kadar bir değer veya Ans girer.  

Dimensions (Boyutlar)     Dim()
(1) Bir listedeki eleman sayısını belirler.

Sözdizimi 1: Dim(List n)
(2) Liste elemanlarının sayısını belirler ve tüm elemanları sıfır olan bir liste değişkeni oluşturur.

Sözdizimi 2: Eleman Sayısı a → Boyut(Liste n) (a = tam sayı, 1 ≤ a ≤ 999)

Fill List (Listeyi Doldurma)     Fill(,)
Bir liste değişkenindeki tüm elemanların değerlerini aynı değerle (a) değiştirir.

Sözdizimi: Fill( a,List n)

Generate Sequence (Dizi Oluşturma)     Seq(,,,,)
Bir sayı dizisi oluşturmak için bir fonksiyon tanımlar ve onu liste biçiminde döndürür.

Syntax: Seq( f (x),x,Start Value,End Value,Increment) (Dizi( f (x),x,Başlangıç Değeri,Bitiş Değeri,Artış Miktarı))
•　x herhangi bir alfabetik değişken olabilir.

Örnek: Seq(x2,x,1,11,5) = {1,36,121}

Minimum     Min()
Sözdizimi 1: Min(Liste n) Bir listedeki tüm elemanlardan minimum değeri ayıklar.
Sözdizimi 2: Min(Liste n,Liste m) İki listedeki aynı konumdaki daha küçük olan elemanı ayıklar.

Maksimum     Max()
Sözdizimi 1: Max(Liste n) Bir listedeki tüm elemanlardan maksimum değeri ayıklar.
Sözdizimi 2: Max(Liste n,Liste n) İki listedeki aynı konumdaki daha büyük olan elemanı ayıklar. 

Mean (Ortalama)     Mean()
Bir listedeki tüm elemanların ortalama değerini bulur.

Sözdizimi: Mean(List n)

Median (Medyan)     Median()
Biri veri, diğeri frekans olmak üzere iki listenin medyanını bulur.

Sözdizimi: Median(List n,List m)
•　Liste n： Veri Listesi, Liste m： Frekans listesi

Liste n ve Liste m'deki eleman sayısı aynı olmalıdır.
Örnek: Liste 1 = {36, 16, 58, 46, 56}, Liste 2 = {75, 89, 98, 72, 67} olduğunda, Medyan(Liste 1, Liste 2) = 46

Combine Lists (Listeleri Birleştirme)     Augment(,)
İki listeyi tek bir listede birleştirir.

Sözdizimi: Augment(List n,List m)
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Sum of List Elements (Liste Elemanlarının Toplamı)     Sum()
Bir listedeki tüm elemanların toplamını bulur.

Sözdizimi: Sum(List n)

List Product (Liste Çarpımı)     Prod()
Bir listedeki tüm elemanların çarpımını bulur.

Sözdizimi: Prod(List n)

Cumulative Frequency (Kümülatif Frekans)     Cuml()
Bir listedeki elemanların kümülatif frekansını (yığmalı sıklığını) hesaplar.

Sözdizimi: Cuml(List n)
Örnek: Liste 1 = {2, 3, 6, 5, 4} olduğunda, Kümül(Liste 1) = {2, 5, 11, 16, 20}

Data Percentages (Veri Yüzdeleri)     Percent()
Bir listedeki her bir elemanın, listedeki tüm elemanların toplamına göre yüzdesini hesaplar.

Sözdizimi: Percent(List n)

List Data Diff (Liste Veri Farkı)     ΔList
n elemanlı (n ≥ 2) bir listede {2. Eleman - 1. Eleman, 3. Eleman - 2. Eleman, ... n. Eleman - (n-1). Eleman} 
işlemlerini hesaplar ve sonucu liste biçiminde 

Sözdizimi: ΔList a (a = List variable number)
Not: "ΔListe 1→Liste 2" yazarak sonucu Liste 2'ye kaydedebilirsiniz.

Estimated x-Data (Tahmini x-Verisi )     x
Estimated y-Data (Tahmini y-Verisi)     y

Bu fonksiyonlar, "İstatistik" uygulamasıyla bir regresyon hesaplaması* yaptıktan hemen sonra kullanılır. Bir değişken 
için (x veya y) belirtilen bir değere karşılık, regresyon modeline dayanarak diğer değişkeni tahmin ederler.

Sözdizimi: y-değeri x (y-değeri için tahmini bir x-değeri hesaplar.)
x-değeri y (x-değeri için tahmini bir y-değeri hesaplar.)

*　Aşağıdaki regresyon modelleri için tahmini değerler hesaplanamaz: Medyan-Medyan Regresyon, 
Kuadratik Regresyon, Kübik Regresyon, Kvartik Regresyon, Sinüzoidal Regresyon, Logaritmik 
Regresyon.

Sample Standard Deviation (Standart Sapma ve Varyans)     StdDev()
Bir liste ile belirtilen verilerin örnek standart sapmasını bulur.

Sözdizimi: StdDev(Liste n[,Liste m]) (Liste n ... Örnek veri, Liste m ... Frekans verisi)
Örnek: StdDev({10,20,30,40},{3,5,4,1}) = 9.26808696

Population Standard Deviation (Popülasyon Standart Sapması)     StdDev_σ()
Bir liste ile belirtilen verilerin popülasyon standart sapmasını bulur..

Sözdizimi: StdDev_σ(Liste n[,Liste m]) (Liste n ... Örnek veri, Liste m ... Frekans verisi)

Unbiased Variance (Yansız Varyans)     Variance()
Bir liste ile belirtilen verilerin yansız varyansını bulur.

Sözdizimi: Varyans(Liste n[,Liste m]) (Liste n ... Örnek veri, Liste m ... Frekans verisi)

Population Variance (Popülasyon Varyansı)     Variance_σ2()
Bir liste ile belirtilen verilerin popülasyon varyansını bulur.

Sözdizimi: Varyans_σ²(Liste n[,Liste m]) (Liste n ... Örnek veri, Liste m... Frekans verisi)

List to Matrix (Listeyi Matrise Dönüştürme)     List→Mat()
Liste içeriklerini Mat Ans'a kaydeder.

Sözdizimi: List→Mat(List n,List m)
(Liste n ve Liste m'deki eleman sayısı aynı olmalıdır.)

Örnek: Liste 1 = {2, 3, 4}, Liste 2 = {20, 30, 40} olduğunda, Liste→Mat(Liste 1, Liste 2) =
2 20
3 30
4 40
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Matrix to List (Matrisi Listeye Dönüştürme)     Mat→List()
Belirtilen bir matris değişkeninin sütunlarını Ans Listesi'ne kaydeder.

Sözdizimi: Mat→List(Mat n,m)
(n, A'dan Z'ye bir harf veya Ans'dır ve m bir sütun numarasıdır.

Örnek: Mat A =            olduğunda, Mat→Liste(Mat A,1) = {2, 3, 4} 
2 20
3 30
4 40

Not: "Mat→Liste(Mat A,1)→Liste 1" yazarak Mat A'nın 1. Sütunundaki elemanları Liste 1'e atayabilirsiniz.

Distribution (Dağılım): Standart Normal Dağılım için Olasılık Hesaplaması

fx-1AU GRAPH Kullanıcıları için Dikkat Edilmesi Gerekenler
•　fx-1AU GRAPH'ta "Dağılım" kategorisi bulunmamaktadır, ancak bu bölümde açıklanan tüm komutlar 

C   > [All] (Tümü) menüsünden çağrılabilir.
Örnek: "P()" fonksiyonunu çağırmak için C   > [All] > [P] > [P()] seçin.

Bu bölümde açıklanan her bir matematiksel fonksiyon, "İstatistik" uygulamasıyla 1-Değişkenli bir istatistiksel 
hesaplama yaptıktan hemen sonra kullanılmak üzere tasarlanmıştır.

Normal Probability (Normal Olasılık) P(t)     P()
Normal Probability (Normal Olasılık) Q(t)     Q()
Normal Probability (Normal Olasılık) R(t)     R()

Bu fonksiyonlar, argüman olarak normalize edilmiş t değişkenini alarak, aşağıdaki şekillerde gösterilen standart 
normal dağılım için olasılık değerlerini bulur. t değeri, t() fonksiyonu kullanılarak belirlenir.

Sözdizimi: P(t) ; Q(t) ; R(t)

P(t)

0 t

Q(t)

0 t

R(t)

0 t

Normal Variable (Normal Değişken) t(x)     t()
x veri değerindeki normalize edilmiş t(x) değişkeni, 1-Değişkenli istatistiksel hesaplama sonucunda elde edilen 
ortalama    ve popülasyon standart sapması     değerlerine dayanarak aşağıdaki formülle belirlenir:x σx

t(x) = x x
σx

Sözdizimi: t(x)
Bu fonksiyon, standart normal dağılımın olasılık değerlerini bulmak için P(), Q() ve R() ile birlikte kullanılır.

Örnek:  Bir üniversitedeki 20 öğrencinin boy verileri "İstatistik" uygulamasına girildi ve 1-Değişkenli istatistiksel 
 hesaplama yapıldı. 180 cm boyundaki öğrencinin yüzde kaçlık dilimde olduğunu belirleyin.

R(t(180))
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Distribution (Dağılım): Dağılım Hesaplamaları

fx-1AU GRAPH Kullanıcıları için Dikkat Edilmesi Gerekenler
•　fx-1AU GRAPH'ta bir "Dağılım" kategorisi yoktur, ancak bu bölümde açıklanan tüm komutlar C   > [All] 

menüsünden çağrılabilir.
Örnek: "NormPD()" fonksiyonunu çağırmak için C   > [All] > [N] > [NormPD()] seçeneğini belirleyin.

Bu bölümdeki her fonksiyon, farklı bir dağılım hesaplaması türü gerçekleştirir.

Sözdizimi Notları
•　Aşağıdaki liste, yazım kurallarındaki sembol ve kısaltmaların anlamlarını göstermektedir:

x: veri değeri
Lower: alt sınır
Upper: üst sınır
μ：popülasyon ortalaması
σ： popülasyon standart sapması (σ > 0)
λ： ortalama (λ > 0)
p: olasılık  (0 ≤ p ≤ 1)
df : serbestlik derecesi (df  > 0)

n:df : payın serbestlik derecesi (pozitif tam sayı)

d:df : paydanın serbestlik derecesi (pozitif tam sayı)

P: başarı olasılığı (0 ≤ P ≤ 1)
n: popülasyondan deneme sayısı (0 ≤ n tam sayı)
M : popülasyondaki başarı sayısı (0 ≤ M  tam sayı)
N : popülasyon boyutu (n ≤ N  , M  ≤ N  tam sayı)

•　Parantez içinde [ ] yer alan argümanlardan herhangi biri atlandığında, aşağıdaki değerler yerine konur:
μ=0, σ=1, tail=”L” (Sol)

Hesaplama Sonucu Saklama Değişkenleri
Her fonksiyonun hesaplama sonuçlarının saklandığı değişkenlere (p, xInv, x1InvN, x2InvN, zLow, zUp, tLow, 
tUp) C   > [Değişken Verisi] > [Dağılım] üzerinden erişilebilir.

Normal Probability Density (Normal Olasılık Yoğunluğu)     NormPD()
Belirtilen veri için normal olasılık yoğunluğunu (p değeri) döndürür.

Sözdizimi: NormPD( x[,μ,σ])
•　x için tek bir değer veya bir liste belirtilebilir. Hesaplama sonucu p, p ve Ans (x bir liste olduğunda Liste 

Ans) değişkenlerine atanır.

Örnek: NormPD(1) = 0.2419707245 ; NormPD({0.5,1}) = {0.3520653268,0.2419707245}

Normal Cumulative Dist (Normal Kümülatif Dağılım)     NormCD(,)
Belirtilen veri için normal kümülatif dağılımı (p değeri) döndürür.

Sözdizimi: NormCD(Lower,Upper[, μ,σ])
•　Lower ve Upper için tek değerler veya listeler belirtilebilir. Hesaplama sonuçları p, zLow ve zUp, sırasıyla p, 

zLow ve zUp değişkenlerine atanır. Hesaplama sonucu p aynı zamanda Ans'e (Lower ve Upper listeyse 
Liste Ans) atanır.

Örnek: NormCD(-1,1) = 0.6826894921 ; NormCD({-1,-2},{1,2}) = {0.6826894921,0.9544997361}

Inverse Normal Cumul Dist (Ters Normal Kümülatif Dağılım )     InvNormCD()
Belirtilen p değeri için ters normal kümülatif dağılımı (alt ve/veya üst değerleri) döndürür.

Sözdizimi: InvNormCD([tail,] p[,μ,σ])
•　"Kuyruk" (tail) için Sol, Sağ veya Merkez belirtebilirsiniz. "Kuyruk" ayarını belirtmek için aşağıdaki sayı veya 

harfleri girin:
Sol： -1 veya ”L” Merkez： 0 veya ”C” Sağ ： 1 veya ”R”
•　p için tek bir değer veya bir liste belirtilebilir. Hesaplama sonuçları, kuyruk ayarına göre aşağıda 

açıklandığı gibi çıktı verilir.

tail = Sol Üst değer, x1InvN ve Ans (p bir liste olduğunda Liste Ans) değişkenlerine atanır. 
tail = Sağ                   Alt değer, x1InvN ve Ans (p bir liste olduğunda Liste Ans) değişkenlerine atanır.
tail = Merkez              Alt ve üst değerler sırasıyla x1InvN ve x2InvN değişkenlerine atanır. Yalnızca alt 
                                   değer Ans'e (p bir liste olduğunda Liste Ans) atanır. 

Örnek: InvNormCD(”L”,0.7,35,2) = 36.04880103
InvNormCD({0.5,0.7},35,2) = {35,36.04880103}
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t Probability Density (t Olasılık Yoğunluğu)     tPD(,)
Belirtilen veri için Student-t olasılık yoğunluğunu (p değeri) döndürür.

Sözdizimi: tPD(x,df ) "PD Sözdizimi" (sayfa 236) bölümüne bakınız.
Örnek: tPD(1,1) = 0.1591549431 ; tPD({0,1},1) = {0.3183098862,0.1591549431}

t Cumulative Distribution (t Kümülatif Dağılım)     tCD(,,)
Belirtilen veri için Student-t kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: tCD(Lower,Upper,df )
•　Lower ve Upper için tek değerler veya listeler belirtilebilir. Hesaplama sonuçları p, tLow ve tUp, sırasıyla 

p, tLow ve tUp değişkenlerine atanır. Hesaplama sonucu p ayrıca Ans'e (Lower ve Upper listeyse 
Liste Ans) atanır.

Örnek: tCD(0,1,1) = 0.25 ; tCD({0,0},{1,2},1) = {0.25,0.3524163823}

Inverse t Cumulative Dist (Ters t Kümülatif Dağılım)     InvTCD(,)
Belirtilen p değeri için ters Student-t kümülatif dağılımını (Lower değeri) döndürür.

Sözdizimi: InvTCD(p,df ) "Ters Kümülatif Dağılım Yazım Kuralları (sürekli 
dağılımlar)" (sayfa 236) bölümüne bakınız.

Örnek: InvTCD(0.25,1) = 1 ; InvTCD({0.25,0.75},1) = {1,-1}

χ2 Probability Density (Olasılık Yoğunluğu)     ChiPD(,)
Belirtilen veri için     olasılık yoğunluğunu (p değeri) döndürür. χ2

Sözdizimi: ChiPD(x,df ) "PD Sözdizimi" (sayfa 236) bölümüne bakınız..
Örnek: ChiPD(1,1) = 0.2419707245 ; ChiPD({0,1},1) = {0,0.2419707245}

χ2 Cumulative Distribution (Kümülatif Dağılım)     ChiCD(,,)
Belirtilen veri için     kümülatif dağılımını (p değeri) döndürür.χ2

Sözdizimi: ChiCD(Lower,Upper,df ) "CD Sözdizimi" (sayfa 236) bölümüne bakınız.
Örnek: ChiCD(0,1,1) = 0.6826894921 ; ChiCD({0,0},{1,2},1) = {0.6826894921,0.8427007929}

Inverse χ2 Cumulative Dist (Ters      Kümülatif Dağılım)     InvChiCD(,)
Belirtilen p değeri için ters     kümülatif dağılımını (Lower değeri) döndürür. χ2

Sözdizimi: InvChiCD(p,df ) "Ters CD Sözdizimi (sürekli dağılımlar)" (sayfa 
236) bölümüne bakınız.

Örnek: InvChiCD(0.319,1) = 0.9930420738 ; InvChiCD({0.64,0.319},1) = {0.2187421667,0.9930420738}

F Probability Density (F Olasılık Yoğunluğu)     FPD(,,)
Belirtilen veri için F olasılık yoğunluğunu (p değeri) döndürür. 

Sözdizimi: FPD(x,n:df ,d:df ) "PD Sözdizimi" (sayfa 236) bölümüne bakınız.
Örnek: FPD(1,1,2) = 0.1924500897 ; FPD({1,2},1,2) = {0.1924500897,0.08838834765}

F Cumulative Distribution (F Kümülatif Dağılım)     FCD(,,,)
Belirtilen veri için F kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: FCD(Lower,Upper,n:df ,d:df ) "CD Sözdizimi" (sayfa 236) bölümüne bakınız.
Örnek: FCD(0,1,1,2) = 0.5773502692 ; FCD({0,0},{1,2},1,2) = {0.5773502692,0.7071067812}

Inverse F Cumulative Dist (Ters F Kümülatif Dağılım)     InvFCD(,,)
Belirtilen p değeri için ters F kümülatif dağılımını (Lower değeri) döndürür.

Sözdizimi: InvFCD( p,n:df ,d:df ) "Ters CD Sözdizimi (sürekli dağılımlar)" (sayfa 
236) bölümüne bakınız..

Örnek: InvFCD(0.43,1,2) = 0.9625240705 ; InvFCD({0.86,0.43},1,2) = {0.03998368013,0.9625240705}

Binomial Probability (Binom Olasılık Yoğunluğu)     BinomialPD(,)
Belirtilen veri için binom olasılığını (p değeri) döndürür.

Sözdizimi: BinomialPD([x,]n,P) "PD Sözdizimi" (sayfa 236) bölümüne bakınız.
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Örnek: BinomialPD(3,5,0.5) = 0.3125 ; BinomialPD({3,5},5,0.5) = {0.3125,0.03125}

Binomial Cumulative Dist (Binom Kümülatif Dağılım)     BinomialCD(,)
Belirtilen veri için binom kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: BinomialCD([[Lower,]Upper,]n,P) "CD Sözdizimi" (sayfa 236) bölümüne bakınız. 
Örnek: BinomialCD(5,10,0.5) = 0.623046875 ; BinomialCD({0,5},{5,8},10,0.5) =

{0.623046875,0.6123046875}

Inverse Binomial Cumulative Dist (Ters Binom Kümülatif Dağılım)     InvBinomialCD(,,)
Belirtilen p değeri için ters binom kümülatif dağılımını döndürür.

Sözdizimi: InvBinomialCD( p,n,P) "Ters CD Sözdizimi (ayrık dağılımlar)" 
(sayfa 236) bölümüne bakınız. 

Örnek: InvBinomialCD(0.6,10,0.5) = 5 ; InvBinomialCD({0.6,0.3},10,0.5) = {5,4}

Önlemler
•　Ters Binom Kümülatif Dağılım hesaplamasını gerçekleştirirken, hesap makinesi belirtilen p 

değerini ve p değerinin en az anlamlı basamağından bir eksik olan değeri (p' değeri) kullanarak 
minimum deneme sayısı değerlerini hesaplar. Sonuçlar xInv (p kullanılarak hesaplanan sonuç) 
ve *xInv (p' kullanılarak hesaplanan sonuç) değişkenlerine atanır. Hesap makinesi her zaman 
sadece xInv değerini gösterir. Ancak, xInv ve *xInv değerleri farklı olduğunda, aşağıda gösterilen 
mesaj her iki değerle birlikte ekranda belirir.

p değeri

p’ değeri

Ters Binom Kümülatif Dağılımının hesaplama sonuçları tam sayılardır. p değeri 10 veya daha fazla 
basamaklı olduğunda doğruluk azalabilir. Hesaplama doğruluğundaki küçük bir farkın bile 
hesaplama sonuçlarını etkilediğini unutmayın. Bir uyarı mesajı görünürse, görüntülenen 
değerleri kontrol edin.

Poisson Probability (Poisson Olasılığı)     PoissonPD(,)
Belirtilen veri için Poisson olasılığını (p değeri) döndürür.

Sözdizimi: PoissonPD(x,λ) "PD Sözdizimi" (sayfa 236) bölümüne bakınız. 
Örnek: PoissonPD(1,1.2) = 0.3614330543 ; PoissonPD({1,2},1.2) = {0.3614330543,0.2168598326}

Poisson Cumulative Dist (Poisson Kümülatif Dağılım)     PoissonCD(,)
Belirtilen veri için Poisson kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: PoissonCD([Lower,]Upper,λ) "CD Sözdizimi" (sayfa 236) bölümüne bakınız. 
•　Lower atlanırsa, Lower = 0 varsayılır.

Örnek: PoissonCD(1,2,1.2) = 0.5782928869 ; PoissonCD({1,1},{2,3},1.2) = {0.5782928869,0.6650368199}

Inverse Poisson Cumul Dist (Ters Poisson Kümülatif Dağılım)     InvPoissonCD(,)
Belirtilen p değeri için ters Poisson kümülatif dağılımını döndürür.

Sözdizimi: InvPoissonCD( p,λ) "Ters CD Sözdizimi (ayrık dağılımlar)" 
(sayfa 236) bölümüne bakınız.

Örnek: InvPoissonCD(0.58,1.2) = 1 ; InvPoissonCD({0.58,0.75},1.2) = {1,2}
"Ters Binom Kümülatif Dağılım" (sayfa 235) bölümündekilerle aynıdır.

Geometric Probability (Geometrik Olasılık)     GeoPD(,)
Belirtilen veri için geometrik olasılığı (p değeri) döndürür.

Sözdizimi: GeoPD(x,P) "PD Sözdizimi" (sayfa 236) bölümüne bakınız. 
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Örnek: GeoPD(2,0.8) = 0.16 ; GeoPD({2,3},0.8) = {0.16,0.032}

Geometric Cumulative Dist (Geometrik Kümülatif Dağılım)     GeoCD(,)
Belirtilen veri için geometrik kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: GeoCD([Lower,]Upper, P) "CD Sözdizimi" (sayfa 236) bölümüne bakınız. 
•　Lower atlanırsa, Lower = 0 varsayılır.

Örnek: GeoCD(1,2,0.8) = 0.96 ; GeoCD({1,1},{2,3},0.8) = {0.96,0.992}

Inverse Geometric Cumul Dist (Ters Geometrik Kümülatif Dağılım)     InvGeoCD(,)
Belirtilen p değeri için ters geometrik kümülatif dağılımını döndürür.

Sözdizimi: InvGeoCD(p,P) “Ters CD Yazım Kuralları (ayrık dağılımlar)" 
(sayfa 236) bölümüne bakınız.

Örnek: InvGeoCD(0.96,0.8) = 2 ; InvGeoCD({0.96,0.992},0.8) = {2,3}
Önlemler: "Ters Binom Kümülatif Dağılım" (sayfa 235) bölümündekilerle aynıdır.

Hypergeometric Probability (Hipergeometrik Olasılık)     HypergeoPD(,,,)
Belirtilen veri için hipergeometrik olasılığı (p değeri) döndürür.

Sözdizimi: HypergeoPD(x,n,M ,N) "PD Sözdizimi" (sayfa 236) bölümüne bakınız. 
Örnek: HypergeoPD(1,5,10,20) = 0.1354489164 ; HypergeoPD({1,2},5,10,20) =

{0.1354489164,0.3482972136}

Hypergeometric Cumul Dist (Hipergeometrik Kümülatif Dağılım)     HypergeoCD(,,,)
Belirtilen veri için hipergeometrik kümülatif dağılımını (p değeri) döndürür.

Sözdizimi: HypergeoCD([Lower,]Upper,n,M ,N ) "CD Sözdizimi" (sayfa 236) bölümüne bakınız. .
•　Lower atlanırsa, Lower = 0 varsayılır.

Örnek: HypergeoCD(1,2,5,10,20) = 0.48374613 ; HypergeoCD({1,1},{2,3},5,10,20) =
{0.48374613,0.8320433437}

Inverse Hypergeo Cumul Dist (Ters Hipergeometrik Kümülatif Dağılım)     InvHypergeoCD(,,,)
Belirtilen p değeri için ters hipergeometrik kümülatif dağılımını döndürür.

Sözdizimi: InvHypergeoCD(p,n,M ,N) "Ters CD Yazım Kuralları (ayrık dağılımlar)" 
(sayfa 236) bölümüne bakınız.

Örnek: InvHypergeoCD(0.48,5,10,20) = 2 ; InvHypergeoCD({0.48,0.83},5,10,20) = {2,3}
Önlemler: "Ters Binom Kümülatif Dağılım" (sayfa 235) bölümündekilerle aynıdır. .

Sözdizimi ve Açıklamaları
Sözdizimi Açıklama

PD Sözdizimi x için tek bir değer veya liste belirtilebilir. Hesaplama sonucu p değeri, p ve 
Ans ( x bir liste ise Liste Ans) değişkenlerine atanır.

CD Sözdizimi Lower ve Upper için tek değerler veya listeler belirtilebilir. Hesaplama sonucu p 
değeri, p ve Ans ( Lower ve Upper listeyse Liste Ans) değişkenlerine atanır.

Ters CD Sözdizimi
(sürekli dağılımlar)

p için tek bir değer veya liste belirtilebilir. Lower değeri xInv ve Ans (p bir liste 
ise Liste Ans) değişkenlerine atanır.

Ters CD Sözdizimi
(ayrık dağılımlar)

p için tek bir değer veya liste belirtilebilir. Hesaplama sonucu olan X değeri 
xInv ve Ans ( p bir liste ise Liste Ans) değişkenlerine atanır.
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Angle/Coord/Sexa (Açı/Koordinat/Altmışlık Sistem)

Degrees (Derece)     °
Açı birimi olarak dereceyi belirtir.

Sözdizimi: n°

Örnek: S  > [Angle] > [Radian olarak ayarlandığında                  ] , 90° = 12 π

Radians (Radyan)      r

Açı birimi olarak radyanı belirtir.
Sözdizimi: nr

Örnek: S  > [Angle] > [Degree] olarak ayarlandığında, π2
r = 90

Gradians (Gradyan)      g

Açı birimi olarak gradyanı belirtir.
Sözdizimi: ng

Örnek: S  > [Angle] > [Degree] olarak ayarlandığında, 100g = 90

Rectangular to Polar (Dikdörtgeni Kutupsala Dönüştürme)     Pol(,)
Dikdörtgen koordinat değerlerini kutupsal koordinatlara dönüştürür ve liste biçiminde döndürür.

Sözdizimi: Pol(x,y) = (r,θ)
•　Ortaya çıkan kutupsal koordinat θ, S    > [Açı] ayarına bağlı olarak aşağıdaki aralıkta görüntülenir.

Derece: -180 < θ ≤ 180 Radyan: - π < θ ≤ π Gradyan: -200 < θ ≤ 200

Örnek: S  > [Angle] > [Radian] olarak ayarlandığında, Pol( 2, 2) = {2,14π}

Polar to Rectangular (Kutupsalı Dikdörtgene Dönüştürme)     Rec(,)
Kutupsal koordinat değerlerini dikdörtgen koordinatlara dönüştürür ve liste biçiminde döndürür.

Sözdizimi: Rec( r,θ) = (x,y)

Örnek: S  > [Angle] > [Radian] olarak ayarlandığında, Rec(2,14π) = { 2, 2}

Degs Mins Secs (Derece, Dakika, Saniye)     °
Altmışlık sistemde bir değer girer.

Sözdizimi: Degree Value°[Minute Value°[Seconds Value°]]
Örnek: 1°15° = 1.25 ; 0°75° = 1.25 ; 0°15° = 0.25 ; 0°0°900° = 0.25
Not: Hesaplama sonuçlarını altmışlık değerler olarak görüntülemek için sF       > [Sexagesimal] seçeneğini 
belirleyin. Daha fazla bilgi için "Hesaplama Sonuçlarının Görüntü Biçimini Değiştirme (Biçim Menüsü)" 
(sayfa 17) bölümüne bakınız.

.

Decimal to Sexagesimal (Ondalıktan Altmışlığa )    DMS
Ondalık bir değeri altmışlık bir değere (derece (saat), dakika, saniye) dönüştürür.

Sözdizimi: nI DMS
Örnek: 1.25I DMS = 1°15’00”

Hyperbolic Calc (Hiperbolik Hesaplamalar)
Hiperbolik ve ters hiperbolik fonksiyonlar aşağıdaki menü öğeleri kullanılarak girilebilir.

Menü öğesi Fonksiyon
sinh sinh()
cosh cosh()
tanh tanh()

Menü öğesi Fonksiyon
sinh−1 sinh−1()
cosh−1 cosh−1()
tanh−1 tanh−1()

Örnek: sinh(1) = 1.175201194 ; sinh−1(Ans) = 1
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Mühendislik Sembolleri (Engineer Symbol)
Mühendislik sembolleri aşağıdaki menü öğeleri kullanılarak girilebilir.

Menü Öğesi           Sembol 10n

Milli m 10−3

Micro μ 10−6

Nano n 10−9

Pico p 10−12

Femto f 10−15

Menü Öğesi           Sembol 10n

Kilo k 103

Mega M 106

Giga G 109

Tera T 1012

Peta P 1015

Exa E 1018

•　Bir değerin hemen sonuna bir mühendislik sembolü eklemek, o değerin 10   ile çarpılmasına neden olur (n 
burada 3'ün tam katı bir sayıdır).

n

Örnek: 7.1k = 7100 ; 2G÷100M = 20
Not: Hesaplama sonuçlarını mühendislik sembolleri ile görüntülemek için S    > [Display] > [(Engineer Symbol)] 
ayarını açın. Ayrıntılar için "Ekran (Genel)" (sayfa 218) bölümüne bakınız.

 
.
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Birim Dönüşümleri (Unit Conversions)
Bir birimdeki değeri başka bir birime dönüştürür.
Sözdizimi:   birim komutu    birim komutu (n  = gerçek sayı veya gerçek sayı listesi) n 
•　İki birim komutu "   " ile birbirine bağlanır ve tek bir birim dönüştürme komutu olarak kullanılır. İki birim 

komutu da aynı kategoriden olmalıdır. Kullanılabilir birim komutları için aşağıdaki "Birim Komutu Listesi"ne 
bakın.

Örnek: 25.4 [cm]  [in] = 10 ; {175,162} [m2]  [ha] = {0.0175,0.0162}

Birim Komutu Listesi (Unit Command List)

Kategori         Birim Komutu
Length [fm]
(Uzunluk) [Å]

[μm]
[mm]
[cm]
[m]
[km]
[AU]
[l.y.]
[pc]
[Mil]
[in]
[ft]
[yd]
[fath]
[rd]
[mile]
[n mile]

Area
(Alan)

[cm2]

[m2]
[ha]

[km2]

[in2]

[ft2]

[yd2]
[acre]

[mile2]
Volume
(Hacim)

[cm3]
[mL]
[L]

[m3]

[in3]

[ft3]
[fl_oz(UK)]
[fl_oz(US)]

Kategori         Birim Komutu
Volume [gal(US)]
(Hacim) [gal(UK)]

[pt]
[qt]
[tsp]
[tbsp]
[cup]

Time
(Zaman)

[ns]
[μs]
[ms]
[s]
[min]
[h]
[day]
[week]
[yr]
[s-yr]
[t-yr]

Temperature [°C]
(Sıcaklık) [K]

[°F]
[°R]

Velocity [m/s]
(Hız) [km/h]

[knot]
[ft/s]
[mile/h]

Mass
(Kütle)

[u]
[mg]
[g]
[kg]
[mton]
[oz]
[lb]
[slug]
[ton(short)]

Kategori         Birim Komutu
Mass (Kütle) [ton(long)]
Force
(Kuvvet)

[N]
[lbf]
[tonf]
[dyne]
[kgf]

Pressur
(Basınç)

e [Pa]
[kPa]
[mmH2O]

[mmHg]
[atm]
[inH2O]

[inHg]

[lbf/in2]
[bar]

[kgf/cm2]
Energy [eV]
(Enerji) [J]

[calth]

[cal15]

[calIT]

[kcalth]

[kcal15]

[kcalIT]

[l-atm]
[kW･h]
[ft･lbf]
[Btu]
[erg]
[kgf･m]

Power [W]
(Güç) [calth/s]

[hp]
[ft･lbf/s]
[Btu/min]
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Değişken Veri (Variable Data)
Değişken Veri kategorisi, her bir uygulamanın giriş ve çıkış değerlerini saklayan değişkenleri içerir. 
C    > [Variable Data] seçeneğini belirlediğinizde beliren menü öğeleri, uygulama adlarıdır.

Variable Data > Statistics (Değişken Veri > İstatistikler)
Bu kategorideki değişkenler, İstatistik uygulamasını kullanarak gerçekleştirilen istatistiksel hesaplamalar ve 
çizilen grafikler için giriş değerlerini ve hesaplama sonuçlarını saklar.

İstatistikler > X
Tek değişkenli veya eşleşmiş değişkenli istatistiksel hesaplamalardaki x veri değerleri:

Menü Öğesi Değişken
Data Items n
Data x Mean −

Data x Sum x

x-Data Sum of Squares x2

Menü Öğesi Değişken
x-Data Population Std Dev σx
x-Data Sample Std Dev sx
X-Data Minimum minX
X-Data Maximum maxX

İstatistikler > Y
Eşleşmiş değişkenli istatistiksel hesaplamalardaki y veri değerleri:

Menü Öğesi Değişken
Data y Mean −

Data y Sum y
y-Data Sum of Squares y2

xy-Data Products Sum xy

Menü Öğesi Değişken
y-Data Population Std Dev σy
y-Data Sample Std Dev sy
Y-Data Minimum minY
Y-Data Maximum maxY

İstatistikler > Graph
Regresyon modeli bilgi değerleri:

Menü Öğesi Değişken
a Regression Coefficient a
b Regression Coefficient b
c Regression Coefficient c
d Regression Coefficient d

Menü Öğesi Değişken
e Regression Coefficient e
Correlation Coefficient r

Coefficient of Determination r2

Error Mean Square MSe

Tek değişkenli istatistiksel hesaplama çıkış değerleri:

Menü Öğesi Değişken
1st Quartile Q1

Input Data Median Med

Menü Öğesi Değişken
3rd Quartile Q3

Input Data Mode Mod
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İstatistikler > Point Coordinates (Nokta Koordinatları)
Med-Med Regresyon yapıldığında özet noktalarının koordinatları:

Menü Öğesi Değişken
Summary Point Coords x1 x1

Summary Point Coords x2 x2

Summary Point Coords x3 x3

Menü Öğesi Değişken
Summary Point Coords y1 y1

Summary Point Coords y2 y2

Summary Point Coords y3 y3

İstatistikler > Input (Girdi)
İstatistiksel hesaplama giriş değerleri:

Menü Öğesi Değişken
Sample Size n
Sample Mean −

Sample Standard Deviation sx
Sample 1 Size n1
Sample 2 Size n2

Menü Öğesi Değişken
Sample 1 Mean −1
Sample 2 Mean −2
Sample 1 Standard Deviation sx1
Sample 2 Standard Deviation sx2
Sample p Standard Deviation sp

İstatistikler > Result > Test (Sonuç > Test)
Test hesaplama sonuçları:

Menü Öğesi Değişken
p p
z z
t t

χ2 χ2

F F
Estimated Sample Proportion
Estim Sample 1 Proportion 1
Estim Sample 2 Proportion 2
Degree of Freedom df
Standard Error se
Correlation Coefficient r

Coefficient of Determination r2

p Value of Factor A pa
F Value of Factor A Fa
Factor A Degrees of Freedom Adf

Menü Öğesi Değişken
Factor A Sum of Squares SSa
Factor A Mean Squares MSa
p Value of Factor B pb
F Value of Factor B Fb
Factor B Degrees of Freedom Bdf
Factor B Sum of Squares SSb
Factor B Mean Squares MSb
Factor AB p Value pab
Factor AB F Value Fab
Factor AB Deg of Freedom ABdf
Factor AB Sum of Squares SSab
Factor AB Mean Squares MSab
Error Degrees of Freedom Edf
Error Sum of Squares SSe
Error Mean Square MSe

İstatistikler > Result > Confidence Interval (Sonuç > Güven Aralığı)
Güven aralığı hesaplama sonuçları:

Menü Öğesi Değişken
Confidence Int Lower Limit Lower
Confidence Int Upper Limit Upper
Estimated Sample Proportion

Menü Öğesi Değişken
Estim Sample 1 Proportion 1
Estim Sample 2 Proportion 2
Degree of Freedom df
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Değişken Veri > Dağılım (Variable Data > Distribution)
Bu kategorideki değişkenler, Dağılım uygulamasını kullanarak gerçekleştirilen dağılım hesaplamalarının 
sonuçlarını saklar.

Menü Öğesi Değişken
p p
x Inverse xInv
x1 Inverse x1InvN
x2 Inverse x2InvN

Menü Öğesi Değişken
Normal Cumulative Dist Lower zLow
Normal Cumulative Dist Upper zUp
t Cumulative Dist Lower tLow
t Cumulative Dist Upper tUp

Değişken Veri > Tablo (Variable Data > Table)
Menü Öğesi Değişken Açıklama

Function Table Result F Result Grafik&Tablo uygulamasının Tablo sekmesindeki 
içerikleri matris biçiminde çıktı verir.

 

Değişken Veri > Özyineleme (Recursion)
Menü Öğesi Değişken Açıklama

Recursion Table Result R Result Özyineleme uygulamasının Tablo sekmesindeki 
içerikleri matris biçiminde çıktı verir.

Değişken Veri > Denklem (Equation)
Bu kategorideki değişkenler, Denklem uygulamasını kullanarak çözülen yüksek dereceli veya eş zamanlı 
denklemler için giriş değerlerini ve hesaplama sonuçlarını saklar.

Menü Öğesi Değişken Açıklama

Hi-Ord Coeff Ply Coef Yüksek dereceli denklem giriş katsayılarını matris 
biçiminde çıktı verir.

Hi-Ord Solutions Ply Result Yüksek dereceli denklem hesaplama sonuçlarını 
matris biçiminde çıktı verir.

Linear Coeffs Sim Coef Eş zamanlı denklem giriş katsayılarını matris 
biçiminde çıktı verir.

Linear Solutions Sim Result Eş zamanlı denklem hesaplama sonuçlarını matris 
biçiminde çıktı verir.

Tümü > A'dan Z'ye 
C    > [All] menüsü, hesap makinesindeki tüm fonksiyonların, komutların ve uygulama değişkenlerinin alfabetik bir 
listesini görüntüler. Ayrıntılar için "Katalog Menüsü Ayrıntıları" (sayfa 221) bölümüne bakın.
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Tümü > Sembol (All > Symbol)
Bu menü, aşağıdaki tabloda yer alan fonksiyon ve sembolleri içerir.

 3 () ! ∠ E (Engineer Symbol)

10^() ° (Degrees) : P (Engineer Symbol)

{  r (Radians) T (Engineer Symbol)

}  g (Gradians) = G (Engineer Symbol)

≠ ° $ M (Engineer Symbol)

<  () , k (Engineer Symbol)

>  x ( m (Engineer Symbol)

≤ −1 ) μ (Engineer Symbol)
≥ 2 [ n (Engineer Symbol)
” ＾ ] p (Engineer Symbol)
~  (Sci Notation) f (Engineer Symbol)

π -  (Sci Notation)  
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Ek (Appendix)

CSV Dosyalarını Kullanma
Liste değişkenlerinde, matris değişkenlerinde veya Elektronik Tablo uygulamasında saklanan verileri CSV 
dosyaları olarak kaydedebilirsiniz. Ayrıca, hesap makinesinin Depolama Belleği'ne kaydedilmiş CSV 
dosyalarını liste veya matris değişkenlerine ya da Elektronik Tablo uygulamasına yükleyebilirsiniz.

Önemli!
•　CSV dosyalarını kaydetmek ve içe aktarmak için hafıza alanı olarak Depolama Belleği (sayfa 196) kullanılır. 
•　CSV dosyalarını kaydederken ve içe aktarırken, ayırıcıyı ve ondalık noktayı doğru şekilde belirttiğinizden 

emin olun. Ayrıntılar için "CSV Dosyası İçe ve Dışa Aktarma Biçimini Belirleme (CSV Formatı)" 
(sayfa 201) bölümüne bakınız.

.

CSV Dosyası İçe Aktarma Gereksinimleri
Hesapla, İstatistikler, Elektronik Tablo uygulamalarından çıktı olarak alınan bir CSV dosyası veya bilgisayardan 
Depolama Belleği'ne aktarılan bir CSV dosyası içe aktarım için kullanılabilir. Aşağıdaki CSV dosya türleri içe 
aktarım için desteklenmektedir:
•　Ayırıcı olarak virgül (,) veya noktalı virgül (;), ondalık noktası olarak da nokta (.) veya virgül (,) kullanan bir 

CSV dosyası. Ayırıcı olarak sekmeyi (tab) kullanan bir CSV dosyası desteklenmez.
•　Satır sonu kodu olarak CR, LF ve CRLF desteklenmektedir.
•　Bir CSV dosyasını hesap makinesine aktarırken, dosyanın her sütununun 1. satırındaki veriler (veya dosyanın 

1. sütununun 1. satırı) çift tırnak (") veya tek tırnak (') içine alınmış bir karakter dizisi ise, CSV dosyasının tüm 
sütunlarının 1. satırı göz ardı edilecek ve veri girişi 2. satırdan itibaren başlayacaktır.

•　Bir CSV dosya adı en fazla sekiz tek baytlık karakterden oluşabilir.

Bir CSV Dosyasına Dışa Aktarma ve İçe Aktarma

Önemli!
•　Matris değişkenlerini, liste değişkenlerini veya Elektronik Tablo uygulaması verilerini bir CSV dosyasına 

kaydederken, bazı veriler aşağıda açıklandığı gibi dönüştürülür:
-　Kesir verileri: Hesaplama satırı biçimine dönüştürülür (Örnek: 2 3 4 → =2+3/4)
-　 ve π verileri: Ondalık değere dönüştürülür (Örnek: 5  → 2.236067977)

•　Bir matris veya liste değişkeni bir CSV dosyası olarak kaydedildiğinde, değişken tarafından saklanan 
karmaşık sayı verisinin sanal kısmı atlanır. Bu, yalnızca gerçek kısmın kaydedildiği anlamına gelir.

•　Aşağıdaki CSV dosyası türlerini içe aktarma girişimi hatayla sonuçlanacaktır:
-　Dönüştürülemeyen veriler (ifade veya dize) içeren bir CSV dosyası. Bu durumda, dönüştürülemeyen 

verinin bulunduğu CSV dosyasındaki konumu (Örnek: 2. satır, 3. sütun) gösteren bir hata mesajı 
görünecektir.

-　Bir matris değişkenine 999'dan fazla sütun veya 999'dan fazla satır içeren bir CSV dosyası.
Bir liste değişkenine veya bir elektronik tabloya 26'dan fazla sütun veya 999'dan fazla satır içeren bir 
CSV dosyası.Bu durumda, "Geçersiz Veri Boyutu" hatası meydana gelecektir.

Matris Değişkenlerini Bir CSV Dosyasına Kaydetme (Calculate (Hesapla) uygulaması)
1.　Hesapla uygulamasının Matris sekmesini görüntüleyin. 
2.　Bir CSV dosyasına kaydetmek istediğiniz matris değişkenini vurgulayın ve ardından       > [CSV] > [Save 

As] seçeneğini belirleyin.
•　Bu işlem, veriyi kaydetmek için bir klasör seçebileceğiniz bir iletişim kutusu görüntüler.

3.　Kayıt hedef klasörünü seçmek için aşağıdaki işlemi kullanın:

Bu klasörü seçmek için: Bu işlemi gerçekleştirin:
Root directory (Kök dizin) ROOT'u vurgulayın ve ardından O    tuşuna basın.
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Other folders
(Diğer Klasörler)

(1)　 Seçmek istediğiniz klasörü vurgulayın ve O    tuşuna basın. Bu işlem 
sizi seçtiğiniz klasörün içine götürecektir.

(2)　 Klasörün adını vurgulayın ve tekrar O    tuşuna basın.

4.　Görüntülenen iletişim kutusunu kullanarak dosya adı için en fazla sekiz karakter girin ve ardından O    tuşuna 
basın.

CSV Dosyasını Bir Matris Değişkenine İçe Aktarma (Calculate (Hesapla) Uygulaması)
1.　Hesapla uygulamasının Matris sekmesini görüntüleyin.

2.　CSV dosyasını içine aktarmak istediğiniz matris değişkenini vurgulayın.
•　Vurguladığınız matris değişkeni zaten veri içeriyorsa, bir sonraki adım mevcut verilerin üzerine yazılmasına 

neden olacaktır.

3.　T    > [CSV] > [Load] seçeneğini belirleyin.

4.　Görüntülenen iletişim kutusunda, içe aktarmak istediğiniz CSV dosyasını vurgulayın ve O    tuşuna basın.

Liste Değişkenini Bir CSV Dosyasına Kaydetme (İstatistikler Uygulaması)
Aşağıdaki işlem, şu anda açık olan Liste Dosyalarının (sayfa 32) içeriğini (Liste Düzenleyici'deki tüm liste 
değişkenleri) bir CSV dosyası olarak kaydeder.

1.　İstatistikler uygulamasının Liste Düzenleyici sekmesini görüntüleyin.

2.　T    > [CSV] > [Save As] seçeneğini belirleyin.
•　Bu işlem, veriyi kaydetmek için bir klasör seçebileceğiniz bir iletişim kutusu görüntüler.

3.　Kayıt hedef klasörünü seçmek için aşağıdaki işlemi kullanın:

Bu klasörü seçmek için:          Bu işlemi gerçekleştirin:
Root directory (Kök dizin) ROOT'u vurgulayın ve ardından O   tuşuna basın.
Other folders (Diğer klasörler) (1)　 Seçmek istediğiniz klasörü vurgulayın ve O   tuşuna basın. Bu işlem 

sizi seçtiğiniz klasörün içine götürecektir.

(2)　 Klasörün adını vurgulayın ve tekrar O    tuşuna basın.

4.　Görüntülenen iletişim kutusunu kullanarak dosya adı için en fazla sekiz karakter girin ve ardından O 
tuşuna basın.

CSV Dosyasını Liste Düzenleyici'ye İçe Aktarma (İstatistikler Uygulaması)
1.　İstatistikler uygulamasının Liste Düzenleyici sekmesini görüntüleyin.
2.　CSV dosyasını içe aktarmak için kullanmak istediğiniz yönteme bağlı olarak aşağıdaki işlemlerden birini 

gerçekleştirin.

Bunu yapmak için: Bu menü öğesini seçin:
Belirli bir sütundan içe 
aktarmaya başla

T  > [CSV] > [Load] > [List]

Mevcut tüm Liste Düzenleyici 
içeriklerinin üzerine yaz

T  > [CSV] > [Load] > [File]

3.　Görüntülenen iletişim kutusunda, içe aktarmak istediğiniz CSV dosyasını vurgulayın ve O   tuşuna basın.
•　Yukarıdaki 2. adımda [List] seçeneğini belirlediyseniz, içe aktarma işlemi imlecin şu anda bulunduğu 

hücreyi içeren sütundan başlar. Liste Düzenleyici'deki sütunların üzerine, CSV dosyasında bulunan 
sütun sayısı kadar veri yazılır.

Elektronik Tabloyu Bir CSV Dosyasına Kaydetme (Elektronik Tablo (Spreadsheet) Uygulaması)
1.　Elektronik Tablo uygulamasının Spreadsheet sekmesini görüntüleyin.

2.　Gerekirse, elektronik tablo içeriğini yeniden hesaplamak için T    > [Recalculate] seçeneğini belirleyin.
•　Elektronik tablo içeriğini bir CSV dosyasına kaydettiğinizde yeniden hesaplamanın otomatik olarak 

yapılmadığını unutmayın. Elektronik tablo, eşittir sembolü (=) ile başlayan bir formül içeriyorsa, yeniden 
hesaplamayı mutlaka gerçekleştirin.

•　Formüller CSV dosyasına kaydedilmez. Sadece hesaplama sonuçları kaydedilir.
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•　Elektronik tabloda yer alan ERROR (HATA) hücre verilerinin tümü, boş veri olarak kaydedilir.

3.　T    > [CSV] > [Save As] seçeneğini belirleyin.
•　Bu işlem, veriyi kaydetmek için bir klasör seçebileceğiniz bir iletişim kutusu görüntüler.
•　Bu prosedürün geri kalanı için, "Matris Değişkenlerini Bir CSV Dosyasına Kaydetme (Hesapla uygulaması)" 

(sayfa 244) bölümündeki 3. adımdan itibaren devam edin.

CSV Dosyasını Elektronik Tabloya İçe Aktarma (Spreadsheet (Elektronik Tablo) Uygulaması)
1.　Elektronik Tablo uygulamasının Spreadsheet sekmesini görüntüleyin.

2.　T    > [CSV] > [Load] seçeneğini belirleyin.

3.　Görüntülenen iletişim kutusunda, içe aktarmak istediğiniz CSV dosyasını vurgulayın ve O    tuşuna basın.
•　Bu işlem, belirttiğiniz CSV dosyasının içeriğini elektronik tabloya aktarır.

Hesaplama Öncelik Sırası
Hesap makinesi, hesaplamaları belirli bir öncelik sırasına göre gerçekleştirir.
•　Temel olarak, hesaplamalar soldan sağa doğru yapılır.
•　Parantez içindeki ifadeler en yüksek önceliğe sahiptir.
•　Aşağıda, her bir komut için öncelik sırası gösterilmektedir.

Parantezli ifadeler
2  A Tipi Fonksiyonlar

-　Parantez içinde argüman alan fonksiyonlar: sin(), log(), d/dx() vb.
-　Liste, matris ve vektör değişkenleri için önekler: List, Mat, Vct
-　Bileşik fonksiyonlar  (sayfa 77)： yn, rn, Xtn, Ytn, Xn (n: 1-20)

3 B Tipi Fonksiyonlar (giriş değerinden sonra gelen fonksiyonlar)
-　x2, x-1, x!, ° ’ ”, °, r, g
-　engineering symbols (mühendislik sembolleri)

4 üsler( ), kökler ( )
5 Kesirler
6  π, bellek adı veya değişken adının önündeki örtük çarpma formatı: 2π, 5A vb.
7 Negatif işaret ((-))

C Tipi Fonksiyonlar (giriş değerinden önce gelen fonksiyonlar)
-　Liste hesaplama fonksiyonu (Δlist)
-　Taban öneki (d, h, b, o)

8 A Tipi fonksiyonların, C Tipi fonksiyonların ve parantezlerin önündeki örtük çarpma formatı: 2  3, 
A log(2) vb.

9  Permütasyon (nPr), kombinasyon (nCr), karmaşık sayı kutupsal koordinat sembolü (∠)
10  Metrik dönüşüm komutları
11 × , ÷, Int÷, Rmdr
12 +, –
13 İlişkisel operatörler: =, ≠, >, <, ≥, ≤
14  And (mantıksal operatör), and (bit seviyesi operatör)
15  Or, Xor (mantıksal operatör), or, xor, xnor (bit seviyesi operatör)

Not
•　Aynı önceliğe sahip fonksiyonlar birbiri ardına kullanıldığında, yürütme sağdan sola doğru gerçekleştirilir.
•　Bileşik fonksiyonlar sağdan sola doğru yürütülür.
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•　Bir hesaplama negatif bir değer içeriyorsa, bu değeri parantez içine almanız gerekebilir.
Örneğin, -2 değerinin karesini almak istiyorsanız, (-2)  şeklinde giriş yapmanız gerekir. Bunun nedeni, 
    'nin değerden önce gelen bir fonksiyon olmasıdır (Öncelik 3), bu nedenle önceliği, bir önek sembolü 
olan negatif işaretinden (Öncelik 7) daha yüksektir.
x2

Örnek: s- (M )2iE                  -22 = -4
(s- (M )2)iE      (-2)2 = 4

•　k   tuşuna bastığınızda girilen veri, mevcut S    > [            Key] (sayfa 219) ayarına bağlıdır. Hesaplama 
önceliği, girilen formülün yazım kuralına bağlıdır. Bu nedenle, yukarıdaki ayarı değiştirmek, aynı tuş 
işlemleriyle formül girseniz bile hesaplama sonuçlarını etkileyebilir.

Örnek: 
S  > [ Key] > [  (Power)]:

100 ÷ 2 hesaplamasının önceliği daha yüksektir, bu 
nedenle sonuç (100 ÷ 2) × 102 = 5000 olur.

S  > [ Key] > [  (Sci Notation)] or [  (Sci Notation)]:

2 × 102 hesaplamasının önceliği daha yüksektir, bu 
nedenle sonuç 100 ÷ (2 × 102) = 0.5 olur.

Error (Hata) Mesajı Tablosu
Genel Hesaplama Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Syntax ERROR Gerçekleştirdiğiniz hesaplamanın 
(Sözdizimi Hatası) biçiminde bir sorun var.

Gerekli düzeltmeleri yapın.

Math ERROR •
(Matematik Hatası)

　Hesaplama aralığını aşan bir sonuç
oluştu.

•　Ara veya nihai hesaplama sonucu izin 
verilen hesaplama aralığı dışında.

•　Matematiksel hata (sıfıra bölme vb.).

Giriş değerlerini kontrol edin ve değerlerin 
izin verilen sınırlar içinde olduğundan 
emin olmak için düzeltmeler yapın.

Stack ERROR  Gerçekleştirdiğiniz hesaplama, sayısal
(Yığın Hatası)  yığının veya komut yığınının kapasitesini 

 aştı.

Hesaplama ifadesini, yığının kapasitesini 
aşmayacak şekilde basitleştirin.

Gerçekleştirdiğiniz hesaplama, matris 
veya vektör yığınının kapasitesini aştı.

Hesaplamayı iki veya daha fazla parçaya 
bölmeyi deneyin.

Giriş değeri tam 
sayı olmalı

Tam sayı girişi gerektiren bir yere tam 
sayı olmayan bir değer girmeye çalışılıyor.

Bir tam sayı değeri girin.

Giriş değeri matris 
olmalı

Matris girişi gerektiren bir yere matris 
olmayan bir değer girmeye çalışılıyor.

Bir matris değeri girin.

Giriş değeri matris 
veya vektör olmalı

Matris veya vektör girişi gerektiren bir 
yere matris veya vektör olmayan bir 
değer girmeye çalışılıyor.

Bir matris veya vektör girin.

Giriş değeri liste 
olmalı

Liste girişi gerektiren bir yere liste 
olmayan bir değer girmeye çalışılıyor.

Bir liste değeri girin.

Giriş değeri gerçek 
sayı olmalı 

Gerçek sayı girişi gerektiren bir yere 
gerçek sayı olmayan bir değer girmeye 
çalışılıyor.

Bir gerçek sayı değeri girin.

Geçersiz Kutupsal      Kutupsal formun (r∠θ)  r veya θ değeri 
Form için sanal bir sayı girmeye çalışılıyor.

Kutupsal formu kontrol edin.
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Yanlış argüman 
boyutu ilişkisi

İki argüman arasındaki boyut ilişkisi 
olması gerekenin tersidir.

Örnek: 3 C10

Değerleri, yazım kuralının gerektirdiği 
boyut ilişkisini koruyacak şekilde değiştirin.

Non-Real ERROR  Argüman gerçek sayı olmasına
(Gerçek Olmayan 
Hata)

rağmen, S    > [Complex Mod] > [Real] 
ayarı belirtildiğinde karmaşık sayı üreten 
bir hesaplama. 

[Complex Mod] ayarını [Real] dışında 
bir değere değiştirin.

Kesir 
Sadeleştirilemiyor

I   Simp fonksiyonu (sayfa 223) 
kullanılarak kesir sadeleştirmesi denenmiş,
ancak belirtilen bölenle sadeleştirme 
yapılamamıştır. Örnek: 4/8 kesrini 
sadeleştirmek için bölen olarak 3 belirtme.

Farklı bir bölen belirtin veya bölen 
belirtmeden I   Simp komutunu çalıştırın.

Çözülemiyor! 
Başlangıç değerini 
veya sınırları ayarla. 
Tekrar dene.

Bir Solve (Çöz) hesaplaması, belirtilen 
başlangıç varsayılan tahmini değeri içinde 
bir çözüm elde edemedi.

Belirtilen başlangıç varsayılan tahmini 
değerini değiştirin veya giriş ifadesini 
düzeltin.

Zaman Aşımı Bir Solve (Çöz) hesaplaması, yakınsama 
koşullarını karşılayamadı.

Bir Solve hesaplaması yapıyorsanız, 
başlangıç varsayılan tahmini değerini 
beklenen çözüme daha yakın bir değere 
getirmeyi deneyin.

Conversion ERROR •
(Dönüşüm Hatası)

　Birim dönüştürme komutunu kullanarak 
iki farklı kategorideki birimler arasında 
dönüştürme yapmaya çalışılıyor.

•　Bir dönüştürme ifadesinde aynı komut 
iki kez kullanılıyor.

Bir dönüştürme ifadesinde, aynı 
kategoride olan iki farklı komut belirtin.

Geçersiz Tip               Yasa dışı bir veri tipi belirtildi. Geçerli verileri belirtin.

Liste, Matris ve Vektör Hesaplama Hataları
Bu mesajı 
gördüğünüzde: 

Anlamı budur: Yapmanız gerekenler:

Geçersiz liste, 
matris veya vektör 

Bir liste, matris veya vektörün yanlış 
kullanımı.

 

Dimension ERROR
(Boyut Hatası)

Matris, vektör veya liste hesaplamaları 
sırasında yasa dışı bir boyut kullanıldı.

Matris, vektör veya liste boyutunu kontrol 
edin.

Listede Karmaşık 
Sayı

Karmaşık sayı verisinin geçersiz olduğu 
bir hesaplamada veya işlemde karmaşık 
sayı içeren bir liste kullanıldı.

Listedeki tüm elemanları gerçek sayılarla 
değiştirin.

Matriste Karmaşık 
Sayı

Karmaşık sayı verisinin geçersiz olduğu 
bir hesaplamada veya işlemde karmaşık 
sayı içeren bir matris kullanıldı.

Matristeki tüm elemanları gerçek sayılarla 
değiştirin.

Matris veya 
Vektörde Karmaşık 
Sayı

Karmaşık sayı verisinin geçersiz olduğu 
bir hesaplamada veya işlemde karmaşık 
sayı içeren bir matris veya vektör kullanıldı.

Matris veya vektördeki tüm elemanları 
gerçek sayılarla değiştirin.

Yanlış Eleman 
Sayısı

Eleman sayısı maksimum limiti aşan bir 
liste, matris veya vektör oluşturmaya 
çalıştınız.

Bir liste 999'dan fazla elemana, bir matris 
999'dan fazla satır × 999'dan fazla sütuna 
sahip olamaz. Vektör elemanları için 1 
satır × 999 sütun veya 999 satır × 1 sütun 
içinde belirtin.
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Equation (Denklem) Uygulaması Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Infinitely Many
Solutions

Eş zamanlı doğrusal denklemler için 
sonsuz sayıda çözüm var. –

No Solution  Eş zamanlı doğrusal denklemler için 
                                   çözüm yok. –

No Variable  Çözücü (Solver) (sayfa 116) denkleminde 
                                   değişken yok.

Değişken içeren bir denklem girin.

Graph&Table, Recursion, Dyna Graph, Conic Graphs Uygulama Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Range ERROR  Bir grafik çizildiğinde Görüntü Penceresi 
                                   (View Window) aralık ayarları aşıldı.

Uygun Görüntü Penceresi ayarlarını 
kullanarak yeniden çizin.

Circular ERROR  Girilen iki özyineleme formülü birbirini 
                                    çapraz referanslıyor.

Çapraz referanslamayı çözmek için özyi-
neleme formüllerini düzenleyin. Ayrıntılar 
için "Bir özyineleme formülü girmek veya 
düzenlemek için" (sayfa 109) altındaki 
Not'a bakınız.

No Variable  Dyna Grafik uygulamasında dinamik 
                                    grafik çizimi için kullanılan bir fonksiyonda 
                                    değişken belirtilmedi.

Grafik fonksiyonu için bir değişken belirtin.

No item is selected  Hiçbir veri seçili değilken bir grafik çizme-
                                    ye veya tablo oluşturmaya çalışılıyor.

Veri seçin ve tekrar deneyin.

Equation does not
have a parameter.

Değişken içeren bir ifade seçili değilken 
Değiştir (Modify) fonksiyonu işlemini 
gerçekleştirmeye çalıştınız.

Değişken içeren en az bir ve sadece bir 
ifade seçin.

Condition ERROR  Değişken içeren birden fazla ifade 
                                    seçiliyken Değiştir (Modify) işlemini 
                                    gerçekleştirmeye çalıştınız.

Expression in use  Değiştir (Modify) işlemi çalışırken, bir 
                                    grafiğin ifadesini, grafik çizimi için kullanı-
                                    lan bir ifadenin bulunduğu bir alana kop-
                                    yalamaya çalışılıyor.

Farklı bir alan seçin ve tekrar deneyin.

Too Many Variables  Beşten fazla değişken içeren bir ifade 
                                    kullanarak Değiştir (Modify) fonksiyonunu 
                                    gerçekleştirmeye çalışılıyor.

İfadeyi en fazla beş değişken içerecek 
şekilde değiştirin.

Invalid Graph Type •　Grafik&Tablo uygulamasında matematik-
sel fonksiyon ifadelerinden birini ((a) ila 
(d)) seçtiniz ve T    > [Modify] komutunu 
çalıştırmaya çalıştınız.

•　Grafik&Tablo uygulamasında matematik-
sel fonksiyon ifadelerinden birini ((a) ila 
(d)) seçtiniz ve bir sayı tablosu 
oluşturmaya çalıştınız.

(a)　 Alfa değişkenleri içeren, değişken-
lere atanan değerlerin belirtildiği 
fonksiyon ifadesi
(Örnek: y=Ax − 1,[A=1,2,3])

(b)　Liste içeren fonksiyon ifadesi 
(Örnek: y={1,2,3}x)

(c)　 Değişken aralığı olan fonksiyon 
ifadesi (Örnek: y=x,[0,2])

Başka bir tür fonksiyon seçip tekrar 
deneyin.
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(d)　 Eşitsizlik (Örnek: y>sin(x))

Too Many Sectors  Grafik analizi (Grafik Çöz) ile [∫dx] > [Kök], 
                                    [∫dx] > [Kesişim] veya [∫dx] > [Karışık] 
                                    kullanarak bir hesaplama yapmaya 
                                    çalıştınız, ancak belirtilen aralıkta 21 veya 
                                    daha fazla kök (veya kesişim) var.

Daha dar bir aralık belirtin ve tekrar 
deneyin.

Statistics (İstatistikler) Uygulaması Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Condition ERROR Farklı türlerde birden fazla istatistiksel 
                                   grafik görüntülemeye çalışıyorsunuz.

"Birden Fazla Grafik Kurulumu Kullanarak 
Grafik Çizme" (sayfa 42) bölümüne bakın.

Data is in use  T   > [Save Residuals in List] veya T   > 
                                    [Save Result in List] seçeneklerini belirle-
                                    dikten sonra çıkan iletişim kutusunu kulla-
                                    narak, o anda kullandığınız listeyi kaydet-
                                    me hedefi olarak belirlediniz.

Boş bir listenin numarasını belirtin.

Spreadsheet (Elektronik Tablo) Uygulaması Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Range ERROR  Yapıştırma, geri çağırma veya başka bir 
                                    hücre işlemiyle elektronik tablo hücre 
                                    aralığı aşıldı.

Hücre aralığının aşılmamasına dikkat 
ederek işlemi tekrarlayın.

Circular ERROR  Elektronik tabloda döngüsel bir referans 
                                    var (örneğin, A1 hücresinde =A1).

Döngüsel referansları kaldırmak için hücre 
içeriğini değiştirin.

Memory (Bellek) Uygulaması Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Memory ERROR  Hesaplama veya bellek depolama işlemi, 
                                    kalan bellek kapasitesini aşıyor.

•　Kaydetmeye çalıştığınız veriyi basitleşti-
rerek mevcut bellek kapasitesi içinde 
kalmasını sağlayın. 

•　Artık ihtiyaç duymadığınız verileri silerek 
yeni veriler için yer açın.

Folder has over 200
files. Some will be
skipped. 

Bellek uygulamasında açmaya çalıştığınız 
depolama belleği klasöründeki dosya 
sayısı 200'ü aşıyor.

Bilgisayarınızı kullanarak (sayfa 210) 
dosyaları birden fazla klasöre dağıtın, 
böylece hiçbir depolama belleği 
klasöründe 200'den fazla dosya bulunmaz.

Sub-folders in this
folder cannot be
displayed. 

Bellek uygulamasında, 3. seviye iç içe geç-
miş bir depolama belleği klasörü görüntü-
leniyor ve bu klasör, 4. seviye iç içe geç-
miş bir klasör içeriyor. (4. seviye klasör 
görüntülenecek, ancak açılamayacaktır.)

Bilgisayarınızı kullanarak (sayfa 210), 
erişmek istediğiniz tüm dosyaları ilk üç 
klasör iç içe geçme seviyesinde saklayın.

Too Much Data          Veri öğesi sayısı çok fazla.                           İhtiyaç duyulmayan verileri silin.
Invalid Name Girdiğiniz dosya adı geçersiz karakterler 
                                   içeriyor.

Geçerli bir dosya adı girmek için doğru 
karakterleri kullanın.

Invalid Type Yasa dışı bir veri tipi belirtildi. Geçerli verileri belirtin.
Storage Memory
Full

Depolama belleği dolu. İhtiyaç duyulmayan verileri silin.

Data ERROR Bir veri hatası oluştu. Doğru türde veri yazdığınızdan emin olun 
ve tekrar deneyin.

Memory Full g4m dosyasını ana belleğe yüklemeye 
                                   çalıştınız, ancak yeterli alan yok.

g4m dosyalarını yüklemek için yer açmak 
amacıyla artık ihtiyaç duymadığınız 
verileri silin.
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File System ERROR  Bilgisayar ve hesap makinesi arasında bir 
                                    bağlantı kurulduktan sonra, bilgisayardan 
                                    yapılan bir işlemle hesap makinesinin 
                                    belleği yanlışlıkla biçimlendirilmiştir. 
                                    Biçimlendirme sonrası USB kablosu 
                                    çıkarıldığında bu mesaj görünür.

Biçimlendirme, hesap makinesi belleğinde 
kalan tüm verileri siler. Ne yapmanız 
gerektiğini öğrenmek için "Hesap makinesi 
belleğini yanlışlıkla biçimlendirirseniz" 
(sayfa 251) bölümüne bakın.

Cihazdaki bir elektronik bileşenin kullanım 
ömrünü tamamlaması veya başka bir 
nedenle bellek alanı ciddi şekilde 
bozulmuştur.

Mesajla birlikte görünen menüden 
[Initialize All] seçeneğini belirleyin ve 
O   tuşuna basın. Bu işlem sorunu 
çözmezse, satıcınızla veya en yakın 
CASIO servis merkeziyle iletişime geçin.

Hesap Makinesi Belleğini Yanlışlıkla Biçimlendirirseniz
Belleği yanlışlıkla biçimlendirildiği için hesap makinesi Dosya Sistemi HATASI (File System ERROR) mesajını 
görüntülüyorsa, hesap makinesini başlatmanız gerekir.

Aşağıdaki tabloda gösterilen işlemlerden birini gerçekleştirin:

Bunu yapmak için: Bu işlemi gerçekleştirin:
Biçimlendirme işleminden sonra hesap 
makinesine veri aktardıysanız, 
başlatmadan önce aktarılan verileri 
bilgisayarınıza kaydedin.

(1)　 [Save data to PC] seçeneğini vurgulayın ve O    tuşuna basın. 
(2)　 "Hesap Makinesini Bir Bilgisayara Bağlama" (sayfa 210) 

altındaki işlemleri gerçekleştirerek hesap makinesi verilerini 
bilgisayarınıza kaydedin ve ardından hesap makinesini 
bilgisayardan ayırın. 
•　Bu işlem, hesap makinesinin File System ERROR 

mesajını tekrar görüntülemesine neden olur.

(3)　 [Initialize All] seçeneğini vurgulayın ve O    tuşuna basın.

Hesap makinesini başlatın, bu işlem 
belleğinde kalan tüm verileri atacaktır.

[Initialize All] seçeneğini vurgulayın ve O    tuşuna basın.

Veri İletişim Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

CSV error in row [A]
or column [B]

İçe aktarılan CSV dosyası, 
dönüştürülemeyen veriler içeriyordu.

Bilgisayarınızı kullanarak dosyadaki A 
satırı, B sütunundaki verileri kontrol edin 
ve dönüştürülebilecek verilerle değiştirin.

USB Connect
ERROR

Veri iletişimi sırasında USB kablo 
bağlantısı kesildi.

USB kablosunu kullanarak hesap makine-
si ve bilgisayarı doğru şekilde bağlayın.

3D Graph app errors
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

No item is selected Hiçbir veri seçili değilken bir grafik 
                                   çizmeye çalışılıyor.

Veri seçin ve tekrar deneyin.

Intersection requires
two or more objects. 
(fx-CG100 only)

Önce Çizgi veya Düzlem şablonunu 
kullanmadan bir kesişim noktası 
belirlemeye çalıştınız.

Birden fazla 3B grafik çizmek için Çizgi 
şablonunu veya Düzlem şablonunu 
kullanın ve tekrar deneyin.
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birden fazla 3D grafik çizmek için Çizgi 
veya Düzlem şablonunu kullanmalısınız.

Relationship
requires two or more
objects. 
(fx-CG100 only)

Önce Çizgi veya Düzlem şablonunu 
kullanarak birden fazla 3D grafik çizmeden 
ilişki belirlemeye çalıştınız.

Birden fazla 3D grafik çizmek için Çizgi 
şablonunu veya Düzlem şablonunu 
kullanın ve tekrar deneyin.

Geometri Uygulaması Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

First select a
segment. 

Önce bir doğru parçası seçmeden dikey 
kenarortay oluşturmaya çalışıyorsunuz.

Gerekli nesneleri seçin ve tekrar deneyin.

First select a line
and point. 

Önce bir doğru parçası ve bir nokta 
seçmeden dikey veya paralel bir doğru 
oluşturmaya çalışıyorsunuz.

First select 2 points
or a segment. 

Önce iki nokta veya bir doğru parçası 
seçmeden bir orta nokta oluşturmaya 
çalışıyorsunuz.

First select the
applicable figure. 

•　Önce iki doğru seçmeden bir kesişim 
noktası oluşturmaya çalışıyorsunuz.

•
　
Gerekli nesneyi seçmeden T    > 
[Animate] > [Add Animation] veya [
Replace Animation] komutunu 
çalıştırmaya çalışıyorsunuz. 

•　Gerekli nesneyi seçmeden T    > 
[Animate] > [Add Table] komutunu 
çalıştırmaya çalışıyorsunuz.

First select 2
segments. 

Önce iki doğru parçası seçmeden bir 
açıortay oluşturmaya çalışıyorsunuz.

Range ERROR Görüntü Penceresi (View Window) aralık 
                                   ayarları aşıldı.

F   (Sığdırmak İçin Yakınlaştır) tuşuna 
basın veya       > [View] > [View Window] > 
[Pre-setWindows] > [Initialize] seçeneğini 
seçin

Animasyonları Düzenle ekranında t0 = t1 
belirtmeye çalışıyorsunuz.

t0 ve t1 için farklı değerler belirtin.

Too Many Objects! Çalışma belleği neredeyse doldu. Artık ihtiyaç duymadığınız nesneleri silin 
                                                                     veya yeni bir dosya açın.

Too Many Objects!
Work memory
cleared. 

Çalışma belleği doldu. Artık ihtiyaç duymadığınız nesneleri silin 
veya yeni bir dosya açın.

Invalid
Measurement

İfade komutunu (T   >[Option] > 
[Expression]) kullanarak, mevcut olmayan 
bir ölçüm içeren bir ifade girmeye 
çalışıyorsunuz.

Girdiğiniz ifadenin yalnızca şu anda 
ekranda bulunan ölçümleri içerdiğinden 
emin olun.

Too Many
Animations

10'dan fazla animasyon eklemeye 
çalışıyorsunuz.

Artık ihtiyaç duymadığınız animasyonları 
silmek için Animasyonları Düzenle ekranı-
nı kullanın veya yeni bir dosya oluşturup 
yeni animasyonlar ekleyin.

First select point(s). Önce bir nokta seçmeden T   > [Animate]
> [Trace] komutunu çalıştırmaya 
çalışıyorsunuz.

Bir veya daha fazla nokta seçin ve tekrar 
deneyin.

Too Many Trace
Points

10'dan fazla iz noktası belirtmeye 
çalışıyorsunuz.

En fazla 10 nokta seçin ve tekrar deneyin.
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Too Many Columns    Bir animasyon tablosuna 26'dan fazla 
                                   sütun eklemeye çalışıyorsunuz.

Animasyon tablosundan ihtiyacınız 
olmayan sütunları silin ve tekrar deneyin.

First configure
animation settings. 

•　Önce ayarlarını yapılandırmadan bir 
animasyonu çalıştırmaya çalışıyorsunuz.

•　Önce animasyon ayarlarını yapılandırma-
dan T    > [Animate] > [Add Table] ko-
mutunu çalıştırmaya çalışıyorsunuz.

Animasyon ayarlarını yapılandırın ve 
tekrar deneyin.

Cannot Add
Animation 

•　Animasyon Ekle veya Animasyonu 
Değiştir komut işlemi için seçtiğiniz 
nokta, kilitli olması gibi bir nedenle 
animasyonda kullanılamaz

•　Animasyon Ekle veya Animasyonu 
Değiştir komut işlemi için seçtiğiniz 
nokta, zaten yapılandırmakta olduğunuz 
animasyonda veya başka bir 
animasyonda kullanıldığı için 
animasyonda kullanılamaz.

Animasyon eklenebilecek bir nokta seçin 
ve tekrar deneyin.

Select the
applicable
measurement icon. 

Önce uygun ölçüm simgesini seçmeden 
T    > [Animate] > [Add Table] komutunu 
çalıştırmaya çalışıyorsunuz.

Animasyon tablosuna eklenebilecek bir 
ölçüm simgesi seçin.

First configure
animation settings
and create a table.

Bir animasyon tablosu oluşturmadan T   > 
[Animate] > [Display Table] 
komutunu çalıştırmaya çalıştınız.

Önce bir animasyon tablosu oluşturun.

Create at least one
figure with a fill color. 

Ekranda dolgu rengine sahip hiçbir şekil 
yokken bir yüzey alanı hesaplaması (T 
> [Option] > [Area Calc]) yapmaya 
çalışıyorsunuz.

Dolgu rengi olan bir şekil çizin ve tekrar 
deneyin.

Settings (Ayar) Hataları
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

Out of Domain İzin verilen giriş aralığının dışında bir 
                                   değer girmeye çalışılıyor.

İzin verilen aralık içinde bir değer girin.

Invalid Setting Uygun olmayan bir Görüntü Penceresi         Görüntü Penceresi değerini aralık içinde
                                   (View Window) değeri girildi. within range.

Aralık ekranında uygun olmayan bir değer 
girildi ve bu değer yürütme için kullanıldı.

Uygun bir aralık değeri girin.

Adım (Step) değeri 0 olan bir tablo 
oluşturmaya çalışılıyor.

0'dan farklı bir Adım değeri belirtin. 

Yasa dışı Görüntü Penceresi ayarı 
kombinasyonları girmeye çalışılıyor. 
Örnek: x Minimum = 10, x Maksimum = 10

Birbiriyle uygun ilişkiye sahip değerler 
girin.

Özyineleme uygulamasında Başlangıç 
(Start) değeri Bitiş (End) değerine eşit 
veya ondan büyükken bir tablo 
oluşturmaya çalışılıyor.

Değeri, Başlangıç değerinin Bitiş 
değerinden küçük olacak şekilde değiştirin.

Bir fonksiyon hesaplaması veya İstatistik 
ya da Finansal uygulamasında bir 
hesaplama yürütülürken dahili hesaplama 
matematiksel bir hata (sıfıra bölme vb.) 
üretti.

Hesaplama, hesaplanamayan bir veya 
daha fazla değer içerdiğinden, farklı 
değerler girin ve tekrar deneyin.

3D Grafik uygulamasında bir şablon kat-
sayısı için uygun olmayan değerler girildi.

3D grafiği tanımlayabilecek katsayı 
değerlerini girin.
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Out of Range Hesaplama sonucu, hesap makinesi 
                                   ekran aralığını aşıyor.

Hesaplama formülünü değiştirin.

Diğer Hatalar
Bu mesajı 
gördüğünüzde:

Anlamı budur: Yapmanız gerekenler:

No Data Belirtilen veri mevcut değil. (Veri 
içermeyen bir listeye veya değişkene 
atıfta bulunulduğunda oluşur.)

Veri tanımını değiştirin.

Not Enough
Elements

Bir hesaplama için belirttiğiniz liste, 
hesaplamayı gerçekleştirmek için gereken 
sayıda eleman içermiyor.

Gerçekleştirmeye çalıştığınız hesaplama-
nın gerektirdiği eleman sayısını kontrol 
edin ve liste elemanlarının sayısını buna 
göre ayarlayın.

Frekans verisi için tüm elemanları sıfır 
olan bir liste kullanarak istatistiksel bir 
hesaplama yapmaya çalıştınız.

Frekans verisi için elemanları sıfırdan 
büyük değerler içeren bir liste kullanın.

Hesaplama Aralıkları, Basamak Sayısı ve Hassasiyet

Calculation Range (Hesaplama Aralığı) ve Precision (Hassasiyet)

Calculation Range ±1 × 10-99 ile ±9.999999999 × 1099 veya 0
Number of Digits for
Internal Calculation

15 basamak

Precision Genel olarak, tek bir hesaplama için 10. basamakta ±1. Üstel gösterim için 
hassasiyet, en az anlamlı basamakta ±1'dir. Ardışık hesaplamalarda hatalar
birikir.

Function Calculation Input Ranges and Precision (Fonksiyon Hesaplama Giriş 
Aralıkları ve Hassasiyeti)

Fonksiyon Giriş Aralığı

sinx
cosx

Derece |x| < 9 × 109

Radyan |x| < 5 × 107π

Gradyan |x| < 1 × 1010

tanx
Derece sinx ile aynı, ancak  |x| ≠ 90(2n−1)
Radyan sinx ile aynı, ancak x| ≠ π/2(2n−1)
Gradyan sinx ile aynı, ancak                       |x| ≠ 100(2n−1)

sin-1x
cos-1x |x| ≤ 1

tan-1x |x| < 1 × 10100

sinhx
coshx |x| ≤ 230.9516564

tanhx |x| < 1 × 10100

sinh-1x |x| < 1 × 10100

cosh-1x 1 ≤ x < 1 × 10100

tanh-1x |x| < 1

logx *

lnx * 1 × 10-99 ≤ x < 1 × 10100

10x * -1 × 10100 < x < 100

254

 |



ex * -1 × 10100 < x ≤ 230.2585092

x * 0 ≤ x < 1 × 10100

x2 * |x| < 1 × 1050

x-1 * |x| < 1 × 10100 ; x ≠ 0
x! 0 ≤ x ≤ 69 (x bir tam sayıdır)

nPr
0 ≤ r ≤ n, n < 1 × 1010 (n, r tam sayılardır)

1 ≤ {n!/(n−r)!} < 1 × 10100

nCr
0 ≤ r ≤ n, n < 1 × 1010 (n, r tam sayılardır)

1 ≤ n!/r! < 1 × 10100 or 1 ≤ n!/(n−r)! < 1 × 10100

Pol(x,y) x2 + y2 < 1 × 10100

Rec(r,θ) |r| < 1 × 10100

θ : sin                     ile aynıx, cosx, tanx

a°b’c” |a|, b, c < 1 × 10100 ; 0 ≤ b, c

a°b’c” = x
|x| < 1 × 10100

Sexagesimal display (Altmışlık gösterim): |x | < 1 × 107

xy *

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1  (m, n tam sayılardır)

Ancak: -1 × 10100 < ylog |x| < 100

yx  *

y > 0: x ≠ 0, -1 × 10100 < 1x  logy < 100

y = 0: x > 0

y < 0: x = 2n+1, 2n + 1
m  (m ≠ 0; m, n tam sayılardır)

Ancak: -1 × 10100 < 1x  log |y| < 100

ab c
Tam sayının, payın ve paydanın toplamı (ayırıcı sembol dahil) 10 basamaktan az veya 
eşit olmalıdır.

GCD(a,b) |a|, |b| < 1 × 1010 (a, b tam sayılardır)

LCM(a,b) 0 ≤ a, b < 1 × 1010 (a, b tam sayılardır)
*　Karmaşık sayılar argüman olarak kullanılabilir.
•　Hassasiyet, temel olarak "Hesaplama Aralığı ve Hassasiyeti" (sayfa 254) bölümünde açıklananlarla aynıdır.
•　xy, yx , x!, nPr, nCr gibi fonksiyonlar, her hesaplamada oluşan hataların birikmesine neden olabilecek ardışık 

dahili hesaplama gerektirir.
•　Hata birikir ve bir fonksiyonun tekil noktası ve bükülme noktası yakınında büyük olma eğilimindedir.
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MicroPython Lisans Bilgileri
MIT Lisansı (MIT License)
 
Telif hakkı (c) 2013-2017 Damien P. George ve diğerleri
 
İş bu belgeyle, bu yazılımın ve ilgili dokümantasyon dosyalarının ("Yazılım") bir kopyasını elde eden herhangi 
bir kişiye, Yazılımı kısıtlama olmaksızın, kullanma, kopyalama, değiştirme, birleştirme, yayımlama, dağıtma, 
alt lisans verme ve/veya kopyalarını satma hakları dahil olmak üzere, Yazılımı elden çıkarma hakkı ücretsiz 
olarak verilmiştir. Bu iznin verildiği kişiler, aşağıdaki koşullara tabi olmak kaydıyla Yazılımın kendilerine 
sağlanmasını kabul eder: 
Yukarıdaki telif hakkı bildirimi ve bu izin bildirimi, Yazılımın tüm kopyalarına veya önemli bölümlerine dahil 
edilecektir.
 
YAZILIM "OLDUĞU GİBİ", AÇIK VEYA ZIMNİ HİÇBİR GARANTİ OLMAKSIZIN, SATILABİLİRLİK, BELİRLİ BİR 
AMACA UYGUNLUK VE İHLAL ETMEME GARANTİLERİ DAHİL ANCAK BUNLARLA SINIRLI OLMAMAK 
KAYDIYLA SUNULMAKTADIR. 
HİÇBİR DURUMDA YAZARLAR VEYA TELİF HAKKI SAHİPLERİ, YAZILIMDAN VEYA YAZILIMIN 
KULLANIMINDAN YA DA DİĞER İŞLEMLERDEN KAYNAKLANAN VEYA BUNLARLA BAĞLANTILI OLAN 
HERHANGİ BİR İDDİA, HASAR VEYA DİĞER YÜKÜMLÜLÜKTEN SORUMLU DEĞİL TUTULACAKTIR.
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